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Preface

This document provides information and instructions to help you use the maintenance
utility and some of the functions in Device Manager - Storage Navigator as needed to
perform system administration tasks and change settings for VSP E990, VSP G130, G350,
G370, G700, G900, and VSP F350, F370, F700, F900 storage systems. It explains the GUI
features and provides basic navigation information.

Please read this document carefully to understand how to use the software described in
this manual, and keep a copy for reference.

Intended audience

This document is intended for system administrators, Hitachi Vantara representatives,
and authorized service providers who install, configure, and operate VSP E990, or VSP
G130, G/F350, G/F370, G/F700, G/F900 storage systems.

Readers of this document should be familiar with the following:
■ Data processing and RAID storage systems and their basic functions.
■ The VSP E990 storage systems.
■ The VSP G130, G/F350, G/F370, G/F700, G/F900 storage systems.
■ The operating system and web browser software on the system used to log in to and

manage the storage system.

Product version

This document revision applies to the following product versions:
■ VSP G130, F/G350, F/G370, F/G700, F/G900: firmware 88-06-02 or later
■ VSP E990: firmware 93-02-03 or later
■ SVOS RF 9.4 or later

Release notes

Read the release notes before installing and using this product. They may contain
requirements or restrictions that are not fully described in this document or updates or
corrections to this document. Release notes are available on Hitachi Vantara Support
Connect: https://knowledge.hitachivantara.com/Documents.

Preface

System Administrator Guide for VSP E990 and VSP G130, G/F350, G/F370, G/F700, G/F900 13

https://knowledge.hitachivantara.com/Documents


Changes in this revision
■ Updated procedure for Installing Storage Device Launcher for Adobe Air

environments.
■ Added procedure for updating SSL certifiactes in a batch.
■ Added SLL Communication support for Hitachi Ops Center Administrator.
■ Updated syslog server settings
■ Added the following system option modes (SOMs): 1182, 1198, 1199.
■ Updated the descriptions of the following SOMs: 1093, 1106.

Document conventions

This document uses the following storage system terminology conventions:

Convention Description

VSP E series Refers to the following storage systems:
■ Hitachi Virtual Storage Platform E990

This document uses the following typographic conventions:

Convention Description

Bold ■ Indicates text in a window, including window titles, menus,
menu options, buttons, fields, and labels. Example:

Click OK.
■ Indicates emphasized words in list items.

Italic ■ Indicates a document title or emphasized words in text.
■ Indicates a variable, which is a placeholder for actual text

provided by the user or for output by the system. Example:

pairdisplay -g group

(For exceptions to this convention for variables, see the entry for
angle brackets.)

Monospace Indicates text that is displayed on screen or entered by the user.
Example: pairdisplay -g oradb

Changes in this revision
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Convention Description

< > angle
brackets

Indicates variables in the following scenarios:
■ Variables are not clearly separated from the surrounding text or

from other variables. Example:

Status-<report-name><file-version>.csv

■ Variables in headings.

[ ] square
brackets

Indicates optional values. Example: [ a | b ] indicates that you can
choose a, b, or nothing.

{ } braces Indicates required or expected values. Example: { a | b } indicates
that you must choose either a or b.

| vertical bar Indicates that you have a choice between two or more options or
arguments. Examples:

[ a | b ] indicates that you can choose a, b, or nothing.

{ a | b } indicates that you must choose either a or b.

This document uses the following icons to draw attention to information:

Icon Label Description

Note Calls attention to important or additional information.

Tip Provides helpful information, guidelines, or suggestions for
performing tasks more effectively.

Caution Warns the user of adverse conditions and/or consequences
(for example, disruptive operations, data loss, or a system
crash).

WARNING Warns the user of a hazardous situation which, if not
avoided, could result in death or serious injury.

Conventions for storage capacity values

Physical storage capacity values (for example, disk drive capacity) are calculated based
on the following values:

Conventions for storage capacity values
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Physical capacity unit Value

1 kilobyte (KB) 1,000 (103) bytes

1 megabyte (MB) 1,000 KB or 1,0002 bytes

1 gigabyte (GB) 1,000 MB or 1,0003 bytes

1 terabyte (TB) 1,000 GB or 1,0004 bytes

1 petabyte (PB) 1,000 TB or 1,0005 bytes

1 exabyte (EB) 1,000 PB or 1,0006 bytes

Logical capacity values (for example, logical device capacity, cache memory capacity) are
calculated based on the following values:

Logical capacity unit Value

1 block 512 bytes

1 cylinder Mainframe: 870 KB

Open-systems:
■ OPEN-V: 960 KB
■ Others: 720 KB

1 KB 1,024 (210) bytes

1 MB 1,024 KB or 1,0242 bytes

1 GB 1,024 MB or 1,0243 bytes

1 TB 1,024 GB or 1,0244 bytes

1 PB 1,024 TB or 1,0245 bytes

1 EB 1,024 PB or 1,0246 bytes

Accessing product documentation

Product user documentation is available on Hitachi Vantara Support Connect: https://
knowledge.hitachivantara.com/Documents. Check this site for the most current
documentation, including important updates that may have been made after the release
of the product.

Accessing product documentation
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Getting help

Hitachi Vantara Support Connect is the destination for technical support of products and
solutions sold by Hitachi Vantara. To contact technical support, log on to Hitachi Vantara
Support Connect for contact information: https://support.hitachivantara.com/en_us/
contact-us.html.

Hitachi Vantara Community is a global online community for Hitachi Vantara customers,
partners, independent software vendors, employees, and prospects. It is the destination
to get answers, discover insights, and make connections. Join the conversation today!
Go to community.hitachivantara.com, register, and complete your profile.

Comments

Please send us your comments on this document to
doc.comments@hitachivantara.com. Include the document title and number, including
the revision level (for example, -07), and refer to specific sections and paragraphs
whenever possible. All comments become the property of Hitachi Vantara LLC.

Thank you!

Getting help
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Chapter 1:  Accessing the storage system

During the initial set up and configuration of the storage system, the management client
must be configured to use the management software.

If your storage system includes an SVP, you must configure Device Manager - Storage
Navigator, Hitachi Ops Center Administrator or other management software before
administering their system.

Initial setup of the management client

The management client is the computer used to log in to and manage your storage
system. The management client is LAN-attached to the storage system and
communicates with the service processor (SVP) or with the controller if your storage
system does not have an SVP. If your storage system is equipped with an SVP, you can
use Hitachi Device Manager - Storage Navigator (HDvM - SN) as well as other
management software such as Hitachi Ops Center Administrator to manage your storage
system. If your storage system does not have an SVP, you can use the Maintenance Utility
and other embedded tools such as Hitachi Storage Advisor Embedded (HSAE) to manage
your storage system.

Workflow for setting up the management client

Perform the following tasks to set up the management client for use of Device Manager -
Storage Navigator (HDvM - SN).

1. Confirm that the management client meets the hardware and software
requirements for running HDvM - SN (Requirements for management clients (on
page 19) ).

2. Configure the management client to connect through a firewall (Connecting through
a firewall (on page 24) ).

3. Set up IPv4/IPv6 communications on the management client (Setting up IPv4/IPv6
communications (on page 25) ).

4. Register the primary SVP host name on the management client (Registering the
primary SVP host name (on page 26) ).

5. Configure the web browser on the management client (Configuring the web
browser on the management client (on page 27) ).

6. For a management client running Windows, add the SVP to the trusted sites zone
(Adding your SVP to the trusted sites zone for Windows Server computers (on
page 27) ).
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7. Install Captive Bundle Application on the SVP (Installing Captive Bundle Application
(CBA) on the SVP (on page 29) ). CBA is required to use HDvM - SN with Adobe®

AIR® from HARMAN™.
8. Install Storage Device Launcher on the management client (Installing Storage Device

Launcher on the management client (on page 29) ). Storage Device Launcher is
required to use HDvM - SN with Adobe AIR from HARMAN.

9. Configure the management client for the HDvM - SN secondary window
(Configuring the management client for the HDvM - SN secondary window (on
page 31) ).

Requirements for management clients

The Device Manager - Storage Navigator administrator is responsible for setting up
management clients. Device Manager - Storage Navigator runs on supported versions of
the Windows and UNIX/Linux operating systems. If you use a physical or virtual server
running on Windows as a management client, you must configure the server to run
Device Manager - Storage Navigator.

General requirements

■ The management client must be connected to the network via LAN. Device Manager -
Storage Navigator connects to the SVP through a TCP/IP network.

■ Use category 5e or 6a LAN cable for LAN connections when the transfer speed is 1
Gbps. Maximum cable length is 328 feet (100 meters). For assistance, contact
customer support.

■ Several storage systems can be managed by one management client. Device Manager
- Storage Navigator must be set up for each storage system.

■ A maximum of 32 management clients (Device Manager - Storage Navigator) can
access the same storage system at the same time.

Requirements for Windows-based management clients

The management client must meet hardware and software requirements to run Device
Manager - Storage Navigator (HDvM - SN) in a Windows® environment.

Hardware requirements for the management client (Windows)

Item Requirement

Processor (CPU) Pentium 4 640 3.2 GHz or better

(Not dependent on a specific CPU vendor and
processor family. Core2Duo E6540 2.33 GHz or better
is recommended.)

Memory (RAM) 2 GB or more Recommended: 3 GB

Requirements for management clients
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Item Requirement

Available storage space 500 MB or more (+ 80 MB for each managed storage
system)

When HDvM - SN is using Adobe® AIR® from
HARMAN™, an additional 80 MB of free space is
required for each storage system managed by HDvM -
SN.

Monitor True Color 32-bit or better Resolution: 1280 x 1024 or
better

Keyboard and mouse You cannot use the mouse wheel feature.

Ethernet LAN card for TCP/IP
network

100BASE-TX

1000BASE-T

Software requirements for the management client (Windows)

On a Windows management client, you can use HDvM - SN with Adobe AIR from
HARMAN or with Adobe Flash Player. The following tables specify the requirements for
each method. The combinations and versions of operating system, architecture, browser,
Java Runtime Environment (JRE), and Flash Player specified below are fixed
requirements. Using other combinations or versions might produce unpredictable
results such as the inability to use the HDvM - SN windows.

Note:
■ Adobe will end support of Flash Player by the end of 2020. Make sure you

are using HDvM - SN with Adobe AIR from HARMAN before the end of
Flash Player support. If desired, you can disable use of HDvM - SN with
Flash Player. For details, see #unique_28.

■ Use software that is supported by the manufacturer. Behavior is not
guaranteed for software whose support period has expired.

Table 1 Requirements for using HDvM with AIR from HARMAN

Operating system Architecture Web browser TLS

Windows 10 64 bit Internet Explorer
11.0*

Google Chrome
63.0 or later

TLS1.2

TLS1.2 must be
enabled. AIR does
not support TLS1.3.

Windows 8.1 64 bit Internet Explorer
11.0*

Google Chrome
48.0 or later

Requirements for Windows-based management clients
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Operating system Architecture Web browser TLS

* Only the latest version of Internet Explorer that runs on each operating system is
supported according to Microsoft® Support Policy.

Table 2 Requirements for using HDvM - SN with Flash Player

Operating
system1 Architecture Browser

Java Runtime
Environment

(JRE) 5
Adobe Flash

Player 2, 4

Windows 8.1 32 bit Internet
Explorer 11.03

JRE 8.0 Update
131 or earlier

13.0 to 30

64 bit Internet
Explorer 11.03

JRE 8.0 Update
131 or earlier

13.0 to 32

64 bit Internet
Explorer 11.03

OpenJDK
11.0.1+13

13.0 to 32

32 bit Google Chrome
48.0 or later

JRE 8.0 Update 71 20.0

64 bit Google Chrome
48.0 or later

JRE 8.0 Update 71 20.0 to 32

64 bit Google Chrome
48.0 or later

OpenJDK
11.0.1+13

20.0 to 32

Windows 106 32 bit Internet
Explorer 11.03

JRE 8.0 Update
162 or earlier

13.0 to 30

64 bit Internet
Explorer 11.03

JRE 8.0 Update
162 or earlier

13.0 to 32

64 bit Internet
Explorer 11.03

OpenJDK
11.0.1+13

13.0 to 32

32 bit Google Chrome
63.0 or later

JRE 8.0 Update
152 or earlier

13.0 to 28.0

64 bit Google Chrome
63.0 or later

JRE 8.0 Update
152 or earlier

13.0 to 32

64 bit Google Chrome
63.0 or later

OpenJDK
11.0.1+13

13.0 to 32

Windows
Server 2012
Update

64 bit Internet
Explorer 10.03

JRE 8.0 Update
131 or earlier

13.0 to 30

64 bit Internet
Explorer 10.03

OpenJDK
11.0.1+13

13.0 to 30

Requirements for Windows-based management clients
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Operating
system1 Architecture Browser

Java Runtime
Environment

(JRE) 5
Adobe Flash

Player 2, 4

64 bit Google Chrome
63.0 or later

JRE 8.0 Update
152 or earlier

13.0 to 28.0

64 bit Google Chrome
63.0 or later

OpenJDK
11.0.1+13

13.0 to 28.0

Windows
Server 2012
R2 Update

64 bit Internet
Explorer 11.03

JRE 8.0 Update
131 or earlier

13.0 to 32

64 bit Internet
Explorer 11.03

OpenJDK
11.0.1+13

13.0 to 32

64 bit Google Chrome
63.0 or later

JRE 8.0 Update
152 or earlier

13.0 to 32

64 bit Google Chrome
63.0 or later

OpenJDK
11.0.1+13

13.0 to 32

Windows
Server 2016

64 bit Internet
Explorer 11.03

JRE 8.0 Update
111

13.0 to 32

64 bit Internet
Explorer 11.03

OpenJDK
11.0.1+13

13.0 to 32

64 bit Google Chrome
63.0 or later

JRE 8.0 Update
152 or earlier

13.0 to 32

64 bit Google Chrome
63.0 or later

OpenJDK
11.0.1+13

13.0 to 32

Notes:

1. If the SVP supports Internet Protocol Version 6 (IPv6), you can specify IPv6
addresses.

2. Use Flash Player with the same architecture (32 bit or 64 bit) as the browser.
3. Only the latest version of Internet Explorer active on each OS is supported,

according to Microsoft support policy.
4. The management client must be restarted after enabling Flash Player.
5. For VSP E990 (all SVP firmware versions) and for VSP G130, G/F350, G/F370, G/

F700, G/F900 SVP firmware versions 88-04-01 and later, use either JRE8 update
171 or later or OpenJDK 11.0.1+13 or later. You can use the HDvM - SN secondary
window only when these JRE versions are installed. If you want to use other JRE
versions, contact customer support.

If the SVP firmware is updated from earlier than 88-04-01 to 88-04-01 or later, see
Checking Java security settings (on page 33) .

Requirements for Windows-based management clients
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Operating
system1 Architecture Browser

Java Runtime
Environment

(JRE) 5
Adobe Flash

Player 2, 4

6. Do not right-click when executing commands in the Command Prompt window of
Windows 10. If you do, the processing might be stopped in the middle of the
execution and the prompt does not return.

Note:
■ Some Device Manager - Storage Navigator operations are performed

through the HDvM - SN secondary window that runs within Java.
■ When you display an HTML format report saved in your local file system in

a web browser that uses Flash Player version 23 or later, add the folder
containing the HTML format report to Trusted Location Settings.

Requirements for UNIX/Linux-based management clients

The management client must meet hardware and software requirements to run Device
Manager - Storage Navigator (HDvM - SN) in a UNIX® or Linux® environment.

Hardware requirements for the management clients (UNIX/Linux)

Item Requirement

Processor (CPU) Pentium 4 640 3.2 GHz or better

(Recommended: Core2Duo E6540 2.33 GHz or better)

Memory (RAM) 2 GB or more

Recommended: 3 GB

Available storage space 500 MB or more

Monitor Resolution: 1280 x 1024 or better

Keyboard and mouse You cannot use the mouse wheel feature.

Ethernet LAN card for TCP/IP
network

100BASE-TX

1000BASE-T

Software requirements for the management clients (UNIX/Linux)

The following table specifies the software requirements for using HDvM - SN in a UNIX or
Linux environment. The combinations of operating system, architecture, browser, Java
Runtime Environment, and Adobe Flash Player described below are fixed requirements.
Using other combinations or versions might produce unpredictable results such as the
inability to use the HDvM - SN windows.

Requirements for UNIX/Linux-based management clients
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Caution: If the SVP microcode version is updated from earlier than 88-04-01-
XX/00 to 88-04-01-XX/00 or later, see Checking Java security settings (on
page 33) .

Operating
system Architecture Browser

Java Runtime

Environment (JRE)1
Adobe Flash

Player

Red Hat
Enterprise Linux
7.4

64 bit Google Chrome
63.0 or later

JRE 8.0 Update 152 Adobe Flash
Player 28

Google Chrome
63.0 or later

OpenJDK 11.0.1+13

Firefox 58.0 or
later2

JRE 8.0 Update 152

Firefox 58.0 or
later2

OpenJDK 11.0.1+13

Red Hat
Enterprise Linux
7.5

64 bit Google Chrome
69.0 or later

JRE 8.0 Update 171

Google Chrome
69.0 or later

OpenJDK 11.0.1+13

Firefox 60.0 or
later2

JRE 8.0 Update 171

Firefox 60.0 or
later2

OpenJDK 11.0.1+13

Notes:

1. If the SVP microcode version is updated from earlier than 88-04-01 to 88-04-01 or later, see
Checking Java security settings (on page 33) .

2. IPv6 HTTPS connection from Firefox is not supported.

Connecting through a firewall

To connect the management client and the SVP through a firewall, configure the firewall
so that the TCP/IP port for the protocol you use becomes available.

When attaching Device Manager - Storage Navigator to multiple storage systems, the
installer must log in to the SVP of each storage system using separate Device Manager -
Storage Navigator sessions and separate web browser instances.

When operating the management GUI directly from the SVP without using the
management client, it is not necessary to register ports of protocols other than RMI, SLP,
and SMI-S in the table below.

The type of the protocol and the port used is shown in the following table.

Connecting through a firewall
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Protocol Port number Direction of communication

HTTP 80 From the Device Manager - Storage Navigator
web client to the SVP

HTTPS 443

RMI 1099

RMI (SSL) 5443

RMI 51099

RMI 51100-51355

SLP 427

SMI-S 5989-6244

Note: If you change the port numbers used by the SVP, the firewall is set with
the changed port numbers.

Setting up IPv4/IPv6 communications

You should assign the SVP the same type of IP addresses (IPv4 or IPv6) as those used on
the storage system. You must also configure the client computers with the same IP
version that you assign to the SVP. In addition, use the same communication options for
the management client and the SVP. If the SVP uses IPv6, you must configure the
management clients to use IPv6 for communication.

If you use IPv6 to display the Device Manager - Storage Navigator main window when
both IPv4 and IPv6 are available, IPv6 addresses are displayed in the Device Manager -
Storage Navigator secondary window but IPv4 communication is actually used.

Configuring IPv6 communication in Windows 7

If the SVP uses IPv6, you must configure Windows 7 management clients to use IPv6 for
communication.

Procedure

1. Select Control Panel > Network and Sharing Center > Manage network
connections.

2. Right-click the network where the SVP resides, and then click Properties in the pop-
up menu.
If the User Account Control dialog box opens click Continue. Otherwise, the
Networking dialog box opens.

3. In the Networking dialog box, clear the Internet Protocol Version 4 (TCP/IPv4)
check box.

4. Click OK to save the changes and close the dialog box.

Setting up IPv4/IPv6 communications
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Configuring IPv6 communication in Solaris 10

If the SVP uses IPv6 and you plan to use Device Manager - Storage Navigator (HDvM - SN)
in a web browser, you must configure Solaris 10 management clients to use IPv6 for
communication. If you plan to run HDvM - SN using Adobe AIR, you do not need to
perform this task.

Procedure

1. Start a command window or system console.
2. Execute the following command:

ifconfig network-interface-name inet down

Registering the primary SVP host name

You must register the primary SVP host name before completing any of the following
tasks.
■ Specify a host name instead of an IP address when accessing Device Manager -

Storage Navigator.
■ Obtain the public key certificate for SSL-encrypted communication from the CA

(Certificate Authority). You must register the server name as the host name to the
DNS server or the hosts file. The server name is entered in the certificate as a
common name.

Enter the SVP host name and IP address in the DNS server or the hosts file of the
management client. You can register any host name to the DNS server or the hosts
file, but there are restrictions on the letters you can use for the host name.

■ DNS setting: You must register the IP address and host name of the SVP to the DNS
server that manages the network to which the SVP is connected.

■ Hosts file setting: You must enter the IP address and host name of the SVP to the
hosts file of the management client. The general directory of the hosts file is:
● Windows: C:\Windows\System32\drivers\etc\hosts
● UNIX: /etc/hosts

Caution: If the host name listed in the hosts file is also listed in the CCI
configuration definition file, CCI must be restarted.

Configuring IPv6 communication in Solaris 10
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Configuring the web browser on the management client

Configure the web browser on the Hitachi Device Manager - Storage Navigator(HDvM -
SN) management client as described below.

Note: If you are using HDvM - SN with Adobe® AIR® from HARMAN™:
■ You must configure the web browser as described below because these

settings are used by AIR.
■ You do not need to install Adobe Flash Player.

Web browser settings
■ The browser must allow first-party, third-party, and session cookies.
■ The pop-up blocker and plug-ins must be disabled.
■ The browser must be configured to use TLS 1.2.
■ For Windows 8.1, Windows Server 2012, Windows Server 2012 R2 Update, Windows

Server 2012 Update, and Windows Server 2016, JavaScript must be enabled. For
details, see Enabling JavaScript for Windows (on page 28) .

■ For Windows Server and Internet Explorer:
● Internet Explorer must be configured so it does not save encrypted pages to disk

(Tools > Internet Options > Advanced > Do not save encrypted pages to disk).
● The URL of the SVP must be registered in Internet Explorer (Tools > Internet

Options > Security).
● For Windows Server 2012, the IE security level for the trusted sites must be set to

Medium-high (Tools > Internet Options > Security > Trusted sites > Security
level for this zone).

■ For Firefox and Chrome, Adobe Flash Player must be enabled in your web browser.
■ For the Japanese version of Firefox, the browser must be configured to use the C

locale (default system language) by using the X Server Emulator.

In a B Shell, enter the following command:

LANG=C
export LANG

In a C Shell, enter the following command:

setenv LANG C

Adding your SVP to the trusted sites zone for Windows Server
computers

If you are using Device Manager - Storage Navigator on a Windows Server computer, the
following message may appear during login. If it does, you must add the SVP to the
trusted sites zone.

Configuring the web browser on the management client
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The message below may appear differently depending on the Windows version you are
using.

Procedure

1. Click Add in the message dialog box. The Trusted Sites dialog box opens.
2. In Add this web site to the zone, enter the URL of the SVP that you want to log in

to. For example, if the host name is host01, the URL is http://host01. If the IP
address is 127.0.0.1, the URL is http://127.0.0.1.

3. Click Add to add the URL of the SVP to the web sites list.
4. Click Close to close the dialog box.

Enabling JavaScript for Windows

If you use Windows 8.1, Windows Server 2012 R2 Update, Windows Server 2012 Update,
or Windows Server 2016, you must enable JavaScript.

Note: This setting is required even if you use Device Manager - Storage
Navigator with Adobe AIR because the web browser settings are used by AIR.

Procedure

1. Launch Internet Explorer.
2. On the Internet Explorer menu bar, click Tools > Internet Options > Security.
3. Click the Security tab.
4. Click Custom Level.
5. On the Security Settings window, set Active scripting to Enable.
6. Click OK.
7. When the Warning dialog box appears, click YES.

Enabling JavaScript for Windows
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8. Click OK to close the Internet Options window.
9. Exit and then restart Internet Explorer.

Installing Captive Bundle Application (CBA) on the SVP

Captive Bundle Application (CBA) is the application on the SVP that enables HDvM - SN to
run with Adobe AIR from HARMAN. Before you can use HDvM - SN with AIR, you must
install CBA on the SVP. If you are using one SVP to manage multiple storage systems, you
must install CBA for each storage system.

Before you begin
■ You must have the serial number of the storage system. The serial number is

displayed in S/N in the Storage Device List window on the SVP.

Procedure

1. Close all HDvM - SN sessions connected to the storage system for which you are
installing CBA.

2. Log in to the SVP.
3. Open a command prompt on the SVP with administrator permissions.
4. Move the current directory to the folder containing the MappFlashDisable.bat

batch file (for example, C:\MAPP\wk\Supervisor\MappIniSet).

5. Run the batch file specifying the storage system serial number and the CBA file (with
absolute path) as arguments as follows:

C:\MAPP\wk\Supervisor\MappIniSet> MappFlashDisable.bat serial-number 
CBA-file

For example:

C:\MAPP\wk\Supervisor\MappIniSet> MappFlashDisable.bat 400102 C:\temp
\CBA-file-name

6. When the completion message is displayed, press any key to exit the processing.
7. Close the command prompt window.

Next steps

After installing Captive Bundle Application (CBA) on the SVP, you can log in to HDvM - SN
using AIR. For instructions, see Logging in to HDvM - SN by using AIR (on page 39) .

Installing Storage Device Launcher on the management client

The Storage Device Launcher application is required to run HDvM - SN with Adobe AIR
from HARMAN. Storage Device Launcher is included in the Web Console Launcher setup
file on the SVP. Use the following procedure to install Storage Device Launcher on the
management client.

Installing Captive Bundle Application (CBA) on the SVP
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Note: If you are using one management client to access multiple storage
systems, you only need to install Storage Device Launcher on the
management client once.

Before you begin
■ You must have the model identification number of the storage system. The model

identification number is the same as the folder name of the SVP firmware installation
directory.

Example: C:\Mapp\wk\936000400001
■ In this example, the 12-digit character string 936000400001 is the model

identification number. The last 6 digits indicate the serial number of the storage
system.

■ C:\Mapp is the default installation directory for the SVP firmware. The location of
the installation directory depends on the conditions specified when the SVP
firmware was installed.

If multiple storage systems are registered on the SVP, you can use the model
identification number of any storage system whose SVP firmware version supports
AIR.

Procedure

1. Download the Web Console Launcher setup file for Windows from the SVP to the
management client.

■ If you can log in to HDvM - SN by using a web browser, click Tool > Download in
the HDvM - SN menu bar, and then download the Web Console Launcher setup
file for Windows (WCLauncher_win.zip).

■ If you cannot log in to HDvM - SN by using a web browser, open the download
the Web Console Launcher setup file as follows:

a. Open a web browser on the management client, and enter the following
URL:

https://IP-address-or-host-name-of-SVP/sanproject/ToolDownload/
serial-number-of-storage-system

If you changed the port number of the protocol HTTPS from the initial value
(443 by default), specify the following URL:

https://IP-address-or-host-name-of-SVP:port-number-of-protocol-
HTTPS/sanproject/ToolDownload/serial-number-of-storage-system

Installing Storage Device Launcher on the management client
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Note: If the SVP firmware version is earlier than 93-02-02 or
88-06-02, enter the following URL instead:

https://IP-address-or-host-name-of-SVP(:port-number-of-
protocol-HTTPS)/dev/storage/model-identification-
number/htdocs/tool/tooldownload.html

After the download page opens, go to step (c).

b. In the authentication window, enter the user name and password.
c. Download the Web Console Launcher setup file for Windows

(WCLauncher_win.zip).

2. Expand the downloaded Web Console Launcher setup file.
Use only 1-byte alphanumeric characters for the expanded folder or directory
name.

Caution: If a security warning or a window blocking the operation is
displayed, do not expand the setup file. Change the properties of the
setup file as follows and then expand the file:

a. Right-click WCLauncher_win.zip, and then click Properties.

b. In Security, select Unblock, and then click OK.

3. Right-click WCLauncher_win\WCLauncher\Setup_SDLauncher.bat, and run it by
selecting Run as Administrator.
Storage Device Launcher is added on the desktop and in the start menu.

4. Open WCLauncher_win\WCLauncher\log\Setup.log with a text editor, and
confirm that "completed" is displayed.

Caution: Do not move or delete the WCLauncher_win folder after
Storage Device Launcher installation is complete. This folder contains
files required for running Storage Device Launcher.

Configuring the management client for the HDvM - SN secondary
window

If you plan to use any of the following functions, you must configure the management
client for use of the Device Manager - Storage Navigator (HDvM - SN) secondary window:
■ Login Message function
■ Data Retention Utility
■ Server Priority Manager

The Device Manager - Storage Navigator (HDvM - SN) secondary window runs within the
Java Runtime Environment (JRE) on the management client. The secondary window is
disabled by default in HDvM - SN and must be enabled by using HDvM - SN or Web
Console Launcher (when Java 11 or later is installed on the HDvM - SN management
client). If the secondary window is not enabled, the functions listed above are not
accessible in HDvM - SN.

Configuring the management client for the HDvM - SN secondary window
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Restrictions for using the HDvM - SN secondary window with Google Chrome

When you open the secondary window, Google Chrome displays the following message:
This type of file can harm your computer. Are you sure you want to download
<file name>.jnlp? . Click Save in the message window and save the object file. Then
open the file. You can continue the operation even though a Java security warning is
displayed when you open the file.

SJsvlSNStartServlet (<serial number>).jnlp is saved in the download folder.
This file is duplicated every time you open the secondary window (because it is not
overwritten or deleted automatically). Delete extraneous downloaded
SJsvlSNStartServlet (<serial number>).jnlp files periodically to prevent
shortage of capacity. To confirm the download location, follow Chrome Menu > Settings >
Show advanced settings > Downloads.

Do not click Discard in the message window. If you do, you will not be able to use HDvM -
SN for a while until error (20020-108000) appears. When error (20020-108000) appears,
click OK to close the error and continue working in HDvM - SN.

If you don't want to wait for the error to appear, you can close Chrome and then log in to
HDvM - SN again.

The error also appears if you do not click Save or if you do not open the saved file for
some time.

Enabling the HDvM - SN secondary window

If you plan to use any of the following functions in Device Manager - Storage Navigator
(HDvM - SN), you must enable the HDvM - SN secondary window:
■ Login Message function
■ Data Retention Utility
■ Server Priority Manager

The HDvM - SN secondary window runs within the Java Runtime Environment (JRE) on
the management client. The secondary window is disabled by default in HDvM - SN and
must be enabled by using HDvM - SN, or by using Web Console Launcher when Java 11
or later is installed on the HDvM - SN management client. If the secondary window is not
enabled, the functions listed above are not accessible in HDvM - SN.

Before you begin
■ Required role: Storage Administrator (View Only)

Procedure

1. From the Settings menu, click Environmental Settings > Edit Information
Display Settings.
The Edit Information Display Settings window opens.

2. In Secondary window, click Enable.
3. Click Apply.

Using Web Console Launcher to enable the secondary window (Java 11 or later)

Enabling the HDvM - SN secondary window

Chapter 1: Accessing the storage system

System Administrator Guide for VSP E990 and VSP G130, G/F350, G/F370, G/F700, G/F900 32



When Java 11 or later is installed on the Device Manager - Storage Navigator (HDvM - SN)
management client, you must download and execute Web Console Launcher to enable
the HDvM - SN secondary window. The setup file that you download contains the
following applications:
■ Web Console Launcher: This application is required to enable the HDvM - SN

secondary window when HDvM - SN is running on a web browser with Java 11 or later
installed.

■ Storage Device Launcher: This application is required to start HDvM - SN in the Adobe
AIR environment. Storage Device Launcher is contained only in the setup file for
Windows.

When the HDvM - SN secondary window is opened, you must enable the .jnlp file
included in the setup file.

Note: You must perform the following procedure each time the SVP firmware
is upgraded.

Procedure

1. From the Menu bar, click Tool > Download.
2. Download the Web Console Launcher tool for Windows or UNIX.
3. Expand and execute the download file by the following OS method:

Windows: Expand the file, right click WCLauncher\Setupwin.bat and execute it by
selecting Run as Administrator. This associates the downloaded .jnlp file with Web
Console Launcher.

UNIX: Enter tar zxvf WCLauncher_unix.tgz to expand the file, and then enter
sudo shsetupunix.sh in the expanded directory to execute it.

Note: When you execute Web Console Launcher, Java8 is disabled.

Next steps

Each time you open the HDvM - SN secondary window with Java 11 or later, you must
enable the .jnlp file using Web Console Launcher.

Caution: Do not delete or move the WCLauncher_win folder. This folder
contains files required to run Web Console Launcher.

Checking Java security settings

If the SVP microcode version is updated from earlier than 88-04-01-XX/00 to 88-04-01-
XX/00 or later, perform the following procedure to check and, if necessary, change the
settings.

If the SVP microcode version is earlier than 88-04-01-XX/00, IP addresses of SVPs might
be registered in the exception site list in Java security settings on the management client,
for using Device Manager - Storage Navigator secondary windows. If the SVP microcode
version is 88-04-01-XX/00 or later, registration of IP addresses to the exception site list is
not necessary.

Checking Java security settings

Chapter 1: Accessing the storage system

System Administrator Guide for VSP E990 and VSP G130, G/F350, G/F370, G/F700, G/F900 33



Procedure

1. Start Java Control Panel on the management client by either of the following ways:

■ From Windows Control Panel, double-click the Java icon.

■ From the Windows Start menu, click All Programs > Java > Configure Java.

2. Click the Security tab.
3. Check whether the following URLs are registered in Exception Site List:

http://IP-address-of-SVP
https://IP-address-of-SVP
If these URLs are not registered, click Cancel to finish the operation.

4. Click Edit Site List.
5. In the Exception Site List dialog box, select the URLs shown in step 3, and then

click Remove.
6. Click OK
7. In Exception Site List, confirm that the corresponding URLs are removed.

If the corresponding URLs are removed, go to the next step.

If the corresponding URLs are not removed, see steps 4 and 5 and correct the
problems.

8. Click the Advanced tab.
9. Under Perform signed code certificate revocation checks on, select All

certificates in the chain of trust, and then click OK.

Caution: Even when Perform signed code certificate revocation
checks on is not displayed and Perform certificate revocation checks
on is displayed instead, select All certificates in the chain of trust, and
then click OK.

10. Close the Control Panel.

Configuring a management client

Before you can use Hitachi Device Manager - Storage Navigator to manage your storage
system, you must set up a management client to use the management software.

Backing up HDvM - SN configuration files

Before replacing an SVP, you must make a backup copy of the Device Manager - Storage
Navigator configuration files on the SVP. You can then use the backup copy to restore the
configuration file if it becomes necessary, or to configure a replacement SVP if one fails.

Configuring a management client
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The following configuration items can be backed up and restored. Before you create the
backup, ensure that the settings are correct.
■ Device Manager - Storage Navigator environment parameters
■ Authentication server connection settings
■ Key management server connection settings
■ Display settings (table width) for each Device Manager - Storage Navigator user
■ Device Manager - Storage Navigator login warning messages
■ Device Manager - Storage Navigator task information
■ SMI-S application settings
■ SSL certification for HTTPS/SMI-S/RMI

Before you begin
■ You must have the Storage Administrator (Initial Configuration) role to perform this

task.
■ You must be logged into the SVP.

Procedure

1. Stop all services running on the storage system.
2. Open a command prompt window with administrator permissions.
3. In the folder where the .bat file is located, execute the following command:

C:\MAPP\wk\Supervisor\MappIniSet>MappBackup.bat absolute-path-of-
backup-file

Note:

■ The backup file must be in .tgz format.

■ A space is required between .bat file and the path to the backup file.

4. A completion message displays. Click any key to continue.
5. Close the command prompt window.

Tip:

■ If you do not specify a folder in which to save the file, the system
automatically creates a default file in the following location:

SVP-root\wk\Supervisor\MappIniset
\LogsyyyyMMddHHmmss.tgz
where yyyyMMddHHmmss is the year, month, date, and time that the
file was created.

■ The backup file is compressed and uses the .tgz format. Use a tool
that supports tar and gzip to extract the data from the .tgz file.

6. Save the backup file to another computer or external memory device such as a USB
flash memory or hard drive.

Backing up HDvM - SN configuration files
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Restoring HDvM - SN configuration files

You can use a saved copy of a configuration file to restore the active configuration file if it
becomes necessary, or to configure a replacement SVP if one fails.

Before you begin
■ The storage systems registered in the SVP you backed up are registered in a new SVP.
■ The services on the storage system are stopped.
■ The SVP is configured so that the service does not start automatically when starting

the system.

Procedure

1. Copy the backup file to any folder in the SVP.
2. Open a command prompt window with administrator permissions.
3. In the folder where the .bat file is located, enter

C:\MAPP\wk\Supervisor\MappIniSet>MappRestore.bat absolute-path-
of-backup-file

Note:

■ The backup file must be in .tgz format.

■ A space is required between MappRestore.bat and the path to the
backup file.

4. A completion message displays.
5. Type a key to close the message, and then close the command prompt.
6. Reboot the SVP. It takes about 10 minutes to complete the startup process.

Restoring HDvM - SN configuration files
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Logging in to HDvM - SN in a browser

There are three ways to log in to Device Manager - Storage Navigator (HDvM - SN)
running in a web browser:
■ If you are an administrator, you can log in to HDvM - SN with a one-time-only initial

login.
■ If you are a superuser, you can log in first to HDvM - SN to create other user accounts.
■ If you are a HDvM - SN user or administrator, you can log in normally.

Note:
■ If you cannot log in three times with the same user ID, HDvM - SN stops

responding for one minute. This is for security purposes and is not a
system failure.

■ The operations (roles) and resource groups that the logged-in user can
access are determined when the user logs in. If the roles or resource
allocations are changed while the user is logged in, the changes will take
effect the next time the user logs back in.

Initial superuser login

When logging on to Device Manager - Storage Navigator in a web browser for the first
time, you must log on as a superuser to set up additional user accounts. The superuser
account has a built-in ID that includes all permissions and a default password.

Procedure

1. Contact customer support to obtain the superuser ID and default password.
2. Start a web browser on the management client.
3. In the web browser, enter the URL for your SVP:

https://IP-address-or-host-name-of-SVP/sanproject/
          

To change the port number of the protocol from the initial value (443), specify the
following URL:

https://IP-address-or-host-name-of-SVP:port-number-of-the-protocol/

4. Log in with the superuser ID and password.
5. To prevent unauthorized use of the superuser account, change the password

immediately after you log in. Click Settings > User Management > Change
Password to change your password.

After you log in, the Device Manager - Storage Navigator main window opens. You
can navigate using the menu, tree, or General Tasks. Precise instructions for
performing an operation can be found in the software user guides. Also, see
Appendixes D through G, which describe the screens in the GUI.

Logging in to HDvM - SN in a browser
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User login

This login procedure is for all users other than the superuser.

Procedure

1. Start a web browser on the management client.
2. In the web browser, specify the following URL:

https://IP-address-or-host-name-of-SVP

If you changed the port number of the protocol HTTP from the initial value (443),
specify the following URL:

https://IP-address-or-host-name-of-SVP:port-number-of-the-protocol-
HTTPS/

If the Device Manager - Storage Navigator loading window is displayed, wait until
the service status changes to Ready (Normal). At that time, the login window is
displayed automatically. The following is an example of the loading window.

3. The following actions might be required to open the login dialog box, depending on
your environment:

■ If a message indicates that the enhanced security configuration is enabled on the
management client, select In the future, do not show this message and click
OK.

■ If the SVP is set to support SSL-encrypted communication and security messages
appear, make sure the certificate is correct and follow the instructions in the
dialog box.

■ If a message indicates that certain web sites are blocked, follow instructions in
Adding your SVP to the trusted sites zone for Windows Server computers (on
page 27) .

■ If multiple storage systems are connected, a window that allows selection of the
storage system is displayed. Select the storage system you want to connect.

4. When the Storage Device List window opens, select the storage system.
The Device Manager - Storage Navigator login window appears.

5. Type the user ID and password, and then click Login.
6. If the Security Information dialog box appears, click Yes.

User login
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7. If a local storage area pop-up dialog box of Adobe Flash Player Setting appears, click
Allow to open the Device Manager - Storage Navigator main window. The cache
function of Adobe Flash Player optimizes the process of Device Manager - Storage
Navigator. Denial of the request might delay the processing speed of Device
Manager - Storage Navigator.

Result

After you log in, the Device Manager - Storage Navigator main window opens. You can
navigate using the menu, tree, or General Tasks. Instructions for performing operations
on the storage system using Device Manager - Storage Navigator can be found in the
software user guides (for example, Hitachi Universal Replicator User Guide). For
descriptions of the Device Manager - Storage Navigator GUI windows, see Appendixes D
through G.

Logging in to HDvM - SN by using AIR

When you log in to HDvM - SN by using Adobe AIR from HARMAN for the first time,
Captive Bundle Application (CBA) is downloaded from the SVP to the management client.
CBA is the application that enables HDvM - SN to run with AIR. The downloaded file size
is about 30 MB. If the CBA version on the SVP is updated later, the new CBA version will
be downloaded automatically to the management client.

Use the following procedure to log in to HDvM - SN by using AIR for the first time.

Note: If you are using one management client to access multiple storage
systems, CBA is downloaded for each storage system.

Before you begin
■ Storage Device Launcher must be installed on the management client.
■ CBA must be installed on the SVP.

Procedure

1. Open the HDvM - SN login dialog box.

Logging in to HDvM - SN by using AIR
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You can open the HDvM - SN login dialog box by running Storage Device Launcher
on the management client or by opening a web browser and running Storage
Device Launcher on the SVP.

■ To open the HDvM - SN login dialog box by running Storage Device Launcher:

a. On the management client desktop or start menu, right-click the Storage
Device Launcher batch file, and then run it by selecting Run as
Administrator.

Caution: If a security warning or a window blocking the
operation is displayed, do not run Storage Device Launcher.
Change the properties of the batch file (right-click
SDLauncher.bat, click Properties, and then select Unblock in
Security), and then run the file.

b. Enter the IP address or host name of the SVP.
c. Specify 443 for the HTTPS port number, and then click Connect.

If a security warning message is displayed, verify that the security certificate
is correct, and then follow the instructions in the dialog box.

■ To open the HDvM - SN login dialog box by opening a web browser and running
Storage Device Launcher on the SVP:

a. Start the web browser on the management client with administrator
permissions.

b. Enter the following URL in the web browser:

sdlauncher:///IP-address-or-host-name-of-SVP/

Caution: If a security warning or a window blocking the
operation is displayed, do not run the file. Change the properties
of the batch file (right-click SDLauncher.bat, click Properties,
and select Unblock in Security), and then run the file.

c. If a security warning message is displayed, verify that the security certificate
is correct, and then follow the instructions in the dialog box.

2. Wait about 10 seconds for the CBA file to be downloaded to the management client.
When the download is complete, the HDvM - SN login dialog box opens. You can
close the web browser.

3. Enter the user name and password, and then click Login.
If the Security Information dialog box is displayed, click Yes.
When the storage system configuration information is finished loading, the HDvM -
SN main window opens.

Changing the administrator password

You can change the administrator password using the maintenance utility.

Changing the administrator password
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Before you begin
■ Before changing the password of a user account specified by the registered storage

system in the Storage Device List window, click Stop Service for the registered
storage system. After changing the password of the user account, click Edit and set
the new password, then click Start Service for the storage system.

Procedure

1. In the maintenance utility Menu navigation tree, click System Management.

2. Click Change Password.
3. Enter your current password and a new password. Enter the password again in the

Re-enter Password field.
4. Click Finish.

Changing the initial password

After the administrator gives you a user ID and password, you should change the
password after you log in.

Procedure

1. Log in to Device Manager - Storage Navigator with the user ID and password given
to you by the administrator.

2. Click Settings > User Management > Change Password to change your password.

Download/Upload window for HDvM - SN with AIR

When you use Device Manager - Storage Navigator (HDvM - SN) with Adobe AIR, a
character string that depends on the Adobe AIR environment is displayed in the title of
the window used for selecting a file to be downloaded or uploaded.

Changing the initial password
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Disabling and enabling use of Flash Player with HDvM - SN

Adobe Flash Player is used to run Device Manager - Storage Navigator (HDvM - SN) in a
web browser. If desired, you can disable use of Flash Player with HDvM - SN after you
start using HDvM - SN with Adobe AIR. Later, if you need to run HDvM - SN in a web
browser, you can re-enable use of Flash Player on the management client.

When you use Hitachi Command Suite, however, do not disable use of Flash Player to
run HDvM - SN. If you disable this function, you will not be able to access HDvM - SN
from HCS.

Make sure that the HCS version supports linkage with HDvM - SN running in the Adobe
AIR environment.

Disabling and enabling use of Flash Player with HDvM - SN

Chapter 1: Accessing the storage system

System Administrator Guide for VSP E990 and VSP G130, G/F350, G/F370, G/F700, G/F900 42



Caution: If you disable Flash Player, you will not be able to access HDvM - SN.

Use the following procedure to disable or enable use of Flash Player with HDvM - SN.
When multiple storage systems are managed by using one SVP, you must disable or
enable use of Flash Player for each storage system.

Procedure

1. Close all HDvM - SN sessions connected to the storage system on which this
operation is performed.

2. Log in to the SVP.
3. Open a command prompt on the SVP with administrator permissions.
4. Move the current directory to the folder containing the MappFlashEnable.bat and

MappFlashDisable.bat batch files (for example, C:\MAPP\wk\Supervisor
\MappIniSet), and then run the desired batch file (enable or disable) specifying the
storage system serial number* as the argument. For example:

C:\MAPP\wk\Supervisor\MappIniSet> MappFlashDisable.bat 400102

* The storage system serial number is displayed in S/N in the Storage Device List
window on the SVP.

5. When the completion message appears, press any key to continue the processing.
6. Close the command prompt window.

Accessing the maintenance utility

To configure the storage system and perform maintenance operations, launch the
maintenance utility by selecting the Maintenance Utility menu on the main menu of the
Hitachi Device Manager - Storage Navigator or the management software main window
and clicking on an option from the drop-down menu. The maintenance utility opens on a
separate browser tab.

Note:
■ Click  in the window to see the help menu for the description of the

Maintenance Utility.
■ To display the help, the settings for enlarging and reducing the display

might not be reflected in the help window, depending on the type or
version of your browser.

Accessing the maintenance utility
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Accessing the storage system without management software

You can use the administrator account created during the initial setup to use HDvM - SN
temporarily to access the storage system. You can then perform critical storage
management operations during a planned maintenance activity or an unexpected
downtime on the management server.

Before you begin
■ You must have an administrator login account with permissions equal to or higher

than Administrator User Group has. For information about creating user accounts,
see Creating user accounts (on page 66) in this manual, and the Hardware Reference
Guide for your system model.

■ For Hitachi Ops Center Administrator users, you must have an administrator login
account with the require permissions to access the storage system without
management software.

■ Adobe Flash Player must be configured on the client to use HDvM - SN.

Note: To obtain the administrator login information, contact customer
support.

Procedure

1. Start a web browser.

Accessing the storage system without management software
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2. Enter the following URL:

■ For the VSP F350 and VSP G350 storage system, enter:

https://IP-address-or-host-name-of-the-SVP/dev/storage/
8820004XXXXX/emergency.do (where the model number is '8820004' and '4XXXXX'
indicates the system serial number)

■ For VSP F370, VSP G370, VSP F700, VSP G700,VSP F900, and VSP G900 storage
systems, enter:

https://IP-address-or-host-name-of-the-SVP/dev/storage/
8840004XXXXX/emergency.do (where the model number is '8840004' and '4XXXXX'
indicates the system serial number)

3. The following actions might be required to open the login dialog box, depending on
your environment:

■ If a message indicates that the enhanced security configuration is enabled on the
computer, select In the future, do not show this message and click OK.

■ If the SVP is set to support SSL-encrypted communication and security messages
appear, make sure the certificate is correct and follow the instructions in the
dialog box.

■ If a message indicates that certain web sites are blocked, make sure you have
added the SVP to the trusted sites zone.

4. Enter a user ID and password for the account.
5. Click Log In.
6. If the Security Information dialog box appears, click Yes.
7. If an Adobe Flash Player local storage area pop-up dialog box appears, click Allow to

open the Device Manager - Storage Navigator main window.
The cache function of Adobe Flash Player optimizes the process of Device Manager -
Storage Navigator. Denial of the request might reduce processing speed.

Note: If the login process fails three times with the same user ID, Device
Manager - Storage Navigator will stop responding for one minute. This is
for security purposes and is not a system failure. Wait, and then try
again.

Accessing the storage system without management software
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Chapter 2:  Configuring the storage system

When configuring the storage system, you must set storage system information, set up
the network connection, and register the SVP if using one.

Changing the date and time

You can change the date and time for the controller clock and the SVP clock.

Changing the controller clock settings

Complete the following steps to change the date and time on the storage system
controller.

Caution: If you change the system date and time when the currently set
system date and time is after the real time, the configuration information
might not be backed up. To prevent this from happening, move the existing
backup file to another folder.

Before you begin
■ You must have the Storage Administrator (View & Modify) role to perform this task.

Procedure

1. In the maintenance utility Administration tree, select Date & Time.
The current settings are displayed.

2. Click Set Up.
3. Change the settings as needed, and either click Apply to save them, or click Cancel

to close the window without saving the changes.

Changing the SVP clock and time zone settings

If your configuration includes SVP for the external management server, you need to
ensure that the clock and the time zone settings on the SVP matches those of the
controller clock.

Chapter 2: Configuring the storage system
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Before you begin

Complete the following steps to change the Windows 8.1 date and time on the SVP
■ The management console is connected to the LAN 2 port on the SVP.
■ The console has established a remote desktop connection with the SVP. Note that the

connection cannot be established when you use Remote Desktop Session Host.
■ The management utility window is displayed on the console.
■ Storage systems are not registered in the Storage Device List.
■ If storage systems are registered in the Storage Device List, before changing the SVP

clock settings, click Stop Service for all registered storage systems in the Storage
Device List window.

Procedure

1. Log in to the management console that is connected to the SVP.
2. On the Windows 8.1 desktop, click Start > Control Panel.
3. Click Clock, Language, and Region.
4. Click Date and Time.
5. Click Change date and time. The Date and Time Settings window opens.
6. Set the date and time, then click OK to save the settings.
7. Click Change time zone. The Time Zone Settings windows opens.
8. Select the time zone, then click OK.

Note: If you do not restart the background service, time zone changing
is not reflected. So time zone remain the different settings between SVP
and storage system and this state cause any fails.

Setting up IPv4/IPv6 communications

You should assign the SVP the same type of IP addresses (IPv4 or IPv6) as those used on
the storage system. You must also configure the client computers with the same IP
version that you assign to the SVP. In addition, use the same communication options for
the management client and the SVP. If the SVP uses IPv6, you must configure the
management clients to use IPv6 for communication.

If you use IPv6 to display the Device Manager - Storage Navigator main window when
both IPv4 and IPv6 are available, IPv6 addresses are displayed in the Device Manager -
Storage Navigator secondary window but IPv4 communication is actually used.

Changing network communication settings

This procedure explains how to configure a management client to use IPv6 for
communication with an SVP.

Setting up IPv4/IPv6 communications
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Procedure

1. In the maintenance utility, click Administration to expand the Administration
navigation pane.

2. Click Network Settings.
The Network Settings window displays the current network settings and
permissions.

3. In the Network Settings window, click Set Up Network Settings.
The Network Settings dialog box displays the current settings for the Mac address,
IPv4 and IPv6 settings, and the network connection mode for both controllers 1 and
2. It also displays the current settings for the maintenance port and the storage
system internal network.

4. Change the settings as needed and click Apply.

The dialog box closes and returns you to the Network Settings window.

Note: If you set items for DNS server, register the following items to the
DNS server:

■ host name: localhost

■ IP address: 127.0.0.1

Changing network permissions

This procedure explains how to block or allow HTTP blocking.

Procedure

1. In the maintenance utility, click Administration to expand the Administration
navigation pane.

2. Click Network Settings. The Network Settings window displays the current
network settings and permissions.

3. In the Network Settings window, click Set Up Network Permissions.
4. To enable HTTP blocking, click Enable. To disable HTTP blocking, click Disable.
5. Click Apply. The dialog box closes and returns you to the Network Settings

window.

Creating a login message

When users log in to the maintenance utility, they will see a login message. You can use
the login banner message to inform users of specific system conditions, user
requirements, or to provide other information that users may need to manage the
system.

Before you begin

You must have the Storage Administrator (View & Modify) role to complete this
procedure.

Changing network permissions
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Procedure

1. In the maintenance utility Menu navigation tree, click System Management.

2. Click Edit Login Message.
3. Enter a message to be displayed at the time of login. The message can contain up to

2,048 characters. A line break is counted as one character.
4. Click Apply to save the message and close the dialog box.

Forcing the system lock to release

When performing configuration and maintenance operations, the storage system might
automatically lock itself and release the system when the operations are completed. If
the storage system does not unlock itself, you can unlock the system using Force Release
System Lock in the maintenance utility.

Caution: Before using this feature, ensure that releasing the system lock will
not cause system problems due to processes that are currently running.
Releasing the system lock can terminate a process before it completes and
possibly leave the system in an unknown state. Check with any users that are
logged on. Wait until their processes are complete before releasing the
system lock.

Before you begin

You must have the Storage Administrator (View & Modify) role to complete this
procedure.

Procedure

1. In the maintenance utility Menu navigation tree, click System Management.

Forcing the system lock to release
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2. Click Force Release System Lock.
3. A warning message is displayed. Verify that releasing the lock will not cause data

loss or other problems. To release the system lock, click OK. Click Cancel to close
the dialog box without releasing the system lock.

Setting the SMI-S function

VSP E990, (SVP microcode version 93-02-00-xx/00 or later), VSP Gx00 models, and VSP
Fx00 models storage systems support the SMI-S function developed by SNIA.
Administrators can use the SMI-S function by using SMI-S compliant management
software.

If you cannot access the SMI-S function, check the network environment and access
destination. If access cannot be made even though there is no problem with the network
environment and access destination, contact our company.

For VSP E990 (SVP version 93-02-00-xx/00 or later) and VSP Gx00 models and VSP Fx00
models (SVP version 88-03-01-xx/00 or later), use TLS 1.2.

Note: If SMI-S certificate is expired, upload a new signed certificate to the
SMI-S provider.

Setting the SMI-S function
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Using the SMI-S function

To use the SMI-S function, create a Device Manager - Storage Navigator user account and
specify a storage system as the access destination from the management software.

Procedure

1. Create a Device Manager - Storage Navigator user account in the management
software. The user account must belong to one of the following built-in user groups:

■ Storage Administrator (Initial Configuration)

■ Storage Administrator (System Resource Management)

■ Storage Administrator (Provisioning)

■ Storage Administrator (Performance Management)

■ Storage Administrator (Local Copy)

When the user accesses the SMI-S function with the read-only access authority, the
user account must belong to one of the following built-in user groups:

■ Storage Administrator (Remote Copy)

2. In the management software program, enter the following storage system
information:

■ IP Address of the storage system

■ Protocol: specify HTTPS

■ Port: 5989

Note: The allocation method of the port numbers to be used varies
depending on the SVP software versions.

■ Namespace:root/hitachi/smis or interop

Note:

If you cannot access to the storage system, see "An error (20121-107097)
occurs and the Device Manager - Storage Navigator login fails." in Login
errors (on page 300) .

If this problem occurs again, verify the network environment and the
access destination. If you still cannot access to the storage system after
taking actions, contact customer support.

Uploading an SMI-S provider configuration file

You can control the SMI-S function using the SMI-S provider configuration file that you
create.

Using the SMI-S function
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Before you begin
■ Ensure that the SMI-S provider configuration file has already been created. If the

configuration is not already named array-setting-01.properties, rename it to that
name.

■ You must have the Storage Administrator (View & Modify) role to perform this task.
■ A private key (.key file) has been created. Make sure that the file name is server.key.
■ A signed public key certificate (.crt file) has been acquired. Make sure that the file

name is server.crt.
■ The signed public key certificate (.crt file) must be in X509 PEM format. You cannot use

X509 DER format.
■ The extended profile fields in the X.509 certificate support the following items as

specified in RFC5280:
● BasicConstraints
● KeyUsage
● SubjectKeyIdentifier
● subjectAltName

■ If an intermediate certificate exists, prepare a signed public key certificate (server.crt
file) that has a certificate chain that includes the intermediate certificate.

■ The number of tiers of the certificate chain for the certificate to be uploaded must be
5 tiers or less including the root CA certificate.

■ The public key encryption method for the certificate to be uploaded must be RSA.
■ The passphrase for the private key (server.key file) is released.
■ SMI-S provider service has been stopped.

Note: If the ResourceGroup parameter is set, theVVolForSnapshot parameter
and the PoolIDForSnapshot parameter are not valid.

Procedure

1. On the SVP, start Windows command prompt as an Administrator.
2. Move the current directory to the directory where the tool

MappSmisConfUpload.bat exists. Execute the following command:

cd /d C:\Mapp\wk\Supervisor\MappIniSet
MappSmisConfUpload.bat serial-number-of-storage-system absolute-path-
of-SMI-S-provider-configuration-file

Note: C:\MAPP indicates the installation directory of the storage
management software and the SVP software. When the installation
directory other than C:\Mapp was specified, replace C:\Mapp with the
specified installation directory.

3. The completion message appears. Press any key to continue.

Uploading an SMI-S provider configuration file
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4. Close the command prompt.

Note: To reflect the update of the certificate, you need to start the SMI-S
provider service.

Returning an SMI-S provider configuration file to default

You can return a configuration file uploaded to the SMI-S provider to default.

Before you begin
■ You must have the Storage Administrator (View & Modify) role to perform this task.
■ SMI-S provider service has been stopped.

Procedure

1. On the SVP, start Windows command prompt as an Administrator.
2. Move the current directory to the directory where the tool

MappSmisConfInit.bat exists. Execute the following command:

cd /d C:\Mapp\wk\Supervisor\MappIniSet
MappSmisConfInit.bat serial-number-of-storage-system

Note: C:\MAPP indicates the installation directory of the storage
management software and the SVP software. When the installation
directory other than C:\Mapp was specified, replace C:\Mapp with the
specified installation directory.

3. The completion message appears. Press any key to continue.
4. Close the command prompt.

Note: To reflect the update of the certificate, you need to start the SMI-S
provider service.

Sending SMI-S artificial indication

You can send an SMI-S artificial indication to determine whether the communication
between the listeners and the SMI-S provider succeeds or fails.

Before you begin
■ SMI-S Provider software application must be installed.
■ The network environment is configured so that the computer on which the listener

application operates is connected to the SVP.
■ The listeners are subscribed to the SMI-S provider.

Returning an SMI-S provider configuration file to default
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■ The user specified for the parameter must have the following roles:
● Storage Administrator (Initial Configuration)
● Storage Administrator (System Resource Management)
● Storage Administrator (Provisioning)
● Storage Administrator (Performance Management)
● Storage Administrator (Local Copy)
● Storage Administrator (Remote Copy)

■ The services of the SMI-S provider should be running.

Procedure

1. On the SVP, start Windows command prompt as an Administrator.
2. Move the current directory to the directory where the tool

MappSmisArtificialIndicate.bat exists. Execute the following command:

cd /d C:\Mapp\wk\Supervisor\MappIniSet
MappSmisArtificialIndicate.bat serial-number-of-storage-system 
username password

Note: C:\MAPP indicates the installation directory of the storage
management software and the SVP software. When the installation
directory other than C:\Mapp was specified, replace C:\Mapp with the
specified installation directory.

3. The SMI-S artificial indication result message appears. Press any key to continue.
4. Close the command prompt.

SMI-S provider startup setting

You can enable or disable the service by performing the SMI-S provider startup setting.

Note: If the service is set to disable by the startup setting, the SMI-S function
cannot be used because the service does not start.

Before you begin
■ The SVP software version is 88-03-01-xx/00 or later.
■ SMI-S provider service has been stopped.

Procedure

1. On the SVP, start Windows command prompt as an Administrator.
2. Execute the following command:

C:\Mapp\wk\Supervisor\SMI\SetServiceStartupType.bat Serial-number-of-
storage-system Startup-type

SMI-S provider startup setting
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Specify enable or disable for Startup-type.

Note: C:\MAPP indicates the installation directory of the storage
management software and the SVP software. When the installation
directory other than C:\Mapp was specified, replace C:\Mapp with the
specified installation directory.

3. The completion message appears. Press any key to continue.
4. Close the command prompt.

Note: The startup setting is reflected after starting the service in each
storage system next time.

Setting storage system information

You can set the name, contact information, and location of the storage system.

Caution: When changing a setting more than once, ensure that the current
setting is complete before changing it again. Otherwise, only the new change
will be applied, and the result might be different from what you expected.

Before you begin
■ You must have the Storage Administrator (Initial Configuration) role to complete this

procedure.

Procedure

1. In the Device Manager - Storage Navigator Storage Systems tree, select the storage
system.

2. From Settings, click Environmental Settings > Edit Storage System.
3. Enter the items that you want to set.

You can enter up to 180 alphanumeric characters (ASCII codes) excluding several
symbols (\ , / ; : * ? " < > | & % ^). Do not use a space at the beginning or the end.

4. Click Finish.
5. In the Confirm window, check the settings and enter a task name in Task Name.
6. Click Apply. The task is now registered. If the Go to tasks window for status check

box is checked, the Tasks window opens to show the status of the task.

Preventing errors while using virus detection programs on
the SVP

Running virus detecting programs on an SVP* that has Device Manager - Storage
Navigator installed might cause operation errors while using Device Manager - Storage
Navigator.

Setting storage system information
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To prevent errors caused by virus detection programs, exclude the Device Manager -
Storage Navigator installation directory from the real-time virus scan target in your virus
detection program.

Note: C:\MAPP indicates the installation directory of the storage
management software and the SVP software. When the installation directory
other than C:\Mapp was specified, replace C:\Mapp with the specified
installation directory.

Perform virus scans regularly on the excluded directory during periods when Device
Manager - Storage Navigator is not in use or when the service stops.

Note: *Including standard virus detection programs installed on the
operating system such as Windows Defender.

Preventing errors while using virus detection programs on the SVP
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Chapter 3:  Managing users and user groups

You can create and modify users by assigning them roles, permissions, and groups using
Storage Navigator or the maintenance utility.

User administration overview

Device Manager - Storage Navigator provides a rich set of user administration, roles and
permissions, and access control features. Administrators can manage users by groups
and set up access control by defining who can access what storage resources .

The storage system also provides some basic user management capabilities, such as
create, modify, and delete users without using SVP or Device Manager - Storage
Navigator. For more information, see Managing users using the maintenance utility (on
page 71) .

You can create and manage users locally or configure Device Manager - Storage
Navigator to authenticate storage users with an existing authentication server, such as
LDAP. For more information, see Setting up authentication and authorization with Device
Manager - Storage Navigator (on page 112) .

Note: If you don't create user accounts in the maintenance utility, use the
authentication server to allocate user groups to users by configuring the
same user group name between the storage system and the authentication
server. If you create user accounts in the maintenance utility, users can be
authenticated by the authentication server, but user groups are allocated to
users based on the configuration in the maintenance utility.

User groups

Hitachi Storage Navigator provides several built-in user groups with predefined
permissions based on the available roles. You can use these groups to begin managing
user permissions and access control immediately. Or you can create your own user
groups tailored to meet your unique requirements.

Consider the following when setting up user groups:
■ When a user is assigned to multiple user groups, the user has the permissions of all

the roles in each user group that are enabled on the resource groups assigned to
each user group.

■ You can create two user accounts that are used by the same user playing two roles.
For example, you can create user_1 and user_2 that are used by the same person, but
user 1 is a security administrator that has access to all resource groups and user_2 is
a storage administrator that has access to only one of the resource groups.
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■ All user groups, except for the Storage Administrator groups, have access to all
resources in the storage systems (All Resource Groups Assigned is automatically set
to Yes).

■ If you deleted all the roles except the Storage Administrator, you will need to add all
required resource groups to the user group because the Storage Administrator role
does not have access to all resources by default. See Changing assigned resource
groups (on page 65) .

■ All user groups must have resource groups assigned in order to perform operations
on the storage system.

Roles and permissions

The following table shows all the roles that are available for use and the permissions that
each role provides to the users. You cannot create a custom role.

Note: The Support Personnel group and the Support Personnel (Vendor Only)
role contain permissions to perform maintenance. Assign this role only to the
accounts used by support personnel from vendors responsible for
maintenance.

Role Permissions

Security Administrator
(View Only)

■ Viewing information about user accounts and encryption settings
■ Viewing information about the encryption key in the key SVP
■ Viewing information about the external authentication by the

maintenance utility

Security Administrator
(View & Modify)

■ Configuring user accounts
■ Creating encryption keys and configuring encryption settings
■ Viewing and switching where encryption keys are generated
■ Backing up and restoring encryption keys
■ Deleting encryption keys backed up in the key SVP
■ Viewing and changing the password policy for backing up encryption

keys on the management client
■ Connection to the external server
■ Backing up and restoring connection configuration to the external

server
■ Configuring the certificate used for the SSL communication
■ Configuring the fibre channel authentication (FC-SP)
■ Configuring resource groups
■ Editing virtual management settings

Roles and permissions
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Role Permissions

■ Setting reserved attributes for global-active device
■ Configuring external authentication by the maintenance utility

Audit Log
Administrator (View
Only)

■ Viewing audit log information and downloading audit logs

Audit Log
Administrator (View &
Modify)

■ Configuring audit log settings and downloading audit logs

Storage Administrator
(View Only)

■ Viewing storage system information

Storage Administrator
(Initial Configuration)

■ Configuring settings for storage systems
■ Configuring settings for SNMP
■ Configuring settings for e-mail notification
■ Configuring settings for license keys
■ Viewing, deleting, and downloading storage configuration reports
■ Acquiring all the information about the storage system and updating

Device Manager - Storage Navigator window by clicking Refresh All

Storage Administrator
(System Resource
Management)

■ Configuring settings for CLPR
■ Configuring settings for MP unit
■ Deleting tasks and releasing exclusive locks of resources
■ Configuring LUN security
■ Configuring Server Priority Manager
■ Configuring tiering policies

Storage Administrator
(Provisioning)

■ Configuring caches
■ Configuring volumes, pools, and virtual volumes
■ Formatting and shredding volumes
■ Configuring external volumes
■ Configuring Dynamic Provisioning
■ Configuring host groups, paths, and WWN
■ Configuring Volume Migration except splitting Volume Migration pairs

when using CCI
■ Configuring access attributes for volumes
■ Configuring LUN security
■ Creating and deleting quorum disk used with global-active device

Roles and permissions
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Role Permissions

■ Creating and deleting global-active device pairs
■ Editing virtual management settings
■ Setting reserved attributes for global-active device.

Storage Administrator
(Performance
Management)

■ Configuring monitoring
■ Starting and stopping monitoring

Storage Administrator
(Local Copy)

■ Performing pair operations for local copy
■ Configuring environmental settings for local copy
■ Splitting Volume Migration pairs when using CCI

Storage Administrator
(Remote Copy)

■ Remote copy operations in general
■ Operating global-active device pairs (except for creation and deletion)

Support Personnel
(Vendor Only)

Configuring the SVP
■ Normally, this role is for service representatives.

Support Personnel
(User)

■ Viewing storage system status
■ Installing OS security patches
■ Updating operating systems
■ Performing basic maintenance

Notes:

1. Completing SIMs is permitted for users who are assigned to both the Storage Administrator
(System Resource Management) role and Storage Administrator (Provisioning) role.

2. Normally, the Support Personnel role is reserved for service representatives. However, if the
role is assigned to a user account, dump files can be downloaded using the Dump tool.

Built-in user groups

You can assign users to one or more built-in user groups and custom user groups. You
cannot change roles or resource groups set to the built-in groups, but you can create
custom user groups according to the needs of your storage environment.

The following table shows all the built-in groups, and their built-in roles and resource
groups.

Built-in user groups
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Built-in group Role
Resource

group

Administrator ■ Security Administrator (View &
Modify)

■ Audit Log Administrator (View &
Modify)

■ Storage administrator (Initial
Configuration)

■ Storage Administrator (System
Resource Management)

■ Storage Administrator
(Provisioning)

■ Storage Administrator
(Performance Management)

■ Storage Administrator (Local Copy)
■ Storage Administrator (Remote

Copy)

All Resource
Groups
Assigned

System ■ Security Administrator (View &
Modify)

■ Audit Log Administrator (View &
Modify)

■ Storage Administrator (Initial
Configuration)

■ Storage Administrator (System
Resource Management)

■ Storage Administrator
(Provisioning)

■ Storage Administrator
(Performance Management)

■ Storage Administrator (Local Copy)
■ Storage Administrator (Remote

Copy)

All Resource
Groups
Assigned

Security Administrator (View
Only)

■ Security Administrator (View Only)
■ Audit Log Administrator (View Only)
■ Storage Administrator (View Only)

All Resource
Groups
Assigned

Built-in user groups
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Built-in group Role
Resource

group

Security Administrator (View
& Modify)

■ Security Administrator (View &
Modify)

■ Audit Log Administrator (View &
Modify)

■ Storage Administrator (View Only)

All Resource
Groups
Assigned

Audit Log Administrator (View
Only)

■ Audit Log Administrator (View Only)
■ Storage Administrator (View Only)

All Resource
Groups
Assigned

Audit Log Administrator (View
& Modify)

■ Audit Log Administrator (View &
Modify)

■ Storage Administrator (View Only)

All Resource
Groups
Assigned

Storage Administrator (View
Only)

■ Storage Administrator (View Only) meta_resourc
e

Storage Administrator (View &
Modify)

■ Storage Administrator (Initial
Configuration)

■ Storage Administrator (System
Resource Management)

■ Storage Administrator
(Provisioning)

■ Storage Administrator
(Performance Management)

■ Storage Administrator (Local Copy)
■ Storage Administrator (Remote

Copy)

meta_resourc
e

Support Personnel ■ Storage Administrator (Initial
Configuration)

■ Storage Administrator (System
Resource Management)

■ Storage Administrator
(Provisioning)

■ Storage Administrator
(Performance Management)

■ Storage Administrator (Local Copy)
■ Storage Administrator (Remote

Copy)
■ Support Personnel

All Resource
Groups
Assigned

Built-in user groups
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Creating a new user group

You can customize a user group, as long as it supports your storage system.

This section explains how administrators can create a user group.

A user group name consists of 1 to 64 characters including alphanumeric characters,
spaces, and the following symbols:

! # $ % & ' ( ) + - . = @ [ ] ^ _ ` { } ~

The system can support a maximum of 32 user groups, including the nine built-in user
groups.

Before you begin
■ You must have the Security Administrator (View & Modify) role to perform this task.

Procedure

1. In the Administration tree, select User Groups.
2. In the User Groups tab, click Create User Groups to open the Create User Group

window.
3. Enter a user group name.
4. If you use an authorization server, click Check and verify that the entered user

group name is registered in the authorization server.
5. Click Next to open the Assign Roles window.
6. Select the roles to assign to the user group, and click Add.
7. Click Next to open the Assign Resource Groups window.
8. Select the resource groups to assign to the user group, and click Add. If you select a

role other than the storage administrator in the Assign Roles window, you do not
need to select resource groups because all the resource groups are assigned
automatically.

9. Click Finish to finish and confirm settings.
Click Next to add another user.

10. Check the settings and enter a task name in Task Name.
11. Click Apply. The task is now registered. If the Go to tasks window for status check

box is checked, the Tasks window opens to show the status of the task.

Changing a user group name

You can change the name of a user group by using Hitachi Device Manager - Storage
Navigator.

Creating a new user group
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Before you begin
■ You must have the Security Administrator (View & Modify) role to perform this task.
■ The names of built-in groups cannot be changed.
■ A user group name consists of 1 to 64 characters including alphanumeric characters

(ASCII), spaces and the following symbols:

# $ % & ' ( ) + - . = @ [ ] ^ _ ` { } ~

Procedure

1. In the Administration tree, select User Groups.
2. In the User Groups tab, select the user group.
3. Click More Actions > Edit User Group.
4. In the Edit User Group window, enter a new user group name.
5. If you use an authorization server, click Check and verify that the entered user

group name is registered in the authorization server.
6. Click Finish.
7. In the Confirm window, check the settings and enter a task name in Task Name.
8. Click Apply. The task is now registered. If the Go to tasks window for status check

box is checked, the Tasks window opens to display the status of the task.

Changing user group permissions

You can change the permissions that are assigned to user groups by using Hitachi Device
Manager - Storage Navigator.

Before you begin
■ You must have the Security Administrator (View & Modify) role to perform this task.
■ The permissions of a built-in group cannot be changed.

Procedure

1. In the Device Manager - Storage Navigator Administration tree, select User
Groups.

2. In the User Groups tab, select the user group whose permission you want to
change.

3. Click the Roles tab.
4. Click Edit Role Assignment.
5. In the Edit Role Assignment window, change roles to be assigned to the user

group.

■ Select roles to add, and then click Add.

■ Select a role to remove, and then click Remove.

6. Click Finish.
7. In the Confirm window, check the settings and enter a task name in Task Name.

Changing user group permissions
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8. Click Apply. The task is now registered. If the Go to tasks window for status check
box is checked, the Tasks window opens.

Changing assigned resource groups

You can change the resource groups that are assigned to user groups by using Hitachi
Device Manager - Storage Navigator.

Before you begin
■ You must have the Security Administrator (View & Modify) role to perform this task.
■ Create a resource group to be assigned to the user group in advance.
■ You cannot change the resource groups of a user group that has All Resource Groups

Assigned set to Yes
■ You cannot change resource groups of a built-in group.

Procedure

1. In the Device Manager - Storage Navigator Administration tree, select User
Groups.

2. On the User Groups tab, select a user group to change the resource group.
3. Select the Resource Groups tab.
4. Click Edit Resource Group Assignment to open the Edit Resource Group

Assignment window.
5. In the Edit Resource Group Assignment window, change resource groups to be

assigned to the user group.

■ Select the resource group to add, and click Add.

■ Select the resource group to remove, and click Remove.

6. Click Finish.
7. In the Confirm window, check the settings and enter a task name in Task Name.
8. Click Apply. The task is now registered. If the Go to tasks window for status check

box is checked, the Tasks window opens to display the status of the task.

Deleting a user group

You do not have to retain a user group for the life of the project. You can delete it at any
time by using Hitachi Device Manager - Storage Navigator.

Before you begin
■ You must have the Security Administrator (View & Modify) role to perform this task.
■ You cannot delete a built-in user group.
■ You cannot delete a user group if the users in it belong to only the user group to be

deleted.

Changing assigned resource groups
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Procedure

1. In the Device Manager - Storage Navigator Administration tree, select User
Groups.

2. In the User Groups tab, select the user-created user groups that you want to delete.
3. Click More Actions > Delete User Groups.
4. Check the settings, then click Apply.

User accounts

When adding a new user, you need to add it to a user group with desired permissions.
You can use one of the built-in user group or a custom user group.

For more information about roles, permissions, and user groups, see Roles and
permissions (on page 58) .

You will need to use the local administrator account created during the initial setup step,
or create administrator accounts using the procedures described in this chapter as
needed to access the storage system temporarily when the management software is not
available.

It is prudent to create more than one user account in case the system administrator is
not available when the management software becomes unavailable, or when someone
else needs to access the system. This is also helpful if multiple users need to access
Device Manager - Storage Navigator to use storage features that are not available in the
management software.

Creating user accounts

You must create a user account and register the account to a user group with
appropriate permissions.

Before you begin
■ You must have the Security Administrator (View & Modify) role to perform this task.
■ You or an authorized technical support representative can log in to Device Manager -

Storage Navigator and CCI with user accounts that are created in Device Manager -
Storage Navigator.

■ Support representatives must have the Support Personnel (Vendor Only) role to log
in.

■ The system can support a maximum of 20 user accounts, including the built-in user
accounts.

User accounts

Chapter 3: Managing users and user groups

System Administrator Guide for VSP E990 and VSP G130, G/F350, G/F370, G/F700, G/F900 66



Table 3 User name and password for Device Manager - Storage Navigator

Item
Length in
characters Characters that can be used

User name 1-256 ■ Alphanumeric characters
■ The following symbols:

# $ % & ' * + - . / = ? @ ^ _ ` { | } ~

Password 6-256 ■ Alphanumeric characters
■ All symbols

Table 4 User name and password for logging in to CCI

Item
Length in
characters Characters that can be used

User name 1-63 ■ Alphanumeric characters
■ The following symbols:1

- . @ _

Password 6-63 ■ Alphanumeric characters
■ The following symbols:2

, - . @ _:

Note:

1. When CCI is installed on a UNIX computer, you can also specify a slash (/).
2. When CCI is installed on a Windows computer, back slashes (\) can also be

specified. When CCI is installed on a UNIX computer, forward slashes (/) can also
be used.

Procedure

1. In the Device Manager - Storage Navigator Administration tree, select User
Groups.

2. On the User Groups tab, select a user group to which to add a user. This is
dependent on which permissions you want to give to the user.

3. On the Roles tab, confirm that the displayed permissions are appropriate for the
user.

4. On the Users tab, click Create User.
5. Enter a name.
6. Select Enable or Disable for the account. If you select Disable, the user of this

account is disabled and cannot log in to Device Manager - Storage Navigator.
7. To use an authentication server, select External. To authenticate users with only

Device Manager - Storage Navigator, select Local.

Creating user accounts
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8. If you select Local, enter the password for this user account in two places.
For a password, all alphanumeric characters and symbols can be used. The length
must be between 6 and 256.

9. Click Finish.
10. In the Confirm window, check the settings.
11. Click Apply. The task is now registered. If the Go to tasks window for status check

box is checked, the Tasks window opens to display the status of the task.

Changing user passwords

You can change or reissue passwords for other users by using Device Manager - Storage
Navigator.

Caution: When using Hitachi Command Suite, you need to change
information, such as passwords, registered in Hitachi Command Suite. For
details, see the section describing how to change storage system settings in
the Hitachi Command Suite User Guide.

Caution: Before changing the password of a user account specified by the
registered storage system in the Storage Device List window, click Stop
Service for the registered storage system. After changing the password of the
user account, click Edit and set the new password, then click Start Service for
the storage system.

Before you begin
■ Security administrators with View & Modify roles can change user passwords on

Device Manager - Storage Navigator.
■ If the target user has a local user account for Device Manager - Storage Navigator, the

security administrator can use Device Manager - Storage Navigator to change the
target user's password.

■ If the target user has a local user account for the authentication server, the security
administrator can use the authentication server to change the target user's password.
After the password is changed, the target user can use the new password on both the
authentication server and Device Manager - Storage Navigator.

Procedure

1. In the Device Manager - Storage Navigator Administration tree, select User
Groups.

2. On the User Groups tab, select the user group to which the user belongs.
3. On the User tab, select the user whose password you want to change.
4. In the User tab, click Change Password.
5. In the Change Password dialog box, specify a new password for the user in the two

password fields.
6. Click Finish.
7. In the Confirm window, check the settings and enter a task name in Task Name.

Changing user passwords
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8. Click Apply. The task is now registered. If the Go to tasks window for status check
box is checked, the Tasks window opens to show the status of the task.

Changing user permissions

You can change user permissions by changing membership in the user group. A user can
belong to multiple user groups.

For example, if you want to change the role of the user who manages security to the
performance management role, add this user to the Storage Administrator (Performance
Management) role group and then remove the user from the Security Administrator
(View & Modify) role group.

Before you begin
■ You must have the Security Administrator (View & Modify) role to perform this task.
■ The user whose permissions you want to change must belong to at least one user

group.
■ A user account can belong to up to 8 user groups.
■ A user group can contain a maximum of 20 user accounts, including the built-in user

accounts.

Adding a user

Procedure

1. In the Device Manager - Storage Navigator Administration tree, select User
Groups.

2. On the User Groups tab, select the user group that has the role you want the user
to have, and then add or remove users.
To add users to the selected groups:

a. Click Add Users.
b. In the Add Users window, select a user and click Add.

To remove users from the selected groups:
a. In the Remove Users window, select one or more users.
b. Click More Actions > Remove Users.

3. Click Finish.
4. In the Confirm window, check the settings. If the Task Name field is empty, enter a

task name.
5. Click Apply. The task is now registered. If you selected the Go to tasks window for

status check box, the Tasks window opens to show the status of the task.

Enabling and disabling user accounts

To allow or prevent a user from logging in to Device Manager - Storage Navigator, follow
the steps below.

Changing user permissions
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Caution: Do not select any user account used to connect to a storage system
that is registered in the Storage Device List window. For details, see the
Hardware Reference Guide for your storage system.

Before you begin
■ Log into an account that is different from the user whose account that you want to

disable.
■ You must have the Security Administrator (View & Modify) role to perform this task.

Procedure

1. In the Device Manager - Storage Navigator Administration tree, click User Groups.
2. On the User Group tab, select the user group.
3. On the Users tab, select a user.
4. Click Edit User.
5. Click the Account Status check box.
6. Click Finish.
7. In the Confirm window, check the settings.
8. Click Apply. The task is now registered. If the Go to tasks window for status check

box is checked, the Tasks window opens to show the status of the task.

Deleting user accounts

Security Administrators can delete a user account when the account is no longer in use.
Built-in user accounts cannot be deleted.

Caution: Do not select any user account used to connect to a storage system
that is registered in the Storage Device List window. For details, see the
Hardware Reference Guide for your storage system.

Before you begin

You must have the Security Administrator (View & Modify) role to perform this task.

Procedure

1. In the Device Manager - Storage Navigator Administration tree, select User
Groups.

2. On the User Groups tab, click a user group to which a user belongs.
3. On the Users tab, select the user whose account you want to delete.
4. Click More Actions > Delete Users.
5. In the Delete Users window, select the user to be deleted, then click Finish.
6. In the Confirm window, check the settings.
7. Click Apply. The task is now registered. If the Go to tasks window for status check

box is checked, the Tasks window opens to show the status of the task.

Deleting user accounts
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Unlock a user account

If a user attempting to log in to Device Manager - Storage Navigator or Command
Control Interface enters an incorrect username or password three times, the system sets
the login status to locked, preventing further login attempts for 60 seconds. If necessary,
you can release the locked status before the lock times out.

Before you begin

You must have the Security Administrator (View & Modify) role to perform this task.

Procedure

1. In the Administration tree, select User Groups.
2. On the User Groups tab, click a user group to which the locked-out user belongs.
3. On the User tab, select the user you want to unlock.
4. On the User tab, click More Actions > Release Lockout.

The Release Lockout window opens.
5. Specify a task name, and then click Apply.

Managing users using the maintenance utility

You can create, modify, and delete users in the storage systems without an SVP or Device
Manager-Storage Navigator using the maintenance utility.

The storage system allows minimum user administration - create, modify, and delete
user accounts - using the maintenance utility (embedded maintenance console).

To access the full user administration feature set, you need Device Manager-Storage
Navigator running on SVP.

Required roles

Administrators can control what maintenance utility operation windows are available for
a user by registering the user with the appropriate roles.

The following table lists the required roles for using specific maintenance utility
operation windows.

Unlock a user account
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Maintenance utility operation window Required role name

Initial Setting Wizard Storage Administrator (Initial
Configuration)

Set Up System Information Storage Administrator (Initial
Configuration)

Firmware Support Personnel or User Maintenance1

User Administration Security Administrator (View & Modify)

External authentication setting Security Administrator (View & Modify)

System Monitor Support Personnel or User Maintenance1

Alert Notifications Storage Administrator (Initial
Configuration)

Set Up Date & Time Storage Administrator (Initial
Configuration)

Set Up Network Settings Storage Administrator (Initial
Configuration)

Licenses Storage Administrator (Initial
Configuration)

Audit Log Settings Audit Log Administrator (View & Modify)

Turn on/off Locate LEDs Support Personnel or User Maintenance1

Power on Storage System Support Personnel or User Maintenance1

Power off Storage System Support Personnel or User Maintenance1

Edit UPS Mode Support Personnel or User Maintenance1

Edit Login Message Storage Administrator (Initial
Configuration)

Select Cipher Suite Security Administrator (View & Modify)

Update Certificate Files Security Administrator (View & Modify)

Force Release System Lock Storage Administrator (Initial
Configuration)

Reboot GUM Support Personnel or User Maintenance

View Volume Status Support Personnel or User Maintenance1

Change Password No role is required.

Boot System Safe Mode Support Personnel1

Required roles

Chapter 3: Managing users and user groups

System Administrator Guide for VSP E990 and VSP G130, G/F350, G/F370, G/F700, G/F900 72



Maintenance utility operation window Required role name

Alert Display Support Personnel or User Maintenance1

Alert Display Related to FRU Support Personnel or User Maintenance1

Administration Menu N/A

Power Management N/A

System Management N/A

Resetting GUM N/A

Notes:

1. Support Personnel means operations performed by the service personnel. User
Maintenance means operations performed by the user

Setting up user accounts

You can create up to 20 users, including the built-in user.

Procedure

1. In the Maintenance Utility window, click Administration > User Administration.
2. In the User Groups tab, click Create User.

3. Create a new user account. Specify the User Name, Account Status,
Authentication, and User Group. Click Finish.

Setting up user accounts

Chapter 3: Managing users and user groups

System Administrator Guide for VSP E990 and VSP G130, G/F350, G/F370, G/F700, G/F900 73



Item Description

User Name Create a user name. You can enter up
to 256 one-byte alphanumeric
characters and some symbols (! # $ % &
' * + - . / = ? @ ^ _ ` { | } ~).

Account Status The following statuses are available:

Enable: User can use the account.

Disable: User cannot use the account or
log in to the storage management
software.

Authentication The following methods are available:

Local: Does not use authentication
server. Uses a dedicated password for
storage management software.

External: Uses an authentication server.

4. Confirm the settings, and then click Apply.

Setting up user accounts
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5. When the completion message appears, click Close.

Disabling user accounts

You can disable user accounts by changing the Account Status to Disable.

Observe the following guidelines:
■ Log into an account that is different from the user account that you want to disable

(you cannot disable the current login user account).
■ To disable the user account specified by the registered storage system in the Storage

Device List window, click Stop Service for the registered storage system. After
disabling the user account, click Edit to enable the user account.

Procedure

1. In the Maintenance Utility window, click Administration > User Administration.
2. In the User Groups tab, click the user group belonging to the user.

Disabling user accounts
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3. Click the Users tab, and then select the user account to disable.

4. Click Edit.
5. For Account Status, click Disable, and then click Finish.

Disabling user accounts
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6. Confirm the settings, and then click Apply.

7. When a completion message appears, click Close.

Disabling user accounts
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Deleting user accounts

Security administrators can remove a user account when the account is no longer in use.
Built-in user accounts cannot be deleted. If deleting the current login user account, you
can continue the storage management software operation until you log out.

Note: To delete the user account specified by the registered storage system
in the Storage Device List window, click Stop Service of the registered
storage system. After deletion, click Edit to enable the user account.

Procedure

1. In the Maintenance Utility window, click Administration > User Administration.
2. In the User Groups tab, select the user group belonging to the user.

Deleting user accounts
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3. Click the Users tab, and then select the user to remove.

4. Click Remove.
The Confirm window opens.

5. In the Confirm window, confirm the settings, and then click Apply.

Deleting user accounts
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6. At the completion message, click Close.

Backing up user accounts

Procedure

1. Click User Account Information > Backup.

Backing up user accounts
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2. Specify a storage destination and a file name in the displayed window and
download the file.

3. When the following message appears, click Close.

Restoring user account information

Procedure

1. Click User Account Information > Restore

The Restore User Account window opens.

2. Specify file names to be restored, and then click Apply.

3. When a completion message appears, click Close.

Restoring user account information
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Changing the administrator password

You can change the administrator password using the maintenance utility.

Before you begin
■ Before changing the password of a user account specified by the registered storage

system in the Storage Device List window, click Stop Service for the registered
storage system. After changing the password of the user account, click Edit and set
the new password, then click Start Service for the storage system.

Procedure

1. In the maintenance utility Menu navigation tree, click System Management.

2. Click Change Password.
3. Enter your current password and a new password. Enter the password again in the

Re-enter Password field.

Changing the administrator password
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4. Click Finish.

Managing resource groups

You can divide a provisioned storage system into resource groups that allow you to
manage the storage system as multiple virtual private storage systems. Configuring
resource groups involves creating resource groups, moving storage system resources
into the resource groups, and assigning resource groups to user groups.

About resource groups

A storage system can connect to multiple hosts and be shared by multiple divisions in a
company or by multiple companies. Many storage administrators from different
organizations can access the storage system. Managing the entire storage system can
become complex and difficult. Potential problems are that private data might be
accessed by other users, or a volume in one organization might be accidentally
destroyed by a storage administrator in another organization.

To avoid such problems, use Hitachi Resource Partition Manager software to set up
resource groups that allow you to manage one storage system as multiple virtual private
storage systems. The storage administrator in each resource group can access only their
assigned resources. Resource groups prevent the risk of data leakage or data destruction
by another storage administrator in another resource group.

The following resources can be assigned to resource groups.
■ LDEV IDs
■ Parity groups
■ External volumes
■ Ports
■ Host group IDs
■ iSCSI target IDs

Note:

Before you create LDEVs, you can reserve the desired number of LDEV IDs
and assign them to a resource group for future use. You can also reserve and
assign host group IDs and iSCSI target IDs in advance because the number of
host groups or iSCSI targets per port is limited.

meta_resource

The meta_resource group is the resource group consisting of the resources that exist on
the storage system (other than external volumes) before Resource Partition Manager is
installed. By default, all existing resources initially belong to the meta_resource group to
ensure compatibility with older software when a system is upgraded to include Resource
Partition Manager.

Managing resource groups
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Resource lock

When a task is being processed on a resource, all of the resource groups assigned to the
logged-on user are locked for exclusive access. When a resource is locked, a status
indicator appears on the Device Manager - Storage Navigator status bar. To view
information about the locked resource, click Resource Locked.

Note: Opening a Device Manager - Storage Navigator secondary window
(such as Basic Information Display) or performing an operation from the
service processor (SVP) locks all of the resource groups in the storage system.

Examples

The following examples illustrate how you can configure resource groups on your
storage system.

Resource groups sharing a port

If you have a limited number of ports, you can still operate a storage system effectively
by sharing ports using resource groups.

Examples
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The following example shows the system configuration of an in-house division providing
virtual private storage system for two divisions. Divisions A and B each use their own
assigned parity group, but share a port between the two divisions. The shared port is
managed by the system division.

The Security Administrator in the system division creates resource groups for each
division in the storage system and assigns them to the respective divisions. The Storage
Administrator in Division A can manage the resource groups for Division A but cannot
access the resource groups for Division B. In the same manner, the Storage
Administrator in Division B can manage the resource groups for Division B but cannot
access the resource groups for Division A.

The Security Administrator creates a resource group for managing the common
resources, and the Storage Administrator in the system division manages the port that is
shared between Divisions A and B. The Storage Administrators in Divisions A and B
cannot manage the shared port belonging to the resource group for common resources
management.

Configuration workflow for resource groups sharing a port

1. The system division forms a plan about the resource group creation and
assignment of the resources.

2. The Security Administrator creates the resource groups.
3. The Security Administrator creates the user groups.
4. The Security Administrator assigns the resource groups to the user groups.

Resource groups sharing a port
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5. The Storage Administrator in the system division sets a port.
6. The Security Administrator assigns resources to the resource groups.
7. The Security Administrator assigns the Storage Administrators to the appropriate

user groups.

After the above procedures, the Storage Administrators in Divisions A and B can manage
the resource groups assigned to their own division.

Resource groups not sharing ports

If you assign ports to each resource group without sharing, performance can be
maintained on a different port even if the bulk of I/O is issued from one side port.

The following shows a system configuration example of an in-house system division
providing the virtual private storage system for two divisions. Divisions A and B each use
individual assigned ports and parity groups. In this example, they do not share a port.

The Security Administrator in the system division creates resource groups for each
division in the storage system and assigns them to the respective divisions. The Storage
Administrator in Division A can manage the resource groups for Division A but cannot
access the resource groups for Division B. In the same manner, the Storage
Administrator in Division B can manage the resource groups for Division B but cannot
access the resource groups for Division A.

Resource groups not sharing ports
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Configuration workflow for resource groups not sharing a port

1. The system division forms a plan about creating resource groups and the assigning
resources to the groups.

2. The Security Administrator creates the resource groups.
3. The Security Administrator creates the user groups.
4. The Security Administrator assigns the resource groups to user groups.
5. The Storage Administrator in the system division sets ports.
6. The Security Administrator assigns resources to the resource groups.
7. The Security Administrator assigns each Storage Administrator to each user group.

After the above procedures, the Storage Administrators in Divisions A and B can access
the resource groups allocated to their own division.

Resource group assignments

All resource groups are normally assigned to the Security Administrator and the Audit
Log Administrator.

Each resource group has a designated Storage Administrator who can access only their
assigned resources and cannot access other resources.

All resource groups to which all resources in the storage system belong can be assigned
to a user group. Configure this in Device Manager - Storage Navigator by setting All
Resource Groups Assigned to Yes.

A user who has All Resource Groups Assigned set to Yes can access all resources in the
storage system. For example, if a user is a Security Administrator (with View & Modify
privileges) and a Storage Administrator (with View and Modify privileges) and All
Resource Groups Assigned is Yes on that user account, the user can edit the storage for
all the resources.

If allowing this access becomes a problem with security on the storage system, then
register the following two user accounts and use these different accounts for different
purposes.
■ A user account for a Security Administrator where All Resource Groups Assigned is set

to Yes.
■ A user account for a Storage Administrator who does not have all resource groups

assigned and has only some of the resource groups assigned.

Resource group rules, restrictions, and guidelines

Rules
■ The maximum number of resource groups that can be created on a storage system is

1023.

If you are providing a virtual private storage system to different companies, you should
not share parity groups, external volumes, or pools if you want to limit the capacity that
can be used by each user. When parity groups, external volumes, or pools are shared
between multiple users, and if one user uses too much capacity of the shared resource,
the other users might not be able to create an LDEV.

Resource group assignments
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Creating resource groups

When you create a resource group, you enter a name and assign the desired resources
(parity groups, LDEVs, ports, host groups, and iSCSI targets) to the new group. You can
create more than one resource group at a time.

Before you begin

You must have Security Administrator (View & Modify) role to perform this task.

Procedure

1. In the Explorer pane, expand the Storage Systems tree, click the Administration
tab, and then select Resource Groups.

2. Click Create Resource Groups.
3. In the Create Resource Groups window, enter the name for the new group, select

the desired resources for the new group, and click Add to add the new group to list
of resource groups to be added.

Naming guidelines:

■ A resource group name can use alphanumeric characters, spaces, and the
following symbols: ! # $ % & ' ( ) + - . = @ [ ] ^ _ ` { } ~

■ The characters in a resource group name are case-sensitive.

■ Duplicate occurrences of the same name are not allowed.

■ You cannot use the following names: meta_resource

4. Repeat the previous step for each new resource group to be added. If you need to
remove a group from the list of resource groups to be added, select the group, and
click Remove.

Note: The maximum number of resource groups that can be created on
a storage system is 1023.

5. When you are finished configuring new resource groups in the Create Resource
Groups window, click Next.

6. Enter a task name or accept the default, and then click Submit.
If you select View task status, the Tasks & Alerts tab opens.

Adding resources to a resource group

You can add resources to, remove resources from, and rename existing resource groups.

Note the following restrictions for editing resource groups:
■ Only resources allocated to meta_resource can be added to resource groups.
■ Resources removed from a resource group are returned to meta_resource.
■ No resource can be added to or removed from meta_resource.

Creating resource groups
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■ The name of the meta_resource group cannot be changed or used for any resource
group other than the meta_resource group.

■ The system does not allow duplicate names.
■ LDEVs with the same pool ID or journal ID cannot be added to multiple resource

groups or partially removed from a resource group. For example, if two LDEVs belong
to the same pool, you must allocate both to the same resource group. You cannot
allocate them separately.

You cannot partially remove LDEVs with the same pool ID or journal ID from a
resource group. If LDEV1 and LDEV2 belong to the same pool, you cannot remove
LDEV1 leave only LDEV2 in the resource group.

Use the sort function to sort the LDEVs by pool ID or journal ID. Then select the IDs
and add or remove them all at once.

■ Host groups that belong to the initiator port cannot be added to a resource group.
■ To add or delete DP pool volumes, you must first add or delete DP pools.

Before you begin

You must have Security Administrator (View & Modify) role to perform this task.

Procedure

1. In the Explorer pane, click the Administration tab, and then select Resource
Groups.

2. Select the desired resource group (check the box next to the name of the resource
group) to display the resource information for the resource group.

■ To change the name of the selected resource group, click Edit Resource Group,
and enter the new name.

■ To add resources to the selected resource group, select the Parity Groups,
LDEVs, Ports, or Host Groups / iSCSI Targets tab, click Add Resources, and
follow the instructions on the Add Resources window.

■ To remove resources from the selected resource group, select the Parity
Groups, LDEVs, Ports, or Host Groups / iSCSI Targets tab, select the resources
to be removed, and then click Remove Resources.

3. Enter a task name or accept the default, and then click Submit.
If you select View task status, the Tasks & Alerts tab opens.

Deleting resource groups

You can delete a resource group only when the resource group does not contain any
resources and is not assigned to any user groups.

The following resource groups cannot be deleted:
■ meta_resource
■ A resource group that is assigned to a user group

Deleting resource groups
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■ A resource group that has resources assigned to it
■ Resource groups included in different resource groups cannot be removed at the

same time.

Before you begin

The Security Administrator (View & Modify) role is required to perform this task.

Procedure

1. In the Explorer pane, expand the Storage Systems tree, click the Administration
tab, select Resource Groups.

2. Click the check box of a Resource Group Name.
3. Click Delete Resource Groups.
4. Enter a task name or accept the default, and then click Submit.

If you select View task status, the Tasks & Alerts tab opens.

Deleting resource groups
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Chapter 4:  Setting up security

You can use a Secure Sockets Layer (SSL) certificate to create a secure, encrypted
connection between the storage system and the management client.

Setting up SSL communications

Before you enable SSL encryption, you must create a private key and a public key to
establish a secure communication session.

The following figure shows the procedure to set up SSL communication. Unless
otherwise noted, all steps are required. Note that creation of private and public keys
requires a dedicated program. You can download a program for creating private and
public keys from the OpenSSL website (http://www.openssl.org/).

Setting up SSL encryption using Device Manager - Storage Navigator

To improve security of remote operations from a Device Manager - Storage Navigator
SVP to a storage system, you can set up Secure Sockets Layer (SSL) encrypted
communication. By setting SSL encryption, the Device Manager - Storage Navigator User
ID and Password are encrypted.

The SSL communication can be established between the management client and the SVP
using the following supported protocols and the port numbers:
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Protocol Port Number

HTTPS 443

RMI 11099

RMI 51100

SMI-S 5989

HTTPS (raidinf) 5443

The SSL communication can be established between the following servers and the SVP:
■ Key management server
■ Authentication server
■ Authorization server
■ Hitachi Command Suite server

Note: To enable SSL, the private and public key pair and SVP server certificate
must be valid. If either the keys or the certificate is expired, the user cannot
connect to the SVP.

Note: The extended profile fields in the X.509 certificate support the following
items as specified in RFC5280:
■ BasicConstraints
■ KeyUsage
■ SubjectKeyIdentifier
■ subjectAltName

Note: To add the Secure attribute to cookies using Device Manager - Storage
Navigator, you must block HTTP communication. For details, see Blocking
HTTP communication to the management client (on page 101) .

Note: Device Manager - Storage Navigator supports HTTP Strict Transport
Security (HSTS) with a max range of 31,536,000 seconds (1 year). To enable
HSTS, you must use the security certificate issued by a trusted root certificate
authority for your Device Manager - Storage Navigator domain. HSTS is valid
for one year (31,536,000 seconds), and it is renewed automatically every time
the HSTS header is sent to the browser. The security certificate to use is
determined by the browser. For details, contact your browser vendor.

Setting up SSL encryption using Device Manager - Storage Navigator
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Note: If HSTS is enabled on a Web application on a server you wish to install
Device Manager - Storage Navigator, use a domain that is written to the
security certificate specific to each application. If you use the same domain,
the HSTS settings are applied to all Web applications that use the domain,
and all connections are switched to https. If you have an application that can
be accessed only through http, you cannot establish the connection.

Creating a keypair

To enable SSL, you must create a keypair consisting of a public and a private key on the
management client. The instructions use Windows 8.1 as an example.

Creating a private key using the OpenSSL command

A private key is required to create an SSL keypair. The following procedure for Windows
creates a private key file called server.key in the c:\key folder.

Before you begin

Ensure that OpenSSL is stored in C:\Mapp\OSS\apache\bin\openssl on the SVP. (You do
not need to install OpenSSL.) If not, Download and install openssl.exe from http://
www.openssl.org/ to the C:\openssl folder.

Note: C:\Mapp indicates the installation directory for the storage
management software and SVP software. Specify C:\Mapp for the installation
directory if another directory is specified for the installation directory.

Procedure

1. When you install OpenSSL, if the read-only attribute is set, release it from the
c:\openssl folder. (This step is not necessary if you use OpenSSL on the SVP.)

2. Open a command prompt with administrator permissions.
3. Move the current directory to the folder to which the key file is output (such as

c:\key), and execute the following command.

When OpenSSL is installed:

C:\key>c:\openssl\bin\openssl genrsa -out server.key 2048
When using OpenSSL on the SVP:

C:\key>c:\Mapp\OSS\apache\bin\openssl genrsa -out server.key 2048

Creating a public key using the OpenSSL command

A public key has the file extension .csr. It is required to create an SSL keypair. The
following procedure is for the Windows operating system.

Before you begin

Download openssl.exe from the OpenSSL website or determine to use OpenSSL on
the SVP.

Creating a keypair
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Procedure

1. Open a command prompt with administrator permissions.
2. Execute the following command:

When OpenSSL is installed:

C:\key>c:\openssl\bin\openssl req -sha256 -new -key server.key -
config c:\openssl\bin\openssl.cnf -out server.csr
When using OpenSSL on the SVP:

C:\Key>Mapp\OSS\apache\bin\openssl req -sha256 -new -key
server.key -config c:\Mapp\OSS\apache\conf\openssl.cnf -out
server.csr

Note: C:\Mapp indicates the installation directory for the storage
management software and SVP software. Spacify C:\Mapp for the
installation directory if another directory is specified for the installation
directory.

Note: This command uses SHA-256 as a hash algorithm.

■ Use SHA-256 for the hash algorithm. Do not use MD5 or SHA-1 for the
hash algorithm due to its low security level.

■ When you use OpenSSL on the SVP, do not change the contents of
c:\Mapp\OSS\apache\conf\openssl.cnf.

3. Enter the following information in the prompt:

■ Country Name (two-letter code)

■ State or Province Name

■ Locality Name

■ Organization Name

■ Organization Unit Name

■ Common Name

To create a self-signed certificate, enter the IP address of the SVP or GUM. The
name you entered here is used as the server name (host name). To obtain a
signed and trusted certificate, ensure that the server name is the same as the
host name.

■ Email Address

■ Challenge password (optional)

■ Company name (optional)

Example

The following example shows the contents of a command window when you create a
public key.

......++++++ 

..++++++ 

Creating a public key using the OpenSSL command
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is 65537 (0x10001) 
C:\key>c:\openssl\bin\openssl req -sha256 -new -key server.key -config c 
You are about to be asked to enter information that will be incorporated 
into your certificate request. What you are about to enter is what is 
called a Distinguished Name or a DN. 
\openssl\bin\openssl.cfg -out server.csr 
For some fields there will be a default value. 
If you enter '.', the field will be left blank. 
----- 
Country Name (2 letter code) [AU]:JP 
State or Province Name (full name) [Some-State]:Kanagawa 
Locality Name (eg, city) []:Odawara 
Organization Name (eg, company) [Internet Widgits Pty Ltd]:Hitachi 
Organization Unit Name (eg, section) []:ITPD 
Common Name (eg, YOUR name) []:192.168.0.1 
Email Address []: 
Please enter the following 'extra' attributes 
to be sent with your certificate request 
A challenge password []:

Obtaining a signed certificate

After creating a private key and public key, obtain a signed public key certificate file. You
can use any of these methods to obtain a signed certificate file.
■ Create a certificate by self-signing. See Obtaining a self-signed certificate (on

page 95) .
■ Obtain a certificate from the certificate authority that is used by your company.
■ Request an official certificate from an SSL certificate authority. See Obtaining a signed

and trusted certificate (on page 96) .

Note:

When you send a request to a certificate authority, specify the SVP or GUM as
the host name.

Hitachi recommends that self-signed certificates be used only for testing
encrypted communication.

Obtaining a self-signed certificate

To obtain a self-signed certificate, open a command prompt and execute the following
command:

When OpenSSL is installed:

C:\key>c:\openssl\bin\openssl x509 -req -sha256 -days 10000 -in
server.csr -signkey server.key -out server.crt
When using OpenSSL on the SVP:

Obtaining a signed certificate
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C:\key>c:\Mapp\OSS\apache\bin\openssl x509 -req -sha256 -days 10000
-in server.csr -signkey server.key -out server.crt

Note: C:\Mapp indicates the installation directory for the storage
management software and SVP software. Spacify C:\Mapp for the installation
directory if another directory is specified for the installation directory.

Note: This command uses SHA-256 as a hash algorithm. MD5 or SHA-1 is not
recommended for a hash algorithm due to its low security level.

This command creates a server.crt file in the c:\key folder, which is valid for 10,000
days. This is the signed private key, which is also referred to as a self-signed certificate.

Obtaining a signed and trusted certificate

To obtain a signed and trusted certificate, you must obtain a certificate signing request
(CSR), send that file to a Certificate Authority (CA), and request that the CA issue a signed
and trusted certificate. Each certificate authority has its own procedures and
requirements. Use of this certificate results in higher reliability in exchange for greater
cost and requirements. The signed and trusted certificate is the signed public key.

Uploading the SSL certificate to the SVP or management client

To use SSL-encrypted communication, you must upload the private key and the signed
server certificate (public key) to the management client.

Caution:

When DKCMAIN firmware version 88-03-24 or earlier is updated, the existing
SSL certificate file is deleted and replaced with the default certificate file.
Therefore, back up the SSL certificate file before DKCMAIN firmware version
88-03-24 or earlier is updated, and then install the backed-up certificate file.

When DKCMAIN firmware version 88-03-25-x0/00 or later is updated, the
existing certificate file is inherited.

Before you begin
■ You must have the Storage Administrator (Initial Configuration) role to perform this

task.
■ You must be logged in to the SVP or management client.
■ A private key (.key file) has been created. Make sure that the file name is server.key.

■ A signed public key certificate (.crt file) has been acquired. Make sure that the file
name is server.crt.

■ The private key (.key file) must be in PEM format. You cannot use DER format.
■ The signed public key certificate (.crt file) must be in X509 PEM format. You cannot use

X509 DER format.
■ The passphrase for the private key (server.key file) must be released.

Obtaining a signed and trusted certificate
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■ If an intermediate certificate exists, you must prepare a signed public key certificate
(server.crt file) in a certificate chain that contains the intermediate certificate.

■ The number of tiers of the certificate chain for the certificate to be uploaded must be
5 tiers or less including the root CA certificate.

■ The public key of the certificate to be uploaded must be RSA.

Procedure

1. In the maintenance utility Menu navigation tree, click System Management.

2. Click Update Certificate Files.

Note: For storage systems without an SVP, unselect the Connect to SVP
box.

3. Select the Web Server checkbox, then click Browse.
4. Browse to the certificate file and click Open. The File Upload window closes and

returns you to the Update Certificate Files dialog box.
5. Click Apply.

Uploading the SSL certificate to the SVP or management client
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Releasing an SSL certificate passphrase

An SSL certificate cannot be applied for the SVP if the passphrase is set. If the
passphrase is set, release the passphrase for the SSL certificate before applying the SSL
certificate to the SVP. The following procedure explains how to verify and release the
passphrase settings.

Before you begin
■ A private key (.key file) has been created.
■ OpenSSL must be installed. In this procedure, it is installed in C:\openssl.

Procedure

1. Open a command prompt window with administrator permissions.
2. Move the current directory to the folder (for example, C:\key) where the key file is

stored, and run the following command:

Caution: Executing this command will overwrite the current key file. To
prevent loss of the key file, do one of the following:

■ Back up the key file first.

■ Use a different key file input destination and output destination.

When OpenSSL is installed:

C:\key>c:\openssl\bin\openssl rsa -in key-file-input-destination
-out key-file-output-destination
When using OpenSSL on the SVP:

C:\key>c:\Mapp\OSS\apache\bin\openssl rsa -in key-file-input-
destination -out key-file-output-destination

Note: C:\Mapp indicates the installation directory for the storage
management software and SVP software. Specify C:\Mapp for the
installation directory if another directory is specified for the installation
directory.

If Enter pass phrase for server.key: is displayed, the passphrase is set.
Enter the passphrase. The passphrase in the SSL private key will be released, and
the SSL certificate can be applied to the SVP.

Example (when passphrase is set)

C:\key>c:\openssl\bin\openssl rsa -in server.key -out server.key

Enter pass phrase for server.key: "Enter passphrase"

Writing RSA key

Releasing an SSL certificate passphrase
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Example (when passphrase is not set)

C:\key>c:\openssl\bin\openssl rsa -in server.key –out server.key

Writing RSA key

Converting the SSL certificates to PKCS#12 format

Uploaded SSL certificates need to be in PKCS#12 format.

If you are uploading a created private key and the SSL certificate to the management
client, you need to convert the SSL certificate to PKCS#12 format. If you are not
uploading the SSL certificate, conversion is not required.

Before you begin
■ You must store a private key and SSL certificate in the same folder.
■ In the following procedure:

● The private key file name is “client.key”.
● The SSL certificate file name is “client.crt”.
● The SSL certificate in PKCS#12 format is output to c:\key.
● If you update SSL certificates in a batch, conversion is not required.

Procedure

1. Open a command prompt with administrator permissions.
2. Enter the following command:

When OpenSSL is installed:

C:\key>c:\openssl\bin\openssl pkcs12 -export -in client.crt -
inkey client.key -out client.p12
When using OpenSSL on the SVP:

C:\key>c:\Mapp\OSS\apache\bin\openssl pkcs12 -export -in
client.crt -inkey client.key -out client.p12

Note: C:\Mapp indicates the installation directory for the storage
management software and SVP software. Spacify C:\Mapp for the
installation directory if another directory is specified for the installation
directory.

3. Enter a password, which is used when uploading the SSL certificate in PKCS#12
format. You can use up to 128 alphanumeric characters and the following symbols: !
# $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~

4. The client.p12 file is created in the C:\key folder. This client.p12 file is the
SSL certificate in PKCS#12 format.

5. Close the command prompt.

Converting the SSL certificates to PKCS#12 format
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Importing the SSL certificate to the Web browser

To allow your Web browser to automatically trust SSL certificates, you can import the SSL
certificate into your Web browser.

Consult your Web browser's documentation for instructions to import the SSL certificate
to the Web browser.

Updating SSL certificates for the SVP and storage system in a batch

If only one storage system is registered in the SVP, you can update the following SSL
certificates in a batch:
■ Signed certificate for SSL communication between the SVP and the management

client
■ Certificate for connecting to the SVP
■ Certificate for connecting to the web server on the storage system

Note: The extended profile fields in the X.509 certificate support the following
items as specified in RFC5280:
■ BasicConstraints
■ KeyUsage
■ SubjectKeyIdentifier
■ subjectAltName

Before you begin
■ Ensure that only one storage system is registered in the SVP.
■ A private key for external communication between the SVP and the management

client has been created.
■ A signed public key certificate for external communication between the SVP and the

management client has been acquired.
■ A private key for internal communication for connecting to the SVP or web server and

a signed public key certificate must be X509 PEM or X509 DER format.
■ All users must be logged out of Hitachi Device Manager - Storage Navigator.
■ You must have the Security Administrator (View & Modify) role and Support Personnel

(User) role to perform this task.

Create the following parameter file (in JSON format) beforehand. Allowed characters
when you specify the path to the certificate in the parameter file are alphanumeric
characters, spaces, and symbols: - _ . \ / :.
■ "user": "user-name-of-the-account-registered-in-the-storage-system"

■ "password": "password-of-the-account-registered-in-the-storage-system"

■ "innerConnectionCertPath": "absolute-path-to-the-public-key-certificate-for-internal-
communication"

■ "innerPrivateKeyPath": "absolute-path-to-the-private-key-for-internal-communication"

Importing the SSL certificate to the Web browser
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■ "outerConnectionCertPath": "absolute-path-to-the-public-key-certificate-for-external-
communication"

■ "outerPrivateKeyPath": "absolute-path-to-the-private-key-for-external-communication"

{
"user": "someuser",
"password": "password123",
"innerConnectionCertPath": "c:\\sslcert\\innercert.crt",
"innerPrivateKeyPath": "c:\\sslcert\\innercert.key",
"outerConnectionCertPath": "c:\\sslcert\\outercert.crt",
"outerPrivateKeyPath": "c:\\sslcert\\outercert.key"
}

Procedure

1. On the SVP, start Windows command prompt as an Administrator.
2. Move the current directory to the directory where the tool exists

cd /d C:\Mapp\wk\Supervisor\MappIniSet

Note:

■ C:\Mapp indicates the installation directory of the storage
management software and the SVP software. When the installation
directory other than C:\Mapp was specified, replace C:\Mapp with
the specified installation directory.

■ If you specify --ignore-cert-verification, the signed certificate
for SSL communication between the SVP and the management client
is not verified when the certificate is updated. Specify this option
immediately after you install HDvM - SN on the SVP or when the
certificate has not been normally updated. (You must check the IP
address of the GUM on the storage system beforehand.)

■ If you specify --delete, the parameter file is automatically deleted
after the SSL certificate is updated.

3. Run the following command:

mappsslcertupdate.bat
        --file=name-of-the-parameter-file-created-beforehand

4. A message appears indicating that the command finished, and then the GUM
restarts automatically.

5. Restart the SVP manually.

Blocking HTTP communication to the management client

You can use the HTTP setting tool to block or allow access to the HTTP communication
port as needed.

Blocking HTTP communication to the management client
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Before you begin
■ You must have the Storage Administrator (Initial Configuration) role to perform this

task.
■ You must be logged into the SVP or management client.

Procedure

1. Close all management client sessions on the storage system, including Storage
Advisor Embedded, maintenance utility, and Device Manager - Storage Navigator.

2. Open a command prompt window with administrator permissions.
3. In the folder where the HTTP setting tool is located, execute the following

command:
C:\MAPP\wk\Supervisor\MappIniSet>MappHttpBlock.bat

4. A completion message box displays. Press any key to acknowledge the message and
close the message box.

5. Close the command prompt window.

Releasing HTTP communication blocking

If the web server supports SSL (HTTPS), you can use the HTTP setting tool to release a
block to the HTTP communication port as needed.

Before you begin
■ You must have the Storage Administrator (Initial Configuration) role to perform this

task.
■ You must be logged into the SVP or management client.

Procedure

1. Close all management client sessions on the storage system, including Storage
Advisor Embedded, maintenance utility, and Device Manager - Storage Navigator.

2. Open a command prompt window with administrator permissions.
3. In the folder where the HTTP setting tool is located, execute the following

command:
C:\MAPP\wk\Supervisor\MappIniSet>MappHttpRelease.bat

4. A completion message box displays. Press any key to acknowledge the message and
close the message box.

5. Close the command prompt window.

Managing SSL certificates

When you use encrypted SSL communications to manage your storage system, you can
select the desired cipher suite, update a signed certificate, and return an updated
certificate to default.

Releasing HTTP communication blocking
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SSL connection protects the User IDs and passwords that are exchanged when users log
in to the management client.

Selecting a cipher suite

Cipher suites are part of SSL Version 3 and OSI Transport Layer Security Version 1 Cipher
Specifications.

Before you begin

You must have the Storage Administrator (View & Modify) role to complete this
procedure.

Procedure

1. In the maintenance utility Menu navigation tree, click System Management.

2. Click Select Cipher Suite.
3. Select the type of communication to use between the management client and the

storage system. The selections change the encryption level. Higher encryption
provides better security but the communication speed is slower.

■ TLS_RSA_WITH_AES_128_CBC_SHA (Prioritize Transmission Speed). This selection
provides higher communication speed and lower security.

■ TLS_RSA_WITH_AES_128_CBC_SHA256 (Prioritize Security). This selection provides
higher security and lower communication speed.

4. Click Apply to save the setting and close the dialog box.

Updating a signed certificate

To use SSL-encrypted communication, you must update and upload the private key and
the signed server certificate (public key) to the management client.

Selecting a cipher suite
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Note: The extended profile fields in the X.509 certificate support the following
items as specified in RFC5280:
■ BasicConstraints
■ KeyUsage
■ SubjectKeyIdentifier
■ subjectAltName

Before you begin
■ You must have the Storage Administrator (Initial Configuration) role to perform this

task.
■ You must be logged in to the SVP or management client.
■ A private key (.key file) has been created. Make sure that the file name is server.key.

■ The passphrase for the private key (server.key file) is released.
■ A signed public key certificate (.crt file) has been acquired. Make sure that the file

name is server.crt.

■ The private key (.key file) must be in PEM format. You cannot use DER format.
■ The signed public key certificate (.crt file) must be in X509 PEM format. You cannot use

X509 DER format.
■ The passphrase for the private key (server.key file) must be released.

Procedure

1. Close all management client sessions on the storage system, including Storage
Advisor Embedded, maintenance utility, and Device Manager - Storage Navigator.

2. Open a command prompt window with administrator permissions.
3. In the folder where the .bat file is located, execute the following command:

C:\MAPP\wk\Supervisor\MappIniSet>MappApacheCrtUpdate.bat
absolute-path-of-signed-public-key-certification-file absolute-
path-of-private-key-file

Note:

A space is required between MappApacheCrtUpdate.bat and the signed
public key certification file path.

A space is required between the signed public key certification file path
and the private key file path.

4. A completion message box displays. Press any key to acknowledge the message and
close the message box.

5. Close the command prompt window.

Updating a signed certificate
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Notes on updating a signed certificate for the service processor

The following notes provide additional information about updating a signed certificate.
■ While the service processor certificate is being updated, tasks that are being run or

scheduled to run on Device Manager - Storage Navigator are not executed.
■ Certificates for RMI communication are updated asynchronously. The process takes

about two minutes.
■ If the service processor certificate is updated while Ops Center Administrator or

Hitachi Command Suite is being set up, the setup operation will fail.
■ Updating the SSL certificate might change the system drastically and may lead to

service processor failure. Therefore take sufficient care to consider the content of the
certificate and private key to be set.

■ After the certificate update is complete, depending on the environment, the service
processor can take 30 to 60 minutes to restart.

Returning the certificate to default

You can return the certificate that was updated by the procedure in Updating a signed
certificate (on page 103) back to default.

Before you begin
■ You must have the Storage Administrator (Initial Configuration) role to perform this

task.
■ You must be logged into the management client.
■ A private key (.key file) has been created. Make sure that the file name is server.key.

See Creating a private key using the OpenSSL command (on page 93) .
■ The passphrase for the private key (server.key file) is released.
■ A signed public key certificate (.crt file) has been acquired. Make sure that the file

name is server.crt. See Creating a public key using the OpenSSL command (on
page 93) .

■ The private key (.key file) must be in PEM format. You cannot use DER format.
■ The signed public key certificate (.crt file) must be in X509 PEM format. You cannot use

X509 DER format. See Obtaining a self-signed certificate (on page 95) .
■ The extended profile fields in the X.509 certificate support the following items as

specified in RFC5280:
● BasicConstraints
● KeyUsage
● SubjectKeyIdentifier
● subjectAltName

■ The passphrase for the private key (server.key file) must be released.

Notes on updating a signed certificate for the service processor
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Procedure

1. Close all management client sessions on the storage system, including Storage
Advisor Embedded, maintenance utility, and Device Manager - Storage Navigator.

2. Open a command prompt window with administrator permissions.
3. In the folder where the .bat file is located, execute the following command:

C:\MAPP\wk\Supervisor\MappIniSet>MappApacheCrtInit.bat
4. A completion message box displays. Press any key to acknowledge the message and

close the message box.
5. Close the command prompt window.

Messages about website security certificates

When the message "There is a problem with this website's security certificate." is
displayed, click Continue to this website (not recommended).

When you are using encrypted SSL communications to connect to the storage system,
the browser displays a warning message if the security certificate is not issued by a
trusted certificate authority. This warning message also appears when the IP address or
host name specified in the URL does not match the CN listed in the security certificate.

If this warning message starts to appear after an update of the storage management
software, check to see if the SSL certificate returned to the default. If the SSL certificate
has returned to the default, install the certificate file that was backed up when the
storage management software was updated.

Updating the certificate files

The Update Certificate Files window is used to update the certificates that are used for
communication between the management client and the storage system.

Messages about website security certificates
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Before you begin
■ You must have the Storage Administrator (View & Modify) role to complete this

procedure.

Procedure

1. In the maintenance utility Menu navigation tree, click System Management.

2. Click Update Certificate Files.

Note: For storage systems without an SVP, unselect the Connect to SVP
box.

3. To update the certificate file on the management client:
a. Select the Web Server checkbox, then click Browse.
b. Browse to the certificate file and click Open. The File Upload window closes

and returns you to the Update Certificate Files dialog box.
c. In the Web Server Password: field, enter the certificate password.
d. Enter the password again in the Web Server Re-enter Password: field.

Note: For storage systems without an SVP, continue to step 5.

Updating the certificate files
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4. To update the certificate file on the SVP:
a. Select the Connect to SVP checkbox, then click Browse.
b. Browse to the certificate file and click Open. The File Upload window closes

and returns you to the Update Certificate Files dialog box.
c. In the Connect to SVP Password: field, enter the certificate password.
d. Enter the password again in the Connect to SVP Re-enter Password: field.

5. Click Apply to update the certificates.

Administering management software certificates

You can set or delete certificates for management software including Hitachi Command
Suite and Hitachi Ops Center Administrator that are used to check the server's reliability
when SSL communication external authentication is performed.

You cannot register the certificate for both of the HCS and Ops Center Administrator at
the same time. Register one of the certificate for the server you are using to manage the
storage system.

Registering management software certificates

To check the server reliability during SSL communication for management software
external authentication, upload an public key certificate of the management software to
the web server to register the certificate.

Before you begin
■ You must be logged into the SVP.
■ The private key file on the management software server must be current. Update it if

necessary.
■ The certificate file must have a .crt extension. Rename the file if necessary.
■ The certificate must be in X509 PEM format or X509 DER format.

Procedure

1. Close all Device Manager - Storage Navigator sessions on the SVP.
2. Open a command prompt window with administrator permissions.
3. In the folder where the certificate update tool is located, execute the following

command:
C:\MAPP\wk\Supervisor\MappIniSet>MappHcsCrtEntry.bat absolute-
path-of-signed-public-key-certificate-file

Note: A space is required between MappHcsCrtEntry.bat and the signed
public key certification file path.

Note: If using Hitachi Ops Center Administrator, execute the same
command.

Administering management software certificates
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4. A completion message box displays. Press any key to acknowledge the message and
close the message box.

5. Close the command prompt window.

Deleting HCS certificates

You can delete the certificates you registered for the management software. After you
delete a certificate, server reliability for that certificate is not checked by SSL
communication for management software external authentication.

Before you begin
■ You must be logged into the SVP.
■ The private key file on the management software server must be current. Update it if

necessary.
■ The certificate file must have a .crt extension. Rename the file if necessary.
■ The certificate must be in X509 PEM format or X509 DER format.

Procedure

1. Close all Device Manager - Storage Navigator sessions on the SVP.
2. Open a command prompt window with administrator permissions.
3. In the folder where the certificate update tool is located, execute the following

command:
C:\MAPP\wk\Supervisor\MappIniSet>MappHcsCrtDelete.bat

Note: If using Hitachi Ops Center Administrator, execute the same
command.

4. A completion message box opens. Press any key to acknowledge the message and
close the message box.

5. Close the command prompt window.

Using HSTS

HSTS (HTTP Strict Transport Security) is a security mechanism used when the Web server
communicates with the Web browser using HTTPS.

Note: If you enable HSTS, you might not connect to Device Manager - Storage
Navigator by using HTTP. If the connection does not work by using HTTP, use
HTTPS.

Enabling HSTS

To enable HSTS, use the following procedure:

Deleting HCS certificates
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Procedure

1. Open a command prompt with administrator permissions on the SVP.
2. Move the current directory to the folder in which the setting tool is located, and

then execute the following command:

cd /d C:\Mapp\wk\Supervisor\MappIniSet
MappHstsEnable.bat

Note: C:\Mapp: Indicates the installation directory of storage
management software and SVP software. If you specified an installation
directory other than C:\Mapp, replace C:\Mapp with the specified
installation directory.

3. When "Press any key to continue ..." appears in the window, press the Enter key.
4. To verify that HSTS is enabled, execute the following command:

MappHstsState.bat

Note:

If "hsts=on" appears, HSTS is enabled. Press the Enter key. If "hsts=off"
appears, HSTS is not enabled. Press the Enter key, and then go back to
step 2.

If the message indicating that the specified file could not be found
appears, the HSTS settings failed. Press the Enter key, and then go back
to step 2.

5. Close the command prompt window.

Disabling HSTS

To disable HSTS, use the following procedure:

Procedure

1. Open a command prompt with administrator permissions on the SVP.
2. Move the current directory to the folder in which the setting tool is located, and

then execute the following command:

cd /d C:\Mapp\wk\Supervisor\MappIniSet
MappHstsDisable.bat

Note: C:\Mapp: indicates the installation directory of storage
management software and SVP software. If you specified an installation
directory other than C:\Mapp, replace C:\Mapp with the specified
installation directory.

3. When "Press any key to continue ..." appears in the window, press the Enter key.
4. To verify that HSTS is disabled, execute the following command:

Disabling HSTS
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MappHstsState.bat

Note:

If "hsts=off" appears, HSTS is disabled. Press the Enter key. If "hsts=on"
appears, HSTS is not disabled. Press the Enter key, and then go back to
step 2.

If the message indicating that the specified file could not be found
appears, the HSTS settings failed. Press the Enter key, and then go back
to step 2.

5. Close the command prompt window.

Disabling HSTS
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Chapter 5:  Setting up user authentication

User authentication is required to operate the storage system.

Setting up authentication and authorization with Device
Manager - Storage Navigator

An authentication server enables users to log in to Device Manager - Storage Navigator
with the same password as the password that they use for other applications. The
authentication server must be configured for each user.

Note: If you use the SVP, enable the authentication by the SVP and disable
the external authentication by the Maintenance Utility. For how to disable the
external authentication by the Maintenance Utility, see Disabling external
authentication (on page 130) .

The following figure shows the login workflow without an authentication server:

The following figure shows the login workflow with an authentication server:

If an authorization server works together with an authentication server, the user groups
that are registered in the authorization server can be assigned to a user for Device
Manager - Storage Navigator.

The following figure shows the login workflow when an authentication server and an
authorization server are used in combination:
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You can use the authentication server without knowing the host names and port
numbers, if you register the information of the authentication server as an SRV record in
the DNS server. If you register multiple numbers of authentication servers to the SRV
record, you can determine the authentication server to be used, based on the priority
that has been set in advance.

If the affiliated user group registered in the external authentication server and the user
group registered locally in the storage system are different, the user group in the storage
system has higher priority.

External authentication requirements using authentication server

Authentication servers support the following protocols:
■ LDAPv3 simple bind authentication
■ RFC 2865-compliant RADIUS with PAP and CHAP authentication
■ Kerberos v5

Note: The authentication server needs to support TLS1.2 as a transfer
protocol.

External authentication requirements using authentication server
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The following root certificate file formats to be set on Device Manager - Storage
Navigator are available for LDAP server settings:
■ X509 DER format
■ X509 PEM format

Note:

The root certificate to be set on Storage Navigator must satisfy the
following requirements:
■ The extended profile fields in the X.509 certificate support the following

items as specified in RFC5280:
● BasicConstraints
● KeyUsage
● SubjectKeyIdentifier

The certificate to be set on the connected server must satisfy the following
requirements:
■ The extended profile fields in the X.509 certificate support the following

items as specified in RFC5280:
● BasicConstraints
● KeyUsage
● SubjectKeyIdentifier

■ The public key of the server certificate must be RSA.

One of the following encryption types must be used for the Kerberos server:

Windows
■ AES128-CTS-HMAC-SHA1-96
■ RC4-HMAC
■ DES3-CBC-SHA1
■ DES-CBC-CRC
■ DES-CBC-MD5

Solaris or Linux
■ DES-CBC-MD5

External authentication requirements using authentication server
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External authorization requirements using authorization server

The authorization server must satisfy the following requirements to work together with
the authentication server:

Note: Use an operating system that continues to be supported by a vendor.
The operation using firmware for which vendor support has expired cannot
be guaranteed.

Prerequisite OS
■ Windows Server 20081, 2

■ Windows Server 2008 R21, 2

■ Windows Server 2012 R2

Note:

1. Microsoft support for this operating system has expired. Use an
operating system for which Microsoft continues to provide the
support.

2. VSP E990 does not support this operating system

Prerequisite software
■ Active Directory

Authentication protocol for user for searching
■ LDAP v3 simple bind

Root certificate file format for Device Manager - Storage Navigator
■ X509 DER format
■ X509 PEM format

Requirements for root certificate to be set on Storage Navigator
The extended profile fields in the X.509 certificate support the following items as
specified in RFC5280:
■ BasicConstraints
■ KeyUsage
■ SubjectKeyIdentifier

Requirements for certificate to be set on the connected server
The extended profile fields in the X.509 certificate support the following items as
specified in RFC5280:
■ BasicConstraints
■ KeyUsage
■ SubjectKeyIdentifier

The public key of the server certificate must be RSA.

External authorization requirements using authorization server
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Note:
■ Acquire the root certificate for the authentication server from the

authentication server administrator.
■ The certificates has an expiration date. If the certificate expires, you will

not be able to connect to the authentication server. Make sure to set the
expiration date carefully to prepare the certificate.

■ For more information about the certificate management, consult with the
authentication server administrator and manage it appropriately.

Note: When using an LDAP server or a Kerberos server as an authentication
server, and combining it with an authorization server, use the same host for
the authentication and authorization servers.

When a RADIUS server is used as an authentication server, two
authentication servers (one primary and one secondary) can be specified, but
only one authorization server can be specified.

Creating configuration files

Authentication servers and authorization servers must be configured using configuration
files.

Configuration files can be created for LDAP, RADIUS, and Kerberos authentication
protocols.

Creating an LDAP configuration file

You can use an LDAP server for authentication on your storage system.

To use an LDAP server for authentication, create a configuration file in UTF-8 encoding.
Include information about the authentication server as shown in the following example.
Any file name and extension is allowed.

Caution: If you save the configuration file when using the Windows standard
Notepad application, specify ANSI for the letter code. If you use an editor
other than the memo pad and have the YTF-8 BOM setting, specify No BOM
then save.

auth.server.type=ldap 
auth.server.name=<server_name> 
auth.group.mapping=<value> 
auth.ldap.<server_name>.<attribute>=<value>

A full example is shown here:

auth.server.type=ldap 
auth.server.name=PrimaryServer 
auth.group.mapping=true 
auth.ldap.PrimaryServer.protocol=ldaps 

Creating configuration files
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auth.ldap.PrimaryServer.host=ldaphost.domain.local 
auth.ldap.PrimaryServer.port=636
auth.ldap.PrimaryServer.timeout=3
auth.ldap.PrimaryServer.attr=sAMAccountName
auth.ldap.PrimaryServer.searchdn=CN=sample1,CN=Users,DC=domain,DC=local
auth.ldap.PrimaryServer.searchpw=password
auth.ldap.PrimaryServer.basedn=CN=Users,DC=domain,DC=local
auth.ldap.PrimaryServer.retry.interval=1 
auth.ldap.PrimaryServer.retry.times=3
auth.ldap.PrimaryServer.domain.name=EXAMPLE.COM

The LDAP attributes are defined in the following table.

Attribute Description
Required /
Optional Default value

auth.server.type Type of an authentication
server. Specify ldap.

Required None

auth.server.name The name of an authentication
server.

When registering a primary
and a secondary server, use a
comma to separate the
names. The name of the
server, including the primary
name, secondary name, and
the comma (1 byte) must be
64 bytes or less.

The names can use all ASCII
code characters except for the
following: \ / : , ; * ? " < > | $ %
& ' ˜

In this manual, the value
specified here is called
<server_ name> hereafter.

Required None

auth.group.mappin
g

Information about whether to
work together with an
authorization server:
■ true: Works together
■ false: Does not work

together

Optional False

Creating an LDAP configuration file
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Attribute Description
Required /
Optional Default value

auth.ldap.<server_
name>.protocol

LDAP protocol to use.

Specify "ldaps" (Uses LDAP
over SSL/TLS).

Do not specify "starttls" (Uses
StartTLS)

Required None

auth.ldap.<server_
name>.host

A host name, an IPv4 address
or an IPv6 address of the LDAP
server. An IPv6 address must
be enclosed in square
brackets. To use StartTLS as a
protocol, specify a host name.

If this value is specified,
auth.ldap.<server_name>.dns_
lookup will be ignored

Optional1 None

auth.ldap.<server_
name>.port

A port number of the LDAP
server.

Must be between 1 and
65,535.2

Optional 389

auth.ldap.<server_
name>.timeout

The number of seconds before
the connection to the LDAP
server times out. It must be
between 1 and 30.2

Required 10

auth.ldap.<server_
name>.attr

Attribute name to identify a
user (such as a user ID).
■ Hierarchical model: An

attribute name where the
value that can identify a
user is stored

■ Flat model: An attribute
name for a user entry's
RDN

sAMAccountName is used for
Active Directory.

Required None

auth.ldap.<server_
name>.searchdn

DN of the user for searching. If
omitted,
[value_of_attr]=[Login_ID],
[value_ of _basedn] is used for
bind authentication.3

Otional None

Creating an LDAP configuration file
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Attribute Description
Required /
Optional Default value

auth.ldap.<server_
name>.searchpw

User password that is used for
searching. Specify the same
password that is registered in
the LDAP server.

Required None

auth.ldap.<server_
name>.basedn

BaseDN for searching for
users to authenticate.3

■ Hierarchical model: DN of
hierarchy that includes all
the targeted users for
searching

■ Flat model: DN of hierarchy
that is one level up from
the targeted user for
searching

Required None

auth.ldap.<server_
name>.retry.interv
al

Retry interval in seconds when
the connection to the LDAP
server fails. Must be between
1 and 5.2

Optional 1

auth.ldap.<server_
name>.retry.times

Retry times when the
connection to the LDAP server
fails.

Must be between 0 and 3.
Zero means no retry.2

Optional 3

auth.ldap.<server_
name>.domain.na
me

A domain name that the LDAP
server manages.

Required None

auth.ldap.<server_
name>.dns_lookup

Information about whether to
search the LDAP server with
the information registered in
the SRV records in the DNS
server.

Specify "false" (Searches with
the host name and port
number).

Do not specify "true" (Searches
with the information
registered in the SRV records
in the DNS server).

Optional False

Creating an LDAP configuration file
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Attribute Description
Required /
Optional Default value

Notes:

1. The item can be omitted if true is specified for
"auth.ldap.<server_name>.dns_lookup".

2. If the specified value is not valid, the default value will be used.
3. To use symbols such as + ; , < = and >, enter a backslash (\) before each symbol.

When using multiple symbols, each symbol must have a backslash before it. For
example, to enter abc++ in the searchdn field, use \+ instead of + as shown here:
abc\+\+

To enter \ , /, or ", enter a backslash and then enter the ASCII code in hex for the
following symbols:

■ Enter \5c for \

■ Enter \2f for /

■ Enter \22 for "

For example, to enter abc\ in the searchdn field, enter abc\5c.

Creating a RADIUS configuration file

You can use a RADIUS server for authentication on your storage system.

To use a RADIUS server for authentication, create a configuration file in UTF-8 encoding.
Include information about the authentication server as shown in the following example.
Any file name and extension is allowed. If an authorization server is not used, you do not
need to define the items for it.

Caution: If you save the configuration file when using the Windows standard
Notepad application, specify ANSI for the letter code. If you use an editor
other than the memo pad and have the YTF-8 BOM setting, specify No BOM
then save.

auth.server.type=radius 
auth.server.name=server-name
auth.group.mapping=value
auth.radius.server-name.attribute=value
auth.group.domain-name.attribute=value

A full example is shown below:

auth.server.type=radius 
auth.server.name=PrimaryServer 
auth.group.mapping=true 
auth.radius.PrimaryServer.protocol=PAP 
auth.radius.PrimaryServer.host=example.com 

Creating a RADIUS configuration file
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auth.radius.PrimaryServer.port=1812 
auth.radius.PrimaryServer.timeout=3 
auth.radius.PrimaryServer.secret=secretword 
auth.radius.PrimaryServer.retry.times=3 
auth.radius.PrimaryServer.domain.name=radius.example.com
auth.group.radius.example.com.protocol=ldaps
auth.group.radius.example.com.host=xxx.xxx.xxx.xxx
auth.group.radius.example.com.port=636
auth.group.radius.example.com.searchdn=CN=sample1,CN=Users,DC=domain,
DC=local
auth.group.radius.example.com.searchpw=password
auth.group.radius.example.com.basedn=CN=Users,DC=domain,DC=local

The attributes are defined in the following tables.

Table 5 RADIUS definition (for authentication server)

Attribute Description
Required /
Optional

Default
value

auth.server.type Type of an authentication server.
Specify radius.

Required None

auth.server.name The name of a server.

When registering a primary and
secondary server, use a comma to
separate the names. The name of
the server, including the primary
name, secondary name, and the
comma (1 byte) must be 64 bytes or
less.

The names can use all ASCII code
characters except for the following:

\ / : , ; * ? " < > | $ % & ' ˜

In this manual, the value specified
here is called server-name hereafter.

Required None

auth.group.mapping Information about whether to work
together with an authorization
server
■ true: Works together
■ false: Does not work together

Optional False

Creating a RADIUS configuration file
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Attribute Description
Required /
Optional

Default
value

auth.radius.server-
name.protocol

RADIUS protocol to use.
■ PAP: Password authentication

protocol that transmits plaintext
user ID and password

■ CHAP: Challenge-handshake
authentication protocol that
transmits encrypted password

Required None

auth.radius.server-
name.host

A host name, an IPv4 address or an
IPv6 address of the RADIUS server.
An IPv6 address must be enclosed
in square brackets.

Required1 None

auth.radius.server-
name.port

A port number of the RADIUS
server.

Must be between 1 and 65,535.

Optional2 1,812

auth.radius.server-
name.timeout

The number of seconds before the
connection to the RADIUS server
times out.

Must be between 1 and 30.

Optional2 10

auth.radius.server-
name.secret

RADIUS secret key used for PAP or
CHAP authentication

Required None

auth.radius.server-
name.retry.times

Retry times when the connection to
the RADIUS server fails.

Must be between 0 and 3. 0 means
no retry.

Optional2 3

auth.radius.server-
name.attr.NASIdentifier

Identifier for the RADIUS server to
find SVP. Specify this value if the
attr.NAS-Identifier attribute is used
in your RADIUS environment. ASCII
codes up to 253 bytes long are
accepted.

Optional None

auth.radius.server-
name.attr.NAS-IPv4-
Address

IPv4 address of the SVP. Specify the
value of the NAS-IP-Address
attribute. This value is transmitted
to the RADIUS server when the
authentication is requested.

Optional None

Creating a RADIUS configuration file
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Attribute Description
Required /
Optional

Default
value

auth.radius.server-
name.attr.NAS-IPv6-
Address

IPv6 address of the SVP. Specify the
value of the NAS-IPv6-Address
attribute. This value is transmitted
to the RADIUS server when the
authentication is requested.

Optional None

Notes:

1. If you query DNS with external authorization, the settings are not required.
2. If the specified value is not applicable, the default value will be used.

Table 6 RADIUS definition (for authorization server)

Attribute Description
Required /
Optional

Default
value

auth.radius.server-
name.domain.name

A domain name that the LDAP
server manages. In this manual, the
value specified here is called
domain-name hereafter.

Required None

auth.radius.server-
name.dns_lookup

Information about whether to
search the LDAP server with the
information registered in the SRV
records in the DNS server.

Specify "false" (Searches with the
host name and port number).

Do not specify "true" (Searches with
the information registered in the
SRV records in the DNS server).

Optional false

auth.radius.domain-
name.protocol

LDAP protocol to use.

Specify "ldaps" (Uses LDAP over
SSL/TLS).

Do not specify "starttls" (Uses
StartTLS).

Required None

auth.radius.domain-
name.host

A host name, an IPv4 address or an
IPv6 address of the LDAP server. An
IPv6 address must be enclosed in
square brackets ([ ]).

Optional1 None

auth.radius.domain-
name.port

A port number of the LDAP server.

Must be between 1 and 65535.

Optional2 389

Creating a RADIUS configuration file
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Attribute Description
Required /
Optional

Default
value

auth.radius.domain-
name.searchdn

DN of the user for searching. Required None

auth.radius.domain-
name.searchpw

User password for searching.
Specify the same password that is
registered in the LDAP server.

Required None

auth.radius.domain-
name.basedn

Base DN for searching for users to
authenticate. Specify DN of the
hierarchy, including all the users for
searching because the targeted
users for searching are in lower
hierarchy than the specified DN.

Optional3 abbr

auth.radius.domain-
name.timeout

The number of seconds before the
connection to the LDAP server
times out. Must be between 1 and
30.

Optional2 10

auth.radius.domain-
name.retry.interval

Retry interval in seconds when the
connection to the LDAP server fails.
Must be between 1 and 5.

Optional 1

auth.radius.domain-
name.retry.times

Retry times when the connection to
the LDAP server fails. Must be
between 0 and 3. 0 means no retry.

Optional2 3

Notes:

1. The item can be omitted if true is specified for "auth.radius.server-
name.dns_lookup".

2. If the specified value is not valid, the default value will be used.
3. To use symbols such as + ; , < = and >, enter a backslash (\) before each symbol.

When using multiple symbols, each symbol must have a backslash before it. For
example, to enter abc++ in the searchdn field, use \+ instead of + as shown here:
abc\+\+

To enter \ , /, or ", enter a backslash and then the ASCII code in hex for these
symbols.

■ Enter \5c for \.

■ Enter \2f for /.

■ Enter \22 for "

For example, to enter abc\ in the searchdn field, enter abc\5c.

Creating a RADIUS configuration file
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Creating a Kerberos configuration file

You can use a Kerberos server for authentication on your storage system.

To use a Kerberos server for authentication, create a configuration file in UTF-8 encoding.
Include information about the authentication server as shown in the following example.
Any file name and extension are allowed. If an authorization server is not used, you do
not need to define the items for it.

Caution: If you save the configuration file when using the Windows standard
Notepad application, specify ANSI for the letter code. If you use an editor
other than the memo pad and have the YTF-8 BOM setting, specify No BOM
then save.

auth.server.type=kerberos 
auth.group.mapping=<value> 
auth.kerberos.<attribute>=<value> 
auth.group.<realm name>.<attribute>=<value>

A full example is shown below:

auth.server.type=kerberos 
auth.group.mapping=true 
auth.kerberos.default_realm=example.com 
auth.kerberos.dns_lookup_kdc=true 
auth.kerberos.clockskew=300 
auth.kerberos.timeout=10
auth.group.example.com.protocol=ldaps
auth.group.example.com.port=636
auth.group.example.com.searchdn=CN=sample1,CN=Users,DC=domain,DC=local
auth.group.example.com.searchpw=password
auth.group.example.com.basedn=CN=Users,DC=domain,DC=local

The Kerberos attributes are defined in the following table.

Table 7 Kerberos definition (for authentication server)

Attribute Description
Required /
Optional Default value

auth.server.type Type of an authentication
server. Specify kerberos.

Required None

auth.group.mappin
g

Information about whether to
work together with an
authorization server
■ true: Works together
■ false: Does not work

together

Optional false

Creating a Kerberos configuration file
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Attribute Description
Required /
Optional Default value

auth.kerberos.defa
ult_realm

Default realm name Required None

auth.kerberos.dns_l
ookup.kdc

This is a switch that determines
which information registered in
the SRV records in the DNS
server to use when searching
the Kerberos server.

Specify "false" (Searches with
the host name and port
number).

Do not specify "true" (Searches
with the information registered
in the SRV records in the DNS
server).

Optional false

auth.kerberos.clock
skew

The acceptable range of the
difference in time between the
SVP and the Kerberos server
where the SVP is operating.

Must be between 0 and 300
seconds.

Optional1 300

auth.kerberos.time
out

The number of seconds before
the connection to the RADIUS
server times out. Must be
between 1 and 30. When 0 is
specified, the connection does
not time out until a
communication error occurs.

Optonal1 10

auth.kerberos.real
m_name

Realm identifier name

Any name to distinguish the
information of Kerberos server
in each realm. Duplicate names
cannot be used. If you register
multiple names, use a comma
to separate the names. The
value specified here is called
<realm_name> hereafter.

Optional2 None

auth.kerberos.<real
m _name>.realm

The realm name set to the
Kerberos server.

Optional2 None

Creating a Kerberos configuration file
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Attribute Description
Required /
Optional Default value

auth.kerberos.<real
m_name>.kdc

The host name, the IPv4
address, and the port number
of the Kerberos server. Specify
these in the format of "<Host
name or IP address>[:Port
number]".

Optional2 None

Notes:

1. If the specified value is not valid, the default value will be used.
2. The item can be omitted if true is specified for auth.kerberos.dns_lookup_kdc.

Table 8 Kerberos definition (for authorization server)

Attribute Description Required / Optional Default value

auth.group.<realm_
na me>.protocol

LDAP protocol to
use.

Specify "ldaps"
(Uses LDAP over
SSL/TLS).

Do not specify
"starttls" (Uses
StartTLS).

Required None

auth.group.<realm_
name>.port

A port number of
the LDAP server.

Must be between 1
and 65535.

Optional1 389

auth.group.<realm_
name>.searchdn

DN of the user for
searching.

Required2 None

auth.group.<realm_
name>.searchpw

Password of the
user for searching.
Specify the same
password that is
registered in the
LDAP server.

Required None

Creating a Kerberos configuration file
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Attribute Description Required / Optional Default value

auth.group.<realm_
name>.basedn

BaseDN when the
search for users
begins. When
searching, specify
the hierarchy DN,
including all the
users, because the
targeted user for
the search is in a
lower hierarchy
than the specified
DN.

Optional2 abbr

auth.group.<realm_
name>.timeout

Number of seconds
before the
connection to the
LDAP server times
out. Must be
between 1 and 30
seconds. When 0 is
specified, the
connection does
not time out until a
communication
error occurs.

Optional1 10

auth.group.<realm_
name>.retry.interval

Retry interval in
seconds when the
connection to the
LDAP server fails.
Must be between 1
and 5.

Optional1 1

auth.group.<realm_
name>.retry.times

Retry times when
the connection to
the LDAP server
fails. Must be
between 0 and 3. 0
means no retry.

Optional1 3

Notes:

1. If the specified value is not valid, the default value will be used.
2. To use symbols such as + ; , < = and >, enter a backslash (\) before each symbol.

When using multiple symbols, each symbol must have a backslash before it. For
example, to enter abc++ in the searchdn field, use \+ instead of + as shown here:
abc\+\+

Creating a Kerberos configuration file
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Attribute Description Required / Optional Default value

To enter \ , /, or ", enter a backslash and then the ASCII code in hex for these
symbols.

■ Enter \5c for \

■ Enter \2f for /

■ Enter \22 for "

For example, to enter abc\ in the searchdn field, enter abc\5c.

Connecting two authentication servers

Two authentication servers can be connected to a storage system. When the servers are
connected, the server configurations must be the same, except for the IP address and
the port.

If you search for a server using information registered in the SRV records in the DNS
server, confirm that the following conditions are satisfied:

Note: For RADIUS servers, you cannot use the SRV records.

LDAP server conditions:
■ The environmental setting for the DNS server is completed at the LDAP server.
■ The host name, the port number, and the domain name of the LDAP server are

registered in the DNS server.

Kerberos server conditions:
■ The host name, the port number, and the domain name of the Kerberos server

are registered in the DNS server.

Because UDP/IP is used to access the RADIUS server, no encrypted communications are
available, such as negotiations between processes. To access the RADIUS server in a
secure environment, encryption in the packet level is required, such as IPsec.

Connecting authentication and authorization servers

To use an authentication server and an authorization server, you must create
configuration files and configure your network. Detailed setting information is required
for the authentication server and the authorization server, especially for creating a
configuration file.

Before you begin
■ Contact your server administrator for information about the values to be written in

the LDAP, RADIUS, or Kerberos configuration file. If you use LDAP servers, obtain
certification for the LDAP server files.

■ Contact your network administrator for information about the network settings.

Connecting two authentication servers
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Procedure

1. Create a configuration file. The items to specify depend on the protocol you use.
2. Log in to the SVP and store the following files in an easily accessible location.

■ Certificate (for secure communication)

■ Configuration file

3. Open the Windows command prompt on the SVP.
4. In the folder where the .bat file is located, execute the following command

specifying the configuration file path and the certificate file path:

C:\MAPP\wk\Supervisor\MappIniSet>MappSetExAuthConf "C:\auth
\auth.properties" "C:\auth\auth.cer"

After you complete the settings and verify that you can use the authentication and
authorization servers, back up the connection settings for the authentication server.

If the authentication server and the authorization server are unusable even after
you make the settings, the network or the configuration file settings might have a
problem. Contact the server administrator or the network administrator.

5. When a message appears asking if you want to delete the specified configuration
file and certificate file, press y to delete the files.
If you do not delete these files now when prompted, delete them manually.

Disabling external authentication

You can disable the external authentication server using the maintenance utility.

Procedure

1. Log in to the maintenance utility.
2. Click Administration > External Authentication > Set Up Server > Disable.
3. When the confirmation window appears, click Apply.
4. When the completion message appears, click Close.

Disabling external authentication
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Chapter 6:  Monitoring alerts and events

Use alert notifications to monitor the storage system for changes in configuration or
status.

Alert notifications overview

You can view alert email messages, alert Syslog messages, and alert SNMP trap
messages using Device Manager - Storage Navigator or using the maintenance utility.

Before you begin

You must have the Storage Administrator (View Only) or Storage Administrator (Initial
Configuration) role to perform this task.
■ Email: Check your email to view alerts sent by email. Alerts that are reported through

email are the same as the SIM information that is displayed in the Alert window or
reported through an SNMP trap.

■ Syslog: Check the messages on the Syslog server to view alert information sent there.

■ SNMP traps: To view SNMP trap information, use the SNMP Manager in Device
Manager - Storage Navigator. See the Hitachi Alert Notification Guide for information
about using SNMP traps.

Configuring email notifications

Procedure

1. In the maintenance utility Administration pane, select Alert Notifications.
2. To send email notices, click Enable, next to Email Notice. Click Disable to not send

email notices.
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3. Click Add to add an email address to the list of registered addresses.

4. Enter the email address and then use the pull-down menu to select the type of
address: To, Cc, or Bcc.

5. Click OK to save the email address and close the dialog box.
6. Enter an email address in Email Address (From).
7. Enter an email address in Email Address (Reply To:).
8. In Mail Server Settings, select the mail server type: Identifier, IPv4, or IPv6.
9. To use SMTP authentication, click Enable.

10. In Account, enter an SMTP account name.
11. In Password, enter the SMTP account password.
12. Click Apply to save the changes and close the Set Up Alert Notifications window.

Configuring email notifications
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Note: If SIMs are not transferred through email, verify the settings in the
procedure. If all settings are correct, verify the settings and operating
conditions of the mail server itself, and the operating conditions of the
Management LAN.

Syslog settings

Procedure

1. Click the Syslog tab.

2. Select the type of transfer protocol to use.
3. In Primary Server:

a. Click Enable to use the server or Disable not to use it.
b. Select the type of IP address to use for the server: IPv4 or IPv6.
c. In Client Certificate File Name, click Browse to select a client certificate file.

4. In Secondary Server:
a. Click Enable to use the server or Disable not to use it.
b. Select the type of IP address to use for the server: IPv4 or IPv6.

Syslog settings
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c. In Client Certificate File Name, click Browse to select a client certificate file.

5. In Location Identification Name, enter a name to use to identify the server.
6. To set up an automatic attempt to reconnect to the server in case of communication

failure, in Retry, click Enable. Click Disable to not use this feature.
7. If you enabled retry, in Retry Interval, enter the number of seconds that the

system will wait between retry attempts.

Note: If SIMs are not transferred to the Syslog server, verify the settings
in the procedure. If all settings are correct, verify the settings and
operating conditions of the Syslog server itself, and the operating
conditions of the Management LAN.

SNMP settings

Procedure

1. Click the SNMP tab.
2. In SNMP Agent, click Enable to use the agent or Disable not to use it.
3. In Trap Destination, click the type of address to send the SNMP trap information:

Community or Public.
4. Click Add to add an SNMP trap address.

5. In Community, create a new community name or select an existing one.
6. In Send Trap to, enter a new IP address or select an existing one.
7. Click OK to save the information and close the dialog box.

SNMP settings
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Sending a test email message

Procedure

1. Click the Email tab.
The Email tab displays the current settings for the mail server, SMTP
authentications, and email addresses.

2. Click Send Test Email.
A completion notice is displayed.

3. Click OK to acknowledge the notice and close the message. Verify that the log
(Detailed data: "RefCode: 7FFFFF, This is Test Report.") has been transferred to the
Syslog server.

Example of a test email message

Subject: VSP Gx00 Report 
DATE : 24/10/2014 
TIME : 10:09:30 
Machine : Hitachi Virtual Storage Platform Gx00 (Serial# 64019) 
RefCode : 7fffff 
Detail: This is Test Report.

The field definitions in the test email message are listed in the following table.

Item Description

Subject Email title (name of the storage system) + (report)

DATE Date when a system failure occurred.

TIME Time when a system failure occurred.

Machine Name and serial number of the storage system.

RefCode Reference code. The same code as the one reported by SNMP traps.

Detail Failure details. The same information as the one reported by SNMP traps.

See the SIM Reference Guide for reference codes and failure details.

Sending a test Syslog message

Procedure

1. Click the Syslog tab.
The Syslog tab displays the current settings for the primary and secondary servers.

Sending a test email message
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2. Click Send Test message to the Syslog Server.
A completion notice appears.

3. Click OK to acknowledge the notice and close the message. Verify that the log
(Detailed data: "RefCode: 7FFFFF, This is Test Report.") has been transferred to the
Syslog server.

Sending a test SNMP trap

Procedure

1. Click the SNMP tab.
The SNMP tab displays the current settings for the storage system name, contact,
location, SNMP trap, and SNMP manager.

2. Click Send Test SNMP Trap.
A completion notice displays.

3. Click OK to acknowledge the notice and close the message.

Monitoring SIMs alerts in Device Manager - Storage
Navigator

The Device Manager - Storage Navigator main window opens an icon indicating whether
service information messages (SIMs) occurred in the storage system.

Procedure

1. In the Device Manager - Storage Navigator main window, click Alert. The Alerts
window opens.

2. To check the details of each alert, select and right-click one row, and then click
Detail in the pop-up menu. The detail dialog box opens.

3. If the following SIM reference codes appear, you must resolve the error (xxx
indicates the pool ID):

■ 601xxx, 602xxx, 602fffff, and 624000 (for Thin Image)

■ 620xxx, 621xxx, 622xxx, 624000, 625000, and 626xxx (for Dynamic Provisioning.

For details on how to resolve the error, see the Hitachi Thin Image User Guide or the
Provisioning Guide.

Sending a test SNMP trap
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Checking storage system alerts by using the maintenance
utility

When a notification consisting of information about the detection of a failure in the
storage system is sent via Health Status, an email message, or an SNMP trap message,
you can check the alert information by using the maintenance utility, and then take
appropriate action.

Before you begin

The logged-in user must be registered in the Maintenance user group (a built-in user
group).

Procedure

1. In the navigation bar, click Settings and then select Maintenance Utility to open
the maintenance utility.

2. Click the Alerts tab to display the list of alerts.
3. Check the alerts and then take appropriate action based on the notification

information.

Tip: For details about alerts, see the Provisioning Guide.

4. In the maintenance utility, click Log Out.

Using the Windows event log

Some failure information is output to the Windows event log.

Monitoring the system log using the Windows event log

You can manage the Windows error information by outputting failure information to the
event log.

Before you begin
■ The storage system status in the storage device list must be READY.

Procedure

1. Open a Windows command prompt with administrator permissions in SVP.

Checking storage system alerts by using the maintenance utility
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2. Execute the following command to move the current directory:

cd /d C:\Mapp\wk\model-identification-number\DKC200\mp\pc

■ The default installation directory is C:\Mapp:<installation-directory-of-SVP>

Note:

■ C:\Mapp indicates the installation directory of Device Manager -
Storage Navigator. If you specified another directory, replace
C:\Mapp: with the specified installation directory.

■ Without moving the current directory, failure information is not
output to the Windows event log if you execute the batch file in
step 3.

■ model-identification-number: Use the format <First 2 digits of firmware
version><model-name><serial-number>, where <model-name> is one of the
following:

VSP E990: 6000

VSP F350 and VSP G350: 2000

VSP F370, VSP F700, VSP F900, VSP G370, VSP G700, VSP G900: 6000

For example, for a VSP G700 that has the serial number 400102, the value is
886000400102.

3. Execute the following batch file:

eventlog.bat action monitoring-period

■ action: Specify one of the following:

0: Stop outputting failure information

1: Start outputting failure information

when this parameter is omitted, 0 is set.

■ monitoring-period: If you specified 1 for action, specify the monitoring period,
from 5 to 720 minutes.

■ A space is required between eventlog.bat and action.

■ A space is required between action and monitoring-period.

■ The command prompt is displayed if the command finishes without any errors.

4. Close the command prompt.

Viewing the system log in the Event Viewer

You can view the Windows event log which is output to the SVP.

Viewing the system log in the Event Viewer

Chapter 6: Monitoring alerts and events

System Administrator Guide for VSP E990 and VSP G130, G/F350, G/F370, G/F700, G/F900 138



Procedure

1. From the Windows start menu, click Control Panel > System and Security >
Administrative Tools > Event Viewer.

2. Click Windows Logs > Application in the left pane.

Output example

The storage system delivers a report after you send failure information to the event log.

The storage system failure information will look similar to the following example:

Output example
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# Item Description

1 Overview of the event info Displays the overview of the event
information

2 Detail of the event info Displays the selected information

Date: Date of the event occurrence

Time: Time of the event occurrence

Machine: Model name and serial number
of the storage system

Refcode: Reference code*

Detail: Detailed failure information*

ActionCode: Includes action code,
expected failure parts, and location. A
maximum of 8 failure information can be
shown.

3 Log name Displays the log type

This is always displayed as "Application"

4 Source Displays the name of the application
which issued the event

Output example
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# Item Description

This is always displayed as "Hitachi
Storage Navigator Alert Module"

5 Event ID Displays the event ID

This is always displayed as "10"

6 Level Displays the event alert level
■ Error: Acute or Serious
■ Warning: Moderate
■ Information: Service

7 User This is always displayed as "N/A"

8 OpCode This is always displayed as blank

9 Logged Displays the date and time when the
event log was registered

10 Task category This is always displayed as "None"

11 Keywords This is always displayed as "Classic"

12 Computer Displays the computer name on which the
event occurred

*For reference code, failure details, and alert level, see the SIM Reference Guide.

Events that do not affect the operation of the storage system

Occurrence of the following events does not affect the operation of the storage system:

Note: These events can be ignored.

Event Timing of occurrence of event

Log type: Application

Source: Application Error

Event ID: 1000

Level: Error

Application on which an error occurs:

DkcMan.exe

This event might occur at the following
timing:
■ When the storage management

software is updated
■ When the SVP is shut down or

rebooted

Events that do not affect the operation of the storage system
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Event Timing of occurrence of event

Module in which an error occurs:

ntdll.dll orjvm.dll
Exception code: 0xc0000005

Log type: Application

Source: Application Error

Event ID: 1000

Level: Error

Application on which an error occurs:

KickJava.exe
Module in which an error occurs:

SVPCMN32.dll
Exception code: 0xc0000005

This event might occur when the service
of the storage system is stopped.

Log type: Application

Source: Application Error

Event ID: 1000

Level: Error

Application on which an error occurs:

MpcL7Comm.exe

Module in which an error occurs:

MpcL7Mem.dll

Exception code: 0xc0000005

This event might occur at the following
timing:
■ When the services on the storage

system stop
■ When the storage management

software is updated
■ When the SVP is shut down or

rebooted

Log type: Application

Source: Application Error

Event ID: 1000

Level: Error

Application on which an error occurs:

RestPush_Base.exe

Module in which an error occurs:

jvm.dll

Exception code: 0xc0000005 or
0xc000041d

This event might occur when the service
of the storage system is stopped.

Events that do not affect the operation of the storage system
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Chapter 7:  Managing license keys

Accessing software functionality for your storage system requires a license key.

Overview

When you install a license key, it is automatically enabled and the timer on the license
starts at that time. To preserve time on a term key license, you can disable it without
uninstalling it. When you need the software, enable the license again.

If you do not install the software before you install the license key software, the software
will install correctly but will be disabled. To enable a license key, install the prerequisite
software, and then enable the key.

License key types

To use software, you must install the license key provided when you purchase that
software.

You can use software with licensed capacity for a term key by installing a term key and
overwriting a permanent key as long as the term key is valid. If the term key expires
when the system is being used, and the capacity needed for the operation is insufficient,
operations that you can perform are limited. In this case, a SIM that indicates the term
key expiration (reference code 7ff7xx) is output on the Alerts tab in the Storage Systems
window.

The following table describes the four types of license keys.

Type Description
Effective

term1

Estimating
licensed
capacity

Permanent For purchase No limit Required

Term For purchase 365 days Required

Temporary For trial use before purchase (try and
buy)

120 days Not required

Emergency For emergency use 30 days Not required

Notes:
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Type Description
Effective

term1

Estimating
licensed
capacity

1. When you log in to Device Manager - Storage Navigator, a warning message
appears if 45 days or less remain before the expiration.

Using the permanent key

You can purchase the permanent key to use a software application indefinitely. You must
estimate a licensed capacity required for using the software application and purchase a
license key for the amount of the required capacity.
■ If insufficient license capacity is installed, Not Enough License displays in the status

field of the License Keys window, and the software application is not enabled.
■ If the capacity of the usable volume exceeds the licensed capacity while the storage

system is running (for example, when an LDEV is additionally installed), Grace Period
displays in the status field of the License Keys window. You can continue to perform
the same operations, but the deficient amount of license capacity must be purchased
within 30 days.

Using the term key

You can purchase the term key to use the software application for a specific number of
days. You must estimate a licensed capacity required for using the software application
and purchase a license key for the amount of the required capacity.
■ If insufficient license capacity is installed, Not Enough License or Grace Period

displays in the status field of the License Keys window.
■ You can enable or disable the term key for each software application. Unlike the

temporary key and the emergency key, the number of days the term key is enabled is
counted as the number of effective days of the term key rather than the number of
elapsed days from the installation date.

■ The number of effective days is decremented by one day when the date changes.

For example, if the term key is set to be enabled for 150 days during installation and
the term key is disabled for 100 days and a total of 250 days have elapsed since the
installation, the number of remaining effective days of the term key is 215 days. This
is determined by subtracting 150 days from 365 days. By disabling the term key on
the days when the software application is not used, you can prevent the unnecessary
shortening of the period in which the term key can be used.

■ If the term key is expired, Not Installed displays in the status field of the License Keys
window, and the software application is disabled.

Using the permanent key
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Using the temporary key

You can use the temporary key for trial purposes. The effective term is 120 days from the
time of installation of the temporary key. The effective term is not increased even if the
temporary key is reinstalled during the effective term.

If you uninstall the temporary key, even though the effective term remains, Temporary is
displayed in the status field, Not Installed is displayed in the Key Type field, and the
remaining days of the effective term are displayed in the Term (Days) field of the License
Keys window.

If the temporary key expires, you cannot reinstall the temporary key for 180 days.
Expired displays in the status field of the License Keys window, and the software
application is disabled.

Using the emergency key

You can use the emergency key if the license key cannot be purchased, or if an
emergency occurs, such as a system failure or a communication error.

You can also use the emergency key if the configuration of the software application that
is installed by the temporary key remains in the changed status and cannot be restored
to the original status. For example, if you do not plan to purchase the software
application after using the temporary key for trial purposes, you can restore the changed
configuration to the original status by temporarily enabling the software application with
the emergency key.

Caution:
■ If an emergency key is installed for a software application for which a

permanent or term key is installed, the effective term of the license key is
30 days. However, because the emergency key can be reinstalled during
the effective term, the effective term can be restored to 30 days.

■ In other scenarios, the emergency key can be installed only once.

Software bundle

VSP F350, VSP
F370, VSP F700,

VSP F900
VSP G350, VSP

G370
VSP G700, VSP

G900

Hitachi Foundation
Suite

Unlimited Unlimited Used capacity or
mounted capacity

Hitachi Remote
Data Protection

Unlimited Unlimited Used capacity or
mounted capacity

global-active device Unlimited Unlimited Used capacity or
mounted capacity

Hitachi Encryption
License Key

Unlimited Unlimited Unlimited

Using the temporary key
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Cautions on license capacities in license-related windows

License capacities are displayed not only in license-related windows but also in the Pools
window and the Replication window.

When you install or overwrite a temporary key or an emergency key for an installed
software application, the license capacity before the overwrite installation is displayed as
Permitted (TB) in license-related windows. However, Unlimited (license capacity for the
temporary key or emergency key) is displayed as Licensed Capacity in the Pools window
and the Replication window.

For example: You install a term key that has a license capacity of 5 TB for Compatible
FlashCopy®, and when the term expires, you use an emergency key. In license-related
windows, 5 TB is displayed in the Permitted (TB) field. However, in the Licensed
Capacity field in a Replication window, Unlimited (capacity of the emergency key) is
displayed.

Estimating licensed capacity

The licensed capacity is volume capacity that you are licensed to use with the software
application. You must estimate the amount of capacity that you want to use with the
software application before you purchase the permanent key or the term key.

Software and licensed capacity

The following table describes the three types of licensed capacity: used capacity,
mounted capacity, and unlimited capacity. The type you select depends on the software
application.

Caution: If you use Dynamic Provisioning, the licensed capacity might
become insufficient because the used capacity of Dynamic Provisioning pools
could increase, even if you do not add any volumes. If this happens, you must
purchase an additional license within 30 days to increase the capacity to
match the new volume size. For instructions to calculate pool capacity, see
the Provisioning Guide.

Table 9 Licensed capacity types

Type Description

Used capacity The licensed capacity is calculated by using one of the following
capacities:
■ Normal volumes (volumes)
■ External volumes mapped to the storage system
■ Pools

Cautions on license capacities in license-related windows

Chapter 7: Managing license keys

System Administrator Guide for VSP E990 and VSP G130, G/F350, G/F370, G/F700, G/F900 146



Type Description

If the pool contains pool volumes that belong in accelerated
compression-enabled parity groups, you must purchase physical
capacity of the pool for the license capacity.

Mounted capacity /
usable capacity

The licensed capacity is estimated by using the capacity of all the
volumes in the storage system.

When you estimate for the capacity of the accelerated
compression-enabled parity groups, the physical capacity of the
parity group is the maximum of the estimated capacity, even if
you created an internal volume which exceeds the physical
capacity of the accelerated compression-enabled parity group.
See the Provisioning Guide for an explanation of accelerated
compression.

Unlimited capacity You can use the software regardless of the volume capacity.

The following tables list the software bundles and specify the licensed capacity type(s) for
each bundle.

Table 10 Software bundle licensed capacity for VSP E990

Software bundle Licensed capacity

Base Package Used capacity or mounted capacity

Advanced Package Used capacity or mounted capacity

Remote Data Protection Used capacity or mounted capacity

Global-active device Used capacity or mounted capacity

Table 11 Software bundle licensed capacity for VSP G/F350, G/F370, G/F700, G/F900

Software bundle VSP G350, G370 VSP G700, G900
VSP F350, F370,

F700, F900

Hitachi Foundation
Suite

Unlimited Used capacity or
mounted capacity

Unlimited

Hitachi Remote
Data Protection

Unlimited Used capacity or
mounted capacity

Unlimited

Global-active device Unlimited Used capacity or
mounted capacity

Unlimited

Hitachi Encryption
License Key

Unlimited Unlimited Unlimited

Software and licensed capacity
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Calculating licensed capacity for a normal volume

A normal volume is a volume that is not blocked or protected. For OPEN-V volumes, the
licensed capacity of a volume is the same as the capacity specified when creating the
volume.

Calculating licensed capacity for an external volume

Use the following equation to calculate the licensed capacity for an external volume:

External Volume Capacity (KB) = Volume Capacity (number of blocks) X
512 (bytes) / 1,024

Calculating pool capacity

The license capacity of Dynamic Provisioning is calculated using the total capacity of the
Dynamic Provisioning pool. If you use Dynamic Provisioning V-VOLs as P-VOLs or S-VOLs
of ShadowImage, TrueCopy, Universal Replicator, or global-active device, the license
capacity of ShadowImage, TrueCopy, Universal Replicator, or global-active device is
calculated by using the page capacity allocated to the Dynamic Provisioning V-VOLs (that
is, used pool capacity).

For more information on calculating pool capacity, see the Provisioning Guide.

Accelerated compression-enabled parity group capacity

For the actual capacity of accelerated compression-enabled parity groups, the total
capacity of LDEVs created in the parity group and the physical capacity are compared.
The one with the least capacity is added as the actual capacity. See the following table for
an example.

Total LDEV capacity in the
parity group Physical capacity

Actual capacity which is
added

12 TB 20 TB 12 TB

24 TB 20 TB 20 TB

Installing license keys using maintenance utility

When installing a software product that enables you to use additional features, you first
need to register the license key provided when you purchased that software product.

Before you begin

Prepare the license key code or the license key file for the software product to be
installed.

Calculating licensed capacity for a normal volume
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Procedure

1. In the navigation bar, click  (Settings), and then select Licenses.

2. In the maintenance utility, click Install.
3. Specify the license key code or the license key file, and register the license key.

Tip: For more information, refer to Help in the maintenance utility.

4. In the list of license keys, confirm that the status of the software product has
changed to Installed.

5. In the maintenance utility, click Log Out.

Managing licenses

Use the Licenses window in the maintenance utility to install and uninstall block license
keys.

Caution: If you use Dynamic Provisioning, the licensed capacity might
become insufficient because the used capacity of Dynamic Provisioning pools
could increase even if you do not add any volumes. If this occurs, you must
purchase an additional license within 30 days to cover the capacity shortage.
For details on how to calculate pool capacity, see the Provisioning Guide.

Caution: When you remove Data Retention Utility an error might occur even
if the Permitted Volumes column of the License Keys window indicates that
the licensed capacity is 0 TB.

Enabling a license

You can enable a license that is in disabled status.

Managing licenses
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Before you begin

You must have the Storage Administrator (Initial Configuration) role to perform this task.

Procedure

1. From the Maintenance Utility menu, click License Keys to open the License Keys
window.

2. Select the license to enable. You can select from one to all of the licenses listed in
the window at the same time.

3. Click Enable to display the License Keys window.
4. Check the settings and click Apply.

Disabling a license

You can disable a license that is in enabled status.

Before you begin

You must have the Storage Administrator (Initial Configuration) role to perform this task.

Procedure

1. From the Maintenance Utility menu, click License Keys to open the License Keys
window.

2. Select the license to disable. You can select from one to all of the licenses listed in
window the at the same time.

3. Click Disable to display the License Keys window.
4. Click Finish.
5. Check the settings and click Apply.

Removing a software license

You can remove a software license that is in disabled status.

Before you begin

You must have the Storage Administrator (Initial Configuration) role to perform this task.

Procedure

1. In the maintenance utility Administration tree, click License Keys.
2. In the License Keys window, select the license to uninstall. You can select from one

to all of the licenses listed in the window at the same time.
3. In the License Keys window, click Uninstall Licenses.
4. Check the settings and click Apply.

On rare occasions, a software option that is listed as Not Installed but still has
available licensed capacity (shown as XX TB) might remain in the list. In this case,
select that option and uninstall the software.

Disabling a license
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Note: To reinstall a license key after uninstalling it, contact customer
support to reissue the license key file.

Removing a Data Retention Utility license

Caution: When you remove a Data Retention Utility license, an error might
occur, even if the Permitted Volumes column of the License Keys window
indicates that the licensed capacity is 0 TB.

Procedure

1. Click Actions > Other Function > Data Retention to open the Data Retention
window.

2. In the Data Retention window, find logical volumes that are unusable as S-VOLs.
3. Change the settings so that the logical volumes are usable as S-VOLs.
4. Uninstall the Data Retention Utility.

Examples of license information

The following table provides examples of license information displayed in the License
Keys table of the maintenance utility.

Note: When using Volume Migration, you do not need to install the license
key. The function of Volume Migration is available regardless of the license
key status displayed in the maintenance utility.

License key status
(example) Status Key type

Licensed
capacity Term (Days)

Not installed Not installed blank Blank Blank

Installed with the
permanent key

Installed permanent Permitted -

Installed with the term
key and set to Enabled

Installed term Permitted Number of
remaining days
before
expiration

Installed with the term
key and set to
Disabled

Installed
(Disabled)

term Permitted -

Installed with the
temporary key.

Installed temporary - Number of
remaining days
before
expiration

Removing a Data Retention Utility license
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License key status
(example) Status Key type

Licensed
capacity Term (Days)

Installed with the
emergency key.

Installed emergency - Number of
remaining days
before
expiration

A temporary key was
installed, but has
expired.

Expired temporary - Number of
remaining days
before
expiration

A term key or an
emergency key was
installed, but has
expired.

Not installed blank Blank Blank

Installed with the
permanent key or the
term key, but the
licensed capacity was
insufficient.

Not Enough
License

permanent or
term

Permitted and
Used

-

Installed with the
permanent or term
key, and then LDEVs
are added, but the
license capacity was
insufficient.

Grace Period permanent or
term

Permitted and
Used

Number of
remaining days
before
expiration

Installed with the
temporary key, and
then reinstalled with
the permanent key,
but the license
capacity was
insufficient.

Installed temporary Permitted and
Used

Number of
remaining days
before
expiration

Installed with the
permanent or term
key, then reinstalled
with the emergency
key.

Installed emergency Permitted and
Used

Number of
remaining days
before
expiration

Examples of license information
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License key expiration

If the license key for software-A expires, the license key for software-B is also disabled if
software-B requires an enabled software-A. In this scenario, Installed (Disabled) is shown
for software-B in the Status column of the License Keys table. After that, when you re-
enable software-A, software-B is also re-enabled. If the Status column for software-B
continues to display Installed (Disabled), go to the License Keys table and manually
change the status of software-B back to Installed.

After your license key expires, no new configuration settings can be made, and no
monitoring functions can be used with Performance Monitor. Configuration settings
made before the expiration of the license key remain in effect. You can cancel
configuration changes for some software.

License key expiration
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Chapter 8:  Configuring audit logs

You must set up a syslog server and export an audit log file before you can view an audit
log for the storage system.

Audit log settings window

The following figure is the Audit Log Setting window in the maintenance utility.

The Audit Log Settings window shows the current audit log settings. Select one of more
of the three tabs to change the settings.

Setting up a syslog server

Before you begin

You must have the Audit Log Administrator (View & Modify) role to perform this task.

Procedure

1. In the maintenance utility Administration tree, select Audit Log Settings.
2. Click Set Up Syslog Server.
3. Select the desired Transfer Protocol.
4. Enable or disable the Primary Server.
5. Enable or disable the Secondary Server.
6. Enable or disable the Output Detailed Information.
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7. Click Apply to save the settings or Cancel to close the window without saving the
settings.

Exporting audit log files overview

You can export audit log files stored in the management client using Hitachi Device
Manager - Storage Navigator or files stored in the storage system using the maintenance
utility.

Exporting audit log files stored in the management client

Procedure

1. In the main window, click Audit Log on the menu bar.
The icons on the menu bar show the accumulated status of the audit log files.

2. From the Audit Log Properties window, click Download (SVP) to export logs
operated by the Device Manager - Storage Navigator client computer (SVP window).
Click Download (DKC) to export commands sent from a host or computers using
CCI or logs of events on encryption keys.
The preparation message appears.

Exporting audit log files overview
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Item Description

Usage Rate Indicates how much of storage capacity
of the non-transfer audit logs is used in
comparison to the maximum storage
capacity.

Download (SVP) Audit logs of the following contents or
type are exported:

■ Operation set by the client PC

■ Operation logs of encryption keys for
encrypting stored data

■ Execution logs of Remote
Maintenance API

3. Click OK.
A window opens where you can specify the export destination.

4. Specify the export destination and file name, and then click Save.
5. Click Close.

Exporting audit log files stored in the storage system

You can export audit logs from either the controller or the GUM located on the
controller.

The storage system has two controllers, so to get audit logs for the complete system, you
must log-in to the maintenance utility on each controller to export the audit log
individually.

Before you begin

You must have the Audit Log Administrator (View Only) role to perform this task.

Procedure

1. In the maintenance utility under Administration menu, select Audit Log Settings.
2. Click Export Audit Log in the Audit Log Settings window to select GUM or DKC.
3. Click OK.

Note: The security confirmation window is displayed. If the certificate is
invalid at the time of the connection, the security confirmation window is
displayed. If the security confirmation window is displayed, select
Continue to this website (not recommended).

4. Save the file to the folder containing audit logs.

Note: If you change the location identification name of a syslog server,
the location identification name on new audit logs could be changed
retroactively.

Exporting audit log files stored in the storage system
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Note: If you change the UTC time zone setting of the storage system, the
times recorded on new audit logs could be changed retroactively.

Send test message to syslog server

Use the following procedure to send a test audit log message to the syslog server.

Before you begin

You must have the Audit Log Administrator (View Only) role to perform this task.

Procedure

1. In the maintenance usage Administration tree, select Audit Log Settings.
2. Click Send Test Message to Syslog Server. The following message box opens:

3. Click OK to close the message box. Check the syslog server messages and verify that
the test message was received and is on the server.

Send test message to syslog server
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Chapter 9:  Managing Device Manager - Storage
Navigator storage system reports

Device Manager - Storage Navigator can generate a standard set of reports that provide
views of various aspects of the storage system. In addition to these views, you can
generate custom reports for specific areas of the system. These include a summary of
the system data and configuration, ports, channel adapters, and disk adapters. You can
save reports in CSV files or HTML files. Tables in the HTML version of the configuration
reports are sortable.

Before making changes to a storage system, create reports of your storage system’s
physical configurations and logical settings. Make a similar report after the changes, and
then compare the reports to verify that new settings were made as intended.

About storage system reports

Device Manager - Storage Navigator can generate a standard set of reports that provide
views of various aspects of the storage system. In addition to these views, you can
generate custom reports for specific areas of the system. These include a summary of
the system data and configuration, ports, channel adapters, and disk adapters. You can
save reports in CSV files or HTML files. Tables in the HTML version of the configuration
reports are sortable.

Before making changes to a storage system, create reports of your storage system’s
physical configurations and logical settings. Make a similar report after the changes, and
then compare the reports to verify that new settings were made as intended.

Viewing configuration reports

The configuration report created on Device Manager - Storage Navigator (HDvM - SN) can
be archived by downloading it to the management client.
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Note:
■ Adobe Flash Player is required to display configuration reports created

with SVP firmware version 88-06-01 or earlier.
■ Configuration reports created with SVP firmware version 88-06-0x or later

or later might not be displayed depending on the web browser version on
the management client. You must use the latest version of the web
browser. (Use the management client running an OS that supports the
latest version of the web browser.)

■ If you use Google Chrome, specify the Start Option –allow-file-
access-from-files.

■ If you use Google Chrome, the window used to specify the location where
the folder will be saved might not appear when downloading the report. In
this case, click Chrome Menu > Settings > Show advanced settings, and
under Privacy clear the checkbox for Protect you and your device from
dangerous sites.

Before you begin
■ Adobe Flash Player must be installed.
■ Users can view the reports that they created.
■ Users who have the Storage Administrator (Initial Configuration) role can view all

reports.

Note: The window used to specify the location where the folder will be saved
might not appear when downloading the report in Google Chrome. In this
case, follow Chrome Menu > Settings > Show advanced settings and uncheck
the Protect you and your device from dangerous sites checkbox under
Privacy.

Procedure

1. Expand the Storage Systems tree, and then click Reports.
2. Specify the report to download.
3. Click Download Reports.

Note: If you are running HDvM - SN with Adobe AIR, a character string
that depends on the AIR environment is displayed in the title of the
download window.

4. Specify a folder in which to save a .tgz file.

5. Extract the downloaded .tgz file.

Viewing configuration reports
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6. Display the report.
For HTML reports, open the file extracted-folder\html\index.html.

The following warning message might appear when opening an HTML file: An
ActiveX control on this page might be unsafe to interact with other parts of the
page. Do you want to allow this interaction? This message appears when the
program embedded in the report accesses a local file. Click Yes to continue the
operation.

For CSV reports, open a CSV file in the folder extracted-folder\csv.

Viewing configuration reports in the Reports window

You can view only HTML format reports in the Reports window.

Note:
■ Adobe Flash Player is required to display configuration reports created

with SVP firmware version 88-06-01 or earlier.
■ If you use Google Chrome, specify the Start Option –allow-file-

access-from-files.

Procedure

1. Expand the Storage Systems tree, and then click Reports.
2. Click the name of the report to display.

The report is displayed in the Reports window.
3. In the Reports window, click the name of the report in the list at the left, and then

view the report at the right.

Creating configuration reports

You can create up to 20 configuration reports for each storage system. If you already
created 20 reports, delete unnecessary reports first, and then create a new report.

Before you begin

You must have Storage View permission to perform this task.

Procedure

1. Open the Create Configuration Report window. From General Tasks, click Create
Configuration Report.

2. Specify a task name and click Apply. This task name is used as the report name in
the Reports window. This process takes approximately 10 minutes to complete.

3. Click Refresh to update the Reports window. The created report appears in the list.

Deleting configuration reports

You can delete a configuration report when you no longer need it, or to make room in
the Reports window when the number of reports is near the limit.

Viewing configuration reports in the Reports window
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Before you begin

Users that create the report or users with the Storage Administrator (Initial
Configuration) role can delete a configuration report.

Procedure

1. Expand the Storage Systems tree, and then click Reports.
2. Select the report to delete.
3. Click Delete Reports.
4. Click Apply.

Downloading dump files

Use the Dump tool to download dump files onto a management client. The downloaded
dump files can be used to:
■ Troubleshoot the system. Use the Dump tool to download dump files from the SVP

and give it to the support personnel.
■ Check system configuration. First, click File > Refresh All to update the configuration

information, and then use the Dump tool to download the dump files.
■ Before deleting the storage management software and the SVP software. Collect the

dump files of the SVP system information.

There are two types of dump files:
■ Normal Dump includes all information about the SVP and the minimum information

about the storage system. Select this when you have a less serious problem such as
incorrect display.

■ Detail Dump includes all information about the SVP and the storage system. Select
this when Device Manager - Storage Navigator has a serious problem (for example,
Device Manager - Storage Navigator does not start) or when you need to determine if
the storage system has a problem.

Before you begin
■ You must be logged into the SVP.
■ Device Manager - Storage Navigator must be running.
■ The configuration information must be refreshed by selecting File > Refresh All in

Device Manager - Storage Navigator.
■ All other users (including the SVP user) must stop using the Dump tool.
■ Stop all maintenance operations.
■ Dump tools from other storage systems must not be used during the process.
■ The installation directory of Storage Navigator must be excluded from the real time

virus scan targets by the virus detection program. For the virus detection program
settings, see Preventing errors while using virus detection programs on the SVP (on
page 55) .

Downloading dump files
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Note:

If the error is in regards to Device Manager - Storage Navigator starting up,
collect information about the SVP using the Dump tool, without Device
Manager - Storage Navigator running.

Procedure

1. Close all Device Manager - Storage Navigator sessions on the SVP.
2. Open a Windows command prompt with administrator permissions.
3. Move the current directory to the folder where the tool is available. (For example:

<SVP-root-directory>\DKC200\mp\pc).

4. Specify the output destination of the dump file and execute Dump_Detail.bat or
Dump_Normal.bat.

For example, if you are storing the result of Dump_Detail.bat to
C:\Result_832000400001, enter the following:

C:\MAPP\wk\832000400001\DKC200\mp\pc>Dump_Detail.bat 
C:\Result_832000400001

Downloading dump files
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Note:

■ A space is required between Dump_Detail.bat and C:\Result.

■ The dump file name is hdcp.tgz. To manage dump files by storage
systems, we recommend adding a serial number to the output folder
name. For example, if the serial number is 832000400001, the folder
name should be C:\Result_832000400001.

■ A folder under the network drive cannot be specified as the output
destination.

■ When the tool is being executed, Executing is displayed in the
command prompt. When the execution is completed, the following is
displayed:

zSv_AutoDump.exe is completed.

zSv_AutoDump.exe is completed.” might not be displayed even after
the completion of the tool execution due to the heavy load on the SVP
or other cause. If it is not displayed even after 20 minutes, check
whether a dump file is output in the output folder for the dump file.
When a dump file is output, see the date and time of the file update
to confirm that the file is created after 20 minutes have passed since
the start time of execution of the dump tool. When no dump file is
output, close the command prompt and execute the dump tool again.

Note: If the execution fails, zSv_AutoDump.exe is
failed is displayed.

■ You cannot specify the folders under the network drive as the output
folder.

■ The dump file capacity might become approximately 3 GB depending
on the usage of the storage system.

5. A completion message box displays. Press any key to acknowledge the message and
close the message box.
hdcp.tgz: This is the dump file. Give this file to the maintenance personnel. If you
save too many dump files in the SVP storage, space might not be available.
Therefore, move the dump file outside of SVP storage.

zSv_AutoDump.log: This is the log file of the dump tool. If the dump file is not
output, give this log file to the maintenance personnel. If the dump file is output,
delete the log file.

DumpResult.txt: This is the collection results file. The results are displayed in the
following catagories:

DKC dump
Collection result of the DKC dump data

Dump of GUM of CTRL1
Collection result of the GUM (CTL1) dump data

Downloading dump files
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Dump of GUM of CTRL2
Collection result of the GUM (CTL2) dump data

exist is displayed if the collection was successful. not exist is displayed if the
collection has failed.

6. Close the Windows command prompt.

Collecting dump files manually

You can collect dump files manually if the dump tool is unavailable or is causing an error
in the dump files.

Note:
■ installDir indicates the installation directory of the storage

management software and the SVP software (for example, C:\Mapp).

■ %USERPROFILE% indicates the installation login user of the SVP (for
example, C:\Users\<user name>).

■ %WINDIR% indicates the Windows folder in the system drive (for example,
C:\Windows).

■ [Storage system number](Example) When the storage system number
is 832000400001, the folder name is as follows:. <installDir>\wk
\832000400001\DKC200\mp\pc\*.trc

■ Note that some files do not exist depending on the operating
environment.

Collecting dump files manually
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Files to collect manually:

Collecting dump files manually
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■ <installDir>¥wk¥supervisor¥dkcman¥log¥*.*
■ installDir>¥wk¥supervisor¥dkcman¥cnf¥*.*
■ <installDir>¥wk¥supervisor¥rmiserver¥log¥*.*
■ <installDir>¥wk¥supervisor¥rmiserver¥cnf¥*.*
■ <installDir>¥wk¥supervisor¥sdlist¥log¥*.*
■ <installDir>¥wk¥supervisor¥mappiniset¥logs¥MappIniSet¥*.*
■ <installDir>¥wk¥supervisor¥mappiniset¥mpprt¥cnf
■ <installDir>¥wk¥supervisor¥assist¥log¥*.*
■ <installDir>¥wk¥supervisor¥assist¥cfg¥*.*
■ <installDir>¥wk¥supervisor¥assist¥dat¥*.*
■ <installDir>¥wk¥supervisor¥assist¥history¥*.*
■ <installDir>¥wk¥supervisor¥comweb¥logs¥*.*
■ <installDir>¥wk¥supervisor¥microsetup¥log¥*.*
■ <installDir>¥wk¥supervisor¥portmanager¥cnf¥*.*
■ <installDir>¥wk¥supervisor¥portmanager¥logs¥PortManager¥*.*
■ <installDir>¥wk¥supervisor¥restapi¥data
■ <installDir>¥wk¥supervisor¥restapi¥logs
■ <installDir>¥wk¥supervisor¥restapi¥build.json
■ <installDir>¥wk¥supervisor¥restapi¥version.json
■ <installDir>¥wk¥supervisor¥system¥log¥*.log
■ <installDir>¥wk¥[Storage system number]¥DKC200¥mp¥pc¥*.trc
■ <installDir>¥wk¥[Storage system number]¥DKC200¥mp¥pc¥*.dmp
■ <installDir>¥wk¥[Storage system number]¥DKC200¥mp¥pc¥*.dbg
■ <installDir>¥wk¥[Storage system number]¥DKC200¥mp¥pc¥*.dmb
■ <installDir>¥wk¥[Storage system number]¥DKC200¥mp¥pc¥*.ini
■ <installDir>¥wk¥[Storage system number]¥DKC200¥mp¥pc¥*.inf
■ <installDir>¥wk¥[Storage system number]¥DKC200¥san¥SN2¥SN2Files

¥logs¥*.*
■ <installDir>¥wk¥[Storage system number]¥DKC200¥san¥SN2¥SN2¥logs

¥*.*
■ <installDir>¥wk¥[Storage system number]¥DKC200¥san¥cgi-bin¥utility

¥log¥*.*
■ <installDir>¥wk¥[Storage system number]¥DKC200¥others¥commdata¥*.*
■ <installDir>¥wk¥[Storage system number]¥DKC200¥config¥*.cfg
■ ¥wk¥[Storage system number]¥SMI\logs\*.*
■ <installDir>¥OSS¥apache¥logs¥*.log

Collecting dump files manually
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■ <installDir>¥OSS¥apache¥logs¥ssl¥*.log
■ <installDir>¥OSS¥jetty¥logs¥*.log
■ %USERPROFILE%¥AppData¥LocalLow¥Sun¥Java¥Deployment¥log
■ %WINDIR%¥system32¥config¥SysEvent.Evt
■ %WINDIR%¥system32¥config¥SecEvent.Evt
■ %WINDIR%¥system32¥config¥AppEvent.Evt
■ %WINDIR%¥minidump¥*.dmp
■ %WINDIR%¥System32¥Winevt¥Logs¥Application.evtx
■ %WINDIR%¥System32¥Winevt¥Logs¥Security.evtx
■ %WINDIR%¥System32¥Winevt¥Logs¥System.evtx
■ %WINDIR%¥system32¥drivers¥etc¥HOSTS*
■ %WINDIR%¥system32¥drivers¥etc¥services*
■ %WINDIR%¥minidump¥*.

Handling performance problems of the SVP

If the following performance problems occur in the SVP, collect the performance
information of the SVP and dumps, and then send them to the maintenance personnel.
■ Slow operation of the SVP
■ High CPU usage rate of the SVP
■ Slow operation of the Storage Device List or the Device Manager - Storage Navigator

Caution:

The tool used in this procedure collects the performance information of the
SVP. This tool is installed in the directories corresponding to the serial
numbers of all storage systems registered in the Storage Device List. Although
this tool does not collect performance information of individual storage
systems, it can collect dump files for the storage system corresponding to the
directory used to run the tool. Therefore, for the storage systems other than
that storage system, seeDownloading dump files (on page 161) and Collecting
dump files manually (on page 164) to collect the dump files, and then pass
them to maintenance personnel.

You can collect performance information of the SVP by using the tool in the
following procedure. Collection of performance information takes about 30
minutes, and then the dump files are automatically collected.

Before you begin
■ Any performance problem of the SVP must be occurring.
■ You must be logged into the SVP.
■ Device Manager - Storage Navigator must be running.

Handling performance problems of the SVP
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■ All other users (including the SVP user) must stop using the Dump tool.
■ All maintenance operations must be stopped.
■ Dump tools from other storage systems must not be used during the process.
■ The installation directory of the Device Manager - Storage Navigator must be excluded

from the real time virus scan targets by the virus detection program.

For the virus detection program settings, see Preventing errors while using virus
detection programs on the SVP (on page 55) .

Note: If the error is in regards to Device Manager - Storage Navigator starting
up, collect information about the SVP using the Dump tool, without Device
Manager - Storage Navigator running. If some tools are running, performance
of the SVP might be further degraded.

Procedure

1. On the SVP, open a command prompt window with administrator permissions.
2. Move the current directory to the directory where the tools are installed.

For example, if the serial number of the storage system is 882000400001, the
directory where the tool is installed is C:\Mapp\wk\882000400001\DKC200\mp
\pc. In this case, enter the following:

cd /d C:\Mapp\wk\882000400001\DKC200\mp\pc

Note: C:\MAPP indicates the installation directory of the storage
management software and the SVP software. When the installation
directory other than C:\Mapp was specified, replace C:\Mapp with the
specified installation directory.

3. Run the performance information collection tool GetSVPPerfInfo.bat by
specifying the output folder of the performance information and dump files. In the
command prompt, enter the following:

GetSVPInfo.bat output-directory
For example, when you want to output the performance information and dump files
of the SVP to C:\Result_882000400001, enter the following command:

GetSVPPerfInfo.bat C:\Result_882000400001
If you do not specify output directory, the performance information and dump files
are output to the following folders:

C:\Mapp\wk\882000400001\DKC200\tmp\PerfLog
   C:\Mapp\wk\882000400001\DKC200\tmp\PerfLog

In this example, 882000400001 is the serial number of the registered storage
system.

Handling performance problems of the SVP
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Note:

■ When you enter the command, a space is required between the bat
file of the dump tool and the output directory.

■ A directory under the network drive cannot be specified as the output
destination.

■ Do not click or close the command prompt window while running the
tool.

■ When the tool is being executed, “Executing…” is displayed in the
command prompt.

■ The dump tool automatically starts collecting dumps after collection
of the performance information finishes.

■ Both performance information and system information of the SVP are
collected. Do not click the cancel button on the dialog box that opens
while system information is collected. The dialog box automatically
closes after collection of system information finishes.

■ When all processes are complete, “SVP Performance Information tool
is completed.” is displayed in the command prompt.

4. Check the dump files that were output.
The following files are output:

■ CounterResult_YYYYMMDDhhmmss.blg：Windows performance monitor log

■ ProcessList_YYYYMMDDhhmmss.csv：Information of the processes running on
the SVP

■ Sysinfo_YYYYMMDDhhmmss.txt：System information of the SVP

■ hdcp.tgz

■ zSv_AutoDump.log

■ DumpResult.txt

5. Close the command prompt.
6. An OS failure might cause a failure of collecting dumps by the dump tool. If the

output result of the dump tool in step 4 is not output, collect the dump files
manually.

7. Send all the files that were output in step 4 to the maintenance personnel.

Handling performance problems of the SVP

Chapter 9: Managing Device Manager - Storage Navigator storage system reports

System Administrator Guide for VSP E990 and VSP G130, G/F350, G/F370, G/F700, G/F900 169



Appendix A:  Examples of Device Manager -
Storage Navigator storage configuration reports

The Device Manager - Storage Navigator can show configuration reports for your storage
system in table, graph, and CSV formats.

The following examples show various storage configuration reports in table, graph, and
CSV formats.

Report examples: table view

Some Device Manager - Storage Navigator reports appear in table format.

The following figure provides examples of reports in table format. The  icons are
displayed before the names of the reports in table view. If the icons are not displayed
correctly, update the window. To sort data in table reports, click any column header.

CHAP Users report

The following figure shows an example of a CHAP Users report. The table following the
figure describes the items in the report. The following table describes the items in a
CHAP Users report.
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Item Description

Port Location Name of the port

User Name Name of the CHAP user for authentication

iSCSI Target Alias Alias of the iSCSI target

iSCSI Target Name Name of the iSCSI target

Disk Boards report

The following figure shows an example of a Disk Boards report. The table following the
figure describes the items in the report. The following table describes the items in a Disk
Boards report.

Item Description

DKB Location of the disk board.
■ "External" is displayed when the storage system has an external

storage system.
■ "External (FICON DM)" is displayed when the storage system has

volumes for FICON DM.

Number of PGs The number of the parity groups that the disk board controls.
■ If "DKB" is "External", this item indicates the number of parity groups

mapped to external volumes.
■ If "DKB" is "External (FICON DM)", this item indicates the number of

parity groups mapped to volumes for FICON DM.

Disk Boards report
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Item Description

Number of LDEVs
(Total)

The number of the logical volumes belonging to the parity groups that
the disk board controls.

Number of LDEVs
(Unallocated)

The number of the logical volumes that are inaccessible from the host
and belong to the parity groups controlled by the disk board.

Total LDEV Capacity
(MB)

Total capacity of the logical volumes belonging to the parity groups that
the disk board controls.

Unallocated LDEV
Capacity (MB)

Total capacity of the logical volumes that are inaccessible from the host
and belong to the parity groups controlled by the disk board.

Host Groups / iSCSI Targets report

The following figure shows an example of a Host Groups / iSCSI Targets report. The table
following the figure describes the items in the report. The following table describes the
items in a Host Groups / iSCSI Targets report.

Item Description

Port Location Name of the port

Type Type of the host group

Host Group Name /
iSCSI Target Alias

Name of the host group / alias of the iSCSI target

Host Group ID / iSCSI
Target ID

Number of the host group / ID of the iSCSI target

iSCSI Target Name Name of the iSCSI target

Resource Group Name Resource Group Name where the host group belongs

Resource Group ID Resource Group ID where the host group belongs

Host Groups / iSCSI Targets report
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Item Description

Number of LUNs The number of LU paths defined to the host group

Number of LDEVs The number of logical volumes that are accessible from the hosts in the
host group

Number of PGs The number of parity groups with logical volumes that are accessible
from the hosts in the host group

Number of DKBs The number of disk boards controlling the parity groups where the
logical volumes that are accessible from the hosts in the host group
belong

Total LDEV Capacity
(MB)

Total capacity of the logical volumes accessible from the hosts in the
host group. This is the total capacity of LDEVs referred to in "Number of
LDEVs".

Port Security Security of the port

Authentication :
Method

iSCSI target method authentication settings
■ CHAP
■ None
■ Comply with Host Setting

Authentication : Mutual
CHAP

Enable or disable the iSCSI target mutual CHAP
■ Enabled
■ Disabled

Authentication : User
Name

Authenticated iSCSI target user name

Authentication :
Number of Users

The number of authenticated users registered in the iSCSI target

Host Mode Host mode of the host group

Host Mode Option Host mode option of the host group. Host mode options are separated
by semicolons (;) when more than one option is specified.

Number of Hosts The number of the hosts in the host group.

Hosts report

The following figure shows an example of a hosts report. The table following the figure
describes the items in the report. When a host is registered to more than one port, more
than one record shows information about the same host.

The following table describes the items in a host report. When a host is registered to
more than one port, more than one record shows information about the same host.

Hosts report
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Item Description

Port Location Name of the port

Type Port type

Port Internal WWN Port WWN

Port Security Port security setting

Host Group Name /
iSCSI Target Alias

Name of the host group / alias of the iSCSI target

iSCSI Target Name Name of the iSCSI target

Host Mode Host mode of the host group

Host Mode Option Host group host mode option. When more than one host mode option
is specified, they are separated by semicolons (;)

Host Name Name of the host that can access the LU path through the port

HBA WWN / iSCSI Name Host WWN / host iSCSI name. The name is in 16-digit hex format.

Logical Devices report

The following figure shows an example of a logical volumes report. The table following
the figure describes the items in the report.

The following table describes the items in a logical volumes report.

Logical Devices report
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Item Description

LDEV ID The logical volume number

LDEV Name The logical volume name

Capacity (MB) Capacity of the logical volume

Emulation Type Emulation type of the logical volume

Resource Group Name Resource group name where LDEV belongs

Resource Group ID Resource group ID where LDEV belongs

PG The parity group number.
■ If the number starts with "E" (for example, E1-1), the parity group

contains external volumes.
■ If the number starts with "M" (for example, M1-1), the parity group

contains FICON DM volumes.

A hyphen displays for Dynamic Provisioning or Thin Image V-VOLs.

RAID Level RAID level of the parity group where the logical volume belongs1

Drive Type/RPM Drive type, drive control name, and revolutions-per-minute (RPM) of the
drive of the parity group where the logical volume belongs.

A hyphen (-) is displayed as RPM when the drive is SSD.1

For VSP E990, this item is displayed as Drive Type/Interface.

Drive Type-Code Type code of the drive of the parity group where the logical volume
belongs1

Drive Capacity Capacity of the drive of the parity group where the logical volume
belongs.1

PG Members List of the drive locations of the parity group where the logical volume
belongs1

Allocated Information about whether the host can access the logical volume.

For mainframe volumes and multi-platform volumes, "Y" is displayed
unless the volumes are in the reserved status.

SSID SSID of the logical volume

CVS Information about whether the logical volume is a customized volume

OCS Oracle checksum

Attribute The attribute of the logical volume

Provisioning Type Provisioning type of the logical volume

Logical Devices report
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Item Description

Pool Name ■ For V-VOLs of Dynamic Provisioning, the name of the pool related to
the logical volume is displayed1

■ If the logical volume attribute is Pool, the name of the pool where the
logical volume belongs is displayed

■ When neither of the above are displayed, the pool name is blank

Pool ID The ID of the pool indicated by "Pool Name" A hyphen (-) displays for
volumes other than pool-VOLs or V-VOLs

Current MPU The number of the MP unit that currently controls the logical volume

Setting MPU The number of the MP unit that you specified to control the logical
volume

Command Device:
Security

Indicates whether Security is specified as the attribute for the command
device. A hyphen (-) displays when "Attribute" is not "CMDDEV".

Command Device:

User Authentication

Indicates whether User Authentication is specified as the attribute for
the command device. A hyphen (-) displays when "Attribute" is not
"CMDDEV".

Command Device:

Device Group Definition

Indicates whether Device Group Definition is specified as the attribute
for the command device. A hyphen (-) displays when "Attribute" is not
"CMDDEV".

Encryption Indicates whether the parity group to which the LDEV belongs is
encrypted.
■ For internal volumes: Enabled (encrypted) or Disabled (not

encrypted)
■ For external volumes: blank

T10 PI Indicates the T10 PI attribute set for the LDEV.
■ Enabled
■ Disabled
■ Blank if the emulation type is not OPEN-V

ALUA Mode Indicates whether the ALUA mode is enabled:
■ Enabled: ALUA mode is enabled.
■ Disabled: ALUA mode is disabled.

Notes:

1. A hyphen (-) displays if the LDEV is an external volume.

Logical Devices report
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LUNs report

The following figure shows an example of an LU path definitions report. A record is
created for each LU path. The table following the figure describes the items in the report.

The following table describes the items in a LUNs report.

Item Description

Port Location Name of the port

HBA WWN / iSCSI Name Port WWN or name of the iSCSI (16 digits in hexadecimal)

Port Security Name of the type of security of the port

Host Group Name /
iSCSI Target Alias

Name of the host group or alias of the iSCSI target

iSCSI Target Name Name of the iSCSI target

Host Mode Host mode of the host group

Host Mode Option Host mode option of the host group. Host mode options are separated
by semicolons (;) when more than one option is specified.

LUN Logical unit number

LDEV ID Logical volume number

Emulation Type Emulation type of the logical volume

Capacity (MB) Capacity of the logical volume

Asymmetric Access
State

Asymmetric access status:
■ Active/Optimized: Prioritized
■ Active/Non-Optimized: Lower priority

LUNs report

Appendix A: Examples of Device Manager - Storage Navigator storage configuration reports

System Administrator Guide for VSP E990 and VSP G130, G/F350, G/F370, G/F700, G/F900 177



MP Units report

The following figure shows an example of an MP units report. The table following the
figure describes the items in the report.

The following table describes the items in an MP units report.

Item Description

MP Unit ID MP unit ID

Auto Assignment Auto assignment attribute for the MP unit

Number of Resources
(LDEV)

Number of LDEVs that the MP unit controls

Number of Resources
(Journal)

Number of journals that the MP unit controls

Number of Resources
(External Volume)

Number of external volumes that the MP unit controls (includes
volumes for FICON DM)

Number of Resources
(Total)

The total number of resources that the MP unit controls. It is the total of
Number of Resources (LDEV), Number of Resources (Journal), and
Number of Resources (External Volume).

MP Unit Details report

The following figure shows an example of an MP unit details report. The table following
the figure describes the items in the report.

The following table describes the items in an MP unit details report.

MP Units report
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Item Description

MP Unit ID MP unit ID

Auto Assignment Auto assignment attribute for the MP unit

Resource ID ID of this resource that the MP unit controls

Resource Name The name of the resource that the MP unit controls. If "Type" is LDEV,
the LDEV name that is set is displayed. A hyphen (-) displays for journal
volumes or external volumes.

Type The type of the resource that the MP unit controls

Parity Groups report

The following figure shows an example of a parity groups report. The table following the
figure describes the items in the report.

The following table describes the items in a parity groups report.

Parity Groups report
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Item Description

PG Parity group number
■ If the number starts with "E" (for example, E1-1), the parity group

contains external volumes (Hitachi Universal Volume Manager User
Guide).

■ If the number starts with "M" (for example, M1-1), the parity group
contains volumes for FICON DM.

DKB Name of the disk board that controls the parity group1

RAID Level RAID level of the parity group1

Resource Group Name Name of the resource group in which the parity group belongs

Resource Group ID ID for the resource group in which the parity group belongs

Emulation Type Emulation type of the parity group

Number of LDEVs
(Total)

The number of the logical volumes in the parity group

Number of LDEVs
(Unallocated)

The number of the logical volumes in the parity group that the host
cannot access

Total LDEV Capacity
(MB)

Capacity of the logical volumes in the parity group

Unallocated LDEV
Capacity (MB)

Capacity of the logical volumes in the parity group that the host cannot
access

Drive Type-Code The type code of the drive in the parity group.
■ The type code of the first drive in the parity group.
■ If the parity group contains external volumes, the drive type code

displays the vendor, the model, and the serial number of the storage
system.

■ Separated by semicolons (;) if multiple drive types are set.

Drive Type/
Interface/RPM

Drive type, drive control name, and revolutions-per-minute (RPM) of the
drive in the parity group where the LDEV belongs1

A hyphen (-) is displayed instead of the RPM when the drive is an SSD or
FMD.

For VSP E990, this item is displayed as Drive Type/Interface.

Drive Capacity Capacity of the drive in the parity group1

RAID Concatenation #0 The number indicating a parity group #0 connected to this parity
group1,2

Parity Groups report
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Item Description

RAID Concatenation #1 The number indicating a parity group #1 connected to this parity
group1,2

RAID Concatenation #2 The number indicating a parity group #1,2 connected to this parity
group1,2

Encryption Indicates whether the parity group is encrypted.
■ For internal volumes: Enabled (encrypted) or Disabled (not

encrypted)
■ For external volumes: A hyphen (-) is displayed

Accelerated
Compression

Accelerated compression of the parity group
■ If accelerated compression is supported, Enabled or Disabled is

displayed.
■ If accelerated compression is not supported, a hyphen (-) is

displayed.

Notes:

1. A hyphen is displayed if the parity group contains external volumes.
2. A hyphen is displayed if the parity group is not connected with another parity group or if the

parity group contains external volumes including volumes for FICON DM.

Physical Devices report

The following figure shows an example of part of a Physical Devices report. The actual
report includes more columns of information. A record is created for each physical
device. The table following the figure describes the items in the report.

The following table describes the items in a Physical Devices report.

Physical Devices report
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Item Description

Location Name of physical devices

CR# C# and R# to define physical devices

Output as "XX/YY"

PG Parity group of physical devices

Emulation Type Parity group of physical devices

Drive type Drive type of physical devices
■ SAS
■ SSD

RPM Revolutions-per-minute (RPM) in the parity group
■ 8000
■ 15000

A hyphen (-) is displayed instead of the RPM when the drive type is an
SSD.

For VSP E990, this item is displayed as Interface.

Drive Type-Code Type code of the drive in the parity group.

Output example: SLR5B- M200SS;SFB5A-M200SS; (if multiple drive types
are set)

Drive Size Drive size (inches)
■ 2.5
■ 3.5

Drive Capacity Physical drive capacity (GB or TB)

Drive Version Firmware version of the drive

DKB1 Name of the DKB1 which controls the physical devices

DKB2 Name of the DKB2 which controls the physical devices

Serial Number# Serial product number of the physical devices
■ yy: year (last 2 digits)
■ mm: month (2 digits)
■ xxxxxxxx: product number of the physical devices

RAID Level RAID level of the physical devices
■ RAID1(2D+2D)
■ RAID5(7D+1P)

Physical Devices report
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Item Description

■ RAID6(6D+2P)
■ RAID6(14D+2P)

RAID Concatenation#0 Number indicating a parity group #0 connected to this parity group

Output example: 2-1, 3-1, 4-1

RAID Concatenation#1 Number indicating a parity group #1 connected to this parity group

Output example: 2-1, 3-1, 4-1

RAID Concatenation#2 Number indicating a parity group #2 connected to this parity group

Output example: 2-1, 3-1, 4-1

Resource Group Name Name of resource group to which the parity group of physical devices
belong

Resource Group ID ID (0 to 1023 binary)

Encryption Enable or disable status of the parity group to which the physical
devices belong
■ Enabled: Encryption is enabled.
■ Disabled: Encryption is disabled.

Ports report

The following figure shows an example of part of a ports report. The actual report
includes several more columns of information. The table following the figure describes
the items in the report.

The following table describes the items in a ports report.

Item Description

CHB Name of the channel board

Type Package type of the channel board

Port Location Name of the port on the channel board

Ports report
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Item Description

iSCSI Virtual Port Mode Mode of the iSCSI virtual port

TCP Port Number Port number to use for a socket (decimal)

Internal WWN / Internal
iSCSI Name

WWN / iSCSI name of the port

Fabric One of the Fibre topology settings indicating the setting status of the
Fabric switch

Connection Type One of the Fibre topology settings
■ Point to Point
■ FC-AL

IPv4 : IP Address IPv4 address of the port

Output example: 192.168.0.100

IPv4 : Subnet Mask IPv4 subnet mask of the port

Output example: 255.255.255.0

IPv4 : Default Gateway IPv4 default gateway of the port

Output example: 255.255.255.0

IPv6 : Mode IPv6 settings of the port
■ Enabled
■ Disabled

IPv6 : Link Local
Address

IPv6 link local address of the port (16-digit hexadecimal)

IPv6 : Global Address IPv6 global address of the port.

Output example: xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx (hexadecimal)

IPv6 : Global Address 2 IPv6 global address 2 of the port.

Output example: xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx (hexadecimal)

IPv6 : Assigned Default
Gateway

Assigned IPv6 default gateway

Selective ACK Selective ACK mode
■ Enabled
■ Disabled

Ethernet MTU Size
(Byte)

MTU settings (binary)
■ 1,500

Ports report
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Item Description

Keep Alive Timer iSCSI keep alive timer (0 to 64,800) (sec)

VLAN : Tagging Mode Tagging mode of VLAN
■ Enabled
■ Disabled

VLAN : ID Number of VLAN set to the port (1 to 4,094)

CHAP User Name User name for the CHAP authentication

iSNS Server : Mode iSNS mode settings
■ ON
■ OFF

iSNS Server : IP Address IP address of the iSNS server (30 to 65,535)

iSNS Server : TCP Port
Number

Number of the TCP port used in iSNS (binary)

Address (Loop ID) Fibre port address and Loop ID of the port

Port Security Security of the port
■ Enabled
■ Disabled

Speed Data transfer speed of the port

SFP Data Transfer Rate Maximum transfer rate of SFP which the mounted package supports.
■ 10G
■ 16G
■ 32G
■ A hyphen (-) is displayed if Type is 10iSCSI2c (CHB)).

T10 PI Mode Indicates whether the T10 PI mode can be applied to the port.
■ Enabled
■ Disabled
■ Blank if the port type is a Fibre port other than 16FC2(CHB). For iSCSI

ports, a hyphen (-) is displayed.

Resource Group Name Name of the resource group to which the port belongs

Resource Group ID ID for the resource group to which the port belongs (0 to 1023)

Number of Hosts The number of the hosts registered to the port

Ports report
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Item Description

Number of LUNs The number of the LU paths defined to the port

Number of LDEVs The number of the logical volumes that can be accessed through the
port

Number of PGs The number of the parity groups having the logical volumes that can be
accessed through the port

Number of DKBs The number of the disk boards controlling the parity group that contains
the logical volumes that can be accessed through the port

Power Consumption report

The following figure shows an example of a power consumption report. A record is
created every two hours for each power consumption and temperature monitoring data.
The table following the figure describes the items in the report.

The following table describes the items in a power consumption report. A record is
created every two hours for each power consumption and temperature monitoring data.

No records are created if the DKC is turned off. If the system is in maintenance mode or
the SVP is rebooted, up to two hours of records could be lost.

If a failure occurs in the storage system, the correct information might not be output.

A hyphen(-) is displayed if the power and temperature information cannot be acquired
due to a unit or network failure.

Item Description

Power Consumption Average (W) Average of the power consumption

Power Consumption Maximum (W) Maximum of the power consumption

Power Consumption report
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Item Description

Power Consumption Minimum (W) Minimum of the power consumption

TEMP:HSNBX0-HSNPANEL0 Average
(degrees C)

Average temperature of
HSNBX0:HSNPANEL0

TEMP:HSNBX0-HSNPANEL0 Maximum
(degrees C)

Maximum temperature of
HSNBX0:HSNPANEL0

TEMP:HSNBX0-HSNPANEL0 Minimum
(degrees C)

Minimum temperature of
HSNBX0:HSNPANEL0

TEMP:HSNBX1-HSNPANEL1 Average
(degrees C)

Average temperature of
HSNBX1:HSNPANEL1

TEMP:HSNBX1-HSNPANEL1 Maximum
(degrees C)

Maximum temperature of
HSNBX1:HSNPANEL1

TEMP:HSNBX1-HSNPANEL1 Minimum
(degrees C)

Minimum temperature of
HSNBX1:HSNPANEL1

TEMP:DKC0-Cluster1 Average (degrees C) Average temperature of DKC0:CL1

TEMP:DKC0-Cluster1 Maximum (degrees
C)

Maximum temperature of DKC0:CL1

TEMP:DKC0-Cluster1 Minimum (degrees
C)

Minimum temperature of DKC0:CL1

TEMP:DKC0-Cluster2 Average (degrees C) Average temperature of DKC0:CL2

TEMP:DKC0-Cluster2 Maximum (degrees
C)

Maximum temperature of DKC0:CL2

TEMP:DKC0-Cluster2 Minimum (degrees
C)

Minimum temperature of DKC0:CL2

Table 12 Power Consumption report

Item Description

TEMP:DB00-DBPS00-1 Average
(Temperature in degrees C)

TEMP:DB00-DBPS00-1 Maximum
(Temperature in degrees C),

TEMP:DB00-DBPS00-1 Minimum
(Temperature in degrees C),

TEMP:DB00-DBPS00-2 Average
(Temperature in degrees C),

Average temperature, maximum
temperature, and minimum temperature
of the DB for the two-hour period.
Outputs in the following format:

Power Consumption report
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TEMP:DB00-DBPS00-2 Maximum
(Temperature in degrees C),

TEMP:DB00-DBPS00-2 Minimum
(Temperature in degrees C)

TEMP:DB XX -DBPS XX -CL Average,
Maximum, or Minimum (Temperature in
degrees Celsius)
■ XX: DB number

00 to 07 (VSP F350, VSP G350)

00 to 11 (VSP F370, VSP G370)

00 to 47 (VSP F700, VSP F900, VSP G700,
VSP G900)

00 to 03 (VSP E990)
■ CL: Cluster number (1 or 2)

Spare Drives report

The following figure shows an example of a spare drives report. The table following the
figure describes the items in the report.

The following table describes the items in a spare drives report.

Item Description

Drive Capacity Capacity of the spare drive

Drive Type-Code Type code of the spare drive

Location Location of the spare drive

Spare Drives report
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SSD Endurance report

The following figure shows an example of an SSD endurance report. The table following
the figure describes the items in the report.

The following table describes the items in an SSD endurance report.

Item Description

Drive Type-Code Type code of the drive

Drive Capacity Capacity of the drive

Location Location of the drive

Used Endurance
Indicator (%)

The used endurance of SSD life (0 to 100)

SSD Endurance report
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Item Description

The value of this indicator increases due to drive operation associated
with internal processing of the storage system, and the host I/O. Even
when no data is copied due to a drive failure, the value of this indicator
increases because the spare drive also performs internal processing.

Storage System Summary report

Item Description

Storage System Type Type of the storage system

Serial Number Serial number of the storage system

IP Address IP address of the SVP

Software Versions Version of the following programs.

For VSP G130, G/F350, G/F370, G/F700, G/F900
■ Main
■ DKB
■ ROM BOOT
■ RAM BOOT
■ Expander
■ Config
■ CFM
■ HDD
■ Printout Tool
■ CHB (iSCSI)
■ CHB (FC32G)
■ GUM

For VSP E990
■ Main
■ DKBN
■ NSW
■ ROM BOOT
■ RAM BOOT
■ Config

Storage System Summary report
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Item Description

■ CFM
■ HDD
■ Printout Tool
■ CHB (iSCSI)
■ CHB (FC32G)
■ GUM
■ EDKBN

Number of CUs The number of control units in the storage system

Shared Memory Size
(GB)

Capacity of shared memory

Includes the cache management information (directory)

Cache Size (GB) Capacity of the cache

Number of DKBs The number of disk boards on the module

System Options List of the system options specified for the storage system

Drive Capacity (TB) Total capacity of drives in the storage system except for external
volumes

Spare Drive Capacity
(TB)

Total capacity of the spare drives in the storage system

Free Drive Capacity (GB) Total capacity of the free drives in the storage system

Volume Capacity (GB) 1 List of the capacity of the open volumes

Number of LDEVs1 List of the numbers of the volumes in the following status.
■ Allocated
■ Unallocated
■ Reserved
■ V-VOL

Notes:

1. You cannot sort the list.

Report examples: graphical view

Some Device Manager - Storage Navigator reports appear in graphical format.

Report examples: graphical view
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The reports described in this topic display as graphics.  icons are displayed before the
names of reports in graphical view. If the icons or graphics are not displayed properly,
update the window.

Cache Memories report

This report shows cache memory data, including shared memory, main board, and DIMM
capacity. The total cache memory is displayed for each module.

Figure 1 Cache Memories report (VSP F350, VSP F370, VSP G350, VSP G370)

Figure 2 Cache Memories report (VSP F700, VSP G700)

Cache Memories report
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Figure 3 Cache Memories report (VSP F900, VSP G900)

Figure 4 Cache Memories report (VSP E990)

Channel Boards report

This report shows the channel boards and the ports and types of channel boards for
each channel board. The keys show which channel boards are installed (green keys) and
which channel boards are not installed (gray keys).

If a PCIe channel board installed in the DKC is connected to a channel board box, the
status of the channel board box is displayed.

Channel Boards report
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Figure 5 Channel Boards (VSP F350, VSP F370, VSP G350, VSP G370)

Figure 6 Channel Boards report (VSP F900, VSP G900)

Channel Boards report
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Figure 7 Channel Boards report (VSP E990)

Figure 8 Channel Boards report (when a channel board box is connected)

Physical View report

This report shows disk controller chassis and drive boxes, and includes channel boards,
disk boards, data drives, spare drives, and free drives.

It also shows the storage system type, serial number, and software version. You can
check the legend for disk units, such as SAS, SSD, Spare, Free, or Not Installed.

Physical View report
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If a PCIe channel board installed in the DKC is connected to a channel board box, the
status of the channel board box is displayed.

Physical View report
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Figure 9 Physical View report (VSP F350, VSP F370, VSP G350, VSP G370)

Figure 10 Physical View report (VSP F700, VSP G700)

Physical View report
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Figure 11 Physical View report (VSP F900, VSP G900)

Physical View report
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Figure 12 Physical View report (VSP E990)

Physical View report
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Figure 13 Physical View report (when a channel board box is connected)

Report examples: CSV files

Some Device Manager - Storage Navigator reports appear in CSV format.

This topic describes reports that are saved in CSV format.

AllConf.csv

This is the concatenated file of all the csv files.

CacheInfo.csv

This CSV file contains information about the cache memory on the controller board. A
record is created for each cache memory.

Report examples: CSV files
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Item Content

Location Name of the cache controller board on which the memory is installed

CMG#0 Size (GB)

CMG#1 Size (GB)

Cache memory capacity in the controller board per CMG
(32/64/128/256/ blank). The number of CMG differs by model and the
displayed items are different.
■ VSP E990: CMG#0 Size and CMG#1 Size display
■ VSP F350, VSP F370, VSP G350, VSP G370: Only CMG#0 Size displays
■ VSP F700, VSP F900, VSP G700, VSP G900: CMG#0 Size and CMG#1

Size display

Depending on the installed number of the cache memory (DIMM), one
of the CMG capacities might be blank for VSP E990VSP F700, VSP F900,
VSP G700, VSP G900.

Cache Size (GB) Total cache memory capacity on the controller board (0 to 512)

SM Size (MB) The capacity that cannot be used as data cache memory in the total
cache memory capacity inside of the controller board.

The capacity per cluster is displayed.

Includes the shared memory capacity, cache directory capacity, and the
fixed capacity.

Fixed capacity is the cache memory capacity that is used for controlling
the storage system with the controller board.
■ VSP E990: 0 to 86400
■ VSP F350, VSP G350: 0 to 29568
■ VSP F370, VSP G370: 0 to 58624
■ VSP F700, VSP G700: 0 to 69632
■ VSP F900, VSP G900: 0 to 86400

CFM#0 Type

CFM#1 Type

Type of CFM in the cluster (BM15/BM35/BM45/BM55/BM65/blank). The
number of CFM differs by model and the number of the displayed items
are different.
■ VSP E990: CFM#0 Type and CFM#1 Type
■ VSP F350, VSP F370, VSP G350, VSP G370: CFM#0 Type only
■ VSP F700, VSP F900, VSP G700, VSP G900: CFM #0 Type and CFM#1

Type

Depending on the installed CFM number, one of the CFM types might be
displayed as blank.

CacheInfo.csv
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ChapUserInfo.csv

This CSV file contains information about the iSCSI CHAP authenticated user registered to
the port in the channel board. A record is created for each target related to the CHAP
authenticated user.

Item Content

Port Port name

User Name Name of the CHAP authenticated user1

iSCSI Target ID2 The iSCSI number of the target (00 to fe, hexadecimal)

Notes:

1. If the character string contains a comma, the comma is converted to a tab.
2. For the target information, see the record information with the same iSCSI target ID in

IscsiTargetInfo.csv.

ChaStatus.csv

This CSV file contains information about the status of each channel board (CHB). A
record is created for each CHB.

Table 13 ChaStatus.csv file (Title: <<CHB Status>>)

Item Content

CHB Location CHB name

PCB Status Status of this CHB*

Port#00, #01, …, #03 Status of ports on this CHB*

*1: Normal, 0: Abnormal

DeviceEquipInfo.csv

This CSV file contains information about equipment and devices that are part of the
storage system, including power supplies and batteries for DKC, DB, and CHBB. A record
is created for each device.

ChapUserInfo.csv
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Item Content

Device Location Device location name. For example:
■ For DKCPS: DKCPS-00
■ For DKUPS: DKUPS000-1
■ For Battery: BATTERY-1BA
■ For SVP: SVP-BASIC

Equip Status Equipment status of the device:
■ Equipped
■ Not Equipped

Status Status of the device:
■ Normal
■ Abnormal
■ Blank if "Equip Status" is Not Equipped

DkaInfo.csv

This CSV file contains information about disk boards (DKBs). A record is created for each
DKB.

Item Content

DKB Location DKB name

Package Type DKB type

Output example:
■ Unencryption DKB (2Port)
■ Unencryption DKBN (2Port)
■ Encryption EDKB (2Port)

DkaStatus.csv

This CSV file contains information about the status of disk boards (DKBs). A record is
created for each DKB.

Item Content

DKB Location DKB name

DkaInfo.csv
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Item Content

PCB Status Status of this DKB1

BECON#00 Status of BECON1

BEPORT#0000 to #0001 Status of BEPORT on this DKB1

Items are output in the format BEPORT#XXYY, where:
■ XX: BE controller number (2-digit hexadecimal)
■ YY: BE port number (2-digit hexadecimal)

Notes:

1. 1: Normal, 0: Abnormal

DkcInfo.csv

This CSV file contains information about the DKC. A record is created for each module.

When Module #1 is not installed, the record for Module #1 is not created.

Table 14 DkcInfo.csv file (Title: <<DKC Information>>)

Item Content

Storage System Type Storage system type.

Output example:
■ VSP E990
■ VSP F350, VSP G350*
■ VSP F370, VSP G370*
■ VSP F700, VSP G700*
■ VSP F900, VSP G900*

Serial Number # Serial product number (decimal, from 400001 to 499999)

IP Address IP address

Output example: xxx.xxx.xxx.xxx (decimal, 0 to 255)

Subnet Mask Subnet mask

Output example: xxx.xxx.xxx.xxx (decimal, 0 to 255)

Number of CUs Number of CUs (decimal, 0 to 255)

Number of DKBs Number of DKBs (decimal, 0 to 8)

Zero (0) is sometimes displayed if an HDD is not installed.

DkcInfo.csv
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Item Content

Configuration Type Configuration type

Output example: PCM

Model Storage system model: S1, S2, M, or H

*To determine the model type, see PpInfo.csv (on page 239) .
■ VSP F350, VSP F370, VSP F700, VSP F900: Install is Enabled for All Flash Array
■ VSP G350, VSP G370, VSP G700, VSP G900: Install is Disabled for All Flash Array

DkuTempAveInfo.csv

This CSV file contains information about DB temperature for every two hours. A record is
DB temperature information obtained from the environment monitor. A record output to
the first line shows the latest temperature information. Because DB temperature
information is measured by DBPS, items are displayed in this unit*.

DkuTempAveInfo.csv shows the average temperature as DB temperature data. The total
number of items depends on the model (VSP F350, VSP G350: 17, VSP F370, VSP G370:
25, VSP F700, VSP F900, VSP G700, VSP G900: 97).

The DB temperature data displayed in DkuTempAveInfo.csv (average temperature only),
DkuTempMaxInfo.csv (maximum temperature only), and DkuTempMinInfo.csv (minimum
temperature only) is the same value as the DB temperature data for DkuTempInfo.csv.

If the system is in maintenance mode or the SVP is rebooted, the data that is output
every two hours might not contain data for the period. If a failure occurs in the storage
system, the correct information might not be output.

Item Description

Date Year, month, and date when temperature
data was acquired in the format:

YYYY/MM/DD hh:mm:ss

DB00 DBPS001

Temperature average

Average temperature (°C) for the two-hour
period of DB00 DBPS001

DB47 DBPS472

Temperature average

Average temperature (°C) for the two-hour
period of DB47 DBPS472

For VSP E990, item shows up to DB03
DBPS032.

For VSP F350, VSP G350, item shows up to
DB07 DBPS072.

DkuTempAveInfo.csv
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Item Description

For VSP F370, VSP G370, item shows up to
DB11 DBPS112.

Note: An item name is displayed as DBxx DBPSxxy. The names are listed in ascending
order of the DB number. See DkuTempInfo.csv (on page 206) for locations and values for
DBxx and DBPSxxy.

DkuTempInfo.csv

This CSV file contains information about DB temperature for every two hours. A record is
DB temperature information obtained from the environment monitor. A record output to
the first line shows the latest temperature information. Because DB temperature
information is measured by DBPS, items are displayed in this unit*.

DkuTempInfo.csv shows the average temperature as DB temperature data. The total
number of items depends on the model (VSP E990: 25, VSP F350, VSP G350: 49, VSP
F370, VSP G370: 73, VSP F700, VSP F900, VSP G700, VSP G900: 289).

The DB temperature data displayed in DkuTempAveInfo.csv (average temperature only),
DkuTempMaxInfo.csv (maximum temperature only), and DkuTempMinInfo.csv (minimum
temperature only) is the same value as the DB temperature data for DkuTempInfo.csv.

If the system is in maintenance mode or the SVP is rebooted, the data that is output
every two hours might not contain data for the period. If a failure occurs in the storage
system, the correct information might not be output.

Item Description

Date Year, month, and date when temperature
data was acquired in the format:

YYYY/MM/DD hh:mm:ss

DB00 DBPS001

Temperature average

Average temperature (°C) for the two-hour
period of DB00 DBPS001

DB00 DBPS001

Temperature maximum value

Maximum temperature (°C) for the two-
hour period of DB00 DBPS001

DB00 DBPS001

Temperature minimum value

Minimum temperature (°C) for the two-
hour period of DB00 DBPS001

DB47 DBPS472

Temperature average

Average temperature (°C) for the two-hour
period of DB47 DBPS472

For VSP E990, item shows up to DB03
DBPS032.

DkuTempInfo.csv
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Item Description

For VSP F350, VSP G350, item shows up to
DB07 DBPS072.

For VSP F370, VSP G370, item shows up to
DB11 DBPS112.

DB47 DBPS472

Temperature maximum value

Maximum temperature (°C) for the two-
hour period of DB47 DBPS472

For VSP E990, item shows up to DB03
DBPS032.

For VSP F350, VSP G350, item shows up to
DB07 DBPS072.

For VSP F370, VSP G370, item shows up to
DB11 DBPS112.

DB47 DBPS472

Temperature minimum value

Minimum temperature (°C) for the two-
hour period of DB47 DBPS472

For VSP E990, item shows up to DB03
DBPS032.

For VSP F350, VSP G350, item shows up to
DB07 DBPS072.

For VSP F370, VSP G370, item shows up to
DB11 DBPS112.

Note: An item name is displayed as DBxx DBPSxxy. The names are listed in ascending
order of the DB number.

The following tables list DBxx and DBPSxxy: xx values, where xx is a value from 00 to 03
(VSP E990), 00 to 07 (VSP F350, VSP G350), 00 to 11 (VSP F370, VSP G370), or 00 to 47 (VSP
F700, VSP F900, VSP G700, VSP G900).

DB # 0 1 2 3 4 5

xx 00 01 02 03 04 04

DBxx DB00 DB01 DB02 DB03 DB04 DB05

DBxxy DBPS00y DBPS01y DBPS02y DBPS03y DBPS04y DBPS05y

DB # 42 43 44 45 46 47

xx 42 43 44 45 46 47

DkuTempInfo.csv
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DB # 42 43 44 45 46 47

DBxx DB42 DB43 DB44 DB45 DB46 DB47

DBxxy DBPS42y DBPS43y DBPS44y DBPS45y DBPS46y DBPS47y

The following table lists the DBPSxxy: y values (where DB# is 0 and xx is 00)

DB# 0

y 1 2

DBPSxxy: y DBPS001 DBPS002

DkuTempMaxInfo.csv

This CSV file contains information about DB temperature for every two hours. A record is
DB temperature information obtained from the environment monitor. A record output to
the first line shows the latest temperature information. Because DB temperature
information is measured by DBPS, items are displayed in this unit*.

DkuTempMaxInfo.csv shows the maximum temperature as DB temperature data. The
total number of items depends on the following model:
■ VSP E990: 9
■ VSP F350, VSP G350: 17
■ VSP F370, VSP G370: 25
■ VSP F700, VSP F900, VSP G700, VSP G900: 97

The DB temperature data displayed in DkuTempAveInfo.csv (average temperature only),
DkuTempMaxInfo.csv (maximum temperature only), and DkuTempMinInfo.csv (minimum
temperature only) is the same value as the DB temperature data for DkuTempInfo.csv.

If the system is in maintenance mode or the SVP is rebooted, the data that is output
every two hours might not contain data for the period. If a failure occurs in the storage
system, the correct information might not be output.

Item Description

Date Year, month, and date when temperature
data was acquired in the format:

YYYY/MM/DD hh:mm:ss

DB00 DBPS001

Temperature maximum value

Maximum temperature (°C) for the two-
hour period of DB00 DBPS001

DkuTempMaxInfo.csv
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Item Description

DB47 DBPS472

Temperature maximum value

Maximum temperature (°C) for the two-
hour period of DB47 DBPS472

For VSP E990, item shows up to DB03
DBPS032.

For VSP F350, VSP G350, item shows up to
DB07 DBPS072.

For VSP F370, VSP G370, item shows up to
DB11 DBPS112.

Note: An item name is displayed as DBxx DBPSxxy. The names are listed in ascending
order of the DB number. See DkuTempInfo.csv (on page 206) for locations and values for
DBxx and DBPSxxy.

DkuTempMinInfo.csv

This CSV file contains information about DB temperature for every two hours. A record is
DB temperature information obtained from the environment monitor. A record output to
the first line shows the latest temperature information. Because DB temperature
information is measured by DBPS, items are displayed in this unit*.

DkuTempMinInfo.csv shows the minimum temperature as DB temperature data. The
total number of items depends on the following model:
■ VSP E990: 9
■ VSP F350, VSP G350: 17
■ VSP F370, VSP G370: 25
■ VSP F700, VSP F900, VSP G700, VSP G900: 97

The DB temperature data displayed in DkuTempAveInfo.csv (average temperature only),
DkuTempMaxInfo.csv (maximum temperature only), and DkuTempMinInfo.csv (minimum
temperature only) is the same value as the DB temperature data for DkuTempInfo.csv.

If the system is in maintenance mode or the SVP is rebooted, the data that is output
every two hours might not contain data for the period. If a failure occurs in the storage
system, the correct information might not be output.

Item Description

Date Year, month, and date when temperature
data was acquired in the format:

YYYY/MM/DD hh:mm:ss

DB00 DBPS001

Temperature minimum value

Minimum temperature (°C) for the two-
hour period of DB00 DBPS001

DkuTempMinInfo.csv
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Item Description

DB47 DBPS472

Temperature minimum value

Minimum temperature (°C) for the two-
hour period of DB47 DBPS472

For VSP E990, item shows up to DB03
DBPS032.

For VSP F350, VSP G350, item shows up to
DB07 DBPS072.

For VSP F370, VSP G370, item shows up to
DB11 DBPS112.

ELunInfo.csv

This CSV file contains information about external volumes. Information about one
external volume is output to multiple records according to the number of prioritized
paths between the local and the external storage systems.

For details of external volumes, see Hitachi Universal Volume Manager User Guide.

Item Content

VDEV# Virtual device number to which the external volume is mapped

Characteristic1 Identification number of the external volume1

Characteristic2 Extended information for identifying the external volume

Device Product name reported to the host by the external volume1

Capacity(blocks) Capacity of the external volume (in blocks)

Cache Mode Indicates whether the write data from the host to the external storage
system is reflected synchronously or asynchronously
■ Enabled: Asynchronously
■ Disabled: Synchronously

ECC Group Number of parity group to which the external volume is mapped.

If the number starts with "E" (for example, E1-1), the parity group
contains external volumes.

Range of values: E1-1 to E16384-4096

Current MPU Number and name of a current MP unit controlling the parity group to
which the external volume is mapped
■ MPU-10
■ MPU-20

ELunInfo.csv
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Item Content

Setting MPU Number and name of an MP unit configured to control the external
volume indicated by ECC Group
■ MPU-10
■ MPU-20

Vendor Vendor name of the external storage system

Product Name Product name of the external storage system

Serial Number# Serial product number of the external storage system

Path Mode Mode which indicates how the paths between local and external storage
systems operate
■ Multi
■ Single
■ ALUA

Port Name of a local port from which the external path is connected to the
external storage system

WWN Port identifier number of the external storage system

Blank if "Package Type" is iSCSI

LUN LU number set for the external volume.

Priority Priority of the paths between the storage systems to be used for
connection with the external volume.

"1" indicates the path of the highest priority.

Status Status of the path between storage systems.
■ Normal
■ Blocked

IO TOV I/O timeout value for the external volume

Range of values: 5 to 240

QDepth The number of Read/Write commands that can be issued to the external
volume at a time

Range of values: 2 to 128

Resource Group ID (ECC
Group)

Resource group ID for the parity group that is mapping external
volumes (in decimal format)

Range of values: 0 to 1023

ELunInfo.csv
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Item Content

Resource Group Name
(ECC Group)

Resource group name of the parity group that is mapping external
volumes

Load Balance Mode I/O load balance distribution logic specified for external volume
■ Normal Round-robin
■ Extended Round-robin
■ Disabled

A hyphen is displayed if Single is specified in Path Mode

Path Mode on Profile Path mode on profile information of the external storage system:
■ Multi
■ Single

ALUA Settable Indicates whether ALUA mode can be set as path mode on the external
storage system
■ Yes: ALUA mode can be set
■ No: ALUA mode cannot be set

ALUA Permitted Indicates whether ALUA is used as path mode on the local storage
system:
■ Enabled: ALUA mode is used
■ Disabled: ALUA mode is not used

Target Port Asymmetric
Access State

Status of the port on the external storage system when the path mode
is ALUA:
■ Active/Optimized
■ Active/Non-Optimized

Package Type Type of CHB to which a port of the local storage system connecting to
the external storage system belongs
■ Fibre: 16FC2 (CHB), 32FC4R (CHB)
■ iSCSI: 10iSCSI2o (CHB), 10iSCSI2c (CHB)

IP Address IP address for an iSCSI target of an external storage system
■ IPv6:

XXXX:XXXX:XXXX:XXXX:XXXX:XXXX:XXXX:XXXX (hexadecimal)
■ IPv4:

XXX.XXX.XXX.XXX (decimal)
■ Blank if "Package Type" is iSCSI.

ELunInfo.csv
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Item Content

TCP Port Number TCP port number (1 through 65535) for the iSCSI target of an external
storage system

Blank if "Package Type" is Fibre.

iSCSI Target Name iSCSI target name of an external storage system

Blank if "Package Type" is Fibre.

Virtual Port ID Virtual port number of own storage system to which external storage
system is connected.

If Virtual Port Mode is Disabled, this column to be blanked.

Notes:

1. If the character string contains a comma, the comma is converted to a tab.

EnvMonInfo.csv

This CSV file contains information about the power and temperature of the storage
system. Power and temperature measurements from the environment monitor are
recorded every two hours.

No records are created if the DKC is turned off. If the system is in maintenance mode or
the SVP is rebooted, up to two hours of records could be lost.

If a failure occurs in the storage system, the correct information might not be output.

Item Description

Date Year, month, and date when record data was acquired for the two-hour
period in the format:

YYYY/MM/DD HH:MM:SS

Electric power average Average value of electric power (W)

Electric power
maximum value

Maximum value of electric power (W)

Electric power
minimum value

Minimum value of electric power (W)

In the following cases, a lower value might be temporarily displayed:
■ When the storage system is starting up
■ Right after replacing storage system parts
■ During or after microcode update

DKC0 CLT01
Temperature average

DKC0: Average temperature of CLT01 (°C)

EnvMonInfo.csv
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Item Description

DKC0 CLT01
Temperature maximum
value

DKC0: Maximum temperature of CLT011 (°C)

DKC0 CLT01
Temperature minimum
value

DKC0: Minimum temperature of CLT01 (°C)

DKC5 CLT52
Temperature average

DKC5 CLT52: Average temperature of CL2 (°C)

DKC5 CLT52
Temperature maximum
value

DKC5 CLT52: Maximum temperature of CL2 (°C)

DKC5 CLT52
Temperature minimum
value

DKC5 CLT52: Minimum temperature of CL2 (°C)

A hyphen(-) is displayed if the power and temperature information cannot be acquired
due to a unit or network failure.

HduInfo.csv

This CSV file contains information about hard drive boxes (DB). A record is created for
each drive box.

Item Description

DB Location DB location name

DB Status Information about whether this DB is installed
■ Installed
■ Not installed

Slot Size Slot size (inches)
■ 2.5
■ 3.5
■ Blank for DBF (FMD or FMD DC2).

DB Type DB type
■ DBS (DB for 2.5-inch drives)
■ DBL (DB for 3.5-inch drives)

HduInfo.csv
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Item Description

■ DB60 (dense drive box for 3.5-inch drives)
■ DBF (DB for FMD or FMD DC2, 2PORT)
■ DBN (DB for 2.5-inch NVMe drives)

IscsiHostInfo.csv

This CSV file contains information about iSCSI Initiator (Host) set to the channel board
port. A record is created for each iSCSI Host (Initiator) target.

Item Content

Port Port name

iSCSI Name iSCSI host name

Host Name Nickname for iSCSI host name

iSCSI Target ID1 iSCSI target number (hexadecimal format, 00 to fe)

Notes:

1. For the target information, see the record information with the same iSCSI target ID in
IscsiTargetInfo.csv.

IscsiPortInfo.csv

This CSV file contains information about iSCSI information set to the channel board port.
A record is created for each iSCSI host (initiator) target.

Item Content

Port Port name

IPv4 | IP Address IPv4 address

Output example: xxx.xxx.xxx.xxx (decimal)

IPv4 | Subnet Mask IPv4 subnet mask (decimal)

Output example: xxx.xxx.xxx.xxx (decimal)

IPv4 | Default Gateway Port IPv4 default gateway

Output example: xxx.xxx.xxx.xxx (decimal)

IscsiHostInfo.csv
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Item Content

IPv6 | Mode Port IPv6 settings
■ Enabled
■ Disabled

IPv6 | Link Local
Address

Port IPv6 link local address
■ Output example: xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx (hexadecimal)
■ Output example: Auto

Auto is displayed if the link local address is automatically set. Blank if
"IPv6 | Mode" is Disabled.

IPv6 | Global Address IPv6 global address of the port
■ Output example: xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx (hexadecimal)
■ Output example: Auto

Auto is displayed if the global address is automatically set. Blank if "IPv6
| Mode" is Disabled.

IPv6 | Assigned Default
Gateway

Port IPv6 assigned default gateway
■ Output example: xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx (hexadecimal)

Blank if "IPv6 | Mode" is Disabled.

Channel Speed Data transfer speed of the port (10 Gbps)

Security Switch Port security switch settings
■ On
■ Off

TCP Port Number The number of the port for using socket (1 to 65535)

Ethernet MTU Size
(Byte) | MTU

MTU settings
■ 1500
■ 4500
■ 9000

Keep Alive Timer (sec.) Keep alive timer value of iSCSI (30 to 64800) (sec)

Selective ACK Selective ACK mode
■ Enabled
■ Disabled

IscsiPortInfo.csv
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Item Content

Delayed ACK Delayed ACK mode
■ Enabled
■ Disabled

Maximum Window Size
(KB)

Window scale option settings
■ 64KB
■ 128KB
■ 256KB
■ 512KB
■ 1024KB

iSNS Server | Mode iSNS mode settings
■ On
■ Off

iSNS Server | IP
Address

IP address of the iSNS server
■ IPv4: xxx.xxx.xxx.xxx (decimal)
■ IPv6: xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx (hexadecimal)
■ Blank if "iSNS Server | Mode" is Off.

iSNS Server | TCP Port
Number

Port number of TCP used for iSNS (1 to 65535).

Blank if "iSNS Server | Mode" is Off.

VLAN | Tagging Mode VLAN tagging mode set to the port
■ On
■ Off

VLAN | ID VLAN number set to the port (1 to 4094)

Blank if "VLAN | Tagging Mode" is set to Off.

Resource Group ID
(Port)

Resource group ID of the port (0 to 1023 in decimal)

Resource Group
Name(Port)

Resource group name of the port

iSCSI Name iSCSI name of the port

CHAP User Name Authenticated user name of the port

IscsiPortInfo.csv
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Item Content

IPv6 | Global Address 2 IPv6 global address 2 of the port
■ Output example: xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx (hexadecimal)
■ Output example: Auto

Auto is displayed if the global address 2 is automatically set. Blank if
"IPv6 | Mode" is Disabled.

Virtual Port Mode Virtual port mode of the port
■ Enabled
■ Disabled

IscsiTargetInfo.csv

This CSV file contains information about iSCSI target information set to the channel
board port. A record is created for each iSCSI target.

Item Content

Port Port name

iSCSI Target Alias iSCSI target alias

iSCSI Target ID Number of the iSCSI target (00 to fe, hexadecimal)

iSCSI Target Name Name of the iSCSI target

Host Mode Host mode set to the iSCSI target (hexadecimal)

Host Mode Option Host mode option set to the iSCSI target (decimal)

Separated with a semicolon (;) if multiple host mode options are set.

Security Switch Security switch status set to the iSCSI target port
■ On
■ Off

Authentication |
Method

Authentication method settings of the iSCSI target
■ CHAP
■ None
■ Comply with Host Setting

Authentication | Mutual
CHAP

Mutual CHAP authentication function settings of the iSCSI target
■ Enabled
■ Disabled

IscsiTargetInfo.csv
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Item Content

Authentication | User
Name

User name set when iSCSI target was authenticated

Resource Group ID
(iSCSI Target)

Resource group ID of the iSCSI target (0 to 1023)

Resource Group Name
(iSCSI Target)

Resource group name of the iSCSI target

JnlInfo.csv

This CSV file contains information about journals. A record is created for each journal.

Item Content

JNL# Journal number (in hexadecimal)

Current MPU Number and name of MP unit currently controlling the journal

(MPU-10, MPU-20)

Setting MPU Number and name of MP unit configured to control the journal

(MPU-10, MPU-20)

LdevCapaInfo.csv

This CSV file contains information about LDEV capacities. A record is created for each of
the classifications shown in "Volume Kind".

Item Content

Volume Kind The following classifications are output:
■ Internal OPEN Volumes
■ External OPEN Volumes
■ Total OPEN Volumes

Allocated LDEV Capacity
(GB)

Allocated LDEV capacity

Unallocated LDEV
Capacity (GB)

Unallocated LDEV capacity

Reserved Capacity (GB) Reserved LDEV capacity

JnlInfo.csv
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Item Content

Total Volume Capacity
(GB)

Total capacity of "Allocated LDEV Capacity", "Unallocated LDEV Capacity"
and "Reserved Capacity"

Free Space (GB) Free Space

Total Capacity (GB) Total Capacity

The sum of "Total Volume Capacity" and "Free Space"

LdevCountInfo.csv

This CSV file contains information about the number of logical devices (LDEVs). A record
is created for each of the classifications shown in "Volume Kind".

Item Content

Volume Kind The following classifications are output:
■ Internal Volumes
■ External Volumes
■ Total Volumes

Allocated OPEN LDEVs The number of allocated open-system volumes (LDEVs).

Unallocated OPEN
LDEVs

The number of unallocated open-system volumes (LDEVs).

Reserved OPEN LDEVs The number of reserved open-system volumes (LDEVs).

V-VOL The number of virtual volumes.

Output only when "Volume Kind" is Total Volumes.

Total(All LDEVs) Total number of LDEVs.

ECC Groups Total number of parity groups.

LdevInfo.csv

This CSV file contains information about logical devices (LDEVs). A record is created for
each LDEV.

For details of LDEVs, see the Provisioning Guide.

Item Content

ECC Group Number of parity group where the LDEV belongs.

LdevCountInfo.csv
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Item Content

Output example: X-Y (decimals)
■ If the number starts with "E" (for example, E1-1), the parity group

contains external volumes.
■ If "LDEV Type" is Dynamic Provisioning or Thin Image, a hyphen is

output.

LDEV# LDEV number

(00:00:00 to 00:fe:ff)

LDEV Name LDEV name1

LDEV Emulation LDEV emulation type

LDEV Type LDEV type:
■ Basic
■ Dynamic Provisioning
■ External
■ Thin Image
■ ALU

LDEV Attribute LDEV Attribute:
■ CMDDEV (Command device)
■ CMDDEV1 (Remote command device)
■ Journal ( Journal volume)
■ Pool (Pool volume)
■ Quorum disk (used with global-active device)
■ ALU
■ SLU
■ Deduplication system data volume
■ Regular (Others)

Volume Size(Cyl) LDEV capacity (in cylinders)

Volume Size(MB) LDEV capacity (in MB)

Volume Size(Blocks) LDEV capacity (in blocks)

CVS Information about whether the LDEV is a custom-sized volume:
■ On: Custom-sized volume
■ Off: Others

LdevInfo.csv
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Item Content

Pool ID Pool number. This is blank except for the following cases:
■ If "LDEV Type" is Dynamic Provisioning
■ If LDEV Attribute is Pool

RAID Concatenation#0 Number of parity group to be concatenated to parity group (#0)
identified by ECC Group. Blank if the parity group is not concatenated to
another parity group.

RAID Concatenation#1 Number of parity group to be concatenated to parity group (#1)
identified by ECC Group. Blank if the parity group is not concatenated to
another parity group.

RAID Concatenation#2 Number of parity group to be concatenated to parity group (#2)
identified by ECC Group. Blank if the parity group is not concatenated to
another parity group.

ORACLE CHECK SUM Information about whether this LDEV is an Oracle check sum target.
■ On
■ Off

Current MPU Number of the MP unit currently controlling the LDEV.

(MPU-10, MPU-20)

Setting MPU Number of the MP unit configured to control LDEV.

(MPU-10, MPU-20)

Allocated Information about whether this LDEV is allocated to a host.
■ "Y" is output for volumes accessible to the host.

Pool Name The pool's name1

■ If the provisioning type is Dynamic Provisioning, the name of the pool
related to the logical volume is displayed.

■ If the attribute is Pool, the name of the pool where the logical volume
belongs is displayed.

■ When neither of the above are displayed, the pool name is blank.

CmdDevSecurity Indicates whether Security is specified as the attribute for the command
device.
■ Enabled: Command device security setting is set.
■ Disabled: Command device security setting is not set.
■ Blank: "LDEV Attribute" is not CMDDEV.

LdevInfo.csv
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Item Content

CmdDevUserAuth Indicates whether User Authentication is specified as the attribute for
the command device.
■ Enabled: User authentication setting is set.
■ Disabled: User authentication setting is not set.
■ Blank: "LDEV Attribute" is not CMDDEV.

CmdDevDevGrpDef Indicates whether Device Group Definition is specified as the attribute
for the command device.
■ Enabled: Device group definition setting is set.
■ Disabled: Device group definition setting is not set.
■ Blank: "LDEV Attribute" is not CMDDEV.

Resource Group ID
(LDEV)

LDEV resource group ID (number in the decimal format)

Resource Group Name
(LDEV)

LDEV resource group name (0 to 1,023, decimal)

Encryption Indicates whether the parity group identified by ECC Group is encrypted.
■ For internal volumes: Enabled (encrypted) or Disabled (not

encrypted)
■ For external volumes: blank

T10 PI Indicates the T10 PI attribute set for the LDEV.
■ Enabled
■ Disabled
■ Blank if "LDEV Emulation" is not OPEN-V.

ALUA Mode Indicates whether the ALUA mode is enabled.
■ Enabled: ALUA mode is enabled.
■ Disabled: ALUA mode is disabled.

Accelerated
Compression

Indicates whether accelerated compression is enabled.

For internal volumes:
■ Enabled: accelerated compression is enabled.
■ Disabled: accelerated compression is disabled.

If the parity group with LDEV does not support accelerated compression,
a blank space is displayed. Also, for external volumes, a blank is
displayed.

Notes:

LdevInfo.csv
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Item Content

1. If the character string contains a comma, the comma is converted to a tab.

LdevStatus.csv

This CSV file contains information about the status of logical devices (LDEVs). A record is
created for each LDEV.

Item Content

VDEV# Virtual device number in which the LDEV is defined

VDEV Status VDEV status of "VDEV#"
■ 1: Normal
■ 0: Abnormal

HDEV# LDEV number

HDEV Status LDEV status
■ 1: Normal
■ 0: Abnormal

LDEV Emulation LDEV emulation type

ECC Group Number of the parity group where the LDEV belongs.
■ If the number starts with "E" (for example, E1-1), the parity group

contains external volumes.
■ If the type of the LDEV is a Dynamic Provisioning or Thin Image

virtual volume, a hyphen is output.

Refer to "LdevInfo.csv" for information about the LDEV type.

LPartition.csv

This CSV file contains information about the cache logical partitioning function. A record
is created for each cache partition for a managed resource.

For details of the cache logical partitioning function, see the Performance Guide.

Item Content

CLPR# CLPR ID (in decimal)

CLPR Name CLPR name

LdevStatus.csv
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Item Content

Cache Size(MB) Cache size allocated to this CLPR (in MB)

ECC Group Number of parity group allocated to this CLPR.
■ If the number starts with "E" (for example, E1-1), the parity group

contains external volumes.
■ If the type of the LDEV is a Dynamic Provisioning or Thin Image

virtual volume, a hyphen is output.

Refer to "LdevInfo.csv" for information about the LDEV type.

LDEV#(V-VOL) LDEV number allocated to this CLPR.
■ VSP E990: (00:00:00 to 00:fe:ff)
■ VSP F350, VSP G350: (00:00:00 to 00:3f:ff)
■ VSP F370 or VSP G370: (00:00:00 to 00:7f:ff)
■ VSP F700, VSP G700: (00:00:00 to 00:bf:ff)
■ VSP F900, and VSP G900: (00:00:00 to 00:fe:ff)

The type of this LDEV is Dynamic Provisioning, Thin Image, or ALU.

LunInfo.csv

This CSV file contains information about LU path definitions. A record is created for each
host group. For more information about LU path definitions, see the Provisioning Guide.

Item Description

Port Port name

Host Group Host group name

If "Package Type" is iSCSI, the iSCSI target alias is output.

Host Mode Host mode specified for this host group (hexadecimal)

Host Mode Option Host mode option set for this host group (decimal)

If more than one option is specified, the options are separated by
semicolons (;).

LUN# LUN number for this LU path definition (hexadecimal)

LDEV# LDEV number for this LU path definition

LunInfo.csv
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Item Description

Command Device Information about whether the LDEV is a command device:
■ On: Command Device
■ On*: Remote Command Device
■ Off: Others

Command Security Information about whether the command device is secured:
■ On
■ Off

CVS Information about whether the LDEV is a custom-sized volume:
■ On: Customized volume
■ Off: Other volumes

CHB Location Name of the CHB on which this port is installed

CHB-1A/1B/1C/1D or CHB

Package Type CHB type for CHB Location:
■ Fibre:

● 16FC2 (CHB)
● 32FC4R (CHB)

■ iSCSI:
● 10iSCSI2o (CHB)
● 10iSCSI2c (CHB)

Resource Group ID
(Host Group)

Resource group ID of a host group (0 to 1,023, decimal)

Resource Group Name
(Host Group)

Resource group name of a host group

T10 PI Mode Indicates whether the T10 PI mode can be applied to the port for which
the LU path is defined.
■ Enabled
■ Disabled
■ Blank if "Package Type" is not 16FC2 (CHB) or 32FC4R (CHB).

LunInfo.csv
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Item Description

T10 PI Information about the T10 PI attribute which is set for the LDEV number
of the LU path definition.
■ Enabled
■ Disabled
■ Blank if LDEV# is blank

Asymmetric Access
State

Asymmetric access status (output only for an open system CHB that is
Fibre or FCoE)

Indicates the asymmetric access status:
■ Active/Optimized: Prioritized
■ Active/Non-Optimized: Lower priority

Blank if "Package Type" is iSCSI

LunPortInfo.csv

This CSV file contains information about LU path definition. A record is created for each
port.

For details of LU path definition, see the Provisioning Guide.

Item Content

Port Port name.

Security Switch The setting status of the security switch:
■ On
■ Off

Port Address Port address (2-digit hexadecimal number) 00 to ff

Blank if "Package Type" is iSCSI

Loop ID Port address (0 - 125, decimal)

Blank if "Package Type" is iSCSI

Fabric One of the Fibre topology settings indicating the setting status of the
Fabric switch:
■ On
■ Off
■ Blank if "Package Type" is iSCSI

LunPortInfo.csv
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Item Content

Connection One of the Fibre topology settings:
■ Point to Point
■ FC-AL
■ Blank if "Package Type" is iSCSI

Channel Speed Channel Speed of this port
■ 1 Gbps
■ 4 Gbps
■ 8 Gbps
■ 10 Gbps
■ 16 Gbps
■ 32 Gbps
■ Auto

WWN WWN of this port (hexadecimal number)

Blank if "Package Type" is iSCSI

CHB Location CHB on which the port is installed.

Package Type CHB type for CHB Location
■ Fibre:

● 16FC2 (CHB)
● 32FC4R (CHB)

■ iSCSI:
● 10iSCSI2o (CHB)
● 10iSCSI2c (CHB)

T10 PI Mode Indicates whether the T10 PI mode can be applied to the port.
■ Enabled
■ Disabled
■ Blank if "Package Type" is not 16FC2 (CHB) or 32FC4R (CHB)

MicroVersion.csv

This CSV file contains information about software versions.

MicroVersion.csv
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Table 16 For VSP G130, G/F350, G/F370, G/F700. G/F900:

Item Content

DKCMAIN The version of the firmware for the RAID storage system (10 digits)

ROM BOOT ROM BOOT firmware version (6 digits)

RAM BOOT RAM BOOT firmware version (6 digits)

Config Config version (8 digits)

HDD HDD firmware version (4 digits)

HDD version in the format "(HDD-device-type - code):(version)".

If an HDD drive is not installed, only a colon is displayed.

Expander Expander firmware version (6 digits)

CFM CFM firmware version (8 digits)

DKB DKB firmware version (6 digits)

Printout Tool Printout tool version (xx-yy-zz-mm/aa)

CHB (FC32G) 32G FC protocol chip firmware version (8 digits)

CHB (iSCSI) CHB(iSCSI) protocol chip firmware version (8 digits)

GUM GUM firmware version (8 digits)

Table 17 For VSP E990:

Item Content

DKCMAIN The Version of the firmware for the RAID
storage system (10 digits)

ROM BOOT ROM BOOT firmware version (6 digits)

RAM BOOT RAM BOOT firmware version (6 digits)

Config Config version (8 digits)

HDD HDD firmware version (4 digits)

HDD version in the format "(HDD-device-
type - code):(version)".

If an HDD drive is not installed, only a
colon is displayed.

CFM CFM firmware version (8 digits)

Printout Tool Printout tool version (xx-yy-zz-mm/aa)

MicroVersion.csv
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Item Content

CHB(FC32G) 32G FC protocol chip firmware version (8
digits)

CHB(iSCSI) CHB9iSCSI) protocol ship firmware version
(8 digits)

GUM GUM firmware version (8 digits)

DKBN DKBN firmware version (6 digits)

NSW NSW firmware version (6 digits)

EDKBN EDKBN firmware version (6 digits)

MlcEnduranceInfo.csv

This CSV file contains information about endurance information of MLC. A record is
created for each MLC endurance information.

If you change the SVP time 1 month or more, the history acquisition months will not be
in order.

Item Content

ECC Group Number of parity groups of which this MLC (including FMD and FMD
DC2 ) is a component.
■ If it is a spare drive, Spare Drive is displayed.
■ If it is a free drive, Free Drive is displayed.

CR# C# and R# (2-digit hexadecimal numbers), which identify the PDEV

Output in the format of "XX/YY"

XX: C#

YY: R#

Device Type-Code Drive type code of this drive

Output example: SLR5A-M800SS

Used Endurance
Indicator (%)

The current used endurance of SSD life (0 to 100)

The value of this indicator increases due to drive operation associated
with internal processing of the storage system, and the host I/O. Even
when no data is copied due to a drive failure, the value of this indicator
increases because the spare drive also performs internal processing.

History1 (date) Date on which the used endurance of SSD life was acquired (1 month
ago)

MlcEnduranceInfo.csv
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Item Content

Output example: yyyy/mm/dd

History1 (%) The used endurance of SSD life (0 to 100)(1 month ago)

History2 (date) Date on which the used endurance of SSD life was acquired (2 months
ago)

Output example: yyyy/mm/dd

History2 (%) The used endurance of SSD life (0 to 100) (2 months ago)

History3 (%) ... History
119 (%)

Life (0 to 100) (3 months ago ...119 months ago)

History120 (date) Date on which the used endurance of SSD life was acquired (120 months
ago)

Output example: yyyy/mm/dd

History120 (%) The used endurance of SSD life (0 to 100) (120 months ago)

ModePerLpr.csv

This CSV file contains information about system option modes. A record is created for
each system option mode.

Item Content

System Option Mode# System option mode # (0 to 2047, decimal number)

LPR#0, LPR#1, …,
LPR#31

System option mode for LPR#0 to LPR#31
■ If the system option mode is on:

On
■ If the system option mode is not on:

Blank

MpPathStatus.csv

This CSV file contains information about the status of logical paths. A record is created
for each MP blade or LR.

ModePerLpr.csv
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Item Content

MPU#/CTL# MP unit number or CTL number (2-digit hexadecimal number)
■ For MP unit number

MPU#00 to MPU#01
■ For CTL number

CTL#00 to CTL#01

CMG#00-00 to 01

CMG#01-00 to 01

Path status1 for the MP unit number with the cache module

(CMG#XX-YY) XX: I path, YY: CMG#

MPU#00-00 to 01

MPU#01-00 to 01

Path status1 and the MP unit for the MP unit number

(MPU#XX-YY) XX: I path, YY: MPU#

CMG#00-00 to 01

CMG#01-00 to 01

Path status1 with the cache module for the CTL number

(CMG#XX-YY) XX: I path, YY: CMG#

MPU#00-00 to 01

MPU#01-00 to 01

Path status1 with the MP unit number for the CTL number

(MPU#XX-YY) XX: I path, YY: MPU#

Note:

1. 1=Normal, 0=Abnormal

MpPcbStatus.csv

This CSV file contains information about the status of MP Unit. A record is created for
each MP unit.

Table 18 MpPcbStatus.csv file (Title: <<MP PCB Status>>)

Item Content

MPU ID MP unit ID (MPU-10, MPU-20)

Auto Assignment Information about whether this MP unit is set to be automatically
assigned to each resource.
■ Enabled: Set to be automatically assigned
■ Disabled: Not set to be automatically assigned

MPU Status MP unit status*

MP#00, #01, …, #19 MP status*

MpPcbStatus.csv
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Item Content

The number of output items differs for each model, because the
number of installed MPs is different.
■ VSP E990: MP#00,01,…,1b
■ VSP F350, VSP G350: MP#00,01,…,05
■ VSP F370, VSP G370: MP#00,01,…,09
■ VSP F700, VSP G700: MP#00,01,…,11
■ VSP F900, VSP G900: MP#00,01,…,19

Note:

* 1=Normal, 0=Abnormal

PcbRevInfo.csv

This CSV file contains information about revisions of packages such as channel boards
(CHBs) and others. A record is created for each package.

Table 19 PcbRevInfo.csv file (Title: <<PCB Revision Information>>)

Item Content

Cluster# Cluster number 1 or 2

Location Part name

FRU number Product name of the package or some other name

PK Revision Revision of the package

Factory Factory manufacturing the package

Number Serial number of the package

MAC Address MAC address of the package

PdevCapaInfo.csv

This CSV file contains information about physical device (PDEV) capacities. A record is
created for each of the classifications shown in "PDEV Kind".

PcbRevInfo.csv
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Item Content

PDEV Kind The following four classifications are output:
■ OPEN System (TB)
■ Total Capacity (TB)
■ Number of PDEVs

HDD Drive HDD drive capacity (TB)

Spare Drive Spare drive capacity (TB)

SSD Drive SSD capacity (TB)

Free Drive Free drive capacity (TB)

PdevInfo.csv

This CSV file contains information about physical devices (PDEVs). A record is created for
each PDEV.

Item Content

ECC Group Number of parity group of which this PDEV is a component.
■ Spare Drive: For spare drives
■ Free Drive: For free drives

Emulation Type Emulation type for the parity group indicated by "ECC Group"
■ Blank: "ECC Group" is Spare Drive.
■ Free Drive: "ECC Group" is Free Drive.

CR# C# and R# (2-digit hexadecimal numbers), which identify the PDEV

Output in the format XX/YY, where:
■ XX: C#
■ YY: R#

PDEV Location PDEV location name

Device Type Drive type
■ SAS
■ SSD

RPM Revolutions per minute

Blank displays as RPM when the drive is SSD.

PdevInfo.csv
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Item Content

For VSP E990, this item is displayed as Interface.

Device Type-Code Device type code of this drive

Output example: DKR5D-J600SS

Device Size Drive size (inches)
■ 2.5
■ 3.5
■ Blank for DBF (FMD or FMD DC2 )

Device Capacity Drive capacity (GB or TB)

Drive Version Drive firmware version (4-digit hexadecimal number)

DKB1 Name of the DKB1 controlling the PDEV

DKB2 Name of the DKB2 controlling the PDEV

Serial Number # Serial number of this drive (yymm xxxxxx), where:
■ yy Year (last 2 digits)
■ mm Month (2 digits)
■ xxxxxx: Serial number of this drive

RAID Level RAID level of the parity group indicated by "ECC Group"

Blank if the "ECC Group" is Spare Drive or Free Drive

RAID Concatenation #0 Number of parity group to be concatenated to parity group (#0)
identified by "ECC Group"1

RAID Concatenation #1 Number of parity group to be concatenated to parity group (#1)
identified by "ECC Group"1

RAID Concatenation #2 Number of parity group to be concatenated to parity group (#2)
identified by "ECC Group"1

Resource Group ID (ECC
Group)

Resource group ID of parity group (0 to 1023, decimal number)

Resource Group Name
(ECC Group)

Resource group name of parity group

Encryption Encryption status of the parity group to which the PDEV belongs
■ Enabled: Encryption enabled
■ Disabled: Encryption disabled

PdevInfo.csv
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Item Content

Accelerated
Compression

Accelerated compression setting.
■ Enabled: accelerated compression is enabled.
■ Disabled: accelerated compression is disabled.

If the parity group with PDEV does not support accelerated
compression, or if the ECC Group is Spare Drive, a blank space is
displayed.

Automatically manage
compressed space of
FMD parity group

Indicates whether to manage the compressed area of the FMD parity
group automatically.2

■ Enabled: The area is managed automatically.
■ Disabled: The area is not managed automatically

If the parity group with PDEV does not support accelerated
compression, a blank space is displayed.

Notes:

1. Blank if the parity group is not concatenated to another parity group or is Spare Drive.
2. Blank if the parity group to which PDEV belongs does not support accelerated compression.

PdevStatus.csv

This CSV file contains information about the status of physical devices (PDEVs). A record
is created for each PDEV.

Item Content

CR# C# and R# (2-digit hexadecimal numbers), which identify the PDEV

Output in the format XX/YY, where:
■ XX: C#
■ YY: R#

Pdev Status PDEV status1

Port0 Status Status of Port 0 on this PDEV1

Port1 Status Status of Port 1 on this PDEV1

Pdev Location Location name of this PDEV

Notes:

1. 1=Normal, 0=Abnormal

PdevStatus.csv
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PECBInfo.csv

This CSV file contains information about the PECB (PCIe channel board) and connecting
destination for VSP F900 or VSP G900.

For VSP E990 and all other VSP Gx00 models or VSP Fx00 models, hyphens are displayed
for all contents.

Item Content

Location PECB location name

Status Whether the PECB is installed
■ Installed
■ Not Installed

Type Destination module type of the PECB
■ CHBB

Expansion mode Expansion mode set in the destination module of the PECB

PkInfo.csv

This CSV file contains information about channel boards (CHBs). A record is created for
each CHB.

Table 20 PkInfo.csv file (Title: <<PK>>)

Item Content

CHB Location CHB name

Port# Number of the port installed on the CHB (2-digit hexadecimal number),
00 to ff

Port Name of port installed on the CHB

Package Type CHB type indicated on the CHB Location
■ Fibre: 16FC2 (CHB), 32FC4R (CHB)
■ iSCSI: 10iSCSI2o (CHB), 10iSCSI2c (CHB)

SFP Kind SFP (Small Form factor Pluggable) Kind
■ Short Wave
■ Long Wave
■ Blank if "Package Type" is 10iSCSI2c (CHB).

PECBInfo.csv
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Item Content

SFP Status SFP Status:
■ Normal
■ Failed
■ Not Fix
■ Blank if "Package Type" is 10iSCSI2c (CHB).

Fabric One of the Fibre topology settings indicating the setting status of the
Fabric switch:
■ On
■ Off

Connection One of the Fibre topology settings
■ Point to Point
■ FC-AL

Port Address Port address (00 to ff, 2-digit hexadecimal number)

Blank if "Package Type" is iSCSI.

Resource Group ID
(Port)

Resource group ID of port (0 to 1023, decimal number)

Resource Group Name
(Port)

Resource group name of the port.

Port Internal WWN Port WWN

Blank if "Package Type" is iSCSI.

T10 PI Mode Indicates whether the T10 PI mode can be applied to the port.
■ Enabled
■ Disabled
■ Blank if "Package Type" is not 16FC2 (CHB) or 32FC4R (CHB).

SFP Data Transfer Rate Maximum transfer rate of SFP which the mounted package supports.
■ 10G
■ 16G
■ 32G
■ Blank if the "Package Type" is 10iSCSI2c (CHB)

PkInfo.csv
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PpInfo.csv

This CSV file contains information about the software. A record is created for each
software product.

For details about the license key, see Managing license keys (on page 143) .

Item Content

Program Product Name Software name.

Install Information about whether the installed license key is enabled or not
■ Enabled: Installed and the software can be used
■ Disabled: Installed but the software cannot be used

Key Type Installed license key type
■ Permanent
■ Temporary
■ Emergency
■ Term

If no license key is installed, "Not Installed" is output.

Permitted Volumes(TB) Permitted volume capacity for this software (in TB)

If no upper limit value is set for the capacity, "Unlimited" is output.

Expiration Date Expiration date of the software.

The format is mm/dd/yyyy (Month/Day/Year).

Status License key status of the software
■ Installed
■ Not Enough License
■ Grace Period
■ Expired
■ Not Installed
■ Installed (Disabled)

SMfundat.csv

This CSV file contains information about SM functions. A record is created for each of the
classifications shown in "SM Install Function".

PpInfo.csv
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Item Content

SM Install function The following classifications are output for VSP F350, VSP F370, VSP
G350, VSP G370:

1. Base
2. Extension 1
3. Extension 2

The following classifications are output for VSP E990, VSP F700, VSP
F900, VSP G700, VSP G900:

1. Base
2. Extension1
3. Extension2
4. Extension3

Availability Information about whether the function of "SM Install function" is
enabled
■ Enabled
■ Disabled

SsdDriveInfo.csv

This CSV file contains information about SSDs. A record is created for each SSD.

Item Content

ECC Group Number of the parity group of which this SSD is a component.
■ Spare Drive: The SSD is a spare drive.
■ Free Drive: The SSD is a free drive.

CR# C# and R# (2-digit hexadecimal numbers), which identify the PDEV

Output in the format XX/YY, where:
■ XX: C#
■ YY: R#

PDEV Location Drive type code of the PDEV location name for this drive

Device Type-Code Drive type code

Output example: SLR5A-M800SS

Device Capacity Drive capacity in GB or TB

SsdDriveInfo.csv
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Item Content

SSD Device Type SSD drive type
■ MLC
■ FMD
■ FMD DC2
■ SSD(RI)

Used Endurance
Indicator (%)

The used endurance of SSD life (0 to 100)

Used Endurance
Indicator Threshold (%)

Drive life threshold (0 to 100)

Used Endurance
Indicator Warning SIM
(%)

Warning SIM threshold (0 to 100)

FMD Battery Life
Indicator Warning SIM
(%)

Threshold of battery life warning SIM (0 to 100)

Blank if SSD is other than FMD

For VSP E990, no information is output.

FMD Battery Life
Indicator (%)

Used battery life (0 to 100)

Blank if SSD is other than FMD

For VSP E990, no information is output.

SsidInfo.csv

This CSV file contains information about SSIDs. A record is created for each SSID.

Item Content

DEV# Start First LDEV number for the SSID

DEV# End Last LDEV number for the SSID

SSID Subsystem ID (hexadecimal)

SysoptInfo.csv

This CSV file contains information about system options.

SsidInfo.csv
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Item Content

Spare Disk Recover Speed of copying data to the spare drive.
■ Interleave mode
■ Full Speed mode

Dynamic Sparing Information about whether to perform automatic copy to a spare drive
if the occurrences of drive failures exceed the threshold.
■ On
■ Off

Correction Copy Information about whether to perform correction copy to a spare drive
if a drive is blocked.
■ On
■ Off

Disk Copy pace Speed of copying the spare drive in the Interleave mode.
■ Faster
■ Medium
■ Slower

System Option On System options that are set to ON.

Output example: modeXXXX (0 to 2047, decimal number)

Link Failure Threshold Threshold to notify the link failure (0 to 255, decimal)

WwnInfo.csv

This CSV file contains information about hosts. A record is created for each host.

Item Content

Port Port name.

Host Group Host group name

iSCSI target alias is output if the "Package Type" is iSCSI.

Host Mode Host mode that is set for the host group (hexadecimal)

Host Mode Option Host mode option that is set for the host group (decimal)

Multiple options are separated by semicolons (;)

WWN World Wide Name of the host bus adapter registered to the host group
(hexadecimal number)

WwnInfo.csv
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Item Content

Blank if the "Package Type" is iSCSI.

Nickname Nickname of the host

Blank if the "Package Type" is iSCSI.

Host Group# Host group number (00 to fe, hexadecimal)

iSCSI target ID will be output if the "Package Type" is iSCSI.

CHB Location Name of port installed on the CHB

Package Type CHB type indicated on the CHB Location
■ Fibre: 16FC2 (CHB), 32FC4R(CHB)
■ iSCSI: 10iSCSI2o (CHB), 10iSCSI2c (CHB)

T10 PI Mode Indicates whether the T10 PI mode can be applied to the port.
■ Enabled
■ Disabled
■ Blank if "Package Type" is not 16FC2 (CHB) or 32FC4R (CHB).

WwnInfo.csv
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Appendix B:  SMI-S provider configuration file

To use this SMI-S function you must create a SMI-S provider configuration file. This
section describes the SMI-S provider configuration files.

Array-setting-01.properties file

The array-setting-01.properties file is an SMI-S provider user configuration file. This
section describes the description format and organization format of SMI-S provider user
configuration files and parameters to be defined.

File description format

The format of the array-setting-01.properties file includes the following items:
■ File format: text
■ Character code: ISO 8859-1
■ Line-end symbol: \n, \r, or \r\n
■ Comment: Line on which # or ! is the first non-space character

File organization format

The organization of the array-setting-01.properties file is shown here:

# comment line

   parameter1= parameter1_setting_value

  parameter2= parameter2_setting_value

# comment line

Parameters defined in user configuration files

The following table describes the parameters can be specified in user configuration files.

Parameter name Description

ResourceGroup Specifies the resource groups that the SMI-S provider can use.

For parameter details, see ResourceGroup parameter (on
page 245) .

Appendix B: SMI-S provider configuration file

System Administrator Guide for VSP E990 and VSP G130, G/F350, G/F370, G/F700, G/F900 244



All parameters are optional. If no value is specified for a parameter, the default value
applies.

ResourceGroup parameter

Use the ResourceGroup parameter to specify resource groups that the SMI-S provider
can use.

All resource groups are specified by default.

Setting up the ResourceGroup parameter

Set up the parameter by using <RangeOfResourceGroupID> and
<SingleResourceGroupID> with a comma (,) as a delimiter:
■ <RangeOfResourceGroupID>: Specifies a range of resource group IDs
■ <SingleResourceGroupID>: Specifies a single resource group ID

<RangeOfResourceGroupID> format

<Start ResourceGroupID>to<End ResourceGroupID>
■ <Start ResourceGroupID>: ID of the first resource group in the specified range
■ <End ResourceGroupID>: ID of the last resource group in the specified range

<SingleResourceGroupID> format

<ResourceGroupID>
■ <ResourceGroupID>: ID of the resource group to be specified

Example

ResourceGroup=1to2,4,6to8
In this example, resource groups having one of the following resource group IDs are
used:
■ 1, 2, 4, 6, and 8

ResourceGroup parameter
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Appendix C:  System option modes (SOMs)

System option modes allow the storage system to be configured to specific customer
operating requirements.

System option modes

To provide greater flexibility, the storage systems have additional operational parameters
called system option modes (SOMs) that allow you to tailor the storage system to your
unique operating requirements. The SOMs are set on your storage system by your
service representative.

The following table lists and describes the SOMs for the following DKCMAIN firmware
versions:
■ VSP E990: 93-02-03
■ VSP G130, G/F350, G/F370, G/F700, G/F900: 88-06-02

Review the SOMs for your storage system, and work with your service representative to
ensure that the appropriate SOMs for your operational environment are configured on
your storage system.

Note: The SOM information might have changed since this document was
published. For the latest SOM information, contact customer support.

Table 21 System option modes for VSP E990 and VSP G130, G/F350, G/F370, G/F700, G/F900

Mode Category Description Default MCU/RCU

15 Common This SOM can reduce the host response time to be
within about 6 seconds.

ON -
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Mode Category Description Default MCU/RCU

Notes:

1. This SOM is used on a storage system where
slow or delayed drive response may affect
business operations.

2. When Dynamic Sparing or Auto Correction
Mode is used, because host I/Os conflict with
copy processing, the I/O watching time is 30
seconds even when this SOM is set to ON.

3. Even though SOM 15 is set to ON, the function
does not apply to SATA or NL-SAS drives.

4. When SOM 771 or SOM 797 is set to ON, the
setting of SOM 771/797 is prioritized for the
read I/O watching time.

5. For additional details about this SOM
(interaction with other SOMs, operational
details), contact customer support (see
SOM015 sheet).

22 Common Regarding the correction copy or the drive copy, in
case ECCs/LRC PINs are set on the track of copy
source HDD, SOM 22 can be used to interrupt the
copy processing (default) or to create ECCs/LRC
PINs on the track of copy target HDD to continue
the processing.

Mode 22 = ON: If ECCs/LRC PINs (up to 64) have
been set on the track of copy source HDD,
ECCs/LRC PINs (up to 64) will be created on the
track of copy target HDD so that the copy
processing will continue. If the number of
ECCs/LRC PINs exceeds 64, the corresponding copy
processing will be interrupted.

Mode 22 = OFF: If ECCs/LRC PINs have been set on
the track of copy source HDD, the copy processing
will be interrupted. (First recover ECCs/LRC PINs by
using the PIN recovery flow, and then perform the
correction copy or the drive copy again).

One of the controlling option for correction/drive
copy.

OFF None

142 Common When a command issued to a drive turns to time-
out, the failure is counted on the failure counter of
the drive port. If the failure counter reaches the
port blockage threshold, the drive port is blocked.
When this SOM is set to ON, the port is blocked
when the number of failures reaches the half point

ON -

System option modes
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Mode Category Description Default MCU/RCU

of the threshold, which mitigates the occurrence
possibility of the host time-out.

Mode 142 = ON (default): The threshold value of
blocking a drive port due to command time-out is
changed to the half of the normal threshold.

Mode 142 = OFF: The threshold value of blocking a
drive port due to command time-out does not
change.

Notes:

1. This SOM should always be set to ON. This
SOM can be set to OFF only when the
customer does not allow to set this SOM to
ON for a storage system already in
production.

2. This SOM is effective for the entire storage
system.

144 Common This mode is intended to detect and block an HDD
whose response is permanently delayed to keep
reliability.

1. Normal response delay detection logic

Mode 144 = ON: When a response delay drive
is detected, SSB=A4CE and A4DE are logged,
the drive with response delay is blocked, and
SSB=AE4A and SIM=EF0XXX or EF1XXX are
reported.

The behavior varies depending on the
combinations of SOM settings. For details,
contact customer support (see SOM144
sheet).

Mode 144 = OFF: When a response delay drive
is detected, SSB=A4CE and A4DE are logged,
and SIM=DFFXXX is reported.

The behavior varies depending on the
combinations of SOM settings. For details,
contact customer support (see SOM144
sheet).

ON
(88-01-
02 only)

OFF
(88-01-
03 and
later)

-

System option modes
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Mode Category Description Default MCU/RCU

2. Early response delay detection logic

When the logic that detects a minor drive
response delay early, which is enabled or
disabled by setting SOM1068 to ON or OFF,
detects a drive response delay, the drive with
response delay is blocked.

SOM144 works with the logic and determines
whether to block a drive or not when the logic
detects a response delay.

Mode 144 = ON: When a response delay is
detected by the logic, SSB=A4CF and A4DD are
logged, the drive with response delay is
blocked, and then SSB=AE4A and SIM=EF0XXX
or EF1XXX are reported.

The behavior varies depending on the
combinations of SOM settings. For details,
contact customer support (see sheet
SOM144).

Mode 144 = OFF: When a response delay is
detected by the logic, SSB=A4CF is logged and
SIM=DFFXXX is reported.

The behavior varies depending on the
combinations of SOM settings. For details,
contact customer support (see sheet
SOM144).

Note: The mode is applied if a stable host
response is prioritized by separating a drive whose
response is permanently delayed at early stage
when the drive delay is detected. To apply the
mode, note that separating the drive causes
decrease in redundancy.

310 Common Mode 310 = ON: The monitoring timer for MP
hang-up is 6 seconds and returning a response to
the host within 8 seconds is guaranteed.

Mode 310 = OFF (default): The monitoring timer
for MP hang-up is 8 seconds.

OFF -

System option modes
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Mode Category Description Default MCU/RCU

Notes:

1. This SOM applies to a site where strict host
response performance is required.

2. If a hardware failure occurs when this SOM is
set to ON, the time until MPB blockage is
determined is shorter than usual.

448 Universal
Replicator

Mode 448 = ON: After a physical path failure (such
as path disconnection) is detected, a mirror is split
(suspended) one minute after the detection. On
the MCU side, the mirror is suspended one minute
after read journal commands from the RCU stop.
On the RCU side, the mirror is suspended one
minute after read journal commands fail.

Mode 448 = OFF (default): After a physical path
failure (such as path disconnection) is detected, a
mirror is split (suspended) if the path is not
restored within the path monitoring time set by the
mirror option.

Notes:

1. The mode is applied when a user requires to
suspend the pair one minute after a
communication error between UR MCU and
RCU is detected.

2. When SOM 449 is set to ON, SOM 448 does
not function.

OFF -

449 Universal
Replicator

This mode is used to enable and disable detection
of communication failures between the MCU and
RCU. The default setting is ON.

Mode 449 = ON (default): When a physical path
failure is detected, the pair is not suspended. On
the MCU side, checking read journal command
disruption from the RCU is disabled, and
monitoring read journal command failures is
disabled on the RCU side.

Mode 449 = OFF: When a physical path failure is
detected, the pair is suspended after the path
monitoring time set by the mirror option has
passed or after one minute. Detecting
communication failures between the MCU and RCU
is enabled. When this mode is set to OFF, SOM 448
can be enabled.

ON MCU

System option modes
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Mode Category Description Default MCU/RCU

Notes:

1. This SOM is applied when disabling the
detection of communication failures between
the MCU and RCU in UR configuration is
required.

2. When this SOM is set to ON, SOM 448 does
not work.

3. This SOM setting is not changed by microcode
upgrade.

4. This SOM is not effective for remote paths
between an Initiator port on the MCU and a
Target port on the RCU.

5. While a path from the RCU to MCU is
disconnected, if the UR pair remains in
Suspending or Deleting status, recover it in
accordance with the procedure in Recovery
from UR Failure in TROUBLE SHOOTING
section of Maintenance Manual.

454 Virtual
Partition
Manager

CLPR (function of Virtual Partition Manager)
partitions the cache memory in the storage system
into multiple virtual cache and assigns the
partitioned virtual cache for each use. If a large
amount of cache is required for a specific use, it
can minimize the impact on other uses. The CLPR
function works as follows depending on whether
SOM 454 is set to ON or OFF.

Mode 454 = OFF (default): The amount of the
entire destage processing is periodically
determined by using the highest workload of all
CLPRs (*a). (The larger the workload is, the larger
the amount of the entire destage processing
becomes.)

*a: (Write Pending capacity of CLPR#x of
concerned MPB) ÷ (Cache capacity of CLPR#x of
concerned MPB), x=0 to 31

CLPR whose value above is the highest of all CLPRs

Because the destage processing would be
accelerated depending on CLPR with high
workload, when the workload in a specific CLPR
increases, the risk of host I/O halt would be
reduced.

Therefore, set SOM 454 to OFF in most cases.

OFF -
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Mode Category Description Default MCU/RCU

Mode 454 = ON:

The amount of the entire destage processing is
periodically determined by using the workload of
the entire system (*b). (The larger the workload is,
the larger the amount of the entire destage
processing becomes.)

*b: (Write Pending capacity of the entire system of
concerned MPB) ÷ (Cache capacity of the entire
system of concerned MPB)

Caution: Because the destage processing would
not be accelerated even if CLPR has high workload,
when the workload in a specific CLPR increases, the
risk of host I/O halt would be increased. Therefore,
set SOM 454 to ON only when a CLPR has constant
high workload and the I/O performance in a CLPR
with low workload has higher priority than host I/O
halt in the CLPR with high workload.

Notes:

1. When this SOM is set to ON, even if there is an
overloaded CLPR (CLPR with large Write
Pending capacity), the amount of destage
processing would not increase easily.
Therefore TOV(MIH) may occur in the
overloaded CLPR. Set this SOM to ON only
when the overloaded state of a specific CLPR
would not affect other CLPRs.

When the UR function is used, if user volumes
and journal volumes are defined in different
CLPRs, when the CLPR to which the journal
volumes are assigned overflows, the user
volumes become inaccessible. Therefore it is
recommended to set this SOM to OFF.

2. Because the destage processing will have a
lower priority in the overloaded CLPR, the
overloaded state of the overloaded CLPR is
not removed, and TOV(MIH) might occur.

457 Universal
Volume
Manager

High-speed LDEV format for external volumes.

Mode 457 = ON: The high-speed LDEV format for
external volumes is available by SOM 457 to ON.
When SOM 457 is ON, if you select an external
volume group and perform an LDEV format, any
write processing on the external logical units will
be skipped.

OFF Both
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Mode Category Description Default MCU/RCU

Mode 457 = OFF (default): High-speed LDEV
format for external volumes is not available.

Notes:
■ If the LDEV is not written with data “0” before

performing the function, the LDEV format might
fail.

■ After the format processing, make sure to set
SOM 457 to OFF.

459 ShadowImage When the S-VOL of an SI/SIz pair is an external
volume, the transaction to change the status from
SP-PEND to SPLIT is as follows:

Mode 459 = ON (default): When suspending an SI
pair: Waits for the copy data in cache memory to
completely destage to the external volume S-VOL
before changing the pair status to SUSPEND.

Mode 459 = OFF: When suspending an SI pair: The
status changes to SUSPEND as soon as all of the
delta data is copied to S-VOL cache. The status
does not wait for cache to destage to the S-VOL
external volume.

ON -

467 ShadowImage

Universal
Volume
Manager

Volume
Migration

For the following features, the current copy
processing slows down when the percentage of
“dirty” data is 60% or higher, and it stops when the
percentage is 75% or higher. Mode 467 is provided
to prevent the percentage from exceeding 60%, so
that the host performance is not affected.
■ SI
■ UVM
■ Volume Migration

Mode 467 = ON (default): Copy overload
prevention. Copy processing stops when the
percentage of “dirty” data reaches 60% or higher.
When the percentage falls below 60%, copy
processing restarts.

Mode 467 = OFF: Normal operation. The copy
processing slows down if the dirty percentage is
60% or larger, and it stops if the dirty percentage is
75% or larger.

Caution: This SOM must always be set to ON when
using an external volume as the secondary volume
of any of the applicable replication products.

ON -
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Mode Category Description Default MCU/RCU

Notes:

1. It takes longer to finish the copy processing
because it stops for prioritizing the host I/O
performance.

2. This SOM supports background copy only. The
processing to copy the pre-update data to the
S-VOL, which occurs when overwriting data to
uncopied slots of P-VOL in Split processing or
reading or writing data to uncopied slots of S-
VOL, is not supported.

3. Check the write pending rate of each CLPR per
MP unit. Even though there is some free cache
capacity in the entire system, if the write
pending rate of an MP unit to which pairs*
belong exceeds the threshold, the copy
operation is stopped.

*Applies to pairs of SI, SIz, FCv2, FCSE, and
Volume Migration.

471 Thin Image Since the SIM-RCs generated when the Thin Image
pool usage rate exceeds the threshold value can be
resolved by users, these SIM-RCs are not reported
to the maintenance personnel. This SOM is used to
report these SIM-RCs to maintenance personnel.

The SIM-RCs reported by setting the SOM to ON
are: 601xxx (Pool utilization threshold exceeded),
603000 (SM space warning).

Mode 471 = ON: These SIM-RCs are reported to
maintenance personnel.

Mode 471 = OFF (default): These SIM-RCs are not
reported to maintenance personnel.

Note: Set this SOM to ON when it is required to
inform maintenance personnel of these SIM-RCs.

OFF -

474 Universal
Replicator

UR initial copy performance can be improved by
issuing a command from CCIto execute a dedicated
script consisting of UR initial copy (Nocopy), UR
suspend, TC Sync initial copy, TC Sync delete, and
UR resync.

Mode 474 = ON: For a suspended UR pair, a TC
(Sync) pair can be created with the same P-VOL/S-
VOL so that UR initial copy time can be reduced by
using the dedicated script.

OFF Both
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Mode 474 = OFF (default): For a suspended UR
pair, a TC (Sync) pair cannot be created with the
same P-VOL/S-VOL. For this, the dedicated script
cannot be used.

If the P-VOL and S-VOL are both DP-VOLs, initial
copy performance might not improve with SOM
474 set to ON. This is because with DP-VOLs, not all
areas in a volume are allocated for UR; therefore
not all areas in the P-VOL are copied to the S-VOL.
With less than the full amount of data in the P-VOL
being copied, the initial copy completes in a
shorter time, which might not be improved with
SOM 474.
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Notes:

1. Set this SOM for both primary and secondary
storage systems.

2. When this SOM is set to ON:

■ Execute all pair operations from CCI/BCM.

■ Use a dedicated script.

■ Initial copy operation is prioritized over
update I/O. Therefore, the processing
speed of the update I/O slows down.

3. If this SOM is set to ON, the processing speed
of update I/O slows down by about 15 μs per
command, version downgrade is disabled, and
Take Over is not available.

4. If this SOM is not set to ON for both sides, the
behavior is as follows:

■ OFF in primary and secondary storage
systems: Normal UR initial copy
performance.

■ ON in the primary storage system/OFF in
the secondary storage system: TC Sync pair
creation fails.

■ OFF in the primary storage system/ON in
the secondary storage system: The update
data is copied to the S-VOL synchronously.

5. While this SOM is set to ON, make sure not to
perform microcode downgrade to an
unsupported version.

6. While this SOM is set to ON, make sure not to
perform the Take Over function.

7. This SOM cannot be applied to a UR pair that
is the second mirror in a URxUR multi-target
configuration, URxUR cascade configuration,
or 3DC multi-target or cascading configuration
of three UR sites. If applied, TC pair creation is
rejected with SSB=CBED output.

8. Before setting SOM 474 to ON, make sure that
SOM 1091 is set to OFF. If SOM 1091 is set to
ON, set it to OFF first, and then set SOM 474
to ON.
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506 Universal
Replicator

This SOM is used to enable Delta Resync with no
host update I/O by copying only differential JNL
instead of copying all data.

The UR Delta Resync configuration is required.

Mode 506 = ON (default):
■ Without update I/O: Delta Resync is enabled.
■ With update I/O: Delta Resync is enabled.

Mode 506 = OFF:
■ Without update I/O: Total data copy of Delta

Resync is performed.
■ With update I/O: Delta Resync is enabled.

Note: Even when SOM 506 is set to ON, the Delta
Resync may fail and only the total data copy of the
Delta Resync function is allowed if the necessary
journal data does not exist on the primary storage
system used for the Delta Resync operation.

ON Both

556 Open Prevents an error code from being set in the 8 -
11th bytes in the standard 16-byte sense byte.

Mode 556 = ON: An error code is not set in bytes 8
- 11 in the standard 16-byte sense byte.

Mode 556 = OFF (default): An error code is set in
bytes 8 - 11 in the standard 16-byte sense byte.

OFF Both

589 Universal
Volume
Manager

When this SOM is ON, the frequency of progress
update of disconnection is changed.

Mode 589 = ON: For each external volume,
progress is updated only when the progress rate is
100%.

Mode 589 = OFF (default): Progress is updated
when the progress rate exceeds the previous level.

Notes:

1. Set this SOM to ON when disconnecting an
external volume while the specific host IO
operation is online and its performance
requirement is severe.

OFF Both
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2. Whether the disconnecting status for each
external volume is progressed or not cannot
be confirmed on Device Manager - Storage
Navigator (It indicates “-“until just before the
completion and at the last it changes to
100%).

689 TrueCopy

global-active
device

Allows you to slow the initial copy and resync
operations when the write-pending rate on the
RCU exceeds 60%.

Mode 689 = ON: The initial copy and resync copy
operations are slowed down when the Write
Pending rate on RCU exceeds 60%.

If the CLPR write pending rate where the initial
copy target secondary volume belongs to is not
over 60% but that of MP PCB where the S-VOL
belongs to is over 60%, the initial copy operation is
slowed down.

Mode 689 = OFF (default): The initial copy and
resync copy operations are not slowed down when
the Write Pending rate on RCU exceeds 60% (the
same as before).

OFF Both
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Notes:

1. This SOM can be set online.
2. The micro-programs on both MCU and RCU

must support this SOM.
3. This SOM should be set when requested by

the user.
4. Setting this SOM to ON is recommended when

GAD is installed, as the performance
degradation is more likely to occur due to
active-active I/Os.

5. If the write-pending status remains at 60% or
higher on the RCU for a long time, it takes
extra time for the initial copy and resync copy
to be completed due to the slower copy
operations.

6. If the write pending rate of CLPR to which the
initial copy target S-VOL belongs is not over
60% but that of MP PCB to which the S-VOL
belongs is over 60%, the initial copy operation
is slowed down.

7. Do not set this SOM if the primary or
secondary system is connected to USP V/VM
with microcode earlier than 60-02-xx. If this
SOM is applied and the write-pending rate
reaches 60%, pair suspend might occur.

690 Universal
Replicator

This SOM is used to prevent Read JNL or JNL
Restore when the Write Pending rate on RCU
exceeds 60% as follows:
■ When CLPR of JNL-Volume exceeds 60%, Read

JNL is prevented.
■ When CLPR of Data (secondary)-Volume

exceeds 60%, JNL Restore is prevented.

Mode 690 = ON: Read JNL or JNL Restore is
prevented when the Write Pending rate on RCU
exceeds 60%.

Mode 690 = OFF (default): Read JNL or JNL Restore
is not prevented when the Write Pending rate on
RCU exceeds 60% (the same as before).

OFF RCU
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Notes:

1. This SOM can be set online.
2. This SOM should be set per customer’s

requests.
3. If the Write Pending status long keeps 60% or

more on RCU, it takes extra time for the initial
copy to be completed by making up for the
prevented copy operation.

4. If the Write Pending status long keeps 60% or
more on RCU, the pair status may become
Suspend due to the JNL-Vol being full.

696 Open This SOM is available to enable or disable the QoS
function.

Mode 696 = ON: QoS is enabled. (In accordance
with the Share value set to SM, I/Os are scheduled.
The Share value setting from RMLIB is accepted)

Mode 696 = OFF (default): QoS is disabled. (The
Share value set to SM is cleared. I/O scheduling is
stopped. The Share value setting from host is
rejected.)

Note: Set this SOM to ON when you want to
enable the QoS function.

OFF -

701 Universal
Volume
Manager

Issues the Read command at the logical unit
discovery operation using UVM.

Mode 701 = ON: The Read command is issued at
the logical unit discovery operation.

Mode 701 = OFF (default): The Read command is
not issued at the logical unit discovery operation.

OFF -
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Notes:

1. When the external storage is TagmaStore
USP/NSC and the Open LDEV Guard attribute
(VMA) is defined on an external device, set this
SOM to ON.

2. When this SOM is set to ON, it takes longer
time to complete the LU discovery. The
amount of time depends on external storages.

3. With this SOM OFF, if searching for external
devices with VMA is set, the VMA information
cannot be read.

4. When this SOM is set to ON while the
following conditions are met, the external
volume is blocked:

■ An external volume to which Nondisruptive
migration (NDM) attribute is set exists.

■ The external volume is reserved by the
host

5. As the VMA information is TagmaStore USP/
NSC-specific, this SOM does not need to be
ON when the external storage is other than
TagmaStore USP/NSC.

6. Set this SOM to OFF when an external volume
to which nondisruptive migration (NDM)
attribute is set exists.

704 ShadowImage

Volume
Migration

To reduce the chance of MIH, this SOM can reduce
the priority of ShadowImage, Volume Migration, or
Resync copy internal IO requests so that host IO
has a higher priority. This SOM creates new work
queues where these jobs can be assigned with a
lower priority.

Mode 704 = ON: Copy processing requested is
registered into a newly created queue so that the
processing is scheduled with lower priority than
host I/O.

Mode 704 = OFF (default): Copy processing
requested is not registered into a newly created
queue. Only the existing queue is used.

OFF -
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Notes:

1. Apply this SOM when the load of host I/O to
an ECC that uses ShadowImage or Volume
Migration is high and the host I/O processing
is delayed.

2. If the PDEV is highly loaded, the priority of
Read/Write processing made by
ShadowImage, Volume Migration, or Resync
may become lower. As a consequence the
copy speed may be slower.

721 Common When a parity group is uninstalled or installed, the
following operation is performed according to the
setting of SOM 721.

Mode 721 = ON: When a parity group is
uninstalled or installed, the LED of the drive for
uninstallation is not illuminated, and the
instruction message for removing the drive does
not appear. Also, the windows other than that of
parity group, such as DKA or DKU, are unavailable
to select.

Mode 721 = OFF (default): When a parity group is
uninstalled or installed, the operation is as before:
the LED of the drive is illuminated, and the drive
must be unmounted and remounted.

Notes:

1. When the RAID level or emulation type is
changed for the existing parity group, this
SOM should be applied only if the drive
mounted position remains the same at the
time of the parity group uninstallation or
installation.

2. After the operation using this SOM is
completed, this SOM must be set back to OFF;
otherwise, the LED of the drive to be removed
will not be illuminated at subsequent parity
group uninstalling operations.

OFF -

725 Universal
Volume
Manager

This SOM determines the action that will be taken
when the status of an external volume is Not
Ready.

OFF -
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Mode 725 = ON: When Not Ready is returned, the
external path is blocked and the path status can be
automatically recovered (Not Ready blockade).
Note that the two behaviors, automatic recovery
and block, may be repeated.

When the status of a device is Not Ready blockade,
Device Health Check is executed after 30 seconds.

Mode 725 = OFF (default): When Not Ready is
returned three times in three minutes, the path is
blocked and the path status cannot be
automatically recovered (Response error blockade).

Notes:

1. Applying this SOM is prohibited when USP
V/VM is used as an external storage system
and its external volume is DP-VOL.

2. Applying this SOM is recommended when the
above condition (1) is not met and SUN
storage is used as an external storage.

3. Applying this SOM is recommended when the
above condition (1) is not met and EMC CX
series or Fujitsu Fibre CAT CX series is used as
an external storage.

4. Applying this SOM is recommended if the
above condition (1) is not met and a
maintenance operation such as firmware
update causing controller reboot is executed
on the external storage side while a storage
system other than Hitachi product is used as
an external storage system.

5. While USP V/VM is used as an external storage
system and its volume is DP-VOL, if some
Pool-VOLs constituting the DP-VOL are
blocked, external path blockade and recovery
occurs repeatedly.

6. When a virtual volume mapped by UVM is set
to pool-VOL and used as DP-VOL in local
storage system, this SOM can be applied
without problem.

729 Dynamic
Provisioning

Data
Retention
Utility

When a DP pool is full, if any write operation is
requested to the area where the page allocation is
not provided, this SOM can enable the DRU Protect
attribute for the target DP-VOL.

OFF -

System option modes

Appendix C: System option modes (SOMs)

System Administrator Guide for VSP E990 and VSP G130, G/F350, G/F370, G/F700, G/F900 263



Mode Category Description Default MCU/RCU

Mode 729 = ON: Set the DRU Protect attribute for
the target DP-VOL when any write operation is
requested to the area where the page allocation is
not provided at a time when the DP pool is full.
(Not to set in the case of Read request.)

Mode 729 = OFF (default): Do not set the DRU
Protect attribute for the target DP-VOL when any
write operation is requested to the area where the
page allocation is not provided at a time when DP
pool is full.

For details, contact customer support (see SOM729
& 803 sheet).

Notes:

1. This SOM is applied when:

■ The threshold of pool is high (for example,
95%) and the pool may be full.

■ File system is used.

■ Data Retention Utility is installed.

2. Since the Protect attribute is set for V-VOL, the
Read operation cannot be allowed as well.

3. When Data Retention Utility is not installed,
the desired effect is not achieved.

4. Protect attribute can be released from the
Data Retention window of Device Manager -
Storage Navigator after releasing the full
status of the pool by adding a Pool-VOL.

5. The Virtual Volume Protection (VVP) function
can be enabled/disabled for each pool. With
SOM 729 disabled, VVP is also disabled by
default, but you can enable VVP for each pool
as needed. With SOM 729 enabled, VVP is also
enabled automatically (by default) when you
create a new pool. Caution: A pool is NOT
protected by ANY FUNCTION if you
deliberately turn VVP for the pool from ON
(default) to OFF, even with SOM 729 enabled.

6. When HMO 63 or 73 is set to ON, the setting
of the HMO is prioritized over the SOM 729
setting, so that the behavior remains the
same as when SOM 729 is OFF even when it is
set to ON.
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734 Dynamic
Provisioning

When exceeding the pool threshold, the SIM is
reported as follows:

Mode 734 = ON: A SIM is reported at the time
when the pool usage rate exceeds the pool
threshold (warning, system, or depletion). Once the
pool usage rate falls below the pool threshold, and
then exceeds again, the SIM is reported again. If
the pool usage rate continues to exceed the
warning threshold and the depletion threshold, the
SIM (SIM-RC625000) is repeatedly reported every
eight (8) hours until the pool usage rate falls below
the depletion threshold.

Mode 734 = ON (default): A SIM is reported at the
time when the pool usage rate exceeds the pool
threshold (variable threshold or fixed threshold).
Once the pool usage rate falls below the pool
threshold, and then exceeds again, the SIM is
reported again. If the pool usage rate continues to
exceed the variable threshold and the fixed
threshold, the SIM (SIM-RC625000) is repeatedly
reported every eight (8) hours until the pool usage
rate falls below the higher threshold.

Mode 734 = OFF: A SIM is reported at the time
when the pool usage rate exceeds the pool
threshold (variable threshold or fixed threshold).
Once the pool usage rate falls below the pool
threshold, and then exceeds again, the SIM is
reported again. The SIM is not reported while the
pool usage rate continues to exceed both of the
variable threshold and the fixed threshold.

ON -

741 Dynamic
Provisioning

This SOM enables to switch over whether to report
the following SIM for users to the service
personnel:

SIM-RC 625000 (DP pool usage rate continues to
exceed the threshold)

Mode 741 = ON: SIM is reported to the service
personnel.

Mode 741 = OFF (default): SIM is not reported to
the service personnel.

OFF -
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Notes:

1. This SOM is set to ON to have SIM for users
reported to the service personnel:

■ For the system where SNMP and E-mail
notification are not set.

■ If Device Manager - Storage Navigator is
not periodically activated.

2. When SOM 734 is turned OFF, SIM-RC625000
is not reported; accordingly the SIM is not
reported to the service personnel even
though this SOM is ON.

745 Universal
Volume
Manager

Enables to change the area where the information
is obtained as the Characteristic1 item from
SYMMETRIX.

Mode 745 = ON:
■ The area where the information is obtained as

the Characteristic1 item from SYMMETRIX is
changed.

■ When CheckPaths or Device Health Check (1/
hour) is performed, the information of an
already-mapped external volume is updated to
the one after change.

Mode 745 = OFF (default):
■ The area where the information is obtained as

the Characteristic1 item from SYMMTRIX is set
to the default.

■ When CheckPaths or Device Health Check (1/
hour) is performed, the information of an
already-mapped external volume is updated to
the default.

OFF -
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Notes:

1. This SOM is applied when the EMC
SYMMETRIX is connected using UVM.

2. Enable the setting of EMC SCSI Flag SC3 for
the port of the EMC SYMMETRIX storage
connected with the storage system and
disable the setting of Flag SPC2. If the setting
of EMC SCSI Flag SC3 is not enabled or the
setting of Flag SPC2 is enabled, the effect of
this SOM may not be achieved.

3. If you want to enable this SOM immediately
after setting, perform Check Paths on each
path one by one for all the external ports
connected to the EMC SYMMETRIX storage.
But, without doing Check Paths, the display of
Characteristic1 can automatically be changed
by the Device Health Check to be performed
once an hour. If SSB=AD02 occurs and a path
is blocked, perform Check Paths on this path
again.

749 Dynamic
Provisioning

Dynamic
Tiering

Thin Image

This SOM disables the HDP Rebalance function and
the HDT Tier relocation function which allow the
drives of all ECC Groups in the pool to share the
load.

Mode 749 = ON: The HDP Rebalance function and
the HDT Tier relocation function are disabled.

Mode 749 = OFF (default): The HDP Rebalance
function and the HDT Tier relocation function are
enabled.

Notes:

1. This SOM is applied when no change in
performance characteristic is desired.

2. When a pool is newly installed, the load may
be concentrated on the installed pool
volumes.

3. When 0 data discarding is executed, load may
be unbalanced among pool volumes.

4. Pool VOL deletion while this SOM is set to ON
fails. To delete pool VOLs, set this SOM to OFF.

OFF -

757 Common Enables/disables output of in-band audit logs.

Mode 757 = ON: In-band audit log is not output.

OFF -
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Mode 757 = OFF (default): In-band audit log is
output.

Notes:

1. Mode 757 applies to the sites where
outputting the In-band audit logs is not
needed.

2. When this SOM is set to ON:

■ There is no access to SM for the In-band
audit logs, which can avoid the
corresponding performance degradation.

■ SM is not used for the In-band audit logs.

3. If outputting the In-band audit log is desired,
set this SOM to OFF.

784 TrueCopy

Global-active
device

This SOM can reduce the MIH watch time of RI/O
for a TC or GAD pair internally so that update I/Os
can continue by using an alternate path without
MIH or time-out occurrence in the environment
where Mainframe host MIH is set to 15 seconds, or
Open host time-out time is short (15 seconds or
less). This SOM is effective at initial pair creation or
Resync operation for TC or GAD. (Not effective by
just setting this SOM to ON.)

This SOM is applied to TC and GAD. This SOM
supports Fibre remote copy paths but not iSCSI.

Mode 784 = ON: The MIH time of RIO is internally
reduced so that, even though a path failure occurs
between storage systems in the environment
where host MIH time is set to 15 seconds, update
I/Os can be processed by using an alternate path
promptly, lowering the possibility of host MIH
occurrence.

Mode 784 = OFF (default): The operation is
processed in accordance with the TC or GAD
specification.

OFF Both
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Notes:

1. This SOM is applied to the environment where
Mainframe host MIH time is set to 15 seconds.

2. This SOM is applied to the environment where
OPEN host time-out time is set to 15 seconds
or less.

3. This SOM is applied to reduce RI/O MIH time
to 5 seconds.

4. This function is available for all the TC and
GAD pairs on the storage system, unable to
specify the pairs that are using this function or
not.

5. For a TC or GAD pair with this SOM effective
(RI/O MIH time is 5 seconds), the setting of
RI/O MIH time made at RCU registration
(default is 15 seconds, which can be changed
within range from 10 to 100 seconds) is
invalid. However, RI/O MIH time displayed on
Device Manager - Storage Navigator and CCI is
not “5 seconds” but is what set at RI/O
registration.

6. If a failure occurs on the switched path
between storage systems, Mainframe host
MIH or Open server time-out may occur.

7. If an MP to which the path between storage
systems belongs is overloaded, switching to
an alternate path delays and host MIH or
time-out may occur.

8. If an RI/O retry occurs due to other factors
than RI/O MIH (5 sec), such as a check
condition report issued from RCU to MCU, the
RI/O retry is performed on the same path
instead of an alternate path. If a response
delay to the RI/O occurs constantly on this
path due to path failure or link delay, host MIH
or time-out may occur due to response time
accumulation for each RI/O retried within 5
seconds.

9. Even though this SOM is set to ON, if
Mainframe host MIH time or Open host time-
out time is set to 10 seconds or less, host MIH
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or time-out may occur due to a path failure
between storage systems.

10. Operation commands are not available for
promptly switching to an alternate path.

11. This SOM works for the pair for which initial
pair creation or Resync operation is executed.

12. Micro-program downgrade to an unsupported
version cannot be executed unless all the TC
and GAD pairs are suspended or deleted.

13. For operational specifications in each
combination of MCU and RCU of TC, contact
customer support (see SOM784 sheet).

14. For GAD pairs, this SOM is effective if the
microcode version supports GAD.

15. This SOM does not support iSCSI paths
between storage systems. When iSCSI is used
for paths between storage systems, the time
to switch to an alternate path cannot be
reduced. For this, if a failure occurs on a path
between storage systems in an environment
where host time-out time is short, a time-out
may occur on the host side. A time-out may
also occur on the host side when a failure
occurs on an iSCSI path between storage
systems if storage system paths of Fibre and
iSCSI coexist in an environment where host
time-out time is short so that the
configuration where storage system paths of
Fibre and iSCSI coexist is not supported too.

803 Dynamic
Provisioning

Data
Retention
Utility

While a DP pool VOL is blocked, if a read or write
I/O is issued to the blocked pool VOL, this SOM can
enable the Protect attribute of DRU for the target
DP-VOL.

Mode 803 = ON: While a DP pool VOL is blocked, if
a read or write I/O is issued to the blocked pool
VOL, the DRU attribute is set to Protect.

Mode 803 = OFF (default): While a DP pool VOL is
blocked, if a read or write I/O is issued to the
blocked pool VOL, the DRU attribute is not set to
Protect.

For more details, contact customer support (see
SOM729 & 803 sheet).

OFF -
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Notes:

1. This SOM is applied when:

■ A file system using DP pool VOLs is used.

■ Data Retention Utility is installed.

2. Because the DRU attribute is set to Protect for
the V-VOL, a read I/O is also disabled.

3. If Data Retention Utility is not installed, the
expected effect cannot be achieved.

4. The Protect attribute of DRU for the DP V-VOL
can be released on the Data Retention
window of Device Manager - Storage
Navigator after recovering the blocked pool
VOL.

5. The Virtual Volume Protection (VVP) function
can be enabled/disabled for each pool. With
SOM 803 disabled, VVP is also disabled by
default, but you can enable VVP for each pool
as needed. With SOM 803 enabled, VVP is also
enabled automatically (by default) when you
create a new pool. Caution: A pool is NOT
protected by ANY FUNCTION if you
deliberately turn VVP for the pool from ON
(default) to OFF, even with SOM 803 enabled.

855 ShadowImage

Volume
Migration

By switching this SOM to ON/OFF when
ShadowImage is used with SOM 467 set to ON,
copy processing is continued or stopped as follows.

Mode 855 = ON: When the amount of dirty data is
within the range from 58% to 63%, the next copy
processing is continued after the dirty data created
in the previous copy is cleared to prevent the
amount of dirty data from increasing (copy after
destaging). If the amount of dirty data exceeds
63%, the copy processing is stopped.

Mode 855 = OFF (default): The copy processing is
stopped when the amount of dirty data is over
60%.

For details, contact customer support (see SOM855
sheet).

OFF -
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Notes:

1. This SOM is applied when all the following
conditions are met

■ ShadowImage is used with SOM 467 set to
ON.

■ Write pending rate of an MP unit that has
LDEV ownership of the copy target is high

■ Usage rate of a parity group to which the
copy target LDEV belongs is low.

■ ShadowImage copy progress is delayed.

2. This SOM is available only when SOM 467 is
set to ON.

3. If the workload of the copy target parity group
is high, the copy processing may not be
improved even if this SOM is set to ON.

867 Dynamic
Provisioning

Dynamic
Tiering

All-page reclamation (discarding all mapping
information between DP pool and DP volumes) is
executed in DP-VOL LDEV format. This new method
is enabled or disabled by setting this SOM to ON or
OFF.

Mode 867 = ON (default): LDEV format of the DP-
VOL is performed with page reclamation.

Mode 867 = OFF:LDEV format of the DP-VOL is
performed with 0 data writing.

Notes:

1. This SOM is applied from factory shipment.
2. Do not change the setting of this SOM during

DP-VOL format.
3. If the setting of this SOM is changed during

DP-VOL format, the change is not reflected to
the format of the DP-VOL being executed but
the format continues in the same method.

ON -

896 Dynamic
Provisioning

Dynamic
Tiering

Thin Image

This SOM enables or disables the background
format function performed on an unformatted
area of a DP/DT/TI pool.

For information regarding operating conditions,
see the Provisioning Guide.

Mode 896 = ON: The background format function
is disabled.

OFF -
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Mode 896 = OFF (default): The background format
function is enabled.

Notes:

1. This SOM is applied when a customer requires
the background format for a DP/DT/TI pool in
the environment where new page allocation
(in the case that system files are created from
a host for newly created multiple DP-VOLs, for
example) frequently occurs and the write
performance degrades because of an increase
in write pending rate.

2. When the background format function is
enabled, because up to 42 MB/s of ECCG
performance is used, local copy performance
may degrade by about 10%. Therefore,
confirm whether the 10% performance
degradation is acceptable or not before
enabling the function.

3. When a Dynamic Provisioning VOL on an
external storage system, which is used as an
external VOL, is used as a pool VOL, if the
external pool on the external storage side
becomes full due to the background format,
the external VOL may be blocked.

If the external pool capacity is smaller than
the external VOL capacity (Dynamic
Provisioning VOL of external storage system),
do not enable the background format
function.

4. If the background format function is disabled
by changing this SOM setting, the format
progress is initialized and the entire area
becomes unformatted.

5. The background format for FMC drives is not
disabled. When FMC drives are used, use SOM
1093.

899 Volume
Migration

In combination with the SOM 900 setting, this SOM
determines whether to execute and when to start
the I/O synchronous copy change as follows.

ON -
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Mode 899 = ON (default):
■ SOM 900 is ON: I/O synchronous copy starts

without retrying Volume Migration.
■ SOM 900 is OFF: I/O synchronous copy starts

when the threshold of Volume Migration retry is
 exceeded. (Recommended)

Mode 899 = OFF:
■ SOM 900 is ON: I/O synchronous copy starts

when the number of retries reaches half of the
threshold of Volume Migration retry.

■ SOM 900 is OFF: Volume Migration is retired and
I/O synchronous copy is not executed.

Notes:

1. This SOM is applied when improvement of
Volume Migration success rate is desired
under the condition that there are many
updates to a migration source volume of
Volume Migration.

2. During I/O synchronous copy, host I/O
performance degrades.

900 Volume
Migration

In combination with SOM 899 setting, this SOM
determines whether to execute and when to start
the I/O synchronous copy change as follows.

Mode 900 = ON:
■ SOM 899 is ON: I/O synchronous copy starts

without retrying Volume Migration.
■ SOM 899 is OFF: I/O synchronous copy starts

when the number of retries reaches half of the
threshold of Volume Migration retry.

Mode 900 = OFF (default):
■ SOM 899 is ON: I/O synchronous copy starts

when the threshold of Volume Migration retry is
exceeded. (Recommended)

■ SOM 899 is OFF: Volume Migration is retired and
I/O synchronous copy is not executed.

OFF -
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Notes:

1. This SOM is applied when improvement of
Volume Migration success rate is desired
under the condition that there are many
updates to a migration source volume of
Volume Migration.

2. During I/O synchronous copy, host I/O
performance degrades.

901 Dynamic
Tiering

By setting this SOM to ON or OFF, the page
allocation method of Tier Level ALL when the drive
type of tier1 is SSD changes as follows.

Mode 901 = ON: For tier1 (drive type is SSD), pages
are allocated until the capacity reaches the limit.
Without consideration of exceeding performance
limitation, allocation is done from highly loaded
pages until reaching the capacity limit

When the capacity of tier1 reaches the threshold
value, the minimum value of the tier range is set to
the starting value of the lower IOPH zone, and the
maximum value of the lower tier range is set to the
boundary value.

Mode 901 = OFF (default): For tier1 (drive type is
SSD), page allocation is performed based on
performance potential limitation. With
consideration of exceeding performance limitation,
allocation is done from highly loaded pages but at
the point when the performance limitation is
reached, pages are not allocated any more even
there is free space.

When the capacity of tier1 reaches the threshold
value, the minimum value of the tier range is set to
the boundary value, and the maximum value of the
lower tier range is set to a value of boundary-value
× 110% + 5 [IOPH].

OFF -
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Notes:

1. This SOM is applied when pages with the
maximum capacity need to be allocated to
tier1 (drive type is SSD) with Dynamic Tiering.

2. When Tier1 is SSD while SOM 901 is set to ON,
the effect of SOM 897 and 898 to the gray
zone of Tier1 and Tier2 is disabled and the
SOM 901 setting is enabled instead. In
addition, the settings of SOM 897 and 898 are
effective for Tier2 and Tier3.

3. The following is recommended when applying
SOM 901.

actual I/O value (total number of I/Os of all
tiering policies) < performance potential value
of Tier1* × 0.6

* The performance potential value of Tier1
displayed on Monitor information by using
Dx-ray.

For more details about the interactions between
SOMs 897, 898, and 901, contact customer support
(see SOM897_898_901 sheet).

904 Dynamic
Tiering

By setting this SOM to ON or OFF, the number of
pages to be migrated per unit time at tier
relocation is changed.

Mode 904 = ON: The number of pages to be
migrated at tier relocation is set to up to one page
per second.

Mode 904 = OFF (default):No restriction on the
number of pages to be migrated at tier relocation
(existing specification).

Notes:

1. This SOM is applied when the requirement for
response time is severe.

2. The number of pages to be migrated per unit
time at tier relocation decreases.

OFF -

908 Universal
Replicator

This SOM can change CM capacity allocated to
MPBs with different workloads.

Mode 908 = ON: The difference in CM allocation
capacity among MPBs with different workload is
large.

OFF Both
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Mode 908 = OFF (default): The difference in CM
allocation capacity among MPBs with different
workload is small (existing operation) .

Notes:

1. If a CLPR is used by only some MPBs among
all the installed MPBs, set this SOM to ON for
the CLPR to increase CM capacity allocated to
the MPBs that use the CLPR.

Example:

(a) A CLPR only for UR JNLG.

(b) A configuration where MPBs and CLPRs are
separately used for Open and Mainframe
systems.

2. Since CM capacity allocated to MPBs with low
load is small, the performance is affected by a
sudden increase in load.

3. SOM 908 cannot be used with SOM 933. When
SOM 933 is set to ON, the function of SOM
908 is canceled even though SOM 908 is ON.

4. This SOM is effective for a CLPR. Therefore,
when setting this SOM to ON/OFF, select
target "LPRXX (XX=00 to 31)". For example,
even when CLPR0 is defined (any of CLPR1 to
31 are not defined), select “LPR00” first and
then set this SOM to ON/OFF.

930 Dynamic
Provisioning

Dynamic
Tiering

ShadowImage

When this SOM is set to ON, all of the zero data
page reclamation operations in processing are
stopped. (Also the zero data page reclamation
cannot be started.)

* Zero data page reclamation by WriteSame and
UNMAP functions, and IO synchronous page
reclamation are not disabled.

Mode 930 = ON: All of the zero data page
reclamation operations in processing are stopped
at once. (Also the zero data reclamation cannot be
newly started.)

Mode 930 = OFF (default): The zero data page
reclamation is performed.

For details about interactions with SOM 755,
contact customer support (see SOM930 sheet).

OFF -

System option modes

Appendix C: System option modes (SOMs)

System Administrator Guide for VSP E990 and VSP G130, G/F350, G/F370, G/F700, G/F900 277



Mode Category Description Default MCU/RCU

Notes:

1. This SOM is applied when stopping or
disabling zero data page reclamation by user
request is required.

2. When this SOM is set to ON, the zero data
page reclamation does not work at all.

* Zero data page reclamation by Write Same
and UNMAP, and IO synchronous page
reclamation can work.

3. When downgrading micro-program to a
version that does not support this SOM while
this SOM is set to ON, set this SOM to OFF
after the downgrade.

* Because the zero data page reclamation
does not work at all while this SOM is set to
ON.

4. This SOM is related to SOM 755.

937 Dynamic
Provisioning

Dynamic
Tiering

By setting this SOM to ON, HDT monitoring data is
collected even if the pool is a DP pool.

Mode 937 = ON: HDT monitoring data is collected
even if the pool is a DP pool.

Only Manual execution mode and Period mode are
supported.

Mode 937 = OFF (default): HDT monitoring data is
not collected if the pool is a DP pool

OFF -
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Notes:

1. This SOM is applied when HDT monitoring
data collection is required in DP environment.

2. When HDT is already used, do not set this
SOM to ON.

3. For HDT monitoring data collection, shared
memory for HDT must be installed. For
details, contact customer support (see
SOM937 sheet).

4. If monitoring data collection is performed
without shared memory for HDT installed, an
error is reported and the monitoring data
collection fails.

5. Before removing the shared memory for HDT,
set this SOM to OFF and wait for 30 minutes.

6. Tier relocation with monitoring data collected
when this SOM is set to ON is disabled.

7. When DP is converted into HDT (after
purchase of software license), the collected
monitoring data is discarded.

8. Before downgrading the micro-program to an
unsupported version, set SOM 937 to OFF and
wait for at least 30 minutes.

972 Common By setting this SOM, THP Page Size in Inquiry Page
E3h is changed. THP Page Size varies depending on
the combination of SOM 972 and 973 settings. For
details, contact customer support (see
SOM972_973 sheet).

Notes:

1. This SOM is applied when a delay in host I/O
response due to reclamation processing
occurs in a customer environment.

2. Reclamation processing is delayed.
3. This SOM is to prioritize host I/O response

over reclamation processing in VxVM
environment, so that the time required for
reclamation processing may increase when
this SOM is set to ON.

For details about the interaction between this SOM
and SOM 1069, contact customer support (see
SOM1069 sheet).

OFF -
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973 Common By setting this SOM, THP Page Size in Inquiry Page
E3h is changed. THP Page Size varies depending on
the combination of SOM972 and 973 settings. For
details, contact customer support (see
SOM972_973 sheet).

Notes:

1. This SOM is applied when a delay in host I/O
response due to reclamation processing
occurs in a customer environment.

2. When this SOM is set to ON, reclamation
processing is delayed.

3. This SOM is to prioritize host I/O response
over reclamation processing in VxVM
environment, so that the time required for
reclamation processing may increase when
this SOM is set to ON.

For details about the interaction between this SOM
and SOM 1069, contact customer support (see
SOM1069 sheet).

OFF -

1015 Universal
Replicator

When a delta resync is performed in a 3DC multi-
target configuration with TC and UR, this SOM is
used to change the pair status to PAIR/Duplex
directly and then complete the delta resync. If the
delta resync fails and all differential data items are
copied, the pair status changes to COPY/Pending
regardless of the SOM 1015 setting, and then it
changes to PAIR/Duplex.

When the existing delta resync function is required
(pair status changes to COPY/Pending and then to
PAIR/Duplex), set this SOM to ON before
performing delta resync. If SOM 1015 is set (ON or
OFF) while delta resync is being peformed, the
setting is not applied.

Mode 1015 = ON: The pair status changes to
COPY/Pending and then to PAIR/Duplex when a
delta resync is performed in a 3DC multi-target
configuration.

Mode 1015 = OFF (default): The pair status
changes directly to PAIR/Duplex when a delta
resync is performed in a 3DC multi-target
configuration.

Notes:

OFF MCU

System option modes

Appendix C: System option modes (SOMs)

System Administrator Guide for VSP E990 and VSP G130, G/F350, G/F370, G/F700, G/F900 280



Mode Category Description Default MCU/RCU

1. The pair status changes directly to PAIR/
Duplex when this SOM is OFF (default). Set
this SOM to ON only when the status change
to COPY/Pending and then PAIR/Duplex is
required.

2. Set this SOM on the site of TC S-VOL in TC-UR
3DC configuration. If site switch by delta
resync might occur, set this SOM on both TC
primary and secondary sites.

3. For microcode versions and storage system
models that do not support this SOM, even if
this SOM is set to OFF on L site of TC-UR delta
configuration, the behavior does not change
but the status changes to COPY/Pending and
then the delta resync is completed.

4. Regardless of the remote command device
setting, the copy status does not change to
COPY/Pending and then the delta resync is
completed.

5. If a delta resync fails, all-data copy works. In
this case, the pair status changes to COPY/
Pending and then the delta resync is
completed even when this SOM is set to OFF.

6. When this SOM setting is default (OFF), a delta
resync operation is completed without pair
status change to COPY/Pending. Therefore, if
an operation depends on the pair status
changing to COPY/Pending, such as running
the CCI pairevtwait command, set this SOM to
ON.

7. When this SOM setting is default (OFF) (pair
status changes directly to PAIR/Duplex), SIMs
and SSBs that are reported due to a pair
status change to COPY/Pending are not
reported.

8. If this SOM is set to ON or OFF during delta
resync, the setting is not applied. Change this
SOM setting before delta resync.

9. During delta resync, downgrading the
microcode to a version that does not support
this SOM is disabled in TC-UR delta
configuration. If microcode downgrade is
disabled (FunctionID:0701) when delta resync
is not in process, suspend the UR pair and
then retry the microcode replacement.
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1021 Universal
Volume
Manager

This SOM can enable or disable the auto-recovery
for external volumes of an EMC storage system.

Mode 0121 = ON: An external volume that is
blocked due to Not Ready status can be recovered
automatically regardless of the type of external
storage system.

Mode 1021 = OFF (default): An external volume
that is blocked due to Not Ready status might not
be recovered automatically depending on the type
of external storage system.

Notes:

1. This SOM is applied when the auto-recovery of
external volumes that are blocked due to Not
Ready status is desired in UVM connection
using an ECM storage system as an external
storage system.

2. When this SOM is set to ON and the
connected external storage system is not in
stable status (such as failure and recovery
from failure), a blockage due to Not Ready
status and auto-recovery might occur
repeatedly.

OFF -

1043 Universal
Replicator

This SOM disables journal copy.

Mode 1043 = ON: When the following conditions
are met at the UR secondary site, the journal copy
is disabled.

For VSP G/F350, G/F370, G/F700, G/F900, the
following conditions (1) and (2) or (1) and (3) are
met:

1. 4,096 or more journals are accumulated at the
secondary site.

2. The CLPR write pending rate for journal
volumes of MP unit for which journal
ownership at the RCU is defined is 25% or
higher (including the write pending rate for
other than journal volumes).

3. The initiator operating rate of the MP unit for
which journal ownership at the RCU is defined
is 40% or higher.

OFF Both
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Note: Even though the above conditions are met,
journal copy is not disabled when all time stamps
of the journals accumulated are the same in a
consistency group containing multiple journals.

Mode 1043 = OFF (default): The journal copy is
not disabled.

Notes:

1. This SOM applies when one of the following
conditions is met:

a. Multiple journals are registered in a
consistency group of CCI.

b. Multiple journals are registered in an
extended consistency group.

c. Journals are accumulated at the
secondary site, causing the system
performance to decrease.

2. If SOM 690 is set to ON and the Write Pending
rate is 60% or higher, the journal copy is
disabled regardless of the setting of this SOM.

3. When the host write speed is faster than the
JNL copy speed, the usage rate of the master
journal increases.

4. This SOM is effective within the range of each
CLPR. Therefore, an operation target LPRxx
(xx= 00 to 31) needs to be selected before
setting this SOM to ON/OFF.

For example, when setting this SOM only to
CLPR0 (even though this SOM is not set to
CLPR 1 to 31), select "LPR00" and then set this
SOM to ON/OFF. If "System" is selected and
then this SOM is set to ON, this SOM is not
effective for any of the CLPRs.

5. Set SOM 1043 to ON when journals are not
accumulated at the RCU. If journals have
already been accumulated at the RCU, journal
copy does not start until the journal usage
rate becomes 0%. (If you need to set SOM
1043 to ON while journals are accumulated,
set Purge Suspend, and then perform resync.)

1067 Universal
Replicator

This SOM is used to enable microcode downgrade
to a version that does not support URxUR
(including delta).

OFF Both
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Mode 1067 = ON: Even when a UR pair has been
registered, downgrading the microcode to a
version that does not support URxUR (including
delta) is allowed.

Mode 1067 = OFF (default): If any UR pair has
been registered, downgrading the microcode to a
version that does not support URxUR (including
delta) is not allowed.

Notes:

1. This SOM is applied to enable microcode
downgrade to a version that does not support
URxUR (including delta) if the configuration
where any UR pair has been registered is not
URxUR (including delta).

2. Setting this SOM to ON allows microcode
downgrade at sites where only 1 mirror is
used in URxUR multi-target configuration
without delta resync and cascade
configuration (L or R site in multi-target, and P
or R site in cascade), but the following
phenomena occur after microcode
downgrade. Make sure that the target storage
system does not contain pairs of URxUR
configuration.

Phenomena:

a. When the microcode is downgraded at S
site (local or remote) in multi-target
configuration, the pair between P site
and the target S site cannot be
resynchronized.

b. When the pair between I site and R site in
cascade configuration is resynchronized,
the pair status cannot change from COPY
to PAIR.

c. When the microcode is downgraded at R
site in cascade configuration, the pair
between I site and R site cannot be
resynchronized.

1068 Common This mode can detect and report a minor drive
response delay early by severely checking drives.

Mode 1068 = ON: Drive response delay is checked
and detected with conditions that are more severe
than current conditions.

OFF -
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When SOM 144 is set to ON, the drive with
response delay is blocked.

Target drive: HDD, FMD, SSD

Mode 1068 = OFF: Drive response delay is checked
and detected with current conditions.

The behavior varies depending on the
combinations of SOM settings. For details, contact
customer support (see SOM144 sheet).

Notes:

1. Apply this mode to detect a minor delay in
drive response.

2. When a delay is suspected, a processing to
refer to the statistics data and determine the
delay works.

3. If SOM 157 is set to ON, the output prevention
status of SSB=A4CE is not cleared in one-day
cycle.

4. When applying this mode only, a SIM for delay
detection is reported but the HDD is not
blocked. To block the HDD, SOM 144 also
needs to be applied.

1069 Common By setting this SOM, the INQUIRY Page E3h field is
changed. The field varies depending on the
combination of SOMs 972, 973, and 1069. For
details, contact customer support (see SOM1069
sheet).

Notes:

1. This SOM is applied when the page problem
occurs in an environment where Symantec
ASL 6.0.5 or higher is used and SOM 972
and/or 973 is set to ON.

2. When this SOM is set to ON, reclamation
processing is delayed.

3. The priority of setting when SOMs are set at
the same time is SOM 1069, 972, and then
973. The setting of higher priority SOM is
enabled.

OFF -

1070 Global-active
device

This SOM changes the processing for a group
operation with GAD consistency group (CTG).

Mode 1070 = ON: The status change of all pairs in
a consistency group. is performed for 50 msec.

OFF Both
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Mode 1070 = OFF (default): The status change of
all pairs in a consistency group is performed for 1
msec.

Notes:

1. This SOM is applied when reducing the time to
complete status change of all pairs in a
consistency group at a group operation
(suspension and resync operation) with the
GAD CTG function. In a system configuration
where host I/O performance is prioritized, do
not use this SOM because setting this SOM
may affect the host I/O performance.

2. The MP usage rate increases during status
change of all pairs in a consistency group. For
details about approximate percentage
increase in MP usage rate, contact customer
support (see SOM1070 sheet).

1080 Global-active
device

Universal
Volume
Manager

This SOM is intended for a case that multiple
external connection paths are connected to a
Target port on an external system with a quorum
disk and there is a path whose performance
degrades. For such a case, this SOM can eliminate
impacts on commands run for other external
devices that share the Target port with the quorum
disk on the external system by setting the time to
run a reset command for the Target port to be the
same (15 seconds) as that to run other commands
for the other external devices.

Mode 1080 = ON: The time to run the reset
command for the quorum disk on the external
system is 15 seconds to eliminate the impacts on
commands run for the other external devices that
share the Target port with the quorum disk on the
external system.

If a response to ABTS is delayed for 12 seconds or
longer, the quorum disk may be blocked.

Mode 1080 = OFF (default): The time to run a
reset command for the quorum disk when
performance of a path degrades is 3 seconds so
that a retry is performed by an alternate path to
avoid quorum disk blockage.

OFF -
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Notes:

1. This SOM is applied if avoiding impacts on
commands for other external devices sharing
a Target port on an external system side with
a quorum disk is prioritized over preventing
quorum disk blockage when a response to
ABTS is delayed.

The delay is caused due to path performance
degradation in a configuration where the
Target port is shared between external
devices and the quorum disk.

2. When connection performance degradation
occurs, the quorum disk blockage is more
likely to occur.

1083 Dynamic
Provisioning

Universal
Volume
Manager

This SOM enables or disables DP-VOL deletion
while an external volume associated with the DP-
VOL with data direct mapping attribute is not
disconnected.

Mode 1083 = ON: DP-VOL deletion is enabled.

Mode 1083 = OFF (default): DP-VOL deletion is
disabled.

Notes:

1. This SOM is applied when the following
conditions are met.

■ A DP-VOL with data direct mapping
attribute is deleted.

■ The data of external volume with data
direct mapping attribute associated with a
deletion target DP-VOL with data direct
mapping attribute will not be used again.

2. When SOM 1083 is set to ON, the data of
external volumes cannot be guaranteed.

3. When DP-VOL deletion is performed without
disconnecting an external volume, the data of
the external volume cannot be guaranteed.

OFF -

1093 Dynamic
Provisioning

Dynamic
Tiering

Thin Image

(VSP G130, G/F350, G/F370, G/F700, G/F900) This
SOM is used to disable background unmap during
microcode downgrade from a version that
supports pool reduction rate correction to a
version that does not support the function.

OFF -
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Mode 1093 = ON: Background unmap cannot
work.

Mode 1093 = OFF (default): Background unmap
can work.

This SOM is applied when downgrading microcode
from a version that supports pool reduction rate
correction to a version that does not support the
function is disabled.

Caution: When pool capacity shrinking is
performed for an FMD parity group while this
mode is set to ON, the pool capacity shrinking
cannot be completed. Make sure to set this mode
to OFF before performing pool capacity shrinking
for an FMD parity group.

1096 Universal
Replicator

This SOM disables read-journal frequency
reduction.

Mode 1096 = ON: The read-journal frequency
reduction does not work.

Mode 1096 = OFF (default): The read-journal
frequency reduction works.

Notes:

1. This SOM is applied when a significant delay,
which is about 200 msec or longer, occurs in
the line between MCU and RCU.

2. When this SOM is set to ON while round-trip
delay time is small (about less than 20 msec),
the usage rate of RCU Initiator increases by
10% x the number of journals.

3. Even though this SOM is supposed to be
applied to UR RCU, apply it to both MCU and
RCU on the premise of DR operation.

4. This SOM is effective for each CLPR, so that
select the operation target LPRxx (xx=00 to
31), and then set this SOM to ON/OFF. For
example, when only CLPR0 is defined (CLPR1
to 31 are not defined), select LPR00 and then
set this SOM to ON/OFF. This SOM is not
effective for any CLPRs if “System” is selected
even when this SOM is set to ON.

OFF Both

1097 Common This SOM disables the warning LED to blink when
specific SIMs are reported.

ON -
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Mode Category Description Default MCU/RCU

Mode 1097 = ON (default): When SIM=452XXX,
462XXX, 3077XY, 4100XX, or 410100 is reported, the
warning LED does not blink.

Mode 1097 = OFF: When SIM=452XXX, 462XXX,
3077XY, 4100XX, or 410100 is reported, the
warning LED blinks.

Note: This SOM disables the warning LED to blink
when specific SIMs are reported.

1106 Dynamic
Provisioning

Dynamic
Tiering

On VSP G130, G/F350, G/F370, G/F700, G/F900, this
SOM is used to monitor the page usage rate of
parity groups defined to a pool, and perform
rebalance (the same as the rebalance that works at
pool expansion or after 0 data page reclamation) to
balance the usage rate if the rate differs
significantly among parity groups. On VSP E990,
this SOM is used to perform rebalance even when
the number of reclaimed pages is 0 after 0 data
page reclamation.

Mode 1106 = ON: The rebalance (the same as the
rebalance that works at pool expansion or after 0
data page reclamation) (*3) works when the
following condition (1) is met (VSP G130, G/F350, G/
F370, G/F700, G/F900) or when one of the following
conditions is met (VSP E990):

1. The usage rate is checked for parity groups in
a pool once a day, and the usage rate is not
balanced (*1) among parity groups.

2. After 0 data page reclamation, the number of
reclaimed pages is 0 (*2).

Mode 1106 = OFF (default): The rebalance does
not work even when the usage rate is not
balanced.

*1: How to determine whether usage rate is
unbalanced among parity groups

The pool usage rate is determined as unbalanced
when there is 25% or more difference between the
usage rate of each parity group in the pool and the
average.

OFF -
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Mode Category Description Default MCU/RCU

Note: The term "page usage rate" refers to the
percentage of the number of assigned pages in
each PG compared to the total number of pages in
the pool. For HDT pools, the term "total number of
pages" is the number of pages assigned within
each specific tier.

Examples:

1. In an HDP pool, if the usage rates of PG1, PG2,
and PG3 are 50%, 40%, and 30% respectively,
it is not determined as unbalanced.

Because the average parity group usage rate
is (50%＋ 40%＋ 30%) / 3 ＝ 40% and the
difference in the rate between each parity
group and the average is 10% at the
maximum.

2. In an HDP pool, if the usage rates of PG1, PG2,
and PG3 are 80%, 40%, and 30% respectively,
it is determined as unbalanced.

Because the average parity group usage rate
is (80%＋ 40%＋ 30%) / 3 ＝ 50% and the
difference in the rate between each parity
group and the average is 30% at the
maximum.

3. In an HDT pool, if the usage rates of PG1, PG2,
and PG3 are 80% (SSD), 40% (SAS15K) and
30% (SAS15K), it is not determined as
unbalanced, because:

■ The average parity group usage rate of
Tier1 is (80%) / 1 ＝ 80% and the difference
in the rate between the parity group and
the average is 0%.

■ The average parity group usage rate of
Tier2 is (40%＋ 30%) / 2 ＝ 35% and the
difference in the rate between the parity
group and the average is 5% at the
maximum.

*2: Condition for rebalance after 0 data page
reclamation

(VSP G130, G/F350, G/F370, G/F700, G/F900)
Regardless of the mode setting, rebalance works
when one or more pages are reclaimed at 0 data
page reclamation.
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(VSP E990) When the mode is set to ON, rebalance
works even when reclaimed page is 0 at 0 data
page reclamation.

Note: This SOM is applied when balancing the
usage rate is required at a customer site where the
usage rate is not even.

1113 Deduplication
and
Compression

If a problem occurs while the capacity saving
function is enabled and the MP usage rate needs
to be reduced to identify the failure, use this mode
to stop asynchronous processing of host I/Os by
the capacity saving function other than garbage
collection and de-staging.

Mode 1113 = ON: The asynchronous processing of
host I/Os by the capacity saving function, other
than garbage collection and de-staging, is stopped.

Note: While the capacity reduction processing is
not working, the capacity saving rate might
degrade.

Mode 1113 = OFF (default): The capacity saving
function fully works.

Relationship between SOM 1113 and SOM 1112:
When both modes are set to ON, the setting of
SOM 1112 is prioritized over that of SOM 1113.
When SOM 1112 is set to ON, all asynchronous
processing for host I/Os among those related to
the capacity saving function are stopped, including
garbage collection and de-staging, so that write
I/Os to V-VOLs with Compression or Deduplication
and Compression set are disabled.

OFF -

1115 Deduplication
and
Compression

When this SOM is set to ON, data is initialized
without using metadata at LDEV format for a
virtual volume with capacity saving enabled.

Caution: Use SOM 1115 only when performing
recovery procedures. This SOM is used only when
performing recovery procedures described in the
Maintenance Manual. Contact customer support
before enabling SOM 1115.

Mode 1115 = ON: When LDEV format is performed
for a virtual volume whose capacity saving setting
is Compression, the data is initialized without using
the metadata.

OFF -
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Mode 1115 = OFF (default): When LDEV format is
performed for a virtual volume whose capacity
saving setting is Compression, normal formatting is
performed, but if one of the following conditions is
met, the data is initialized without using metadata.
■ There is a pinned slot.
■ The capacity saving status is “Failed”.
■ The virtual volume is blocked (Normal restore

cannot be performed).

Notes:

1. Apply this SOM only when performing
recovery procedures. For details about when
to turn SOM 1115 on and off, see the
instructions in the Maintenance Manual.

2. The processing time increases with increase in
pool capacity.

Estimate of processing time:

Processing time (minutes) = ceiling(pool
capacity (TB)/40) + 5

ceiling: The value enclosed in ceiling( ) must
be rounded up to the nearest whole number.

The processing finishes early if there is less
capacity of allocated pages.

3. Do not change this SOM setting during LDEV
format for a virtual volume whose capacity
saving setting is Compression. If the setting is
changed, the processing cannot be performed
correctly and may end abnormally depending
on the timing.

4. This SOM is effective only for LDEV format for
a virtual volume whose capacity saving setting
is Compression, so that there is no side effect
in relation to user data, but the processing
may take more time than that when this SOM
is set to OFF depending on the pool capacity.
Therefore, do not use this SOM for cases
other than pool volume blockage recovery.

1118 Open This SOM is used to disable the ENC reuse
function.

OFF -
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Mode 1118 = ON: When a failure occurs in the
Expander chip mounted on a controller board
(CTLS, CTLSE) or an ENC board, the reuse function
does not work but SIM=CF12XX is reported and the
ENC is blocked.

Mode 1118 = OFF (default): When a failure occurs
in the Expander chip mounted on a controller
board (CTLS, CTLSE) or an ENC board, the reuse
function works.

If the ENC is reusable, SIM=CF12XX and then
CF14XX are reported, and the ENC is reused.

If the ENC is not reusable, SIM=CF12XX is reported,
and the ENC is blocked.

Note: The ENC reuse function is enabled as
default. This SOM is applied when you want to
disable the ENC reuse function.

1169 Deduplication
and
Compression

This SOM is used to enable and disable
deduplication during resync processing (TC, SI, and
so on) to change the priority between target
recovery time and deduplication.

Mode 1169 = ON: Deduplication processing is not
performed during resync processing.*

Mode 1169 = OFF: Deduplication processing is
performed during resync processing.

* Deduplication processing might be performed in
the following cases even when SOM 1169 is set to
ON to control free capacity consumption:
■ Free pool capacity is lower than about 240 GB,

or free pool capacity is low. When the free pool
capacity is low, the usage rate might exceed the
warning threshold.

■ Specific volumes with compression or
deduplication and compression enabled have
high usage or contain many data items that
cannot be compressed.

OFF -
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Notes:

1. When SOM 1280 is ON, deduplication
processing is performed even when SOM
1169 is ON.

2. If conditions to disable deduplication
processing by SOM 1191 are met,
deduplication processing is not performed
even when SOM 1169 is OFF. For details about
the conditions to disable deduplication
processing, contact customer support (see
SOM1191 sheet).

3. When SOM 1169 is set to ON, like the post
mode, estimating and reserving the capacity
of a temporary storing area in the copy target
DP volume or pool in advance is necessary.

4. SOM 1169 is not effective for the initial copy at
pair creation, but there are some exceptional
cases for SI and VM, such as pair creation
using a used volume for S-VOL. In this case,
deduplication processing is performed or not
performed according to the mode setting.

5. SOM 1169 is not related to determining
whether to perform deduplication processing
in synchronization with initial write. For
example, the setting of SOM 1169 does not
contribute to a reduction in time to migrate
data to a newly defined volume.

1174 Open

Universal
Volume
Manager

This SOM is used to disable a path that is logged in
from a host or an external storage system (host
path and external path) to be used as an external
path.

Mode 1174 = ON: A path logged in from a host or
an external storage system is excluded from the
WWN discovery target.

Mode 1174 = OFF:A path logged in from a host or
external storage system is included in the WWN
discovery target.

OFF -
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Notes:

1. Apply SOM 1174 when discovery is performed
while specifying a universal port that is being
logged in from a host or an external storage
system.

2. If SOM 1174 is set to ON, external volumes
cannot be created using the paths being
logged in from hosts and external storage
systems.

3. If WWN discovery is performed while SOM
1174 is set to ON, the storage system being
logged in from hosts and external storage
systems are displayed as [Unknown] in the
discovery result.

1180 Common (VSP G130, G/F350, G/F370, G/F700, G/F900) This
SOM determines when SSB=A4DB is logged for a
drive whose response is delayed.

Mode 1180 = ON: SSB=A4DB is logged when a
delayed response is detected once. The SSB is
logged once an hour per drive.

Mode 1180 = OFF: SSB=A4DB is not logged until a
delayed response is detected four times in a row
(existing behavior).

Note: Apply this mode when detecting drives
whose response tends to be delayed is required
and dump information is not available. This mode
can be used for criteria to determine whether to
replace a drive with response delay when a
performance issue occurs.

OFF -

1198 TrueCopy

Universal
Replicator

global-active
device

To expand TC, UR, and GAD pair capacity, the
difference management method must be changed
from shared memory (SM) difference management
to hierarchical difference management. This mode
is used to enable changing the difference
management method by using CCI. The difference
management method is changed at the first TC,
UR, or GAD pair creation or resync operation after
setting this mode.

Mode 1198 = ON: The difference management
method for volumes of 4 TB or less used in TC, UR,
or GAD pairs is changed to hierarchical difference
management regardless of SOM 5, SOM 6, and
SOM 1199 settings.

OFF Both
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Mode 1198 = OFF:
■ When SOM 1198 is OFF and SOM 1199 is ON,

the difference management method for
volumes of 4 TB or less used in TC, UR, or GAD
pairs is changed to SM difference management.

■ When both SOM 1198 and SOM 1199 are OFF,
the difference management method is not
changed.

Note:

1. Apply this mode when the storage system
does not have an SVP and you want to expand
the capacity of volumes used in TC, UR, or
GAD pairs.

2. Changing the difference management method
can affect the I/O response performance
depending on the I/O pattern.

3. Changing the difference management method
can affect the initial copy time depending on
the conditions.

1199 TrueCopy

Universal
Replicator

global-active
device

This mode is used to enable changing the
difference management method from hierarchical
difference management back to SM difference
management if necessary for some reasons after
the method was changed to hierarchical difference
management by setting SOM 1198 to ON. The
difference management method is changed at the
first TC, UR, or GAD pair creation or resync
operation after setting this mode.

Mode 1199 = ON:
■ When both SOM 1199 and SOM 1198 are ON,

the difference management method for
volumes of 4 TB or less used in TC, UR, or GAD
pairs is changed to hierarchical difference
management regardless of SOM 5 and 6
settings.

■ When SOM 1199 is ON and SOM 1198 is OFF,
the difference management method for
volumes of 4 TB or less used in TC, UR, or GAD
pairs is changed to SM difference management
regardless of SOM 5 and 6 settings.

OFF Both
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Mode 1199 = OFF:
■ When SOM 1199 is OFF and SOM 1198 is ON,

the difference management method for
volumes of 4 TB or less used in TC, UR, or GAD
pairs is changed to hierarchical difference
management regardless of SOM 5 and 6
settings.

■ When both SOM 1199 and SOM 1198 are OFF,
the difference management method is not
changed.

Note:

1. Apply this mode when the storage system
does not have an SVP and you want to expand
the capacity of volumes used in TC, UR, or
GAD pairs.

2. Changing the difference management method
can affect the I/O response performance
depending on the I/O pattern.

3. Changing the difference management method
can affect the initial copy time depending on
the conditions.
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Appendix D:  Troubleshooting

Troubleshooting for Device Manager - Storage Navigator involves identifying the cause of
the error and resolving the problem.

This section provides information for identifying and correcting problems with Device
Manager - Storage Navigator for your storage system.

General troubleshooting

If you have a problem with Device Manager - Storage Navigator, check the following
items. If you cannot resolve an error condition, contact customer support.
■ Check the cabling and the LAN. Verify that both the management client and LAN

cabling are firmly attached, and that the LAN is operating properly.
■ Close any programs on the management client that are not responding. If necessary,

reboot the management client and restart a Device Manager - Storage Navigator web
client session.

■ Clear the Java and web browser caches to solve the problem. To clear the Java cache,
click Delete the temporary files in the General dialog box of the Java Control Panel.

■ Check for other general error conditions. For a complete list of Device Manager -
Storage Navigator error codes, see the Hitachi Device Manager - Storage Navigator
Messages.

■ Check the alert icon. Confirm the severity level of the storage system alert by clicking
Alert in the Device Manager - Storage Navigator main window.

Troubleshooting workflow
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Displaying alerts

You can check if the failure (SIM) is reported or not in the storage system by checking the
alert in the Device Manager - Storage Navigator main window.

Procedure

1. In the Device Manager - Storage Navigator main window, click Alert. The Alerts
window opens.

Displaying alerts
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2. On the Alerts tab, click DKC or GUM (CTL1), or GUM (CTL2) to check alert
information.

3. Click the alert ID link to check the detailed information for each alert.
The error information displays in the Alert Detail window.

Login errors

The following table lists login errors:

Error condition Probable cause / Recommended action

Failed to login is displayed. Check that the user name and password are
correct. If you forget your password, log in with the
Security Administrator (View & Modify) and set a
new password.

To confirm that the SVP and the storage system
can communicate normally, check the following:
■ LAN cabling is correct and connections are in

place.
■ IP address of SVP and IP address of GUM are in

the same network.
■ There is no duplicate IP address in the network

to which SVP and GUM belong.
■ GUM is pingable from SVP.

When you are using an external authentication
server such as LDAP, check the following:
■ The authentication server has been started.
■ The authentication server can be accessed from

the SVP via the network
■ The user account has been established on the

authentication server
■ The connection information for the

authentication server that has set on the SVP is
correct.

If the symptom recurs even after you correct the
above settings, use the dump tool to collect HDvM
- SN normal dump files to some recording media
and then contact customer support.

Login errors
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Error condition Probable cause / Recommended action

The HDvM - SN window is not displayed. ■ Make sure the URL of the desired SVP is
registered to the Trusted sites section of the
Internet Options dialog box

■ Make sure that the browser uses TLS 1.2.

HDvM - SN does not start even with repeated
attempts.

Close all the web browser windows and then clear
the web browser cache.

Use the Task Manager to check for "hung" or
duplicate processes.

A network error occurred when you logged in
to HDvM - SN.

Close all dialog boxes and log in to the HDvM - SN
again. If the same error occurs, check the network
environment.

Internet Explorer cannot display the webpage
is displayed.

■ Ensure that the network device is enabled.
■ Ensure that the proxy server settings are

correct if you use proxy for the network
connection.

An error occurred during SVP processing is
displayed.

■ If the web browser is set up to use a proxy
server, disable the proxy server.

■ If a proxy server is not used in the web browser,
wait a few minutes, update the screen, and log
in again.

The login to a storage system from the
Hitachi Command Suite server fails

If you change your password for a storage system,
you need to change the information registered in
Hitachi Command Suite. For details, see the
section describing how to change storage system
settings in the Hitachi Command Suite User Guide.

The window in gray appears and the login
dialog box is not displayed during startup of
HDvM - SN that can run in the Adobe AIR
environment.

Enable the TLS settings of Internet Options for the
web browser.

No-response errors

The following table lists no-response errors:

No-response errors
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Error condition Probable cause / Recommended action

The error 20121-107022 occurs when using
Device Manager - Storage Navigator.

An unsupported locale might be set for the SVP.
Make sure that the correct locale is set for the SVP.

To set the locale, see the Hardware Reference
Guide for your storage system.

The following error occurs when using Device
Manager - Storage Navigator:
■ 20121-107024

The SVP web server might have been restarted.
Close Device Manager - Storage Navigator, wait 10
minutes, and then restart Device Manager -
Storage Navigator.

Error (20121-107096) occurs repeatedly while
you are using Device Manager - Storage
Navigator.

A timeout error may have occurred in Adobe Flash
Player or Adobe AIR.

Close the Device Manager - Storage Navigator
window. Click X in the corner of the browser
window or click the window and press Alt+F4.

The following errors occur when using Device
Manager - Storage Navigator:
■ 20121-107024
■ 20121-107025
■ 20121-107096
■ 20121-107097

This error may occur if the load to the
management client is high, or if you start multiple
instances of Device Manager - Storage Navigator
by using multiple tabs in a tab browser or multiple
browsers.

Close the other applications which cause the high
load, or make sure to start only one Device
Manager - Storage Navigator

The following application error occurs when
using Device Manager - Storage Navigator:
■ 20020-108000

■ The version of Device Manager - Storage
Navigator recognized by the management client
might not match the version installed on the
SVP. Close all the browser windows and then
clear the browser cache.

■ The management client might have entered
standby or hibernate mode. Restart Device
Manager - Storage Navigator.

No-response errors
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Error condition Probable cause / Recommended action

■ If a proxy server is used for network
connections, the proxy server cache may be
storing the older version of the program. If the
problem continues after you clear the browser
cache, contact your network administrator.

■ Java content might be disabled in the web
browser using the JRE 7.0 Update 10 or later.

To enable Java content in the web browser:

1. From Windows, open the Java Control
Panel.

2. In the Java Control Panel, click the Security
tab.

3. If Enable Java content in the browser is
checked, uncheck it and click Apply.

4. The User Account Control dialog box
opens. Click Yes. The confirmation window
opens. Click OK.

5. Restart the browser.

If none of the above actions solve the problem,
save the Device Manager - Storage Navigator
dump file and send it to customer support. Then
restart the web browser.

Device Manager - Storage Navigator does not
respond.

Device Manager - Storage Navigator may
hang in the following cases:
■ The Device Manager - Storage Navigator

main window is grayed out and does not
display the percentage of progress, and
you cannot perform any operation for a
long period of time.

■ You cannot perform any operation for a
long period of time and the dialog box
that says Loading... is not displayed.

■ The dialog box that says Loading... opens
when the window switches. However, you
cannot move the dialog box or perform
any operation for a long period of time.

Close the web browser and reopen it. When using
the Device Manager - Storage Navigator secondary
window, exit Device Manager - Storage Navigator
by pressing Ctrl+Alt+Shift+D all at once.

If you close the web browser but you cannot exit
Device Manager - Storage Navigator, reboot the
management client or restart Device Manager -
Storage Navigator after forcibly closing Device
Manager - Storage Navigator as follows:
■ In Windows:

Exit the web browser and then use the Task
Manager to terminate iexplorer.exe (if you are
using Internet Explorer) or chrome.exe (if you
are using Google Chrome).

■ In UNIX:

Exit the web browser, and then terminate
firefox-bin with the kill command.

No-response errors
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Error condition Probable cause / Recommended action

■ The login window does not appear and
the white screen continues.

■

You clicked the cross mark  or Close,
however the window cannot be closed.

A network error occurred. There is no
response to any operation even after 30
minutes.

Restart the management client. An operation may
take over 30 minutes depending on the use
condition. For example, when several Device
Manager - Storage Navigator web clients are
running, an operation may take a long time.

An internal error occurs, or a web browser
ended abnormally.

Close all dialog boxes and log in to Device Manager
- Storage Navigator again. If the same error occurs,
restart the management client.

During a Device Manager - Storage Navigator
operation, the web browser suddenly
disappears.

Restart the management client.

An error (1-4011) occurs while you are using
Device Manager - Storage Navigator.

The clock time of the management client may have
been changed. Log in to Device Manager - Storage
Navigator again.

The management client reboots on its own. Restart the management client.

A Device Manager - Storage Navigator
window is forcibly closed during a time-
consuming process, such as LDEV formatting.

Close all windows, wait until processing finishes,
and then restart Device Manager - Storage
Navigator.

A Device Manager - Storage Navigator
window is incorrectly closed when you do
one of the following:
■ Click 
■ Use commands such as File > Close on the

web browser
■ Press the Alt and F4 keys

Restart Device Manager - Storage Navigator. If you
cannot log in, wait for one minute and try again.

During a Device Manager - Storage Navigator
operation, an add-on (Flash10e.ocx) error
occurs.

Restart the management client.

If this error occurs repeatedly, reinstall Adobe
Flash Player on the management client.

No-response errors
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Error condition Probable cause / Recommended action

When you log out from the Device Manager -
Storage Navigator, an Internet Explorer error
occurs.

The probable causes are as follows:
■ Internet Explorer has not been updated. Install

the latest updates
■ Internet Explorer may be configured incorrectly.

Re-install Internet Explorer.

When you click File > Refresh All or Refresh in
the Device Manager - Storage Navigator main
window, the percentage of progress remains
99%.

The probable causes are as follows:
■ Another application such as Command Control

Interface may be changing configuration. The
window will be updated shortly after the
configuration change ends.

■ Volume Migration operations, Quick Restore
operations or Thin Image operations may be in
progress. The window will be updated shortly
after the operations end.

One of the following errors occurred during a
Device Manager - Storage Navigator
operation in the main window
■ 20123-107027
■ 20123-108004
■ 00002-058578
■ 00003-002003
■ xxxxx-065740
■ xxxxx-068800

where xxxxx indicates any code.

■ Another application such as Command Control
Interface may be changing configuration.

■ Volume Migration operations, Quick Restore
operations, or Thin Image operations may be in
progress.

■ The configuration data may not be matched if a
communication error occurs between the
storage system and SVP.

Wait a few minutes and then click File > Refresh All
to reload the configuration information. Then run
Device Manager - Storage Navigator again. If a
configuration change operation was performed,
check that all the configuration changes that
caused the error were applied, and then set the
settings that were not applied again.

No-response errors
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Error condition Probable cause / Recommended action

When using Encryption License Key, do the
following:
■ If a failure (00002-058578) occurs when you set

the Encryption Environment for the first time
from the Edit Encryption Environmental
Settings window, do the following:

1. Wait a few minutes and then click File >
Refresh All to reload the configuration
information.

2. Initialize the Encryption Environment
Settings.

3. Set the Encryption Environment again.
■ If a failure (00002-058578) occurs when you set

the Encryption Environment again from the
Edit Encryption Environmental Settings
window, do the following:

1. Wait a few minutes and then click File >
Refresh All to reload the configuration
information.

2. Set the Encryption Environment again.

The Device Manager - Storage Navigator
window turns white and the icon shown
below displays in the center of the web
browser when you use Device Manager -
Storage Navigator.

If you are using Internet Explorer: 

If you are using Google Chrome: 

Restart the management client.

Operations cannot be performed due to a
problem with the Device Manager - Storage
Navigator main window. For example, tables
are not displayed correctly or some buttons
are not displayed. Logging out and back in
does not solve the problem.

The Device Manager - Storage Navigator window
setting information may have been saved with an
incorrect value. Click Settings > Environmental
Settings > Reset View to Settings in the Device
Manager - Storage Navigator main window to clear
the window setting information. Then click any
button in the Device Manager - Storage Navigator
window and check that it operates correctly. You
do not need to log out and back in.

No-response errors
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Error condition Probable cause / Recommended action

Device Manager - Storage Navigator closes
automatically when operating the IPv6
address setting from Device Manager -
Storage Navigator.

When the symptom occurs, the resource group
status remains locked.

Open the Resource Lock Properties window and
release the locked resource group caused by the
symptom. Suspend other operations when
releasing the resource group, as other resource
groups are also released the lock.

If you use HDvM - SN in a web browser, update
Adobe Flash Player to version 13 or later.

The error 20122-208003 occurred when using
Device Manager - Storage Navigator.

A problem might have occurred with the storage
system connection, or user account information
which is used for the storage system connection
might have changed.

Configure the user account information specified
for the registered system of the Storage Device
List window. For details, see the Hardware
Reference Guide for your storage system.

Incorrect display errors

The following table lists incorrect display errors:

Error condition Probable cause / Recommended action

A question mark or icon displays in a table or
other area of the window.

■ When the question mark appears in the View
Tier Properties window, see the topic
describing this window in the Provisioning Guide.
If the problem still persists, contact customer
support.

■ When the question mark appears in the Add
External Volumes window, see the topic
describing this window in the Hitachi Universal
Volume Manager User Guide. If the problem still
persists, contact customer support.

■ If the question mark or icon appears in another
window, update the window. Contact customer
support if the question mark remains after you
update the window.

Incorrect display errors
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Error condition Probable cause / Recommended action

The product name, vendor name, and
function name displayed in HDvM - SN are
incorrect.

Contact customer support.

A part of the HDvM - SN window is not
displayed.

You may be using the zoom in and zoom out
function of the web browser. Do not use this
function of the web browser when using HDvM -
SN.

The display on HDvM - SN's main window is
not updated to the latest information. "Last
Updated" on HDvM - SN's main window is not
updated.

Volume Migration operations, Quick Restore
operations, or Thin Image operations may be in
progress. The window will be updated shortly after
the operations end.

The following message is displayed when
connected to HDvM - SN on Internet Explorer
or Google Chrome.

This content requires Adobe Flash Player.
■ Get and install Adobe Flash Player from

the Adobe web site.
■ Enable Adobe Flash Player.
■ Adjust the browser security settings.

This message displays when Adobe Flash Player is
not installed. Do the following:
■ Install Adobe Flash Player
■ Disable ActiveX Filtering

If you are using Internet Explorer 9 or later, click

Tools > Safety and uncheck ActiveX Filtering.
■ When a message appears indicating that the

specific site was blocked, perform the
procedure described in Adding your SVP to the
trusted sites zone for Windows Server
computers (on page 27) .

■ When using HDvM - SN with Flash Player, do
not change the local storage area value in
Adobe Flash Player.

■ When using HDvM - SN with Flash Player, do
not disable Adobe Flash Player.

■ If you use Internet Explorer, do not change the
settings in Tools > Manage add-ons.

The Maintenance Utility window is not
displayed.

■ Make sure that the browser uses TLS 1.2.
■ If the storage system is registered by using the

host name, you need Windows setting on the
SVP. Add, to the DNS suffix, the domain names
of the hosts that are set for CTL1 and CTL2.

Incorrect display errors
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Error condition Probable cause / Recommended action

When many items are set, some items might
not be displayed even if you scroll through
the table.

Depending on the size of a window, some items in
a table might not be displayed. Do the following:
■ Increase the resolution so that more areas of

the table can be shown.
■ Use the zoom in or zoom out function of your

browser to adjust the viewing area.

Note: Text might become too small.

If you still cannot solve the problem, contact
customer support.

The Maintenance Utility window is displayed
incorrectly.
■ A specific window is not displayed.
■ No response if you click the button.

Set the Maintenance Utility window out of
Compatibility View by first confirming
"Compatibility View" in the Address bar of Internet
Explorer, and then setting Compatibility View to
OFF.

If "Compatibility View" is not displayed (prior to
IE11):

1. Select Tool > Compatible View Settings in
Internet Explorer.

2. Uncheck the Display intranet sites in
Compatibility View and Display all websites in
Compatibility View checkboxes.

3. Click Close.

The message "Unable to launch the
application" appears on the secondary
window, then operation ends abnormally.

Perform the following:

1. If the current JRE (Client) version is JRE 7,
update to JRE 8 or later.

2. Confirm that Use TLS 1.2 for Java is enabled. If
Use TLS 1.2 is disabled, change the TLS
settings for Java to enabled.

UNIX operation errors

The following table lists UNIX operation errors:

UNIX operation errors
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Error condition Probable cause / Recommended action

The web browser is incorrectly displayed
because GUI items, such as labels and icons,
cannot be loaded properly.

Part of a button is outside the window.

If you use Device Manager - Storage Navigator on
the Japanese version of Firefox, log out of Device
Manager - Storage Navigator, and then log in to
Device Manager - Storage Navigator again. Enter
the following commands using the X Server
Emulator.
■ B Shell:

LANG=C
export LANG
■ C Shell:

setenv LANG C

The web browser closes abnormally. This problem can occur if a Mozilla process keeps
running after Mozilla stops responding. Delete the
"java_vm" and "mozilla" processes and continue
with Device Manager - Storage Navigator
operations.

Changing Java security settings

If Java 7 Update 55 or later or Java 8 Update 5 or later is installed on the management
client, execution of the Device Manager - Storage Navigator secondary window
application might be blocked. In this case, you must change Java security settings
according to the following procedure.

Procedure

1. Check the version and update information of Java installed in your management
client. Click Start > Control Panel > Java.

2. On the General tab, click About.
3. Check the version and update information of Java, and then close the About Java

dialog box. If your PC uses either Java 7 update 55 or later, or Java 8 Update 5 or
later, you need to change Java security settings referring to Step 4 and after.

4. Select the Security tab.
5. Click Edit Site List.
6. In Exception Site List, specify the URL of the SVP as follows, and then click Add.

http://IP-address-of-SVP or https://IP-address-of-SVP
7. Click OK.
8. Select the Advanced tab.
9. For Perform signed code certificate revocation checks on, select Do not check

(not recommended), and then click OK.

Changing Java security settings
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10. Close the Control Panel.

Troubleshooting the SMI-S function

If you cannot access the SMI-S function, check the network environment and access
destination. If access cannot be made even though there is no problem with the network
environment and access destination, contact customer support.

The SMI-S certificate might have expired when you receive a storage system. If so, you
must upload a new signed certificate to the SMI-S provider.

SMI-S artificial indication errors

The following table lists SMI-S artificial indication errors:

Error condition Probable cause / Recommended action

The user ID or the password is not valid.
(00190 77302)

User ID or password is invalid. Enter the correct
user ID or password, and then retry the operation.

An error occurred during the listener
information acquisition. (00190 77303)

An error occurred during the listener information
acquisition. Collect Device Manager - Storage
Navigator normal dump file to the media using the
dump tool.

No listeners are subscribed to the provider.
(00190 77304)

The listeners are not subscribed to the SMI-S
provider. Have the listeners subscribe to the
provider, and retry.

The artificial indication cannot be sent to
some listeners. (00190 77305)

The artificial indication cannot be sent to some
listeners. Use the dump tool to collect and save
Device Manager - Storage Navigator normal dump
files. Then contact the customer support.

A time-out error occurred. (00190 77306) Send the artificial indication again. If this problem
persists, use the dump tool to collect Device
Manager - Storage Navigator normal dump files to
some recording media and then contact the
customer support.

An internal error occurred. (00190 77307) Use the dump tool to collect Device Manager -
Storage Navigator normal dump files to some
recording media and then contact the customer
support.

Storage Device Launcher errors

Troubleshooting the SMI-S function
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Error condition Probable cause / Recommended action

■ Storage Device Launcher cannot start.
Or a message appears asking if you
have entered the name correctly
because ..\..\bundle\jre_win
\bin\javaw cannot be found.

■ HDvM - SN that can run in the Adobe
AIR environment cannot start from a
web browser.

After installing Storage Device Launcher,
the WCLauncher_win folder used for the
installation might have been deleted or
moved. If the WCLauncher_win folder
remains, restore it to the location where it
was installed. Or, reinstall Storage Device
Launcher in the new location to which it
has been moved.

If you cannot find the WCLauncher_win
folder, download the setup file and
reinstall Storage Device Launcher. For
details, see Installing Storage Device
Launcher on the management client (on
page 29) .

Other errors

The following table lists other errors that might occur in Device Manager - Storage
Navigator (HDvM - SN) and Tool Panel utlities.

Error condition Probable cause / Recommended action

■ Error about insufficient capacity when
creating an LDEV with sufficient capacity.

■ Operation error about an LDEV that does
not exist when creating a pair for an LDEV
that does exist.

Configuration information displayed in HDvM - SN
and controller configuration information might not
match.

Click File > Refresh All in the Device Manager -
Storage Navigator main window to reload
configuration information.

If the problem persists, contact customer support.

The software on the SVP is upgraded or
downgraded.

Close all HDvM - SN windows, and then clear the
browser cache. Even when you are not sure that
the software on the SVP is upgraded or
downgraded, clear the browser cache.

HDvM - SN processing is temporarily delayed. Internal processing (such as, configuration change,
P.P. check, or operational information acquisition)
might be running on the SVP.

HDvM - SN processing is delayed. If you use HDvM - SN in a brwoser, the local
storage value for Adobe Flash Player might have
decreased. Follow these steps:

Other errors
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Error condition Probable cause / Recommended action

1. Right-click on the HDvM - SN main window
and click Settings to open the Adobe Flash
Player Settings window.

2. In the local storage settings, move the slider
until Unlimited appears and then click Close.

3. Close HDvM - SN.
4. Restart HDvM - SN.
5. If the local storage confirmation dialog box

appears, click Allow.
6. If this problem persists, there might be a

problem with the SVP performances. Contact
customer support.

Installing of signed SSL certificate fails. The passphrase for the SSL certificate might be
set. Release the passphrase. If needed, see
Releasing an SSL certificate passphrase (on
page 98) .

An error (0002-009000) occurs while you are
using HDvM - SN.

Another management client might be changing the
HDvM - SN settings. Close all windows, check that
maintenance personnel are not using the storage
system, and then log in to HDvM - SN again.

If other than above, restart the SVP, and then log in
to HDvM - SN again.

In the Operation Lock Properties window,
Locked is displayed for system lock status
and Unlocked is displayed for resource group
status.

Restart the SVP then log in to HDvM - SN again.

Failed in the certification of the user. appears
when you create a configuration report of a
storage system and try to view it in a
browser.

Close the tab of the configuration report or the
window, and then open it again.

If the problem cannot be solved, address
mismatch of SSL certificates between the SVP and
the management client might have occurred. To
reconfigure SSL communication, see Setting up SSL
communications (on page 91) .

Otherwise, you can display the configuration
report by logging in to HDvM - SN using HTTP.

Note that you cannot connect HDvM - SN that
operates on Adobe AIR by using HTTP (Only HTTPS
connection is available).

HDvM - SN operation is slow, although the
requirements for the SVP are satisfied.

Verify that no anti-virus software runs on the SVP.

Other errors
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Error condition Probable cause / Recommended action

You cannot resolve an error condition. Do the following, and then contact the customer
support.

1. Log in to the SVP.

In the SVP, use the dump tool to copy the
HDvM - SN detailed dump files onto recording
media.

2. Obtain the Java log and trace files (only when
using the HDvM - SN secondary window).

3. Obtain the Java log and trace files (only when
using the HDvM - SN secondary window).

When using Web Console Launcher, collect
the log in <installation-directory-for-
Web-Console-Launcher>\WCLauncher
\log.

Preventing errors while using virus detection programs on
the SVP

Running virus detecting programs on an SVP* that has Device Manager - Storage
Navigator installed might cause operation errors while using Device Manager - Storage
Navigator.

To prevent errors caused by virus detection programs, exclude the Device Manager -
Storage Navigator installation directory from the real-time virus scan target in your virus
detection program.

Note: C:\MAPP indicates the installation directory of the storage
management software and the SVP software. When the installation directory
other than C:\Mapp was specified, replace C:\Mapp with the specified
installation directory.

Perform virus scans regularly on the excluded directory during periods when Device
Manager - Storage Navigator is not in use or when the service stops.

Note: *Including standard virus detection programs installed on the
operating system such as Windows Defender.

Clearing the cache in Internet Explorer

If an error occurs in Device Manager - Storage Navigator, try clearing the web browser
cache to solve the problem.

Preventing errors while using virus detection programs on the SVP
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Clearing the cache in Firefox

If an error occurs in Device Manager - Storage Navigator, try clearing the web browser
cache to solve the problem.

Procedure

1. Click Tools > Options.
2. In the Options window, click Advanced.
3. On the Network tab, under Cached Web Content, click Clear Now.

Clearing the cache in Google Chrome

If an error occurs in Device Manager - Storage Navigator, try clearing the web browser
cache to solve the problem.

Procedure

1. Click Chrome Menu > Settings > Show advanced settings > Privacy > Clear
browsing data.

2. Check the Cached images and files checkbox.
3. Click Clear browsing data.

Downloading dump files

Use the Dump tool to download dump files onto a management client. The downloaded
dump files can be used to:
■ Troubleshoot the system. Use the Dump tool to download dump files from the SVP

and give it to the support personnel.
■ Check system configuration. First, click File > Refresh All to update the configuration

information, and then use the Dump tool to download the dump files.
■ Before deleting the storage management software and the SVP software. Collect the

dump files of the SVP system information.

There are two types of dump files:
■ Normal Dump includes all information about the SVP and the minimum information

about the storage system. Select this when you have a less serious problem such as
incorrect display.

■ Detail Dump includes all information about the SVP and the storage system. Select
this when Device Manager - Storage Navigator has a serious problem (for example,
Device Manager - Storage Navigator does not start) or when you need to determine if
the storage system has a problem.

Clearing the cache in Firefox
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Before you begin
■ You must be logged into the SVP.
■ Device Manager - Storage Navigator must be running.
■ The configuration information must be refreshed by selecting File > Refresh All in

Device Manager - Storage Navigator.
■ All other users (including the SVP user) must stop using the Dump tool.
■ Stop all maintenance operations.
■ Dump tools from other storage systems must not be used during the process.
■ The installation directory of Storage Navigator must be excluded from the real time

virus scan targets by the virus detection program. For the virus detection program
settings, see Preventing errors while using virus detection programs on the SVP (on
page 55) .

Note:

If the error is in regards to Device Manager - Storage Navigator starting up,
collect information about the SVP using the Dump tool, without Device
Manager - Storage Navigator running.

Procedure

1. Close all Device Manager - Storage Navigator sessions on the SVP.
2. Open a Windows command prompt with administrator permissions.
3. Move the current directory to the folder where the tool is available. (For example:

<SVP-root-directory>\DKC200\mp\pc).

4. Specify the output destination of the dump file and execute Dump_Detail.bat or
Dump_Normal.bat.

For example, if you are storing the result of Dump_Detail.bat to
C:\Result_832000400001, enter the following:

C:\MAPP\wk\832000400001\DKC200\mp\pc>Dump_Detail.bat 
C:\Result_832000400001

Downloading dump files
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Note:

■ A space is required between Dump_Detail.bat and C:\Result.

■ The dump file name is hdcp.tgz. To manage dump files by storage
systems, we recommend adding a serial number to the output folder
name. For example, if the serial number is 832000400001, the folder
name should be C:\Result_832000400001.

■ A folder under the network drive cannot be specified as the output
destination.

■ When the tool is being executed, Executing is displayed in the
command prompt. When the execution is completed, the following is
displayed:

zSv_AutoDump.exe is completed.

zSv_AutoDump.exe is completed.” might not be displayed even after
the completion of the tool execution due to the heavy load on the SVP
or other cause. If it is not displayed even after 20 minutes, check
whether a dump file is output in the output folder for the dump file.
When a dump file is output, see the date and time of the file update
to confirm that the file is created after 20 minutes have passed since
the start time of execution of the dump tool. When no dump file is
output, close the command prompt and execute the dump tool again.

Note: If the execution fails, zSv_AutoDump.exe is
failed is displayed.

■ You cannot specify the folders under the network drive as the output
folder.

■ The dump file capacity might become approximately 3 GB depending
on the usage of the storage system.

5. A completion message box displays. Press any key to acknowledge the message and
close the message box.
hdcp.tgz: This is the dump file. Give this file to the maintenance personnel. If you
save too many dump files in the SVP storage, space might not be available.
Therefore, move the dump file outside of SVP storage.

zSv_AutoDump.log: This is the log file of the dump tool. If the dump file is not
output, give this log file to the maintenance personnel. If the dump file is output,
delete the log file.

DumpResult.txt: This is the collection results file. The results are displayed in the
following catagories:

DKC dump
Collection result of the DKC dump data

Dump of GUM of CTRL1
Collection result of the GUM (CTL1) dump data

Downloading dump files
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Dump of GUM of CTRL2
Collection result of the GUM (CTL2) dump data

exist is displayed if the collection was successful. not exist is displayed if the
collection has failed.

6. Close the Windows command prompt.

Firefox web browser problems on UNIX

Note the following when using Firefox web browser on UNIX:
■ If a Mozilla process or a Firefox web browser process becomes unavailable, Device

Manager - Storage Navigator performance is affected. Delete the abnormal process
and continue with Device Manager - Storage Navigator operations.

■ When using Device Manager - Storage Navigator on the Japanese version of the
Firefox web browser, you must use the X Server Emulator to properly configure the
browser, as follows:

In a B Shell, enter the following command:

LANG=C 
export LANG

In a C Shell, enter the following command:

setenv LANG C

When you use Device Manager - Storage Navigator with Firefox, movements of the focus
may differ from movements of the focus in Internet Explorer. For example:
■ When the Device Manager - Storage Navigator login window appears, the focus is not

on the User Name box. Even is the User Name box is emphasized, you cannot enter
any characters in it.

■ When you move the focus by using the Tab key, the destination browser window does
not become active.

In Firefox, when you click Logout at the upper right corner of the Device Manager -
Storage Navigator main window, the Device Manager - Storage Navigator login window
appears after you logout. With Internet Explorer, the window closes after the logout.

Firefox web browser problems on UNIX
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Appendix E:  OLH Only

Navigating the Device Manager - Storage Navigator user
interface

The following figure shows an example of the GUI main window. In this example, Logical
Devices has been selected.

Menu bar

Appendix E: OLH Only

System Administrator Guide for VSP E990 and VSP G130, G/F350, G/F370, G/F700, G/F900 319



Item Description

Click to return to the previous window.

Click to advance to the next window.

File ■ Refresh All: Acquires all the information about the storage
system and updates both the SVP and Device Manager - Storage
Navigator. You must have the Storage Administrator (initial
configuration) permissions to use this function.

■ Logout: Logs the current user out of Device Manager - Storage
Navigator.

Actions Provides actions to the storage system such as creating LDEVs or
performing replication copy.

Reports ■ Task Management: Manages the tasks that will be applied to the
storage system.

■ Configuration Report: Creates and downloads storage system
configuration reports.

■ Performance Monitor: Monitors performance of the storage
system.

■ Shredding Report: Downloads the shredding report.

Settings ■ User Management: Manages Device Manager - Storage
Navigator user accounts, including changing passwords.

■ Resource management: Performs resource group related
operations

■ Security: Performs audit log or encryption operations
■ Environmental Settings: Configures the license, the refresh

interval of the window or an external server. Resets view
settings that can be customized, such as width or order of table
column.

View Changes the font size in the window.

Maintenance
Utility

Launches the storage system's maintenance work window.

Tool ■ Download: Displays the dialog box to download the setup files
for Web Console Launcher (required to use the HDvM - SN
secondary window with Java 11 or later) and Storage Device
Launcher (required to start HDvM - SN running with Adobe AIR).

Help Displays the online help

Menu bar
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Opening Device Manager - Storage Navigator secondary windows

Some Device Manager - Storage Navigator operations are performed through secondary
windows that use a Java application. For this reason, whether you are using JRE 5.0 or
6.0, a message might appear and ask if you want to run a Java Application. You might see
slightly different dialog boxes depending on your environment and configuration. For JRE
7.0, the Warning - Security dialog box (shown below) displays when the digital signature
has expired.

To use Device Manager - Storage Navigator, if you select Do not show this again for apps
from the publisher and location above in the Warning - Security dialog box before
clicking Run, Device Manager - Storage Navigator is always allowed to access the local
files. When you click Run, you will not see this dialog box again.

Note: The Device Manager - Storage Navigator digital signature has an
expiration date and it might be expired depending on the Device Manager -
Storage Navigator version that you use. Even though the digital signature is
expired, you can continue using Device Manager - Storage Navigator.

Note: The following Java versions do not allow the Device Manager - Storage
Navigator secondary window to display.
■ Java 7 Update 55 or later
■ Java 8 Update 5 or later

To start up the window, you need to change Java security settings. For details,
see Changing Java security settings (on page 310) .

Using the Device Manager - Storage Navigator main window

You can perform operations by using the main window and wizards.

Procedure

1. Click a function in the resource tree in the Explorer.

Opening Device Manager - Storage Navigator secondary windows
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2. If necessary, choose a tab and use a filter to reduce the number of items in the
table.

3. Select an item in the table and click a button to open a wizard.

4. Set options in the wizard and click Finish to confirm the setting.
5. Enter a task name and click Apply to apply the setting to the storage system. The

setting is queued as a task and performed in order.

Tip: To open the task window after closing the wizard, select Go to tasks
window for status and click Apply in the wizard.

6. Open the task window to verify the result of the operation. A task can be suspended
or canceled if the processing of the task is not started.

Main window controls

The following figure shows the buttons that appear in the upper left part of the main
window.

Buttons

The Back button displays the previous window; the Next button displays the next
window. Device Manager - Storage Navigator tracks up to 10 operations and the windows
that display depend on the selection from the navigation tree.

Main window controls
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The following figure shows the buttons that appear in the upper right part of the main
window.

Table Controls

The following figures shows the controls used to view and filter the results in a main
window table:

To scroll through pages of the table, use the left and right arrows or type a page number
into the number field. To select all rows in the table, click Select All Pages. To display a
table column, click Column Settings. If filter is ON, the filtered rows are selected. To sort
the table, click the header of the column that you want to use to sort.

To save the displayed information to a TSV file, click Export under More Actions. This
action is demonstrated in the following figure.

When you change the default file name, confirm that the file name contains the .tsv
extension to save the file.

Filtering

To filter the table, select or input the desired filtering conditions and click Apply.

Table Controls
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Note:
■ Users can set up to 16 conditions.
■ When the input condition is wrong, click Apply to clear the condition.
■ Select the attribute whose date and time values must be entered, and

then enter the values.
■ The values of date and time are "YYYY/MM/DD" and "hh:mm:ss",

respectively.
■ After you enter the date in the first box, "00:00:00" is displayed in the

second box as a default time value. Edit this value as needed and click
Apply.

Tooltip

When text displays in the main window, ellipses (...) may be displayed to show that the
text is truncated. If you place the mouse cursor over an ellipsis (...), the full text displays
in a tooltip (a small "hover box").

Main window and Modify mode

There is no Modify mode for the Device Manager - Storage Navigator main window. Main
window and wizard operations are queued as tasks and performed in order. However,
when using a Device Manager - Storage Navigator secondary window, you must be in
Modify mode before changing any settings. Secondary window operations are not
queued or displayed in the task window.

Tooltip
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Using Device Manager - Storage Navigator secondary windows

Some Hitachi Device Manager - Storage Navigator operations are performed through
secondary window within the Java Runtime Environment (JRE).

This section describes requirements, operation methods, notes, and troubleshooting
required to use Hitachi Device Manager - Storage Navigator secondary windows.

Secondary windows and wizards

When you select an operation to perform, a secondary window or wizard is displayed.

Figure 14 Example of a secondary window

Using Device Manager - Storage Navigator secondary windows
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Figure 15 Example of a wizard

Secondary window menus and buttons

The following figure shows the Device Manager - Storage Navigator secondary window.

The following table describes the menus and buttons accessible in the window.

Secondary window menus and buttons
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Item Description

Title bar Provides information about the connected storage system.
■ IP indicates the IP address of the SVP.
■ S/N indicates the serial number.
■ D/N indicates the device name specified in the Edit storage system

window.

File > Refresh
All

Updates the information on the SVP. All information displayed on the
Device Manager - Storage Navigator secondary window is reacquired
from the storage system. We recommend that you use this command
only when error recovery is required.
■ Takes time until the processing has been completed.
■ While updating, other users are not allowed to perform any

operation on the Device Manager - Storage Navigator windows.
Maintenance of the storage system or the SVP operation by the
service personnel is not allowed, either.

■ Available only for the user with Storage Administrator (Initial
Configuration) role.

■ Available only when the user is in Modify mode.
■ The information may not display correctly if SVP maintenance is in

progress.
■ Try this command if the configuration information displayed on

the Device Manager - Storage Navigator differs from the actual
configuration information that can be recognized from the host.

File > Refresh Displays the latest information on Device Manager - Storage
Navigator.

The information might not display correctly when the exclusive lock is
effective or SVP maintenance is in progress.

File > Close Closes the Device Manager - Storage Navigator secondary window

Go menu Indicates software names

Help menu About: Opens the About dialog box to show the version of the
storage system.

 Unlocked

 Locked

Indicates the current operational mode of Device Manager - Storage
Navigator.

If all logged in users are currently working in the view mode, the blue

unlocked-shaped icon ( ) appears. If any user is working in the

Modify mode, the red locked-shaped icon ( ) appears.

Secondary window menus and buttons
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Item Description

Note: The operational status might not be displayed correctly when
the exclusive lock is effective or SVP maintenance is in progress.

 View

 Modify

Allows users to switch the operation mode between Modify and View.
The button always shows the current user operation mode. To change
the modes, click the button.

You cannot switch to the Modify mode while any other user is
operating in the Modify mode. Make sure to confirm the exclusive
lock icon before switching to the Modify mode.

Reset Reset the remaining time for the Modify mode. Appears only when
you are in Modify mode.

Logged in as Shows the user ID of the currently logged-in user.

Logout
Closes the Device Manager - Storage Navigator secondary window.

Apply Implements all the changes or settings displayed in blue bold italics.
This button is available only in Modify mode.

You can create and store up to 20,000 settings or operations before
actually applying them to the storage system. To avoid a possible
error, do not apply more than 20,000 settings at a time.

Cancel Cancels the changes or settings made on the window. This button is
available only in Modify mode.

HDvM - SN secondary windows and Modify mode

A secondary window opens when you click a command from the Device Manager -
Storage Navigator menu. To make settings in a secondary window, you must change to

Modify mode by clicking . Modify mode prohibits other users or programs from
changing the storage system setting. As soon as you close the secondary window, Modify
mode is released.

The secondary window displays the progress bar (shown in the following figure)
indicating the remaining time in the timeout period. To extend this period and remain in
Modify mode, click Reset.

Resetting timeout period for Modify mode

The secondary window displays the progress bar (shown in the following figure)
indicating the remaining time in the timeout period. To extend this period and remain in
Modify mode, click Reset.

HDvM - SN secondary windows and Modify mode
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The Modify mode default timeout period is 30 minutes, but can be changed by modifying
RMI time-out period for Modify.

If Modify mode is released due to a timeout, the current window will still be visible, but
an error message is returned when you click Apply, or when you try to update the

window through File > Refresh All  or Refresh .

Resetting the secondary window

The Device Manager - Storage Navigator secondary window is reset when you do any of
the following:
■ Click Apply or Cancel
■ Click Refresh or Refresh All on the File menu
■ Switch tabs

Cautions when using secondary windows

If you use IPv6 to display the Device Manager - Storage Navigator main window when
both IPv4 and IPv6 are available, IPv6 addresses are displayed in the Device Manager -
Storage Navigator secondary window but actually IPv4 communication is used.
■ The mouse wheel may not function in the Device Manager - Storage Navigator

secondary window.
■ If you accept other processing while you are changing the configuration of the storage

system on the secondary window, an error occurs.
■ If an error occurs when you try to log in or when you click Apply, wait awhile and log

in again.
■ If an error occurs when you switches operation modes (View/Modify) or tabs, wait

awhile and click File > Refresh.

Validity period of the Device Manager - Storage Navigator program

The code signature using the certificate is signed for the Device Manager - Storage
Navigator program to certify the developer of the program. Also, the timestamp* is
stamped to certify that the developer of the program signed the code signature during
the validity period of the certificate. While the timestamp is valid, you can verify that
Hitachi is the developer of the program, and securely use the program.

Note: The timestamp stores (in a secure format that prevents falsification)
the date and time that the code signature was signed. Therefore, by using the
timestamp, you can verify whether the code signature was signed during the
validity period of the certificate, and whether the program has been safe from
falsification after the code signature was signed.

Before the Device Manager - Storage Navigator secondary window opens, the following
dialog box appears. (The contents of the dialog box differ depending on the Java
version.) To start the Device Manager - Storage Navigator secondary window, click Run.

Resetting the secondary window
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Note: To check the validity period of the certificate, click More Information >
View Certificate Details. Even if the certificate expired, the user can securely
use the Storage Navigator secondary window while the timestamp is valid.

Validity period of the Device Manager - Storage Navigator program
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Java updates

Some Device Manager - Storage Navigator operations are performed using Java
applications. You may be prompted to update the Java application when navigating to
these operations, as shown in the following figure.

Note:

The Java Update Needed dialog box appears when a newer version of Java is
available. Depending on your environment, the appearance of this dialog box
might differ.

Note the following:
■ To download and install the recommended Java version, click Update (recommended).

If the secondary window does not display after the update is complete, see Enabling
the HDvM - SN secondary window (on page 32) .

■ To prevent Java content from displaying in the current browser session, click Block. If
the secondary window does not display after the update is complete, see Enabling the
HDvM - SN secondary window (on page 32) .

■ To use the currently installed Java version, click Later. The Device Manager - Storage
Navigator secondary window for the application you are using opens.

After you click Later, if the error 20020-108000 appears, open the Device Manager -
Storage Navigator main window, and then open the secondary window again.

■ To prevent this dialog box from appearing again, check Do not ask again until the next
update is available.

Troubleshooting secondary windows

The following tables list error conditions in the Device Manager - Storage Navigator
(HDvM - SN) secondary window and provide recommended actions to resolve the errors:
■ Java application errors (on page 332)
■ No response errors (on page 336)

Java updates
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■ Incorrect display errors (on page 338)
■ Other errors (on page 340)

Table 22 Java application errors

Error condition Probable cause / recommended action

When you click the HDvM - SN menu, the
system does not respond. One minute
later, application error (20020-108000)
occurs.

The pop-up blocker function of your web
browser might restrict HDvM - SN. If the
problem still continues after you perform
the operation multiple times, perform one
or both of the following actions:
■ Disable the pop-up blocker function of

your web browser.
■ Disable the pop-up blocker function of

any browser plug-in/add-on.

If neither of the above can be performed
in Internet Explorer, you can open the
window by clicking the HDvM - SN menu
while holding down the Ctrl key.

Another possible cause is that a Java
application was not allowed to start. If a
message appears and asks if you want to
run an application, click Run.

If none of the above actions solve the
problem, reinstall the JRE.

When you click the HDvM - SN menu, a
message appears asking you to download
the file SJsvlSNStartServlet.do or
SJsvlAppStartServlet.do. One minute later,
the application error (20020-108000)
occurs.

The possible causes are that the JRE is not
installed in the management client, the
JRE installation failed, or the JRE add-on is
disabled on the web browser. Cancel the
message, and install the JRE. If the JRE is
already installed, reinstall it.

When you click the HDvM - SN menu, a
message appears asking you to save a Jnlp
file.

Perform the following to save the
encrypted page:

1. In Internet Explorer, click Tools >
Internet options, and then select the
Advanced tab.

2. In the Security section, uncheck Do
not save encrypted pages to disk.

3. Click OK.

Troubleshooting secondary windows
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Error condition Probable cause / recommended action

■ The application errors (20020-108000
and 10-6027) occur when you click the
HDvM - SN menu.

■ The application error (10-6027) occurs
and HDvM - SN terminates when you
click the HDvM - SN menu.

If the problem continues after you
perform the operation multiple times, see
the probable causes listed below.

For Windows: Exit all applications using
Java, and then terminate the javaw.exe
and javaws.exe applications through Task
Manager.
■ Java on the HDvM - SN web client might

have failed to start due to timeout.
Close all other applications and
perform the HDvM - SN operation
again.

■ The version of HDvM - SN recognized
by the management client might not
match the version installed on the SVP.
Close all the windows of your web
browser and then clear the Java and
web browser cache.

■ The management client might have
entered standby or hibernate mode.
Restart the management client.

■ If a proxy server is used for network
connections, the proxy cache may be
storing the older version of the
program. If the problem continues
after you clear the Java and web
browser caches, contact your network
administrator.

■ The network connection between the
SVP and the management client might
be blocked by a firewall or some kind
of device.

Check the firewall settings and contact
your network administrator.

If none of the above actions solve the
problem, save the dump file, the Java
trace file and the log file on the
management client, and report to
customer support. Then restart HDvM -
SN.

Troubleshooting secondary windows
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Error condition Probable cause / recommended action

When you click the HDvM - SN menu, the
system does not respond.

If the problem continues after you
perform the operation multiple times,
close all the HDvM - SN windows and clear
the Java and web browser caches.

The application error (1-7050) occurs
when you click the HDvM - SN menu.

The version of HDvM - SN recognized by
the management client might not match
the version installed on the SVP. Close all
the windows of your web browser and
then clear the Java and web browser
caches. In addition, if a proxy server is
used for network connections, the proxy
server cache may be storing the older
version of the program. If the problem
continues after you clear cache of both
Java and web browser, contact your
network administrator.

Java console is grayed out and does not
start when you try to open the HDvM - SN
secondary window (Java application).

Restart the management client, or
terminate the HDvM - SN process with
one of the following methods:
■ For Windows: Exit all applications using

Java, and then terminate the javaw.exe
and javaws.exe applications through
Task Manager.

■ For UNIX: Exit all applications using
Java, and then terminate javaw and
javaws with the kill command.

A message box remains displayed when
opening the HDvM - SN secondary
window (Java application). The HDvM - SN
secondary window does not appear for a
long time.

Restart the management client, or
terminate the HDvM - SN process with
one of the following methods:
■ For Windows: Exit all applications using

Java, and then terminate the javaw.exe
and javaws.exe applications through
the Task Manager.

■ For UNIX: Exit all applications using
Java, and then terminate javaw and
javaws with the kill command.

A message remains displayed when the
HDvM - SN secondary window opens and
the system does not respond.

The SVP may be set as an exception on
the proxy setting of the web browser.

Do the same settings on the Network
Settings displayed in the General tab of
the Java Control Panel.

Troubleshooting secondary windows
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Error condition Probable cause / recommended action

If you open the Java console dialog box by
selecting the Java icon on the system tray
while opening the HDvM - SN secondary
window (Java application), the browser
and Java console may stop responding.

Do not open the Java console dialog box
while opening the HDvM - SN secondary
window. If the browser and Java console
stop responding, restart the management
client.

When you click the HDvM - SN menu. The
application error (20020-108000) occurs.

If the problem continues after you repeat
the operation several times, you might
have cancelled the display of the
secondary window. Restart the
management client, or terminate the
HDvM - SN process with one of the
following methods: For example:
■ You might have clicked Exit on the

Security Warning window.
■ You might have clicked Cancel on the

Warning - Security window.

Close all the HDvM - SN windows and
clear the Java and web browser caches.

If the problem continues after you clear
both Java and web browser caches, save
the HDvM - SN dump file and the Java
trace file, and send them to HDvM - SN.

The following message displays in HDvM -
SN.
■ Java has discovered application

components that could indicate a
security concern.

■ Block potentially unsafe components
from being run. (recommended)

■ The application contains both signed
and unsigned code. Contact the
application vendor to ensure that it has
not been tampered with.

Select Yes to continue using HDvM - SN. If
the problem continues, the cause may be
one of the following:
■ The version of HDvM - SN recognized

by the management client might not
match the version installed on the SVP.
Close all the windows of your web
browser and then clear the cache of
both Java and the web browser

■ If a proxy server is used for network
connections, the proxy server cache
may be storing an older version of the
program. Clear the cache of both Java
and the web browser. If the problem
remains, contact your network
administrator.

In Internet Explorer, the following pop-up
window appears when you open the
HDvM - SN secondary window.

Third-party browser extensions of Internet
Explorer might be enabled.

Disable third-party browser extensions as
follows:

Troubleshooting secondary windows
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Error condition Probable cause / recommended action

"Internet Explorer has stopped working. A
problem caused the program to stop
working correctly. Windows will close the
program and notify you if a solution is
available."

1. In the Windows menu bar, click Tools
> Internet Options, and then click the
Advanced tab.

2. In the Advanced tab, clear the Enable
third-party browser extensions
(requires restart) check box.

3. Restart Internet Explorer.

In Internet Explorer, an application error
(10-6027) occurs when you open the
HDvM - SN secondary window.

The SmartScreen Filter function might be
enabled when you use Internet Explorer
8.0 or later. Turn off SmartScreen Filter as
follows:

1. In the Windows menu bar, click
Safety > SmartScreen Filter > Turn Off
SmartScreen Filter.

2. Restart Internet Explorer.

In Internet Explorer or Google Chrome,
either of the following pop-up windows
appears when you open the HDvM - SN
secondary window.

"Application Blocked by Java Security" or
"Application Blocked by Security Settings"

The certificate used to sign the SVP
program might have expired. Update the
SVP microcode version to 88-04-01-XX/00
or later.

Table 23 No response errors

Error condition Probable cause / recommended action

HDvM - SN hangs and does not respond.

HDvM - SN may hang in the following
cases:
■ When you move a window displayed in

front of the HDvM - SN secondary
window, the area behind the window
remains gray and does not go back to
normal for a long period of time.

■ The entire HDvM - SN secondary
window goes gray and does not go
back to normal for a long period of
time.

From the HDvM - SN secondary window,
press Ctrl+Alt+Shift+D all at once to exit
HDvM - SN.

If you cannot exit HDvM - SN, reboot the
management client or restart HDvM - SN
after finishing HDvM - SN forcibly by the
following way.
■ For Windows: Exit all applications using

Java, and then terminate the javaw.exe
and javaws.exe applications through
Task Manager.

■ For UNIX: Exit all applications using
Java, and then terminate javaw and
javaws with the kill command.

Troubleshooting secondary windows
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Error condition Probable cause / recommended action

When you click Refresh All or Refresh in
the HDvM - SN secondary window, it
displays the message "Loading" for a long
time.

The probable causes are:
■ Another application such as Command

Control Interface may be changing
configuration. The window will be
updated shortly after the configuration
change ends.

■ Volume Migration operations, Quick
Restore operations or Thin Image
operations may be in progress. The
window will be updated shortly after
the operations end.

Error 110-67005 occurred during a HDvM -
SN operation on the secondary window.

The probable causes are:
■ Another application such as Command

Control Interface may be changing
configuration.

■ Volume Migration operations, Quick
Restore operations, or Thin Image
operations may be in progress.

■ The configuration data may not be
matched if a communication error
occurs between the storage system
and the SVP. Wait a few minutes and
then click File > Refresh All to reread
the configuration information. Then
launch Device Manager - Storage
Navigator again.

While you are using a HDvM - SN
secondary Window, it closes unexpectedly
and error 20020-108000 occurs.

Start the HDvM - SN secondary window
from the HDvM - SN main window again. If
this error occurs repeatedly, close all the
HDvM - SN windows, and then clear the
Java and web browser caches.

The web browser closes abnormally This problem can occur if a Mozilla
process keeps running after Mozilla stops
responding. Delete the "java_vm" and
"mozilla" processes and continue with
HDvM - SN operations.

Troubleshooting secondary windows
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Error condition Probable cause / recommended action

One of the following sets of errors
occurred when using HDvM - SN:
■ 20121-107024 and 10-6027
■ 20020-108000 and 10-6027
■ 10-6027

The probable causes are:
■ The SVP may have been restarted.

Close HDvM - SN, wait 10 minutes, and
then restart it.

■ The version of HDvM - SN recognized
by the management client might not
match the version installed on the SVP.
Close all the browser windows and
then clear the browser cache.

■ The management client might be in
standby or hibernate mode. Restart
HDvM - SN.

■ If a proxy server is used for network
connections, the proxy server cache
may be storing the older version of the
program. If the problem continues
after you clear the browser cache,
contact your network administrator.

■ Restart the web browser

If none of the above actions solve the
problem, save the HDvM - SN dump file
and send it to customer support.

Table 24 Incorrect display errors

Error condition Probable cause / recommended action

Only the Exit button and the Refresh and
Refresh All commands are effective when
accessing the SVP from HDvM - SN.

The SVP might not be ready to perform
some write processes from the other
system. Wait a few minutes and then click
File > Refresh. If the SVP is not restored,
click Refresh All.

Only the Exit button and the Refresh All
command are effective when accessing
the SVP from the HDvM - SN.

An error may have occurred in the SVP.
Click File > Refresh All. If the SVP is not
restored, log in to HDvM - SN again.

The commands in the Go menu are
unavailable.

The required software options might not
be installed or an error might occur on the
window that appears after you click the
command.

Troubleshooting secondary windows
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Error condition Probable cause / recommended action

Make sure that all the required software
options are installed. If they are installed,
do one of the following:
■ Click File > Refresh.
■ Click File > Refresh All.
■ Log in to HDvM - SN again.

When you switch windows from one
window to the HDvM - SN window, the
HDvM - SN window is not displayed.

Close all windows, and then log in to
HDvM - SN again.

The items in a list are not synchronized
with a scroll bar.

Click the scroll buttons  or 

above and below the scroll bar.

The focus disappears from the edit box. Close all dialog boxes, and then log in to
HDvM - SN again.

The web browser does not display
correctly, because some GUI items such as
labels and icons cannot be loaded
properly.

Log out of HDvM - SN, and then log in
again. If this error occurs before you log in
to the HDvM - SN, close all dialog boxes
and then log in to HDvM - SN.

The characters are unreadable because
they are overlapped or garbled.

Log out of HDvM - SN, and then log in
again.

The characters are garbled in a window
where a tree is displayed.

Click File > Refresh.

Even though you have clicked Apply to
change storage system settings, the new
settings are not displayed in HDvM - SN.

Click File > Refresh.

The dialog box that says Loading... stays
open for a long period of time.

A HDvM - SN message dialog box other
than the dialog box that says Loading...
might be displayed behind this window.
Press Alt+Tab to switch the dialog box.

If the dialog box that says Loading...
remains displayed for several hours after
you apply the settings to the storage
system, contact customer support.

Troubleshooting secondary windows
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Error condition Probable cause / recommended action

The following information does not
display in HDvM - SN windows:
■ Information on the storage system,

such as ports or HDDs
■ Information configured with another

management client

Click File > Refresh. If the problem
continues, close all HDvM - SN windows,
and then clear the Web browser caches.

The HDvM - SN secondary window does
not display.

■ In the Java Control Panel, click the
Temporary Internet Files section. In the
Disk Space area, enter 1 MB, and then
click Delete Files.

■ Click Security > Java Control Panel.
Ensure that Enable Java content in the
browser is checked.

■ Clear the browser cache.
■ Ensure that Java Plug-in is enabled.

If none of the above actions solve the
problem, the web browser might not
recognize Plug-in correctly. Initialize and
redo the web browser settings.

Table 25 Other errors

Error condition Probable cause / recommended action

If you click in a HDvM - SN secondary
window while a dialog box is open, the
dialog box disappears behind the HDvM -
SN secondary window.

Click the dialog box again.

An error occurs because a digital
signature or security certificate has
expired.

You can continue using HDvM - SN even
though the digital signature for the HDvM
- SN Java application is expired.

You specify IPv6 communication
addresses when you start HDvM - SN, but
IPv6 is not being used. Instead, IPv6 is
being used and IPv4 addresses are output
to audit logs for operations on the HDvM -
SN secondary window.

IPv4 has higher priority when both IPv4
communication and IPv6 communication
can be used. As a result, IPv4 may be used
when you specify IPv6 communication
addresses. Also, IPv4 addresses may
appear in audit logs.

Troubleshooting secondary windows
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Clearing Java caches

When an error occurs on Device Manager - Storage Navigator, clear the Java and web
browser caches to solve the problem. To clear the Java cache, click Delete the temporary
files in the General dialog box of the Java Control Panel.

Saving Java log and trace files

Before you contact your service representative, save the detail dump files collected using
the Dump tool, and the Java log and trace file on your management client, and then
restart the web browser.

Examples of the Windows trace and log file locations are shown below.
■ C:\Users\logon user ID\AppData\LocalLow\Sun\Java\Deployment\log\*.trace
■ C:\Users\logon userID\AppData\LocalLow\Sun\Java\Deployment\log\*.log

Examples of the UNIX trace and log file locations follow:
■ user home directory\.java\deployment\log\*.trace
■ user home directory\.java\deployment\log\*.log

Balloon dialog box

When you click an underlined link on the Device Manager - Storage Navigator screen,
additional information may appear as a pop-up, which is called a balloon dialog box. The
following illustration shows an example of a balloon dialog box.

Clearing Java caches
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Updating your user view

If you remain in the same Device Manager - Storage Navigator view while other users
change the configuration of the system, the changes that others make do not appear in
your view. You can tell how long it has been since your screen was updated by checking
the clock on the title bar to the left of the update button. The clock displays server time,
not the time on your local workstation. When you place the cursor over the clock, the
system displays the number of minutes that have passed since the screen was updated.

To see changes that others might have made, click Update in the title bar in the top right
corner of the screen.

Reverting to the default view

You can adjust Device Manager - Storage Navigator settings for column width and order,
table options, filter conditions, and similar parameters. Device Manager - Storage
Navigator saves these settings after you logout. When you login again, your settings
appear as you left them in your last session.

You can also return your settings to default.

To return your settings to default, select Settings > Environmental Settings > Reset User's
View Settings.

The parts and items that are recorded as user settings are shown in the following table:

Window part Item State after reset

Magnification - Normal (100%)

Summary Open/Closed Open

Table General Selecting row NA

Page First page

Scroll position Top left

Setting column Default state1

Column Sort NA

Width Default state1

Order Default state1

Option Row/Page 1000

Capacity unit GB or Cyl

Filter ON/OFF OFF

Updating your user view
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Window part Item State after reset

Settings NA

Open/Closed Closed

Wizard Option part Open/Closed Default state1

LUN ID notation - - Decimal integer

1. The default state varies from window to window.

Reporting failure information about storage systems

You can report failure information (SIM) about storage systems through Syslog, SNMP
trap, and email. Failure information reported through email is the same as SIM displayed
on the Alert window or reported through SNMP trap. For SNMP trap, the user needs to
access the SNMP Manager to check for failure. However, for report through Syslog or
email, the user has only to check Syslog or email to know about the occurrence of failure.
See the Hitachi Alert Notification Guide for methods of notification with SNMP traps.

Requirements of the Syslog protocol (TLS1.2/RFC5424)

The Syslog protocol (TLS1.2/RFC5424) requires the following:
■ Syslog server which supports TLS1.2.
■ Syslog server certificate.

● The extended profile fields in the X.509 certificate support the following items as
specified in RFC5280:
■ BasicConstraints
■ KeyUsage
■ SubjectKeyIdentifier

Reporting failure information about storage systems
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■ Client certificate. Upload the following:

Certificate type Format Requirements

Syslog server
root certificate

X.509 The extended profile fields in the X.509
certificate support the following items as
specified in RFC5280:
■ BasicConstraints
■ KeyUsage
■ SubjectKeyIdentifier

Client certificate PKCS#12 ■ If an intermediate certificate exists, you
must prepare a signed public key
certificate in a certificate chain that
contains the intermediate certificate.

■ The number of tiers of the certificate
chain for the certificate to be uploaded
must be 5 tiers or less including the root
CA certificate.

■ The public key of the certificate to be
uploaded must be RSA.

■ The IP address or host name of GUM
(CTR1 or CTR2) must be set as Common
Name and Subject Alternative Name of
the client certificate.

If an intermediate certificate is obtained
from a Certificate Authority, set the
intermediate certificate on the Syslog
server.

Each certificate has an expiry date, after which you are prevented from connecting to the
Syslog server. Note the expiration dates when preparing certificates.

Obtain the Syslog server root certificate from the server administrator. Convert the
Syslog server client certificate that is signed by a Certificate Authority (CA) to PKCS#12
format.

Contact the Syslog server administrator for the following:
■ Password set up in the PKCS#12-format client certificate
■ More information about the certificates

Obtaining a client certificate for the Syslog protocol

You must obtain a client certificate from the SVP to enable the Syslog protocol.

Obtaining a client certificate for the Syslog protocol
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Procedure

1. Create a private key (.key file). See Creating a private key using the OpenSSL
command (on page 93) .

2. Create a public key (.csr file). See Creating a public key using the OpenSSL command
(on page 93) .

3. Send the new key to the Syslog server Certificate Authority for signature to obtain a
certificate. The certificate is used as the client certificate.

Caution: If the certificate expires, you cannot connect to the Syslog
server.

4. Open a Windows command prompt, and then set the current directory to the
directory where the PKCS#12 format client certificate is output.

5. Store the private key (.key file) and client certificate in this folder, and then execute
the command below.

C:\key>c:\openssl\bin\openssl pkcs12 -export -in client.crt -inkey 
client.key -outclient.p12

Where

■ Folder to which the PKCS#12 format client certificate is output: C:\key
■ File name of the private key: client.key
■ File name of the client certificate: client.crt

6. Set the password.

You can use a password of up to 128 alphanumeric characters and 31 of the
following symbols:

! # $ % & ' ( ) * + ,- . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~

If you use more than 50 letters, use the following command option example, where
XXXX...X is the password:

C:\key>c:\openssl\bin\openssl pkcs12 -export -in client.crt  
client.key -out-inkey client.p12 -password pass:XXXX...X

Configuring syslog notification for SIMs

You can be notified in syslog format when storage system failures occur. For information
about SIM host reporting, see the Hitachi Alert Notification Guide.

Before you begin
■ You must have the Storage Administrator (Initial Configuration) role to perform this

task. See Roles and permissions (on page 58) .
■ You must have a server that supports syslogs.
■ If a firewall is used, a port must be opened to transfer syslogs.

Configuring syslog notification for SIMs
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Note: In any of the following steps, if you enter an invalid character or do not
enter required information, a message box displays, asking you to reenter the
information.

Procedure

1. In the Maintenance Utility menu, select Alert Notifications.
2. Click Set Up on the Alert Notifications window. The Set Up Alert Notifications

window displays.
3. For Notification Alert, select one of the following:

Host Report: Sends alerts only of SIMs that report to hosts.

All: Sends alerts of all SIMs.

The alert notification destination is common to Syslog, SNMP, and Email.

4. Select the Syslog tab.
5. In Transfer Protocol, select the protocol for Syslog transfer.
6. To transfer Syslog to the primary server and alternative secondary server, select

Enable and set the following items:

■ IP Address or domain name

■ Port Number

■ Client Certificate File Name

■ Password

■ Root Certificate File Name

Use this field only when you select TLS1.2/RFC5424 in Transfer Protocol.

7. Enter a name in Location Identification Name for identification for the storage
system.

8. If you select TLS1.2/RFC5424 in Transfer Protocol, also specify timeout, retry
interval, and number of retries.

9. Click Apply. A completion message box displays. Click OK.

Configuring email notification

You can configure the required information to notify storage system failure (SIM) by
email. For information about SIM host reporting, see the Hitachi Alert Notification Guide.

Before you begin
■ You must have a Storage Administrator account with an Initial Configuration role to

perform this task.
■ You must have a mail server that supports the Simple Mail Transfer Protocol (SMTP).

The SVP uses PLAIN or LOGIN of SMTP authentication (SMTP-AUTH) to connect to the
mail server. CRAM-MD5 and DIGEST-MD5 of SMTP-AUTH are not supported.

■ If a firewall is used, port 25 must be released because port 25 is used for
communication between the SVP and the mail server.

Configuring email notification
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Procedure

1. In the Maintenance Utility menu, select Alert Notifications.
2. Click Set Up on the Alert Notifications window. The Set Up Alert Notifications

window displays.
3. For Notification Alert, select one of the following:

Host Report: Sends alerts only of SIMs that report to hosts.

All: Sends alerts of all SIMs.

Alert destinations are common to Syslog, SNMP, and Email.

4. On the Email tab, for Mail Notice select Enable.
5. In the Email Settings table, set the email destination address and attributes (To, Cc,

Bcc).

■ To add an email address, click Add. On the Add Email Address window, set the
email address and attributes.

■ To delete an email address, select the line for the email address to be deleted
and click Delete. You can select more than one email address.

This field is mandatory when you select Enable in Mail Notice.

6. Enter the email source address (mandatory) and return address (optional).
You can use up to 255 alphanumeric characters (ASCII codes) and symbols (! # $ % &
` + - * / ' ^ { } _ . )

7. Enter the following email server information:

■ Identifier: To specify a host name, select Identifier. You can use up to 63
alphanumeric characters (ASCII codes) and symbols (" ! # $ ` + - * ' { } _ . ).

■ IPv4: To set an IPv4 address, select IPv4, and enter four numbers within the
range of 0 to 255.

Example: XXX.XXX.XXX.XXX (X indicates a numeral)

■ IPv6: To set an IPv6 address, select IPv6, and enter eight hexadecimal
alphanumeric characters within the range of 0 to FFFF. You can also use an
abbreviated-format IPv6 address.

Example: YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY (Y indicates a hexadecimal
digit)

8. In SMTP Authentication, select Enable to use SMTP authentication. Select Disable
to not use SMTP authentication. If you select Enable, enter an account and
password for SMTP authentication.
You can use up to 255 alphanumeric characters (ASCII codes) and symbols (! # $ % &
` + - * / ' ^ { } _ .).

This field is mandatory when you selected Enable in Mail Notice.

9. Click Apply. A completion message box displays. Click OK.

Configuring email notification
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Changing advanced system settings

You can change alert display settings and data acquisition settings in advanced system
settings.

Log off and log in again after you have enabled or disabled an advanced system setting.

Before you begin
■ You must have the Storage Administrator (Initial Configuration) role to perform this

task.

Procedure

1. Click Settings > Environmental Settings > Edit Advanced System Settings.
2. Select the advanced system settings and click Enable.

Option Description

Hide alert
information

If you enable this advanced system setting, the Alert
window in the Device Manager - Storage Navigator main
window does not open.

Refresh forcibly
after Apply

If you enable this advanced system setting, after settings
changes are applied to the storage system, the
configuration information for the storage system is always
updated to the latest information.

Disable data polling If you enable this advanced system setting, polling stops.

Disable retry of
data updating

If you enable this advanced system setting, retry does not
occur even if data cannot be acquired.

Enable Storage
Navigator 2 All
Function

If you enable this advanced system setting, the restrictions
on login from Device Manager - Storage Navigator's login
window are cleared, including the restrictions on the users
who can log in and on the functions available after login.
When enabling or disabling the advanced system setting,
log in again.

Manage differential
bitmaps in DP pool
at pair create and
resync operations
for 4TB or less TC/
TCMF/UR/
URMF/GAD pairs

When enabled, the differential data is maintained in a
pool with which a DP-VOL that has the user capacity (up to
4,194,304 MB) is linked when a new TC/TCMF, UR/URMF or
GAD pair is created using the DP-VOL, or resynchronized.
Note that differential data is maintained, regardless of this
setting, in a pool linked with the DP-VOL that has the user
capacity (greater than 4,194,304 MB) when a new TC/
TCMF, UR/URMF or GAD pair using the DP-VOL is created.

Manage differential
bitmaps in DP pool
at pair create
operations for 4TB

When enabled, the differential data is maintained in a
pool with which a DP-VOL that has the user capacity (up to
4,194,304 MB) is linked when a new TC/TCMF, UR/URMF or
GAD pair is created using the DP-VOL. Note that

Changing advanced system settings
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Option Description

or less TC/TCMF/UR/
URMF/GAD pairs

differential data is maintained, regardless of this setting,
in a pool linked with the DP-VOL that has the user capacity
(greater than 4,194,304 MB) when a new TC/TCMF, UR/
URMF or GAD pair using the DP-VOL is created.

Enable reboot of
background service

Enable this option only when requested. If you enable this
option, the SVP starts monitoring of the background
service process (RMIServer).

When either of the followings exceeds its threshold value,
the background service process for managing
configuration information is restarted

■ The amount of memory used in the background service
process.

■ Time elapsed after the background service process is
started.

Disable cache of the
PP Info

Enable this option only when requested.

Notify an alert
when tier
relocation is
suspended by
system

If you enable this option, when tier relocation is
suspended by the system, an alert is issued to users. For
details about an alert (SIM) to be issued, see the
Troubleshooting chapter of the Provisioning Guide for Open
Systems or Provisioning Guide for Mainframe Systems.

3. Click Finish. The Confirm window opens.
4. In the Confirm window, check the settings and enter a task name in Task Name.
5. Click Apply. The task is now registered. If the Go to tasks window for status check

box is checked, the Tasks window opens to display the status of the task.

Viewing and managing overview

Use Device Manager - Storage Navigator to view storage system information, manage
system configuration reports, and manage queued operations.

Viewing storage system information

Use Device Manager - Storage Navigator to view high-level information, create reports,
and manage tasks.

The storage system information appears immediately when you start Device Manager -
Storage Navigator.

Viewing and managing overview
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Viewing basic information

The main window shows basic information about the storage system.

Viewing other system information

You can also find other system information such as a port status and data regarding
used and unused resources. This information displays in a Device Manager - Storage
Navigator secondary window.

Procedure

1. Click Settings > Environmental Settings > License Keys. Java starts.
2. If a message appears and asks if you want to run the Java application, click Run. The

Device Manager - Storage Navigator secondary window opens.
3. In the Device Manager - Storage Navigator secondary window, click File > Basic

Information. The Basic Information Display dialog box opens.
4. Click the tab to display the Basic Information Display dialog box.
5. To save information in the dialog box, click Export. In the dialog box that opens,

enter location and file name, then click Save.

Viewing port conditions

You can view port conditions by clicking Actions > Component > View Port conditions.

Viewing basic information
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Status icons for certain resources

The status of certain resources is indicated by the following icons:

Status Description

The resource can be used normally.

The resource has the following status:
■ The resource can be used, but has a limit on I/O performance and so

on.
■ The status of the resource is changing.

Status icons for certain resources
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Status Description

■ The status of the resource is being confirmed.
■ The resource has subresources of different status.

For example, parity groups are in this status if the statuses of logical
volumes in the parity groups are not the same.

In this case, the subresources might be blocked. Confirm the status
of subresources.

The resource has the following status:
■ The resource cannot be used because it is blocked due to a failure or

maintenance operations.
■ The status of the resource is unknown.

Restore the resource to the normal status.

Using reports to view storage system information

Device Manager - Storage Navigator can generate reports that contain information about
your storage system's physical configurations and logical settings. Reports can cover
specific areas of the storage system, such as reporting on configuration, ports, channel
board, and disk board. You can save reports as comma-separated-value (CSV) files or as
HTML files. Tables in the HTML version of the configuration reports are sortable.

Before making changes to a storage system, generate reports of your storage system’s
physical configurations and logical settings. Generate a similar report after the changes,
and then compare the reports to verify that new settings were made as intended.

If you log in as the user who created the report, you can download / delete only the
report created by the user. If you log in as a user with the Storage Administrator (Initial
Configuration) role, you can download / delete the reports created by all users.

Viewing configuration information for alert notifications

You can view configuration information required for alert notification in the Alert
Notifications window in the Maintenance Utility.

Before you begin
■ You must have the Storage Administrator (View Only) or Storage Administrator (Initial

Configuration) role to perform this task.

Procedure

1. In the Maintenance Utility menu, select Alert Notifications.
2. View the Email tab, Syslog tab, or SNMP tab.

Using reports to view storage system information
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Managing tasks

You can use Device Manager - Storage Navigator to handle multiple tasks without
interruption.

Because Device Manager - Storage Navigator operations are executed in the background,
you start the next task immediately after performing the previous one. You keep track of
your tasks' progress by entering a task name during each Device Manager - Storage
Navigator procedure and then tracking its status and other information using the Tasks
window.
■ Each procedure you perform requires a task name. For example, when you provision

or configure the system, create a pair, or any other procedure, you must assign a
name for the task.

■ Each task is queued and then processed by the storage system in the order of its
arrival.

Note: You cannot use a secondary window to make any settings while a task
in the main window has a status of In Progress, Waiting, or Suspended.

Only one task is executed at the same time, except for the following. In the case of the
following operations, the next task may be executed before the current task completes
or fails.
■ Create LDEVs
■ Format LDEVs
■ Shred LDEVs
■ Shrink Pool
■ Edit Encryption

Tasks window

The Tasks window can display 384 tasks, including up to 128 tasks with a status of In
Progress, Waiting, and Suspended, and up to 256 tasks with a status of Completed and
Failed. If the number exceeds these limits, the oldest completed tasks are automatically
removed from the window.

Managing your tasks

Device Manager - Storage Navigator allows you to suspend, resume, cancel, and prevent
tasks from being automatically deleted.

Before you begin
■ Users that execute the task or users with Storage Administrator (System Resource

Management) role can view the details of tasks.
■ Users with the Storage Administrator (System Resource Management) role can delete,

suspend, resume tasks, and enable or disable auto-deletion of tasks.

Managing tasks
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Procedure

1. In the tree, click Storage Systems > Tasks. The list of tasks appears.
2. In the list, click the task or tasks that you want to modify.
3. In the bottom right corner of the window, click the corresponding button for the

task you want to perform:

■ Click Delete Tasks to delete or cancel a task.

■ Click Suspend Tasks to suspend a queued task.

■ Click Resume Tasks to resume a suspended task.

■ Click More Actions > Enable Auto Delete to delete tasks from the Task list when
they have completed and the task list is full. This allows you to check for
completed tasks and to clear the list when the limit (384) is reached.

■ Click More Actions > Disable Auto Delete to keep tasks in the task list after the
tasks are completed.

4. Verify the displayed settings and click Apply.

Referencing the detailed task status

To view the Task Status, click Status for each task in the Tasks window.

When an operation that contains several connected tasks is set as one task, you can still
check the status of each task in the Tasks window. You can also check which task has
failed. The following example shows that an error has occurred for the task action
number 2.

Referencing the detailed task status
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In the LDEV creations or LUN operations, some tasks are processed as one and the
individual result may not be reported. Some of the settings may not be applied because
internal processing has been stopped due to the error displayed in the following Tasks
window.

Referencing the detailed task status

Appendix E: OLH Only

System Administrator Guide for VSP E990 and VSP G130, G/F350, G/F370, G/F700, G/F900 356



For example, the following figure shows a single task in which "an LDEV 01 and an LDEV
02" are created. Though shown as a single task, this task is internally divided into two
parts: a setting for LDEV 01 (setting A) and a setting for LDEV 02 (setting B). If an error
occurs in the setting A task, the setting B task will not be processed. The operation result
for the setting A task is displayed in the Status of the Tasks window. The setting B task
will also not be processed for LDEV 01.

After the task operation is complete, check both the LDEV 02 which has failed in the
setting A task and the setting A task for LDEV 01 which has completed. Then run the
necessary task again.

Referencing the detailed task status
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Stalled tasks

If a queued task is not performed over a reasonable period, check the following:
■ Did the task fail? Click failed to view the reason. Then delete the task using the Delete

Tasks window, correct the problem, and try the task again.
■ Are too many tasks in the task list because Auto Delete is disabled? Use the Enable

Auto Delete window to remove tasks from the window.
■ Is another program changing the storage system configuration? Check this by

observing whether Operation Lock is displayed for too long a time. If so, verify that
another program is running and then wait until its changes are completed.

■ The percentage of progress of an ongoing task may not change if another operation is
in progress.

Setting the status refresh interval of the Tasks window

The Tasks window automatically updates every 60 seconds by default. This setting can be
enabled only during logged in. This interval can be changed using the following
procedure.

Procedure

1. Click Settings > Environmental Settings > Edit Information Display Settings.
2. Specify the interval for Task Screen Refresh Interval. If No Update is specified, the

Tasks window will not be automatically updated. In this case, to update the window,
you must use Refresh or File > Refresh All.

3. Click Apply.

Creating a configuration report using the report configuration tool

You can create a configuration report by using a command prompt when you use the
report configuration tool. By preparing a script file that contains a series of commands
and scheduling a task in Windows to execute the script at regular intervals, you can
automate the creation and the deletion of the configuration report.

Preparing a script file

Before creating the configuration report, you will need to write a series of raidinf
commands in a script file. When you run the script, the commands in the script files
execute sequentially and then create or delete a configuration report.

Two examples of scripts are shown below. Refer to these examples as needed to create a
script file that suits your needs.

Example script for creating a configuration report

This script logs the user in, deletes a configuration report, creates a configuration report,
and logs the user out, using the raidinf commands.

Stalled tasks
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For each command except the logout command, this example performs three retries at
intervals of 2 minutes, assuming that communication errors and other errors can occur.
In addition, the delete report command is executed with the -fill option before the
add report command, so that the script does not terminate when 20 configuration
reports accumulate in the SVP.

REM
REM Create Report Script(CreateReport.bat) 
REM
SET USER=<username-for-Device-Manager-Storage-Navigator>
SET PASS=<password-for-Device-Manager-Storage-Navigator>
SET SERVER=<hostname-or-IP-address-of-SVP>
SET REPORT_NAME=DailyConfigurationReport
SET LOOP=2
REM LOOP:0-2 3Times
SET TIMEOUT=121
REM TIMEOUT 2[minutes]=120[s] + 1[s]
SET RAIDINF_PATH="C:\Program Files\raidinf"
SET /a CNT_LOGIN=0

:LOGIN_RETRY
REM ############################# LOGIN %CNT_LOGIN%
SET /a CNT_LOGIN=%CNT_LOGIN% + 1
%RAIDINF_PATH%\raidinf -login %USER% %PASS% -servername %SERVER%
if ERRORLEVEL 1 (
     if %CNT_LOGIN% GTR %LOOP% GOTO :ABEND
         CALL :SLEEP
         GOTO LOGIN_RETRY
) 

SET /a CNT_DEL=0
:DEL_RETRY
REM ############################# DELETE %CNT_DEL%
SET /a CNT_DEL=%CNT_DEL% + 1
%RAIDINF_PATH%\raidinf delete report -servername %SERVER% ^
-report %REPORT_NAME% -fill
if ERRORLEVEL 1 (
         IF %CNT_DEL% GTR %LOOP% GOTO :ABEND
         CALL :SLEEP
         GOTO :DEL_RETRY
) 

SET /a CNT_ADD=0
:ADD_RETRY
REM ############################# ADD %CNT_ADD%
SET /a CNT_ADD=%CNT_ADD% + 1
%RAIDINF_PATH%\raidinf add report -servername %SERVER% -report ^
%REPORT_NAME%
if ERRORLEVEL 1 (
         IF %CNT_ADD% GTR %LOOP% GOTO :ABEND
         CALL :SLEEP

Preparing a script file
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         GOTO ADD_RETRY
) 
GOTO :END
EXIT /B

:SLEEP
REM
REM ############################# SLEEP with %TIMEOUT% sec
REM
ping 127.0.0.1 -n %TIMEOUT% > NUL
EXIT /B

:ABEND
REM ############################# ABEND
ECHO "Create Report Script was ABEND"

:END
REM ############################# Logout
%RAIDINF_PATH%\raidinf -logout -servername %SERVER%

Example script for downloading a configuration report

This script logs the user in, downloads a configuration report, and logs the user out,
using raidinf commands.

For each command except the logout command, this example performs 3 retries at
intervals of 2 minutes, assuming that communication errors and other errors can occur.
The downloaded configuration report is accumulated for 3 generations in the
C:\Reports folder by names from Report_DailyConfigurationReport_1.tgz to
Report_DailyConfigurationReport_3.tgz. In addition, if the script for creating a
configuration report fails, generation copy is terminated so that the past configuration
reports may not be overwritten.

REM
REM Download Report Script(DownloadReport.bat) 
REM
SET USER=<username-for-Device-Manager-Storage-Navigator>
SET PASS=<password-for-Device-Manager-Storage-Navigator>
SET SERVER=<hostname-or-IP-address-of-SVP>
SET REPORT_NAME=DailyConfigurationReport
SET LOOP=2
REM LOOP:0-2 3Times
SET TIMEOUT=121
REM TIMEOUT 2[minutes]=120[s] + 1[s]
SET TARGETFOLDER=C:\Reports\tmp
SET REPORTFOLDER=C:\Reports
SET RAIDINF_PATH="C:\Program Files\raidinf"
REM
REM Create Report Folder
REM
IF NOT EXIST %REPORTFOLDER% (

Preparing a script file
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         MKDIR %REPORTFOLDER%
         IF NOT EXIST %TARGETFOLDER% (
                  MKDIR %TARGETFOLDER%
            ) 
) 

SET /a CNT_LOGIN=0
:LOGIN_RETRY
REM ####################################### Login %CNT_LOGIN%
SET /a CNT_LOGIN=%CNT_LOGIN% + 1
%RAIDINF_PATH%\raidinf -login %USER% %PASS% -servername %SERVER%
if ERRORLEVEL 1 (
         IF %CNT_LOGIN% GTR %LOOP% GOTO :ABEND
         CALL :SLEEP
         GOTO LOGIN_RETRY
) 

SET /a CNT_DL=0
:DL_RETRY
REM ####################################### Download %CNT_DL%
SET /a CNT_DL=%CNT_DL% + 1
%RAIDINF_PATH%\raidinf download report -servername %SERVER% ^
-report %REPORT_NAME% -targetfolder %TARGETFOLDER%
if ERRORLEVEL 1 (
         IF %CNT_DL% GTR %LOOP% GOTO :ABEND
         CALL :SLEEP
         GOTO :DL_RETRY
) 

REM ####################################### Create Error Check
IF EXIST %REPORTFOLDER%\Report_%REPORT_NAME%_1.tgz (
         IF EXIST %TARGETFOLDER%\Report_%REPORT_NAME%.tgz (
                  GOTO :FC_CHECK
         ) else (
                  GOTO :CHECK_END
         ) 
) else (
         GOTO :CHECK_END
) 

:FC_CHECK
FC /B %REPORTFOLDER%\Report_%REPORT_NAME%_1.tgz ^
%TARGETFOLDER%\Report_%REPORT_NAME%.tgz > NUL
if ERRORLEVEL 1 (
         REM
) else (
          DEL %TARGETFOLDER%\Report_%REPORT_NAME%.tgz
          GOTO :END
) 

:CHECK_END

Preparing a script file
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REM ####################################### Migrate Reports
IF EXIST %TARGETFOLDER%\Report_%REPORT_NAME%.tgz (
         IF EXIST %REPORTFOLDER%\Report_%REPORT_NAME%_2.tgz (
                  COPY %REPORTFOLDER%\Report_%REPORT_NAME%_2.tgz ^
%REPORTFOLDER%\Report_%REPORT_NAME%_3.tgz
          ) 
         IF EXIST %REPORTFOLDER%\Report_%REPORT_NAME%_1.tgz (
                  COPY %REPORTFOLDER%\Report_%REPORT_NAME%_1.tgz ^
%REPORTFOLDER%\Report_%REPORT_NAME%_2.tgz
) 
         IF EXIST %TARGETFOLDER%\Report_%REPORT_NAME%.tgz (
                  COPY %TARGETFOLDER%\Report_%REPORT_NAME%.tgz ^
%REPORTFOLDER%\Report_%REPORT_NAME%_1.tgz
                  DEL %TARGETFOLDER%\Report_%REPORT_NAME%.tgz
            ) 
) 
GOTO :END
EXIT /B

:SLEEP
REM ####################################### SLEEP with %TIMEOUT%
ping 127.0.0.1 -n %TIMEOUT% > NUL
EXIT /B

:ABEND
REM ####################################### ABEND
ECHO "Download Report Script was ABEND"

:END
REM ####################################### Logout
%RAIDINF_PATH%\raidinf -logout -servername %SERVER%

Preparing a script file
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Example execution and explanation of script files

■ The first time you execute the script files to create a configuration report and
download a configuration file, the Report_DailyConfigurationReport_1.tgz file
is created in the C:\Reports folder.

■ On the second day:

Report_DailyConfigurationReport_1.tgz is renamed
Report_DailyConfigurationReport_2.tgz, and
Report_DailyConfigurationReport_1.tgz is newly created.

■ From the third day on:

Report_DailyConfigurationReport_1.tgz and
Report_DailyConfigurationReport_2.tgz are renamed
Report_DailyConfigurationReport_2.tgz and
Report_DailyConfigurationReport_3.tgz, and
Report_DailyConfigurationReport_1.tgz are newly created. Because
Report_DailyConfigurationReport_3.tgz is overwritten, the reports for three
days are always accumulated in the C:\Reports folder.

C:\Reports
   CreateReport.bat
   DownloadReport.bat
   Report_DailyConfigurationReport_1.tgz <-Generated today
   Report_DailyConfigurationReport_2.tgz <-Generated yesterday
   Report_DailyConfigurationReport_3.tgz <-Generated two days ago

Error in executing the report configuration tool

When using the report configuration tool, you may see Device Manager - Storage
Navigator error codes and other error codes that are unique to the report configuration
tool. For Device Manager - Storage Navigator error codes, see Hitachi Device Manager -
Storage Navigator Messages. The error codes unique to the report configuration tool and
the corresponding actions are as follows.

Error code Error message Cause of error and action
Return
value

EW_COMERR A certificate does not
become effective.

Please login again.

A certain period of time
elapsed after a login. Log in
again.

131

EW_COMERR Login is necessary.

Please login again.

A command was entered
before logging in. Log in and
then enter the command.

131

EW_ENFILE No such folder.

Please refer to the help.

The specified folder to
download to is not found.

131

Example execution and explanation of script files
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Error code Error message Cause of error and action
Return
value

EW_ENOMEM Memory allocate error.

Please other program
terminate.

Allocation of internal memory
fails. Close unnecessary
programs or reboot the server.

245

EW_INVOPA Report name reserved.

Please check input '-
report' parameter.

You cannot use the report
name specified by the -report
option. Check the report name
and specify a new one.

131

EW_INVOPT Invalid option.

Please refer to the help.

The hyphen (-) is not added to
the option parameter.

131

EW_LNGARG Argument too long.

Please refer to the help.

Either of the following causes is
possible.
■ The length of a parameter of

the command exceeds 256
bytes.

■ The length of all the
parameters of the command
exceeds 1,021 bytes.

131

EW_MAXAPP Maximum application
start.

Please check starting
application.

The maximum number of SVPs
that you can connect
simultaneously is exceeded.
Log out of unnecessary SVPs
and reconnect.

131

EW_MAXARG Maximum argument.

Please refer to the help.

The number of parameters of
the command exceeds 10.

131

EW_REQOPT Required option list.

Please refer to the help.

The required option and
parameters were not entered.

131

EW_SYSERR System error.

Please call to service
center.

An internal error occurred.
Contact customer support.

131

EW_SYSERR Install path is too long.

Specify the install path
with up to 240 bytes.

The installation path exceeds
240 bytes. Specify no more
than 240 bytes.

131

EW_SYSERR Certificate file invalid.

Please call to service
center.

Updating certificate file fails.
Contact customer support.

131

Error in executing the report configuration tool
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Error code Error message Cause of error and action
Return
value

EW_SYSERR The file is illegal.

Please move 'raidinfcer'
file from the installation
directory.

The installation directory
includes a file that will overlap
with another file to be created
by the report configuration tool
and the report configuration
tool cannot start.

Remove the overlapping file
from the installation directory.

131

EW_SYSERR Log file invalid.

Please call to service
center.

The log file cannot be accessed.
Contact customer support.

131

EW_UNWCM
D

Unknown command.

Please refer to the help.

The syntax of the command is
not valid.

230

EW_UNWOPT Unknown option.

Please refer to the help.

The option and parameter are
not valid.

252

EW_UNWOPT Invalid environment
value.

Please confirm the
setting of HTTP_PROXY.

Unable to connect to the proxy
server specified by the
environment variable. Check
the proxy server name.

252

EW_WEBERR Web access error.

Please confirm the
setting of server.

An internal error occurred
while connecting to the server.
Check the setting of the server.

131

EW_WEBERR Server name cannot be
resolved.

Please check the setting
of server name.

The server specified by the -
servername option does not
exist. Check the server name
and specify a new server.

131

EW_WEBERR Server is no response.

Input argument server is
incorrect or server is not
ready.

No response from the server
specified by the-servername
option. Make sure that:
■ The correct server name is

specified.
■ The settings of the server

are correct.

131

Error in executing the report configuration tool
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Error code Error message Cause of error and action
Return
value

EW_WEBERR Web access error.

Please check your
network equipment and
cables.

An internal error occurred
while connecting to the server.
Check the network devices and
cables.

131

EW_WEBERR Web access error.

Please confirm the
setting of proxy server.

An internal error occurred
while connecting to the proxy
server. Check the settings of
the proxy server.

131

EW_WEBERR Proxy server name
cannot be resolved.

Please check the setting
of proxy server name.

Unable to connect to the proxy
server specified by the
environment variable. Check
the proxy server name.

131

EX_CMDRJE The control command
rejected.

The execution of the entered
command was rejected by the
server.

Check the error messages of
Device Manager - Storage
Navigator.

221

Executing a regularly scheduled script file

To execute the created script file on a regular basis, register it as a scheduled task in
Windows.

The following procedure uses the Windows schtasks command to register the script
files created in the example shown in Preparing a script file (on page 358) as tasks of
Windows.

Registration example
■ Create a configuration report at 21:00 every day (CreateReport.bat).

■ Download a configuration report at 22:00 every day (DownloadReport.bat).

Procedure

1. Store the two script files in the C:\Reports folder.

C:\Reports
   CreateReport.bat
   DownloadReport.bat

2. Run the Windows schtasks command to register the two script files as a task of
Windows.

Executing a regularly scheduled script file
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Make sure that the <Username for Windows> parameter of this command is a user
who has write permissions to the following two folders.

■ C:\Reports folder

■ The log folder in the installation folder of the report configuration tool.

schtasks /create /tn CreateReport /tr "C:\Reports
\CreateReport.bat" /sc DAILY /st. 21:00:00 /ru <Username for
Windows> /rp <Password for Windows> schtasks /create /tn
DownloadReport /tr "C:\Reports\DownloadReport.bat" /sc
DAILY /st 22:00:00 /ru <Username for Windows> /rp <Password
for Windows>

3. Run the schtasks /Query command to confirm that the Windows task is
registered.

C:\>schtasks /Query
Task name      Time of next execution  Status
============= ====================== ===============
CreateReport   21:00:00, 2011/05/17
DownloadReport 22:00:00, 2011/05/17

Executing a regularly scheduled script file
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Appendix F:  Device Manager - Storage Navigator
user management GUI reference

This section describes the Device Manager - Storage Navigator windows and wizards that
you use to manage user security and to set up and manage user accounts on your
storage system.

User Groups window

This window lists all user groups created in Device Manager - Storage Navigator.

Summary

The following table describes the fields in the summary section in the User Groups
window.

Item Description

Number of User
Groups

Number of user groups created in Device Manager - Storage
Navigator.

User Groups tab

The following table describes the fields in the User Groups tab in the User Groups
window.
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Item Description

User Group Name Displays user group name.

User Group Type Displays the user group type.

Built-in: Indicates a built-in user group.

User-created: Indicates a user group that users created.

Number of Roles Displays the number of the roles that are assigned to the user
group.

Number of Resource
Groups

Displays the number of the resource groups that are assigned
to the user group.

Number of Users Displays the number of users who belong to the user group.

All Resource Groups
Assigned

Displays whether all the resource groups are assigned.

Yes: All the resource groups are assigned to the user group.

No: All the resource groups are not assigned to the user group.

Create User Group Creates a new user group.

Add Users Adds the created users to the selected user group.

Edit Resource Group
Assignment

Assigns the created resource groups to the selected user
groups.

Edit Role
Assignment*

Assigns the created roles to the selected user groups.

Delete User Groups* Deletes the selected user groups.

Edit User Group* Edits the user group name.

Export* Displays a window for outputting table information.

* Appears when you click More Actions.

Selected User Group Window

The User Group window lists the names of all of the built-in user groups and any user
groups that were created in Device Manager - Storage Navigator. To open a window for a
specific user group, in the User Groups tab, click the user group name.

Selected User Group Window
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The features of the window that opens when a user group is selected are the same, no
matter which user group is selected. The following example uses the Administrator
User Group window to show the features in the window.

The window for each selected user group contains a Summary section and three tabs.

Summary section

The following table describes the fields and settings in the Summary section of the
selected user group window.

Item Description

Number of Roles Displays the number of roles that are assigned to the selected
user group.

Number of
Resource Groups

Displays the number of resource groups that are assigned to the
selected user group.

Number of Users Displays the number of users who belong to the selected user
group.

User Group Type Displays the user group type.

Built-in: Indicates a built-in user group.

User-created: Indicates a user group that a user created.

All Resource Groups
Assigned

Displays whether all the resource groups are assigned.

Yes: All the resource groups are assigned to the user group.

No: All the resource groups are not assigned to the user group.

Users tab

The following table describes the fields and settings in the Users tab of the selected user
group window. It lists the users who belong to the selected user group.

Selected User Group Window
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Item Description

User Name Name of user who belongs to the user group.

Account Status Account status. The following statuses are available:

Enabled: The user can use the account.

Disabled: The user cannot use the account or log in to Device
Manager - Storage Navigator.

Authentication Authentication method. The following methods are available:

Local: Does not use authentication server. Uses a dedicated
password for Device Manager - Storage Navigator.

External: Uses authentication server.

User Type User type. The following types are available:

Built-in or User-created

Number of User
Groups

Displays the number of the user groups where the user belongs.

Create User Creates a new user account.

Change Password Changes your own password if you click this.

Changes the password of other users if you select a user and
then click this.

Edit User Changes the setting for authentication or for the account status.

You can set the password of the selected user if you change
Authentication from External to Local.

Add Users * Adds the created users to the selected user group.

Remove Users * Removes the selected user from the user group. The user
account itself will not be deleted.

Delete Users * Deletes the selected users.

Export * Displays a window for outputting table information.

* Appears when you click More Actions.

Roles tab

The following illustration shows the Roles tab of the selected user group window.

Selected User Group Window
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The following table describes the fields and settings in the Roles tab of the selected user
group window. Role displays the roles assigned to the user group, which determines the
operations the user can perform.

Role Permitted operations

Roles Displays the roles that are assigned to the user
group.

Edit Role Assignment Assigns the created roles to the selected user
groups.

Export Displays a window for outputting table
information.

Resource Groups tab

The following illustration shows the Resource Groups tab of the selected user group
window.

The following table describes the fields and settings in the Resource Groups tab of the
selected user group window. It lists the resource groups that are assigned to the selected
user group.

Selected User Group Window
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Item Description

Resource Group
Name

Displays the name and ID of the resource group assigned to the
user group.

Number of User
Groups

Displays the number of user groups that are assigned to the
resource group.

Number of Parity
Groups

Displays the number of the parity groups that are assigned to
the resource group.

Number of LDEVs Displays the number of the LDEVs that are assigned to the
resource group.

Number of Ports Displays the number of the ports that are assigned to the
resource group.

Number of Host
Groups

Displays the number of the host groups that are assigned to the
resource group.

Number of iSCSI
Targets

Displays the number of the iSCSI targets that are assigned to
the resource group.

Virtual Storage
Machine*

Displays the model type and serial number of the virtual
storage machine set for the resource group.

Edit Resource Group
Assignment

Assigns the created resource groups to the user groups.

Export Displays a window for outputting table information.

* This content is not displayed by default. To display it, change the settings in the
Column Settings window in the table options.

Create User Group wizard

Create User Group window

Use this window to create a new user group.

Create User Group wizard

Appendix F: Device Manager - Storage Navigator user management GUI reference

System Administrator Guide for VSP E990 and VSP G130, G/F350, G/F370, G/F700, G/F900 373



Item Description

User Group Name Enter the name of the user group to be created.

You can specify alphanumeric characters, spaces, and the
following symbols:

! # $ % & ' ( ) + - . = @ [ ] ^ _ ` { } ~

Check Check whether the entered user group name is registered to the
authorization server when you use an authorization server.

Create User Group window
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Create User Group confirmation window

Create User Group

The following table describes the fields in the Create User Group section of the Create
User Group Window.

Item Description

User Group Name Displays the name of user groups that are created.

Number of Roles Displays the number of roles that are assigned to the user group
created.

Number of
Resource Groups

Displays the number of resource groups that are assigned to the
user group created.

Create User Group confirmation window
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Item Description

Number of Users Displays the number of users that belong to the user group
created.

All Resource Groups
Assigned

Displays whether all resource groups are assigned.

Yes: All resource groups are assigned to the user group.

No: All resource groups are not assigned to the user group.

Assigned Roles

The following table describes the fields in the Assigned Roles section of the Create User
Group Window.

Item Description

Role Displays the roles that are assigned to the user group created.

Assigned Resource Groups

The following table describes the fields in the Assigned Resource Group section of the
Create User Group Window.

Item Description

Resource Group
Name (ID)

Displays the name and ID of the resource group assigned to the
user group created.

Number of User
Groups

Displays the number of user groups that are assigned to the
resource group.

Number of Parity
Groups

Displays the number of parity groups that are assigned to the
resource group.

Number of LDEVs Displays the number of LDEVs that are assigned to the resource
group.

Number of Ports Displays the number of ports that are assigned to the resource
group.

Number of Host
Groups

Displays the number of host groups that are assigned to the
resource group.

Number of iSCSI
Targets

Displays the number of the iSCSI targets that are assigned to the
resource group.

Detail Displays details of the selected resource group.

Create User Group confirmation window
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Selected Users

The following table describes the fields in the Selected Users section of the Create User
Group Window. This table displays only when users are added to the user group. This
table displays only when users are added to the user group.

Item Description

User Name Displays the name of the users that belong to the user group to
be created.

Account Status Displays the account status. The following status are available:

Enabled: The user can use the account.

Disabled: The user cannot use the account or log in to Device
Manager - Storage Navigator.

Authentication Displays the authentication method. The following methods are
available:

Local: Does not use authentication server. Uses a dedicated
password for Device Manager - Storage Navigator.

External: Uses authentication server.

Number of User
Groups

Displays the number of user groups where the user belongs.

Create User wizard

Create User window

Use this window to create a new user account.

Create User wizard
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The following table describes the fields and settings in the Create User window.

Item Description

User Name Enter the user name to be created.

The allowable characters and length of user names depend on
the application that the user uses.

Account Status Account statuses. The following statuses are available:

Enable: The user can use the account.

Disable: The user cannot use the account or log in to Device
Manager - Storage Navigator.

Authentication Authentication method. The following methods are available:

Local: Does not use authentication server. Uses a dedicated
password for Device Manager - Storage Navigator.

External: Uses authentication server.

Password Password that the user enters for login.

The allowable characters and length of passwords depend on
the application that the user uses.

Re-enter Password Password as above.

Create User window
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Create User confirmation window

Selected Users

The following table describes the fields and settings used to create a new user account.

Item Description

User Name User name to be created.

Account Status Account statuses. The following statuses are available:

Enabled: The user can use the account.

Disabled: The user cannot use the account or log in to Device
Manager - Storage Navigator.

Authentication Authentication methods. The following methods are available:

Local: Does not use authentication server. Uses a dedicated
password for Device Manager - Storage Navigator.

External: Uses authentication server.

Password Password that the user enters for login.

User Group Name User group name where the user is added.

Create User confirmation window
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Change Password Wizard

Change Password window

Use this window to change the password for yourself or another user.

The following table describes the fields and settings used to change a password.

Item Description

User Name Selected user name.

Current Password Current password of your user account. Required only when you
change your own password.

New Password New password that the selected user enters for login.

The allowable characters and length of passwords depend on
the application that the user uses.

Re-enter New
Password

Same password as above.

Change Password Wizard
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Change Password confirmation window

The following table describes the fields and settings used to change user passwords.

Item Description

User Name Selected user name.

Current Password Current password.

A hyphen (-) indicates no current password is specified.

New Password New password.

Edit User wizard

Edit User window

Use this window to change the setting for authentication or for the account status.

Change Password confirmation window
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The following table describes the fields and settings used to edit user account
information.

Item Description

User Name Selected user name.

Account Status Account statuses. The following statuses are available:

Enabled: The user can use the account.

Disabled: The user cannot use the account or log in to Device
Manager - Storage Navigator.

Authentication Authentication method. The following methods are available:

Local: Does not use authentication server. Uses a dedicated
password for Device Manager - Storage Navigator.

External: Uses authentication server.

Password Password that the user enters for login.

You can specify alphanumeric characters and the following
symbols:

! # $ % & ' ( ) * + , -. / : ; < = > ? @ [ \ ] ^ _` { | } ~

Re-enter Password Password that the user enters for login.

Edit User window
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Edit User confirmation window

The following table describes the fields and settings in the Edit Users window.

Item Description

User Name Selected user name.

Account Status Account status. The following statuses are available:

Enabled: The user can use the account.

Disabled: The user cannot use the account or log in to Device
Manager - Storage Navigator.

Authentication Authentication method. The following methods are available:

Local: Does not use authentication server. Uses a dedicated
password for Device Manager - Storage Navigator.

External: Uses authentication server.

Password Password that the user enters for login.

Edit User confirmation window
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Add User wizard

Add Users window

Use this window to add the created user accounts to the selected user group.

Add User wizard
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Available Users

The following table lists all the candidate users who do not belong to the selected user
group.

Item Description

User Name Selected user name.

Account Status Account status. The following statuses are available:

Enabled: The user can use the account.

Disabled: The user cannot use the account or log in to Device
Manager - Storage Navigator.

Authentication Authentication method. The following methods are available:

Local: Does not use authentication server. Uses a dedicated
password for Device Manager - Storage Navigator.

External: Uses authentication server.

Number of User
Groups

Displays the number of user groups where the user belongs.

Add button

Adds the selected users in the Available Users list to the Selected Users list.

Remove button

Removes the selected users from the Selected Users list and relocates the selected users
to the Available User list.

Add Users window
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Selected Users table

Lists users to be added to the user group.

Item Description

User Name Selected user name.

Account Status Account status. The following statuses are available:

Enabled: The user can use the account.

Disabled: The user cannot use the account or log in to Device
Manager - Storage Navigator.

Authentication Authentication method. The following methods are available:

Local: Does not use authentication server. Uses a dedicated
password for Device Manager - Storage Navigator.

External: Uses authentication server.

Number of User
Groups

Displays the number of user groups where the user belongs.

Add Users window
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Add Users confirmation window

Selected User Group

Item Description

User Group Name Displays the user group name where the user is added.

Selected Users table

Item Description

User Name Selected user name.

Account Status Account status. The following statuses are available:

Enabled: The user can use the account.

Disabled: The user cannot use the account or log in to Device
Manager - Storage Navigator.

Authentication Authentication method. The following methods are available:

Add Users confirmation window
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Item Description

Local: Does not use authentication server. Uses a dedicated
password for Device Manager - Storage Navigator.

External: Uses authentication server.

Number of User
Groups

Displays the number of user groups where the user belongs.

Remove Users window

The Remove Users window is used to remove users from a particular group. However,
the removed users will still remain in the system. To delete users entirely from the
system, see Deleting user accounts (on page 70) .

Selected User Group table

Item Description

User Group Name Displays the name of the user group where the user is removed.

Remove Users window
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Selected Users table

Item Description

User Name Selected user name.

Account Status Account status. The following statuses are available:

Enabled: The user can use the account.

Disabled: The user cannot use the account or log in to Device
Manager - Storage Navigator.

Authentication Authentication method. The following methods are available:

Local: Does not use authentication server. Uses a dedicated
password for Device Manager - Storage Navigator.

External: Uses authentication server.

Number of User
Groups

Displays the number of user groups where the user belongs.

Delete Users window

The Delete Users window is used to delete users entirely from the system. If you want to
remove users from a particular group without deleting them in the system, see Changing
user permissions (on page 69) .

Delete Users window
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Item Description

User Name Selected user name.

Account Status Account status. the following statuses are available:

Enabled: The user can use the account.

Disabled: The user cannot use the account or log in to Device
Manager - Storage Navigator.

Authentication Authentication method. The following methods are available:

Local: Does not use authentication server. Uses a dedicated
password for Device Manager - Storage Navigator.

External: Uses authentication server.

Number of User
Groups

Displays the number of user groups to which the user belongs.

Edit User Group wizard

Edit User Group window

Use this window to change the name of a user group.

The following table describes the fields and settings used to edit user group information.

Edit User Group wizard
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Item Description

User Group Name Enter the new name of the user group.

You can use alphanumeric characters, spaces, and the following
symbols:

! # $ % & ' ( ) + - . = @ [ ] ^ _ ` { } ~

Check Check whether the entered user group name is registered to the
authentication server when you use an authentication server.

Edit User Group confirmation window

The following table describes the fields and settings used to edit user group information.

Item Description

User Group Name Displays the new name of the user group.

Number of Roles Displays the number of roles that are assigned to the user
group.

Number of
Resource Groups

Displays the number of resource groups that are assigned to the
user group.

Number of Users Displays the number of users that belong to the user group.

Edit User Group confirmation window
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Item Description

All Resource Groups
Assigned

Displays whether all the resource groups are assigned.

Yes: All resource groups are assigned to the user group.

No: All resource groups are not assigned to the user group.

Delete User Groups window

Item Description

User Group Name Displays the new name of the user group.

Number of Roles Displays the number of roles that are assigned to the user
group.

Number of
Resource Groups

Displays the number of resource groups that are assigned to the
user group.

Number of Users Displays the number of users that belong to the user group.

All Resource Groups
Assigned

Displays whether all resource groups are assigned.

Yes: All resource groups are assigned to the user group.

No: All resource groups are not assigned to the user group.

Delete User Groups window
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Edit Resource Group Assignment wizard

Edit Resource Group Assignment window

Use this window to assign created resource groups to the user group and to assign
created resource groups to the user group in the Create User Group.

The following table describes the fields and settings used to assign resource groups with
the Create User Group wizard.

Item Description

All Resource Groups
Assigned

Displays whether all the resource groups are assigned to the
user group.

This item is set to Yes when the following roles are assigned in
the Assign Roles window.
■ Security Administrator (View Only)
■ Security Administrator (View & Modify)
■ Audit log Administrator (View Only)
■ Audit log Administrator (View & Modify)
■ Support Personnel (Vendor Only)
■ Support Personnel (User)

Edit Resource Group Assignment wizard
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Item Description

When this item is set to Yes, Unassigned Resource Groups table,
Assigned Resource Groups table, Add button, and Remove
button are disabled.

Unassigned Resource Groups table

The following table lists the resource groups that are not assigned to the user group.

Item Description

Resource Group
Name (ID)

Displays the name and ID of the resource group that is not
assigned to the user group to be created.

Number of User
Groups

Displays the number of user groups that are not assigned to the
resource group.

Edit Resource Group Assignment window
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Item Description

Number of Parity
Groups

Displays the number of parity groups that are not assigned to
the resource group.

Number of LDEVs Displays the number of LDEVs that are not assigned to the
resource group.

Number of Ports Displays the number of ports that are not assigned to the
resource group.

Number of Host
Groups

Displays the number of host groups that are not assigned to the
resource group.

Number of iSCSI
Targets

Displays the number of the iSCSI targets that are assigned to the
resource group.

Detail Displays the detail of the selected resource group.

Add button

Adds the selected resource groups in the Unassigned Resource Groups list to the
Assigned Resource Groups list.

Remove button

Removes the selected resource groups from the Assigned Resource Groups list and
relocates the resource groups to the Unassigned Resource Groups list.

Edit Resource Group Assignment window
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Assigned Resource Groups table

Lists the resource groups to be assigned to the user group.

Item Description

Resource Group
Name (ID)

Displays the name and ID of the resource group assigned to the
user group to be created.

Number of User
Groups

Displays the number of user groups that are assigned to the
resource group.

Number of Parity
Groups

Displays the number of parity groups that are assigned to the
resource group.

Number of LDEVs Displays the number of LDEVs that are assigned to the resource
group.

Number of Ports Displays the number of ports that are assigned to the resource
group.

Edit Resource Group Assignment window
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Item Description

Number of Host
Groups

Displays the number of host groups that are assigned to the
resource group.

Number of iSCSI
Targets

Displays the number of the iSCSI targets that are assigned to the
resource group.

Detail Displays the detail of the selected resource group.

Edit Resource Group Assignment confirmation window

The following tables describe the fields and settings used to assign user group names
with the Create User Group wizard.

Edit Resource Group Assignment confirmation window
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Item Description

User Group Name Displays the new name of the user group.

Selected Resource Groups as Assigned Table

The following table describes the fields and settings used to assign resource groups with
the Create User Group wizard.

Item Description

Resource Group
Name (ID)

Displays the name and ID of the resource group assigned to the
user group to be created.

Number of User
Groups

Displays the number of user groups that are assigned to the
resource group.

Number of Parity
Groups

Displays the number of parity groups that are assigned to the
resource group.

Number of LDEVs Displays the number of LDEVs that are assigned to the resource
group.

Number of Ports Displays the number of ports that are assigned to the resource
group.

Number of Host
Groups

Displays the number of host groups that are assigned to the
resource group.

Number of iSCSI
Targets

Displays the number of the iSCSI targets that are assigned to the
resource group.

Detail Displays the detail of the selected resource group.

Selected Resource Groups as Unassigned Table

The following table lists the resource groups that are not assigned to the user group.

Item Description

Resource Group
Name (ID)

Displays the name and ID of the resource group not assigned to
the user group to be created.

Number of User
Groups

Displays the number of user groups that are not assigned to the
resource group.

Number of Parity
Groups

Displays the number of parity groups that are not assigned to
the resource group.

Edit Resource Group Assignment confirmation window
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Item Description

Number of LDEVs Displays the number of LDEVs that are not assigned to the
resource group.

Number of Ports Displays the number of ports that are not assigned to the
resource group.

Number of Host
Groups

Displays the number of host groups that are not assigned to the
resource group.

Number of iSCSI
Targets

Displays the number of the iSCSI targets that are assigned to the
resource group.

Detail Displays the detail of the selected resource group.

Edit Role Assignment wizard

Edit Role Assignment window

Use this window to add roles to the user group and to assign roles to the user group in
the Create User Group.

Edit Role Assignment wizard
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Unassigned Roles

Lists roles that are not assigned to the user group.

Item Description

Role Displays roles.

Add button

Adds the selected roles in the Unassigned Roles list to the Assigned Roles list.

Remove button

Removes the selected roles from the Assigned Roles list and relocates the selected roles
to the Unassigned Roles list.

Assigned Roles

The following window shows the roles that can be assigned to the selected user group.

Edit Role Assignment window
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Item Description

Role Displays roles.

Edit Role Assignment window
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Edit Role Assignment confirmation window

Selected User Group

Item Description

User Group Name Displays the new name of the user group.

All Resource Groups
Assigned

Displays whether all the resource groups are assigned.

Yes: All the resource groups are assigned to the user group.

No: All the resource groups are not assigned to the user group.

Selected Assigned Roles

Item Description

Role Displays the roles that are assigned to the user group.

Edit Role Assignment confirmation window
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Selected Unassigned Roles

Item Description

Role Displays the roles that are not assigned to the user group.

Edit Role Assignment confirmation window
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Appendix G:  Device Manager - Storage
Navigator licenses GUI reference

This section describes the Device Manager - Storage Navigator windows that you use to
view and manage the licenses for the software applications on your storage system.

Licenses window

Use the Licenses window to install and uninstall license keys.

Summary

The following table describes the fields and settings in the Summary section of the
Licenses window.

Item Description

Number of Software
Licenses

Number of software products installed in the client.

License Keys

The following table describes the fields and settings in the License Keys section of the
License Keys window.
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Item Description

Program Product name Name of the software application

Status The current status of the software
■ Installed: The software is available.
■ Installed (Disabled): Installation is complete, but the

license is set to Disabled. This status might appear if an
error occurs after you install software. Resolve the error
and enable the license. This status also appears when the
license key of this software is installed but the license key
of the prerequisite software has expired.

■ Not Installed: The software is not installed.
■ Not Enough License: Installation is complete, but the

license capacity is insufficient.
■ Grace Period: The licensed capacity is insufficient

because LDEVs are added, or copy pairs are created, or
pool volumes are added. The license expires in 30 days.
Please purchase the licenses before the license key
expires.

■ Expired: The term has already expired for the
temporary key. When the status is Expired, you cannot re-
install the temporary key.

Key Type The license key type:
■ Permanent
■ Term
■ Temporary
■ Emergency

This field is blank if no license key is installed.

License Capacity (TB) ■ Permitted: The window displays the permitted volume
capacity for this software in integers. If no upper limit
value is set for the capacity, "Unlimited" displays. This
field is blank if no license is installed.

■ Used: This is the capacity of the volumes used by the
software. Up to the second decimal place is displayed.
The third decimal place is rounded up. If the license
capacity type is other than Used, a hyphen (-) displays. If
no license isL installed, a blank displays.

Licensed capacity displayed is found from calculations based
on the following:

Licenses window
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Item Description

1 KB= 1,024 bytes, 1 MB = 1,024 KB, 1 GB = 1,024 MB, 1 TB=
1,024 GB

Term (Days) The number of days remaining before the expiration of a
temporary key, an emergency key, or a term key. After the
temporary key has expired, the column shows the number of
days that remain before you can reinstall the temporary key.
If there is no limit on validity, a hyphen (-) displays. This field
is blank if no license is installed.

Install Opens the Install Licenses window

Enable Opens the Enable Licenses window

Disable Opens the Disable Licenses window

Remove Opens the Remove Licenses window

Install Licenses window

This topic describes the Install Licenses window.

The following table describes the fields and settings in the Install Licenses window.

Install Licenses window

Appendix G: Device Manager - Storage Navigator licenses GUI reference

System Administrator Guide for VSP E990 and VSP G130, G/F350, G/F370, G/F700, G/F900 406



Item Description

License Key Code Install software by entering the license key code.

License Key File Specify the license key file by clicking Browse. The file
extension is plk.

Enable Licenses window

This section describes the Enable Licenses window.

The following table describes the fields and settings in the Enable Licenses window.

Item Description

Program Product Name Name of the software application

Status Displays the software installation status. See the Licenses
window (on page 404) for the description of each status.

Key Type The license key type:
■ Permanent
■ Term

Enable Licenses window
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Item Description

■ Temporary
■ Emergency

This field is blank if no license key is installed.

Licensed Capacity (TB) ■ Permitted: The window displays the permitted volume
capacity for this software in integers. If no upper limit
value is set for the capacity, "Unlimited" displays. This
field is blank if no license is installed.

■ Used: This is the capacity of the volumes used by the
software. Up to the second decimal place is displayed.
The third decimal place is rounded up. If the license
capacity type is other than Used, a hyphen (-) displays. If
no license is installed, a blank displays.

Licensed capacity displayed is found from calculations
based on the following:

1 KB= 1,024 bytes, 1 MB = 1,024 KB, 1 GB = 1,024 MB, 1
TB= 1,024 GB

Term (Days) The number of days remaining before the expiration of a
temporary key, an emergency key, or a term key. After the
temporary key has expired, the column shows the number of
days that remain before you can reinstall the temporary key.
If there is no limit on validity, a hyphen (-) displays. This field
is blank if no license is installed.

Disable Licenses window

This section describes the Disable Licenses window.

Disable Licenses window
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The following table describes the fields and settings in the Disable Licenses window.

Item Description

Program Product Name Name of the software application

Status Displays the software's installation status. See the Licenses
window (on page 404) for the description of each status.

Key Type The license key type:
■ Permanent
■ Term
■ Temporary
■ Emergency

This field is blank if no license key is installed.

Disable Licenses window
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Item Description

Licensed Capacity (TB) ■ Permitted: The window displays the permitted volume
capacity for this software in integers. If no upper limit
value is set for the capacity, "Unlimited" displays. This
field is blank if no license is installed.

■ Used: This is the capacity of the volumes used by the
software. Up to the second decimal place is displayed.
The third decimal place is rounded up. If the license
capacity type is other than Used, a hyphen (-) displays. If
no license is installed, a blank displays.

Licensed capacity displayed is found from calculations
based on the following:

1 KB= 1,024 bytes, 1 MB = 1,024 KB, 1 GB = 1,024 MB, 1
TB= 1,024 GB

Term (Days) The number of days remaining before the expiration of a
temporary key, an emergency key, or a term key. After the
temporary key has expired, the column shows the number of
days that remain before you can reinstall the temporary key.
If there is no limit on validity, a hyphen (-) displays. This field
is blank if no license is installed.

Remove Licenses window

This topic describes the Remove Licenses window.

Remove Licenses window
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Item Description

Program Product Name Name of the software application

Status Displays the software's installation status. See the Licenses
window (on page 404) for the description of each status.

Key Type The license key type:
■ Permanent
■ Term
■ Temporary
■ Emergency

This field is blank if no license key is installed.

Remove Licenses window
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Item Description

Licensed Capacity (TB) ■ Permitted: The window displays the permitted volume
capacity for this software in integers. If no upper limit
value is set for the capacity, "Unlimited" displays. This
field is blank if no license is installed.

■ Used: This is the capacity of the volumes used by the
software. Up to the second decimal place is displayed.
The third decimal place is rounded up. If the license
capacity type is other than Used, a hyphen (-) displays. If
no license is installed, a blank displays.

Licensed capacity displayed is found from calculations
based on the following:

1 KB= 1,024 bytes, 1 MB = 1,024 KB, 1 GB = 1,024 MB, 1
TB= 1,024 GB

Term (Days) The number of days remaining before the expiration of a
temporary key, an emergency key, or a term key. After the
temporary key has expired, the column shows the number of
days that remain before you can reinstall the temporary key.
A hyphen (-) displays if the If there is no limit on validity, a
hyphen (-) displays. This field is blank if no license is installed.

Remove Licenses window
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Appendix H:  Configuring storage systems GUI
reference

This section describes the Device Manager - Storage Navigator windows and wizards that
you use to configure storage systems.

Login Message window

The following table describes the fields and settings in the Login Message window.

Item Description

Login Message Enter a login message. You can use up to 2,048 alphanumeric
characters and symbols.
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Edit Storage System wizard

Edit Storage System window

The following table describes the fields and settings in the Edit Storage System window.

Note:
■ The values set in this window are also displayed in the Storage System

window of the maintenance utility and on the SNMP tab of the Alert
Notifications window.

■ For all fields, you can enter up to 180 alphanumeric characters excluding
the following symbols:

\ , / ; : * ? " < > | & % ^
■ Do not enter space characters at the beginning or the end of the values.

Item Description

Storage System
Name

Device name of the storage system. Changing this item also changes the
Storage System name of SNMP tab in the Storage System window, and Alert
Notification window of Maintenance Utility.

Edit Storage System wizard
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Item Description

Contact Contact information such as personnel and telephone number where you can
inquire about the storage system. Changing this item also changes the Contact
of SNMP tab of Storage System window, and Alert Notification window of
Maintenance Utility.

Location Location of the connected storage system. Changing this item also changes the
Location of SNMP tab of Storage System window, and Alert Notification
window of Maintenance Utility.

Edit Storage System confirmation window

The following table describes the fields and settings in the Confirm window (Edit Storage
System).

Item Description

Storage
System Name

Device name of the storage system.

Contact Contact information such as personnel and telephone number where you can
inquire about the storage system.

Location Location of the connected storage system.

Edit Storage System confirmation window
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Alert Notifications wizard

Alert Notifications window

Summary

Item Description

Notification
Alert

Destination of the alert notification
■ Host Report: Sends alerts only of SIMs that report to hosts.
■ All: Sends alerts of all SIMs.

Alert destinations are common to Syslog, SNMP, and Email.

Alert Notifications wizard
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Item Description

Email Notice Failure notification setting
■ Enabled: Reports the SIM by email
■ Disabled: Does not report the SIM by email

Syslog Server
Notice -
Transfer
Protocol

Protocol to transfer the syslog
■ TLS1.2/RFC5424
■ UDP/RFC3164

Syslog Server
Notice -
Primary
Server

Whether to use the Syslog server
■ Enabled: Reports SIM to the Syslog Server through Syslog.
■ Disabled: Does not report SIM to the Syslog Server through Syslog

Syslog Server
Notice -
Secondary
Server

Whether to use an alternate server for the Syslog server
■ Enabled: Reports SIM to the alternate Syslog server through Syslog.
■ Disabled: Does not report SIM to the alternate Syslog server through Syslog

SNMP Agent Whether the SNMP agent is being used
■ Enabled: Reports the SIM through an SNMP trap

■ Disabled: Does not report the SIM through an SNMP trap

Set Up button Displays the Set Up Alert Notifications window

Email tab

Item Description

Mail Server Mail server information (host name or IP address)

SMTP
Authenticatio
n

Whether to perform SMTP authentication
■ Enabled: Performs SMTP authentication
■ Disabled: Does not perform SMTP authentication

SMTP
Authenticatio
n - Account

SMTP Authentication account

Email Address
- From

Source address of the email for failure information report

Email Address
- Reply To

Return email address

Alert Notifications window
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Item Description

Email Address
- To

Destination address of the email for failure information report

Email Address
- Cc

Carbon copy address of the email for failure information alert

Email Address
- Bcc

Carbon copy address of the email for failure information alert

Send Test
Email button

Sends a test SIM by email

Syslog tab

Item Description

Primary
Server - Host
Name/IP
Address

Host name or IP address of the Syslog server. To display the entire host name,
click the button at the right of the field to expand the field.

Primary
Server - Port
Number

Port number of the Syslog server

Alert Notifications window
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Item Description

Secondary
Server - Host
Name/IP
Address

Host name or IP address of the alternate Syslog server. To display the entire host
name, click the button at the right of the field to expand the field.

Secondary
Server - Port
Number

Port number of the alternate Syslog server

Location
Identification
Name

Identification name of the storage system to transfer the SIM to the Syslog server

Retry Retry setting
■ Enable: Retry when communication with syslog server fails

■ Disable: Does not retry when communication with syslog server fails

Retry Interval Retry interval when communication with the Syslog server fails

Send Test
Message to
Syslog Server
button

Sends a test SIM by syslog

SNMP tab (SNMP v1 or v2c)

Alert Notifications window
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Item Description

Storage
System Name

Storage system name

Contact Administrator name and contact information, such as personnel and telephone
number where you can inquire about the storage system

Location Location of the connected storage system

SNMP Engine
ID

SNMP engine identifier

SNMP Version SNMP protocol version

Sending Trap
Setting

■ Community: Community names to which SNMP traps are reported
■ Send Trap to: IP address to which SNMP traps are reported

Request
Authentication
Setting

■ Community: Communities that have permission to execute GET REQUEST,
GETNEXT REQUEST, and GETBULK REQUEST

■ Requests Permitted: IP addresses that have permission to execute GET
REQUEST, GETNEXT REQUEST, and GETBULK REQUEST

Send Test
SNMP Trap
button

Sends a test trap to the IP address registered for the storage system

SNMP tab (SNMP v3)

Alert Notifications window
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Item Description

Storage
System Name

Storage system name

Contact Administrator name and contact information, such as personnel and telephone
number where you can inquire about the storage system

Location Location of the connected storage system

SNMP Engine
ID

SNMP engine identifier

SNMP Version SNMP protocol version

Sending Trap
Setting

■ Send Trap to: IP address to which SNMP traps are reported
■ User Name: User name used for reporting SNMP traps
■ Authentication - Mode: Whether authentication is enabled
■ Authentication - Protocol: Authentication method if authentication is enabled
■ Encryption - Mode: Whether encryption is enabled
■ Encryption - Protocol: Encryption method used if encryption is enabled

Request
Authentication
Setting

■ User Name: Users that have permission to execute GET REQUEST, GETNEXT
REQUEST, and GETBULK REQUEST

■ Authentication - Mode: Whether authentication is enabled
■ Authentication - Protocol: Authentication method used if authentication is

enabled
■ Encryption - Mode: Whether encryption is enabled
■ Encryption - Protocol: Encryption method used if encryption is enabled

Send Test
SNMP Trap
button

Sends a test trap to the IP address registered in the storage system

Alert Notifications window
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Set Up Alert Notifications window

Item Description

Notification
Alert

Displays the destination of the alert notification.
■ Host Report: Sends alerts only of SIMs that report to hosts.
■ All: Sends alerts of all SIMs.

Alert destinations are common to Syslog, SNMP, and Email.

Email tab

Item Description

Mail Notice Select whether or not to report failure information through email.
■ Enable: Reports SIM through email.
■ Disable: Does not report SIM through email.

Set Up Alert Notifications window
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Item Description

Mail Address
(To)

This field is mandatory when you selected Enable in Mail Notice.
■ Add: Adds email addresses. The Add Address window opens
■ Delete: Deletes the selected email address. You can select more than one email

address.

Mail Address
(From)

Enter the source address of the email for failure information report.

You can use a name of up to 255 characters. Usable characters: Alphanumeric
characters and symbols (! # $ % & ` + - * / ' ^ { } _ . )

This field is mandatory when you selected Enable in Mail Notice.

Mail Address
(Reply - To)

Specify the return email address. If you specify this address, return email from the
email recipient is transmitted to the address. If you omit this address, return email
from the email recipient is transmitted to Mail Address (From).

You can use a name of up to 255 characters. Usable characters: Alphanumeric
characters and symbols (! # $ % & ` + - * / ' ^ { } _ . )

Description to
notify

Enter the description for notifying failure information. You can enter up to 511
characters and also a line feed code, which is counted as two characters.

Mail Server
Setting -
Email Server

Enter the Email server information. You cannot set an IP address with all 0s.
■ Identifier: To specify a host name, select Identifier. You can enter a name of up

to 255 characters.
■ IPv4: To set an IPv4 address, select IPv4, and enter four numbers within the

range of 0 to 255.

Example: XXX.XXX.XXX.XXX (X indicates a numeral)

■ IPv6: To set an IPv6 address, select IPv6, and enter eight hexadecimal
alphanumeric characters within the range of 0 to FFFF. You can also use an
abbreviated-format IPv6 address.

Example: YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY (Y indicates a hexadecimal
digit)

This field is mandatory when you select Enable in Mail Notice.

Mail Server
Setting -
SMTP
Authenticatio
n

Select whether or not to perform SMTP authentication.
■ Enable: Performs SMTP authentication.
■ Disable: Does not perform SMTP authentication.

When you select Enable, enter values in Account and Password.

You can use a name of up to 255 characters. Usable characters are: Alphanumeric
characters and symbols (! # $ ` + - * ' { } _ . )

This field is mandatory when you select Enable in Mail Notice.

Set Up Alert Notifications window
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Syslog tab

Item Description

Transfer
Protocol

Select the protocol for Syslog transfer.
■ TLS1.2/RFC5424
■ UDP/RFC3164

Primary
Server

Select whether or not to use the Syslog Server.
■ Enable: Reports SIM to the Syslog Server through Syslog
■ Disable: Does not report SIM to the Syslog Server through Syslog

Set Up Alert Notifications window
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Item Description

Primary
Server -
Syslog Server

Enter the IP address of the server that you want to set as the Syslog Server. You
cannot set an address with all zeros.
■ To set a host name, select Identifier and enter the host name in no more than

255 characters. Allowed characters are alphanumeric characters and symbols: !
$ % - . @ _ ` ~.

■ To set an IPv4 address, select IPv4, and enter four numbers within the range of
0 to 255.

Example: XXX.XXX.XXX.XXX (X indicates a numeral)

■ To set an IPv6 address, select IPv6, and enter eight hexadecimal alphanumeric
characters within the range of 0 to FFFF. You can also use an abbreviated-
format IPv6 address.

Example: YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY (Y indicates a hexadecimal
digit)

Use this field only when you select Enable in Primary Server.

Primary
Server - Port
Number

Enter the port number used by the Syslog Server. Use this field only when you
selected Enable in Primary Server.

Primary
Server - Client
Certificate File
Name

Specify a certificate file. Click Browse and specify the certificate file.

Use this field only when you select TLS1.2/RFC5424 in Transfer Protocol and
selected Enable in Primary Server. Note the following:
■ This field is mandatory when it is activated.
■ If you leave the certificate field blank when you apply settings for the second

time or later, the certificate that was updated the last time is used.

Primary
Server -
Password

Enter a password for the client certificate. Passwords can contain up to 128
alphanumeric characters and the following symbols:

! # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~

Use this field only when you specified Client Certificate File Name.

Primary
Server - Root
Certificate File
Name

Specify a certificate file. Click Browse and specify the certificate file.

Use this field only when you select TLS1.2/RFC5424 in Transfer Protocol and
selected Enable in Primary Server.
■ This field is mandatory when it is activated.
■ If you leave the certificate field blank when you apply settings for the second

time or later, the certificate that was updated the last time is used.

Set Up Alert Notifications window
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Item Description

Secondary
Server

Select whether or not to use an alternate server for the syslog server.
■ Enable: Reports a SIM to the alternate syslog server through Syslog.
■ Disable: Does not report a SIM to the alternate server for the syslog server

through Syslog.

Secondary
Server -
Syslog Server

Enter the IP address of the server that you want to set as the alternate Syslog
Server. You cannot set an address with all 0s.
■ To set an IPv4 address, select IPv4, and enter four numbers within the range of

0 to 255.

Example: XXX.XXX.XXX.XXX (X indicates a numeral)

■ To set an IPv6 address, select IPv6, and enter eight hexadecimal alphanumeric
characters within the range of 0 to FFFF. You can also use an abbreviated-
format IPv6 address.

Example: YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY (Y indicates a hexadecimal
digit)

Use this field only when you select Enable in the secondary server.

Secondary
Server - Port
Number

Enter the port number used by the alternate syslog server. Use this field only
when you selected Enable in Secondary Server.

Secondary
Server - Client
Certificate File
Name

Specify a certificate file. Click Browse and specify the certificate file.

Use this field only when you select TLS1.2/RFC5424 in Transfer Protocol and
selected Enable in the secondary server.
■ This field is mandatory when it is activated.
■ If you leave the certificate field blank when you apply settings for the second

time or later, the certificate that was updated the last time is used.

Secondary
Server -
Password

Enter a password for the client certificate. Passwords can contain up to 128
alphanumeric characters and the following symbols:

! # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~

Use this field only when you specify the client certificate file name.

Secondary
Server - Root
Certificate File
Name

Specify a certificate file. Click Browse and specify the certificate file.

Use this field only when you select TLS1.2/RFC5424 in Transfer Protocol and
selected Enable in the secondary server.
■ This field is mandatory when it is activated.
■ If you leave the certificate field blank when you apply settings for the second

time or later, the certificate that was updated the last time is used.

Set Up Alert Notifications window
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Item Description

Location
Identification
Name

Enter a name for identification of the storage system from which SIM is
transferred to the syslog server. Names can contain up to 32 alphanumeric
characters and the following symbols: (! # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ `
{ | } ~)

Spaces are not allowed. This field is mandatory when Primary Server or Secondary
Server are enabled.

Retry Displays the retry setting
■ Enable: Retry when communication with syslog server fails
■ Disable: Does not retry when communication with syslog server fails

Retry Interval Enter a value between 1 and 60 (seconds) as the retry interval when
communication with the Syslog Server fails. The default is 1.

Use this field only when you selected TLS1.2/RFC5424 in Transfer Protocol.

SNMP tab (SNMP v1 or v2c)

Set Up Alert Notifications window
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Item Description

SNMP Agent Select whether to use the SNMP agent
■ Enable: Reports SIM with SNMP and permits GET REQUEST, GETNEXT REQUEST,

or GETBULK REQUEST*.
■ Disable: Does not report SIM with SNMP nor permit GET REQUEST, GETNEXT

REQUEST, or GETBULK REQUEST*.

SNMP Version Select the SNMP protocol version

Sending Trap
Setting

Displays the community name and IP address for which SNMP traps are reported.
The Registered Sending Trap Settings table includes the following:
■ Community: Displays the communities to which SNMP traps are reported.
■ Send Trap to: Displays the IP address to which SNMP traps are reported.
■ Add: Adds an SNMP trap. The Add Sending Trap Setting window opens. Up to

32 communities can be registered.
■ Change: Opens the Change Sending Trap Setting window for the selected row.
■ Remove: Removes the selected community from the Registered Sending Trap

Settings table.

Request
Authenticatio
n Setting

Displays the name and IP address of the communities that have permission to
execute GET REQUEST, GETNEXT REQUEST and GETBULK REQUEST*. The
Registered Sending Trap Settings table includes the following:
■ Community: Displays the communities that have permission to execute GET

REQUEST, GETNEXT REQUEST and GETBULK REQUEST*.
■ Requests Permitted: Displays the IP addresses that have permission to execute

GET REQUEST, GETNEXT REQUEST and GETBULK REQUEST*.
■ Add: Displays the Add Request Authentication Setting window. Up to 32

communities can be registered.
■ Change: Opens the Change Request Authentication Setting window for the

selected row.
■ Remove: Removes the selected community from the Request Authentication

Settings table.

System Group
Information -
Storage
System Name

Enter the storage system name.

You can enter up to 180 alphanumeric characters excluding the following symbols:

\ , / ; : * ? ” < > | & % ^

Do not enter space characters at the beginning or the end of the value.

This field is mandatory. When you change this field, Storage System Name in the
Storage System window of Device Manager - Storage Navigator and the
maintenance utility is also changed.

Set Up Alert Notifications window
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Item Description

System Group
Information -
Contact

Enter the administrator's name or contact information.

You can enter up to 180 alphanumeric characters excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

When you change this field, Contact in the Storage System window of Device
Manager - Storage Navigator and the maintenance utility is also changed.

System Group
Information -
Location

Enter the location of the storage system.

You can enter up to 180 alphanumeric characters excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

When you change this field, Location in the Storage System window of Device
Manager - Storage Navigator and the maintenance utility is also changed.

SNMP Engine
ID

Displays the SNMP engine ID

Notes*: * Only SNMP v2c supports GETBULK REQUEST.

Set Up Alert Notifications window
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SNMP tab (SNMP v3)

Item Description

SNMP Agent Select whether to use the SNMP agent
■ Enable: Reports SIM with SNMP and permits GET REQUEST, GETNEXT REQUEST,

or GETBULK REQUEST.
■ Disable: Does not report SIM with SNMP nor permit GET REQUEST, GETNEXT

REQUEST, or GETBULK REQUEST.

SNMP Version Select the SNMP protocol version

Sending Trap
Setting

Displays the user name and IP address for which SNMP traps are reported. The
Registered Sending Trap Settings table includes the following:
■ Send Trap to: Displays the IP address to which SNMP traps are reported.
■ User Name: Displays the user name to be used for reporting SNMP traps.
■ Authentication - Mode: Displays whether authentication is enabled.
■ Authentication - Protocol: Displays the authentication method used if

authentication is enabled.
■ Encryption - Mode: Displays whether encryption is enabled.

Set Up Alert Notifications window
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Item Description

■ Encryption - Protocol : Displays the encryption method used if encryption is
enabled.

■ Add: Adds an SNMP trap. The Add Sending Trap Setting window opens. Up to
eight IP addresses can be registered.

■ Change: Opens the Change Sending Trap Setting window for the selected row.
■ Remove: Removes the selected user from the Registered Sending Trap Settings

table.

Request
Authenticatio
n Setting

Displays the users for whom you permit GET REQUEST, GETNEXT REQUEST and
GETBULK REQUEST. The Registered Sending Trap Settings table includes the
following:
■ User Name: Displays names of users that have permission to execute GET

REQUEST, GETNEXT REQUEST and GETBULK REQUEST.
■ Authentication - Mode: Displays whether authentication is enabled.
■ Authentication - Protocol: Displays the authentication method used if

authentication is enabled.
■ Encryption - Mode: Displays whether encryption is enabled.
■ Encryption - Protocol : Displays the encryption method used if encryption is

enabled.
■ Add: Displays the Add Request Authentication Setting window. Up to eight

users can be registered.
■ Change: Opens the Change Sending Trap Setting window for the selected row.
■ Remove: Removes the selected user from the Request Authentication Settings

table.

System Group
Information -
Storage
System Name

Enter the storage system name.

You can enter up to 180 alphanumeric characters excluding the following symbols:

\ , / ; : * ? ” < > | & % ^

Do not enter space characters at the beginning or the end of the value.

This field is mandatory. When you change this field, Storage System Name in the
Storage System window of Device Manager - Storage Navigator and the
maintenance utility is also changed.

System Group
Information -
Contact

Enter the administrator's name or contact information.

You can enter up to 180 alphanumeric characters excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

When you change this field, Contact in the Storage System window of Device
Manager - Storage Navigator and the maintenance utility is also changed.

Set Up Alert Notifications window
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Item Description

System Group
Information -
Location

Enter the location of the storage system.

You can enter up to 180 alphanumeric characters excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

When you change this field, Location in the Storage System window of Device
Manager - Storage Navigator and the maintenance utility is also changed.

SNMP Engine
ID

Displays the SNMP engine ID.

Add Email Address window

Item Description

Email Address Enter the source address of the email for failure information report. You can use
up to 255 alphanumeric characters, including these symbols: !# $ % & ` + - * / ' ^
{ } _ . @ ~ = ? |

Add Sending Trap Setting window (SNMP v1 or v2c)

This window appears when you click Add on the SNMP tab of the Set Up Alert
Notifications window if the SNMP protocol version is SNMP v1 or SNMP v2c.

Add Email Address window
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Item Description

Community Specify the community to which SNMP traps are reported.
■ To select an existing community from a pull down menu, clear New.
■ To create a community, select New, and then enter a name.

You can enter up to 180 alphanumeric characters excluding the following
symbols:

\ , / ; : * ? " < > | & % ^ '

Do not enter space characters at the beginning or the end of the value.

Send Trap to Specify the IP address to which SNMP traps are reported.
■ To select an existing IP address from a pull down menu, clear New.
■ To add an IP address, select New, and then enter an address.
■ IPv4: Enter a valid IPv4 address in the format XXX.XXX.XXX.XXX (where XXX is a

number from 0 to 255)
■ IPv6: Enter a valid IPv6 address in the format

YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY: (where YYYY is a hexadecimal number
from 0 to FFFF). You can also use an IPv6 address in abbreviated format.

■ Minus symbol: Removes the IP address in that row.
■ Add IP Address: Adds an IP address. You can add up to 32 IP addresses.

Add Sending Trap Setting window (SNMP v1 or v2c)
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Add Sending Trap Setting window (SNMP v3)

This window appears when you click Add on the SNMP tab of the Set Up Alert
Notifications window if the SNMP protocol version is SNMP v3.

Item Description

Send Trap to Specify the IP address to which SNMP traps are reported.
■ IPv4: Enter a valid IPv4 address in the format XXX.XXX.XXX.XXX (where XXX is a

number from 0 to 255)
■ IPv6: Enter a valid IPv6 address in the format

YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY: (where YYYY is a hexadecimal number
from 0 to FFFF). You can also use an IPv6 address in abbreviated format.

User Name Enter the user name to be used for reporting SNMP traps.

You can enter up to 32 alphanumeric characters, excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

Note:

Add Sending Trap Setting window (SNMP v3)
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Item Description

If you use a user name that has already been specified for Sending Trap Setting or
Request Authentication Setting, specify the same settings for the following
options that were specified for that name. Otherwise, SNMP traps might not be
sent correctly.
■ Authentication
■ Authentication - Protocol
■ Authentication - Password
■ Encryption
■ Encryption - Protocol
■ Encryption - Key

Authentication Select whether to perform authentication.
■ Enable: Authentication is performed.
■ Disable: Authentication is not performed.

Authentication and encryption information is displayed only if authentication is
enabled.

Authentication
- Protocol

If authentication is enabled, select the authentication method.
■ SHA
■ MD5

Authentication
- Password

If authentication is enabled, enter a password. The password must be 8 to 64
alphanumeric characters, excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

Encryption Select whether to perform encryption.
■ Enable: Encryption is performed.
■ Disable: Encryption is not performed.

Encryption information is displayed only if encryption is enabled.

Encryption -
Protocol

If encryption is enabled, select the encryption method.
■ AES
■ DES

Encryption -
Key

If encryption is enabled, enter a key. The key must be 8 to 64 alphanumeric
characters, excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

Add Sending Trap Setting window (SNMP v3)
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Item Description

Encryption -
Re-enter Key

Re-enter the same key.

Change Sending Trap Setting window (SNMP v1 or v2c)

This window appears when you click Change on the SNMP tab of the Set Up Alert
Notifications window if the SNMP protocol version is SNMP v1 or SNMP v2c.

Item Description

Community Enter the community name to which SNMP traps are reported.

You can enter up to 180 alphanumeric characters excluding the following
symbols:

\ , / ; : * ? " < > | & % ^ '

Do not enter space characters at the beginning or the end of the value.

Change Sending Trap Setting window (SNMP v1 or v2c)
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Item Description

Send Trap to Specify the IP address to which SNMP traps are reported.
■ To select an existing IP address from a pull down menu, clear New.
■ To add an IP address, select New, and then enter an address.
■ IPv4: Enter a valid IPv4 address in the format XXX.XXX.XXX.XXX (where XXX is a

number from 0 to 255)
■ IPv6: Enter a valid IPv6 address in the format

YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY: (where YYYY is a hexadecimal number
from 0 to FFFF). You can also use an IPv6 address in abbreviated format.

■ Minus symbol: Removes the IP address in that row.
■ Add IP Address: Adds an IP address. You can add up to 32 IP addresses.

Change Sending Trap Setting window (SNMP v3)

This window appears when you click Change on the SNMP tab of the Set Up Alert
Notifications window if the SNMP protocol version is SNMP v3.

Change Sending Trap Setting window (SNMP v3)
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Item Description

Send Trap to Specify the IP address to which SNMP traps are reported.
■ IPv4: Enter a valid IPv4 address in the format XXX.XXX.XXX.XXX (where XXX is a

number from 0 to 255)
■ IPv6: Enter a valid IPv6 address in the format

YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY: (where YYYY is a hexadecimal number
from 0 to FFFF). You can also use an IPv6 address in abbreviated format.

User Name Enter the user name to be used for reporting SNMP traps.

You can enter up to 32 alphanumeric characters, excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

Note:

If you use a user name that has already been specified for Sending Trap Setting or
Request Authentication Setting, specify the same settings for the following
options that were specified for that name. Otherwise, SNMP traps might not be
sent correctly.
■ Authentication
■ Authentication - Protocol
■ Authentication - Password
■ Encryption
■ Encryption - Protocol
■ Encryption - Key

Authentication Select whether to perform the authentication.
■ Enable: Authentication is performed.
■ Disable: Authentication is not performed.

Authentication and encryption information is displayed only if authentication is
enabled.

Authentication
- Protocol

If authentication is enabled, select the authentication method.
■ SHA
■ MD5

Authentication
- Change
Password

Select to display the Password field and change the password.

If you are enabling authentication, this selection cannot be cleared.

Change Sending Trap Setting window (SNMP v3)
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Item Description

Authentication
- Password

If authentication is enabled, enter a password. The password must be 8 to 64
alphanumeric characters, excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

Encryption Select whether or not to perform the encryption
■ Enable: Encryption is performed.
■ Disable: Encryption is not performed.

Encryption information is displayed only if encryption is enabled.

Encryption -
Protocol

If encryption is enabled, select the encryption method.
■ AES
■ DES

Encryption -
Change Key

Select to display the Key field and change the key.

If you are enabling authentication, this selection cannot be cleared.

Encryption -
Key

If encryption is enabled, enter a key. The key must be 8 to 64 alphanumeric
characters, excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

Encryption -
Re-enter Key

Re-enter the same key.

Add Request Authentication Setting window (SNMP v1 or v2c)

This window appears when you click Add on the SNMP tab of the Set Up Alert
Notifications window if the SNMP protocol version is SNMP v1 or SNMP v2c.

Add Request Authentication Setting window (SNMP v1 or v2c)
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Item Description

Community Specify the community permitted to execute GET REQUEST, GETNEXT
REQUEST, and GETBULK REQUEST1.
■ To select an existing community from a pull down menu, clear New.
■ To create a community, select New, and then enter a name.

You can enter up to 180 alphanumeric characters excluding the
following symbols:

\ , / ; : * ? " < > | & % ^ '

Do not enter space characters at the beginning or the end of the
value.

Requests
permitted

■ All: All users have perimission to execute GET REQUEST, GETNEXT
REQUEST, and GETBULK REQUEST1.

If All is selected, the IP address column is not displayed.
■ To select an existing IP address from a pull down menu, clear New.
■ To add an IP address, select New, and then enter an address.
■ IPv4: Enter a valid IPv4 address in the format XXX.XXX.XXX.XXX (where

XXX is a number from 0 to 255)
■ IPv6: Enter a valid IPv6 address in the format

YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY: (where YYYY is a hexadecimal
number from 0 to FFFF). You can also use an IPv6 address in
abbreviated format.

Add Request Authentication Setting window (SNMP v1 or v2c)
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Item Description

■ Minus symbol: Removes the IP address in that row.
■ Add IP Address: Adds an IP address. You can add up to 32 IP

addresses.

Notes:

1. Only SNMP v2c supports GETBULK REQUEST.

Add Request Authentication Setting window (SNMP v3)

This window appears when you click Add on the SNMP tab of the Set Up Alert
Notifications window if the SNMP protocol version is SNMP v3.

Item Description

User Name Enter the name of the user permitted to execute GET REQUEST,
GETNEXT REQUEST, and GETBULK REQUEST.

You can enter up to 32 alphanumeric characters, excluding the following
symbols:

\ , / ; : * ? " < > | & % ^

Add Request Authentication Setting window (SNMP v3)
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Item Description

Do not enter space characters at the beginning or the end of the value.

Note:

If you use a user name that has already been specified for Sending Trap
Setting or Request Authentication Setting, specify the same settings for
the following options that were specified for that name. Otherwise,
SNMP traps might not be sent correctly.
■ Authentication
■ Authentication - Protocol
■ Authentication - Password
■ Encryption
■ Encryption - Protocol
■ Encryption - Key

Authenticati
on

Select whether to perform the authentication.
■ Enable: Authentication is performed.
■ Disable: Authentication is not performed.

Authentication information is displayed only if authentication is
enabled.

Authenticati
on - Protocol

If authentication is enabled, select the authentication method.
■ SHA
■ MD5

Authenticati
on -
Password

If authentication is enabled, enter a password. The password must be 8
to 64 alphanumeric characters, excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

Authenticati
on - Re-
enter
Password

Re-enter the same password.

Encryption Select whether or not to perform the encryption
■ Enable: Encryption is performed.
■ Disable: Encryption is not performed.

Encryption information is displayed only if encryption is enabled.

Add Request Authentication Setting window (SNMP v3)
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Item Description

Encryption -
Protocol

If encryption is enabled, select the encryption method
■ AES
■ DES

Encryption -
Key

If encryption is enabled, enter a key. The key must be 8 to 64
alphanumeric characters, excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

Encryption -
Re-enter Key

Re-enter the same key.

Change Request Authentication Setting window (SNMP v1 or v2c)

This window appears when you click Change on the SNMP tab of the Set Up Alert
Notifications window if the SNMP protocol version is SNMP v1 or SNMP v2c.

Item Description

Community Specify the community permitted to execute GET REQUEST, GETNEXT
REQUEST, and GETBULK REQUEST*.

To select an existing community name from a pull down menu, clear
New.

Change Request Authentication Setting window (SNMP v1 or v2c)
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Item Description

You can enter up to 180 alphanumeric characters excluding the
following symbols:

\ , / ; : * ? " < > | & % ^ '

Do not enter space characters at the beginning or the end of the value.

Requests
Permitted

■ All: All users have permission to execute GET REQUEST, GETNEXT
REQUEST, and GETBULK REQUEST1.

If All is selected, the IP address column is not displayed.
■ To select an existing IP address from a pull down menu, clear New.
■ To add an IP address, select New, and then enter an address.
■ IPv4: Enter a valid IPv4 address in the format XXX.XXX.XXX.XXX (where

XXX is a number from 0 to 255)
■ IPv6: Enter a valid IPv6 address in the format

YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY: (where YYYY is a hexadecimal
number from 0 to FFFF). You can also use an IPv6 address in
abbreviated format.

■ Minus symbol: Removes the IP address in that row.
■ Add IP Address: Adds an IP address. You can add up to 32 IP

addresses.

* Only SNMP v2c supports GETBULK REQUEST. Notes:

Change Request Authentication Setting window (SNMP v3)

This window appears when you click Change on the SNMP tab of the Set Up Alert
Notifications window if the SNMP protocol version is SNMP v3.

Change Request Authentication Setting window (SNMP v3)
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Item Description

User Name Enter the name of the user permitted to execute GET REQUEST,
GETNEXT REQUEST, and GETBULK REQUEST.

You can enter up to 32 alphanumeric characters, excluding the following
symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

Note:

Change Request Authentication Setting window (SNMP v3)
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Item Description

If you use a user name that has already been specified for Sending Trap
Setting or Request Authentication Setting, specify the same settings for
the following options that were specified for that name. Otherwise,
SNMP traps might not be sent correctly.
■ Authentication
■ Authentication - Protocol
■ Authentication - Password
■ Encryption
■ Encryption - Protocol
■ Encryption - Key

Authenticati
on

Select whether to perform authentication.
■ Enable: Authentication is performed.
■ Disable: Authentication is not performed.

Authentication and encryption information is displayed only if
authentication is enabled.

Authenticati
on - Protocol

If authentication is enabled, select the authentication method.
■ SHA
■ MD5

Authenticati
on - Change
Password

Select to display the Password field and change the password.

If you are enabling authentication, this selection cannot be cleared.

Authenticati
on -
Password

If authentication is enabled, enter a password. The password must be 8
to 64 alphanumeric characters, excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

Authenticati
on - Re-enter
Password

Re-enter the same password.

Encryption Select whether to perform encryption.
■ Enable: Encryption is performed.
■ Disable: Encryption is not performed.

Encryption information is displayed only if encryption is enabled.

Change Request Authentication Setting window (SNMP v3)
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Item Description

Encryption -
Protocol

If encryption is enabled, select the encryption method.
■ AES
■ DES

Encryption -
Change Key

Select to display the Key field and change the key.

If you are enabling authentication, this selection cannot be cleared.

Encryption -
Key

If encryption is enabled, enter a key. The key must be 8 to 64
alphanumeric characters, excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

Encryption -
Re-enter Key

Re-enter the same key.

Column Settings window

Column Settings window
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Item Description

Restore Default
Settings

Changes the selection of the displayed columns to the factory default settings.

Checkbox Selects the columns to display.

Click the checkbox next to the name of each column that you want to display.
After making the selections, click OK. Only the columns whose checkboxes are
selected are displayed. Columns whose checkboxes are not selected are not
displayed.

Note that you cannot select the checkboxes of the columns that must always
be displayed because they are deactivated.

When you deselect a checkbox, the filter and sort settings of that column are
released. If you display the column again, you must set the filter and sort
settings again.

Column Name Displays the names of the columns in the table. If a column contains two rows,
the name of the upper row is shown on the left of the vertical bar (|). The name
of the lower row is shown on the right of the vertical bar.

Edit Advanced System Settings wizard

Edit Advanced System Settings wizard contains the following topics:
■ Edit Advanced System Settings window (on page 449)
■ Edit Advanced System Settings confirmation window (on page 453)
■ Column Settings window (on page 447)

Edit Advanced System Settings wizard
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Edit Advanced System Settings window

The following table describes the advanced system settings fields and settings in the Edit
Advanced System Settings window.

Item Description

No. Displays the number of function bits for the advanced system
settings.

Advanced System
Setting

Displays advanced system setting names.
■ Hide alert information: The Alert window in the Device

Manager - Storage Navigator main window is not displayed.
■ Refresh forcibly after Apply: The configuration information

for the storage system is forcibly updated after the
configuration changes are applied to the storage system.

■ Disable data polling: Polling stops.
■ Disable retry of data updating: Retry does not take place

even when you fail to acquire data.

Edit Advanced System Settings window
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Item Description

■ Enable Storage Navigator 2 All Function : The restrictions on
login from Device Manager - Storage Navigator's login
window are cleared, including the restrictions on the users
who can log in and on the functions available after login.
When enabling or disabling the advanced system setting, log
in again.

■ Manage differential bitmaps in DP pool at pair create and
resync operations for 4TB or less TC/TCMF/UR/URMF/GAD
pairs: Differential data is maintained in a pool with which a
DP-VOL that has the user capacity (up to 4,194,304 MB) is
linked when a new TC/TCMF, UR/URMF or GAD pair is
created using the DP-VOL, or resynchronized. Note that
differential data is maintained, regardless of this setting, in a
pool linked with the DP-VOL that has the user capacity
(greater than 4,194,304 MB) when a new TC/TCMF, UR/URMF
or GAD pair using the DP-VOL is created.

■ Manage differential bitmaps in DP pool at pair create
operations for 4TB or less TC/TCMF/UR/URMF/GAD pairs:
Differential data is maintained in a pool with which a DP-VOL
that has the user capacity (up to 4,194,304 MB) is linked
when a new TC/TCMF, UR/URMF or GAD pair is created using
the DP-VOL. Note that differential data is maintained,
regardless of this setting, in a pool linked with the DP-VOL
that has the user capacity (greater than 4,194,304 MB) when
a new TC/TCMF, UR/URMF or GAD pair using the DP-VOL is
created.

■ Enable reboot of background service: Enable this option only
when requested. If you enable this option, the SVP starts
monitoring of the background service process (RMI-
Server). When either of the followings exceeds its
threshold value, the background service process for
managing configuration information is restarted.
● The amount of memory used in the background service

process
● Time elapsed after the background service process is

started

Edit Advanced System Settings window
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Item Description

■ Notify an alert when tier relocation is suspended by system:
If you enable this option, when tier relocation is suspended
by the system, an alert is issued to users. For details about
an alert (SIM) to be issued, see the Troubleshooting chapter
of the Provisioning Guide for Open Systems or Provisioning
Guide for Mainframe Systems.

■ Disable cache of the PP Info: Enable this option only when
requested.

Status Displays the statuses of the advanced system settings.

Enable Enables the selected advanced system settings. You can select
more than one advanced system setting.

Disable Disables the selected advanced system settings. You can select
more than one advanced system setting.

The following tables show how the advanced system settings No. 5 works with No. 6, and
No. 15 works with No. 16.

Table 26 Advanced system settings No. 5, No. 6, No. 15, and No. 16

No. 5 No. 6

Description

Create operation Resync operation

Disabled Disabled Change the
management
method from
hierarchical
differences to SM
differences.

Change the
management
method from
hierarchical
differences to SM
differences.

Enabled Change the
management
method from SM
differences to
hierarchical
differences.

The differential data
management
method is not
changed.

Enabled Disabled Change the
management
method from SM
differences to
hierarchical
differences.

Change the
management
method from SM
differences to
hierarchical
differences.

Edit Advanced System Settings window
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No. 5 No. 6

Description

Create operation Resync operation

Enabled Change the
management
method from SM
differences to
hierarchical
differences.

The differential data
management
method is not
changed.

Note: If the LDEV capacity exceeds 4 TB (for open)/262, 668 Cyl (for
mainframe), it becomes the hierarchical memory management regardless
of whether No. 5 and No. 6 are enabled.

No. 15 No. 16 Description

Disabled Disabled Even if a remote path
failure is detected, the
mirror is not split.

Enabled Disabled Even if a remote path
failure is detected, the
mirror is not split.

Disabled Enabled After remote path
failure detection, the
mirror is split if the
remote path is not
restored within the
path monitoring time.

Enabled Enabled After remote path
failure detection, the
mirror is split if the
remote path is not
restored within one
minute after the
detection.

Edit Advanced System Settings window
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Edit Advanced System Settings confirmation window

Item Description

No. Displays the number of function bits for the advanced system setting.

Advanced System
Setting

Displays the name of the advanced system setting.

Status Displays the status of the advanced system setting.

Edit Advanced System Settings confirmation window
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Edit Storage System wizard

Edit Storage System window

The following table describes the fields and settings in the Edit Storage System window.

Note:
■ The values set in this window are also displayed in the Storage System

window of the maintenance utility and on the SNMP tab of the Alert
Notifications window.

■ For all fields, you can enter up to 180 alphanumeric characters excluding
the following symbols:

\ , / ; : * ? " < > | & % ^
■ Do not enter space characters at the beginning or the end of the values.

Item Description

Storage System
Name

Device name of the storage system. Changing this item also changes the
Storage System name of SNMP tab in the Storage System window, and Alert
Notification window of Maintenance Utility.

Edit Storage System wizard
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Item Description

Contact Contact information such as personnel and telephone number where you can
inquire about the storage system. Changing this item also changes the Contact
of SNMP tab of Storage System window, and Alert Notification window of
Maintenance Utility.

Location Location of the connected storage system. Changing this item also changes the
Location of SNMP tab of Storage System window, and Alert Notification
window of Maintenance Utility.

Edit Storage System confirmation window

The following table describes the fields and settings in the Confirm window (Edit Storage
System).

Item Description

Storage
System Name

Device name of the storage system.

Contact Contact information such as personnel and telephone number where you can
inquire about the storage system.

Location Location of the connected storage system.

Edit Storage System confirmation window
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Alert Notifications wizard

Alert Notifications window

Summary

Item Description

Notification
Alert

Destination of the alert notification
■ Host Report: Sends alerts only of SIMs that report to hosts.
■ All: Sends alerts of all SIMs.

Alert destinations are common to Syslog, SNMP, and Email.

Alert Notifications wizard
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Item Description

Email Notice Failure notification setting
■ Enabled: Reports the SIM by email
■ Disabled: Does not report the SIM by email

Syslog Server
Notice -
Transfer
Protocol

Protocol to transfer the syslog
■ TLS1.2/RFC5424
■ UDP/RFC3164

Syslog Server
Notice -
Primary
Server

Whether to use the Syslog server
■ Enabled: Reports SIM to the Syslog Server through Syslog.
■ Disabled: Does not report SIM to the Syslog Server through Syslog

Syslog Server
Notice -
Secondary
Server

Whether to use an alternate server for the Syslog server
■ Enabled: Reports SIM to the alternate Syslog server through Syslog.
■ Disabled: Does not report SIM to the alternate Syslog server through Syslog

SNMP Agent Whether the SNMP agent is being used
■ Enabled: Reports the SIM through an SNMP trap

■ Disabled: Does not report the SIM through an SNMP trap

Set Up button Displays the Set Up Alert Notifications window

Email tab

Item Description

Mail Server Mail server information (host name or IP address)

SMTP
Authenticatio
n

Whether to perform SMTP authentication
■ Enabled: Performs SMTP authentication
■ Disabled: Does not perform SMTP authentication

SMTP
Authenticatio
n - Account

SMTP Authentication account

Email Address
- From

Source address of the email for failure information report

Email Address
- Reply To

Return email address

Alert Notifications window
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Item Description

Email Address
- To

Destination address of the email for failure information report

Email Address
- Cc

Carbon copy address of the email for failure information alert

Email Address
- Bcc

Carbon copy address of the email for failure information alert

Send Test
Email button

Sends a test SIM by email

Syslog tab

Item Description

Primary
Server - Host
Name/IP
Address

Host name or IP address of the Syslog server. To display the entire host name,
click the button at the right of the field to expand the field.

Primary
Server - Port
Number

Port number of the Syslog server

Alert Notifications window
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Item Description

Secondary
Server - Host
Name/IP
Address

Host name or IP address of the alternate Syslog server. To display the entire host
name, click the button at the right of the field to expand the field.

Secondary
Server - Port
Number

Port number of the alternate Syslog server

Location
Identification
Name

Identification name of the storage system to transfer the SIM to the Syslog server

Retry Retry setting
■ Enable: Retry when communication with syslog server fails

■ Disable: Does not retry when communication with syslog server fails

Retry Interval Retry interval when communication with the Syslog server fails

Send Test
Message to
Syslog Server
button

Sends a test SIM by syslog

SNMP tab (SNMP v1 or v2c)

Alert Notifications window
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Item Description

Storage
System Name

Storage system name

Contact Administrator name and contact information, such as personnel and telephone
number where you can inquire about the storage system

Location Location of the connected storage system

SNMP Engine
ID

SNMP engine identifier

SNMP Version SNMP protocol version

Sending Trap
Setting

■ Community: Community names to which SNMP traps are reported
■ Send Trap to: IP address to which SNMP traps are reported

Request
Authentication
Setting

■ Community: Communities that have permission to execute GET REQUEST,
GETNEXT REQUEST, and GETBULK REQUEST

■ Requests Permitted: IP addresses that have permission to execute GET
REQUEST, GETNEXT REQUEST, and GETBULK REQUEST

Send Test
SNMP Trap
button

Sends a test trap to the IP address registered for the storage system

SNMP tab (SNMP v3)

Alert Notifications window
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Item Description

Storage
System Name

Storage system name

Contact Administrator name and contact information, such as personnel and telephone
number where you can inquire about the storage system

Location Location of the connected storage system

SNMP Engine
ID

SNMP engine identifier

SNMP Version SNMP protocol version

Sending Trap
Setting

■ Send Trap to: IP address to which SNMP traps are reported
■ User Name: User name used for reporting SNMP traps
■ Authentication - Mode: Whether authentication is enabled
■ Authentication - Protocol: Authentication method if authentication is enabled
■ Encryption - Mode: Whether encryption is enabled
■ Encryption - Protocol: Encryption method used if encryption is enabled

Request
Authentication
Setting

■ User Name: Users that have permission to execute GET REQUEST, GETNEXT
REQUEST, and GETBULK REQUEST

■ Authentication - Mode: Whether authentication is enabled
■ Authentication - Protocol: Authentication method used if authentication is

enabled
■ Encryption - Mode: Whether encryption is enabled
■ Encryption - Protocol: Encryption method used if encryption is enabled

Send Test
SNMP Trap
button

Sends a test trap to the IP address registered in the storage system

Alert Notifications window
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Set Up Alert Notifications window

Item Description

Notification
Alert

Displays the destination of the alert notification.
■ Host Report: Sends alerts only of SIMs that report to hosts.
■ All: Sends alerts of all SIMs.

Alert destinations are common to Syslog, SNMP, and Email.

Email tab

Item Description

Mail Notice Select whether or not to report failure information through email.
■ Enable: Reports SIM through email.
■ Disable: Does not report SIM through email.

Set Up Alert Notifications window
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Item Description

Mail Address
(To)

This field is mandatory when you selected Enable in Mail Notice.
■ Add: Adds email addresses. The Add Address window opens
■ Delete: Deletes the selected email address. You can select more than one email

address.

Mail Address
(From)

Enter the source address of the email for failure information report.

You can use a name of up to 255 characters. Usable characters: Alphanumeric
characters and symbols (! # $ % & ` + - * / ' ^ { } _ . )

This field is mandatory when you selected Enable in Mail Notice.

Mail Address
(Reply - To)

Specify the return email address. If you specify this address, return email from the
email recipient is transmitted to the address. If you omit this address, return email
from the email recipient is transmitted to Mail Address (From).

You can use a name of up to 255 characters. Usable characters: Alphanumeric
characters and symbols (! # $ % & ` + - * / ' ^ { } _ . )

Description to
notify

Enter the description for notifying failure information. You can enter up to 511
characters and also a line feed code, which is counted as two characters.

Mail Server
Setting -
Email Server

Enter the Email server information. You cannot set an IP address with all 0s.
■ Identifier: To specify a host name, select Identifier. You can enter a name of up

to 255 characters.
■ IPv4: To set an IPv4 address, select IPv4, and enter four numbers within the

range of 0 to 255.

Example: XXX.XXX.XXX.XXX (X indicates a numeral)

■ IPv6: To set an IPv6 address, select IPv6, and enter eight hexadecimal
alphanumeric characters within the range of 0 to FFFF. You can also use an
abbreviated-format IPv6 address.

Example: YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY (Y indicates a hexadecimal
digit)

This field is mandatory when you select Enable in Mail Notice.

Mail Server
Setting -
SMTP
Authenticatio
n

Select whether or not to perform SMTP authentication.
■ Enable: Performs SMTP authentication.
■ Disable: Does not perform SMTP authentication.

When you select Enable, enter values in Account and Password.

You can use a name of up to 255 characters. Usable characters are: Alphanumeric
characters and symbols (! # $ ` + - * ' { } _ . )

This field is mandatory when you select Enable in Mail Notice.

Set Up Alert Notifications window
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Syslog tab

Item Description

Transfer
Protocol

Select the protocol for Syslog transfer.
■ TLS1.2/RFC5424
■ UDP/RFC3164

Primary
Server

Select whether or not to use the Syslog Server.
■ Enable: Reports SIM to the Syslog Server through Syslog
■ Disable: Does not report SIM to the Syslog Server through Syslog

Set Up Alert Notifications window
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Item Description

Primary
Server -
Syslog Server

Enter the IP address of the server that you want to set as the Syslog Server. You
cannot set an address with all zeros.
■ To set a host name, select Identifier and enter the host name in no more than

255 characters. Allowed characters are alphanumeric characters and symbols: !
$ % - . @ _ ` ~.

■ To set an IPv4 address, select IPv4, and enter four numbers within the range of
0 to 255.

Example: XXX.XXX.XXX.XXX (X indicates a numeral)

■ To set an IPv6 address, select IPv6, and enter eight hexadecimal alphanumeric
characters within the range of 0 to FFFF. You can also use an abbreviated-
format IPv6 address.

Example: YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY (Y indicates a hexadecimal
digit)

Use this field only when you select Enable in Primary Server.

Primary
Server - Port
Number

Enter the port number used by the Syslog Server. Use this field only when you
selected Enable in Primary Server.

Primary
Server - Client
Certificate File
Name

Specify a certificate file. Click Browse and specify the certificate file.

Use this field only when you select TLS1.2/RFC5424 in Transfer Protocol and
selected Enable in Primary Server. Note the following:
■ This field is mandatory when it is activated.
■ If you leave the certificate field blank when you apply settings for the second

time or later, the certificate that was updated the last time is used.

Primary
Server -
Password

Enter a password for the client certificate. Passwords can contain up to 128
alphanumeric characters and the following symbols:

! # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~

Use this field only when you specified Client Certificate File Name.

Primary
Server - Root
Certificate File
Name

Specify a certificate file. Click Browse and specify the certificate file.

Use this field only when you select TLS1.2/RFC5424 in Transfer Protocol and
selected Enable in Primary Server.
■ This field is mandatory when it is activated.
■ If you leave the certificate field blank when you apply settings for the second

time or later, the certificate that was updated the last time is used.

Set Up Alert Notifications window
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Item Description

Secondary
Server

Select whether or not to use an alternate server for the syslog server.
■ Enable: Reports a SIM to the alternate syslog server through Syslog.
■ Disable: Does not report a SIM to the alternate server for the syslog server

through Syslog.

Secondary
Server -
Syslog Server

Enter the IP address of the server that you want to set as the alternate Syslog
Server. You cannot set an address with all 0s.
■ To set an IPv4 address, select IPv4, and enter four numbers within the range of

0 to 255.

Example: XXX.XXX.XXX.XXX (X indicates a numeral)

■ To set an IPv6 address, select IPv6, and enter eight hexadecimal alphanumeric
characters within the range of 0 to FFFF. You can also use an abbreviated-
format IPv6 address.

Example: YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY (Y indicates a hexadecimal
digit)

Use this field only when you select Enable in the secondary server.

Secondary
Server - Port
Number

Enter the port number used by the alternate syslog server. Use this field only
when you selected Enable in Secondary Server.

Secondary
Server - Client
Certificate File
Name

Specify a certificate file. Click Browse and specify the certificate file.

Use this field only when you select TLS1.2/RFC5424 in Transfer Protocol and
selected Enable in the secondary server.
■ This field is mandatory when it is activated.
■ If you leave the certificate field blank when you apply settings for the second

time or later, the certificate that was updated the last time is used.

Secondary
Server -
Password

Enter a password for the client certificate. Passwords can contain up to 128
alphanumeric characters and the following symbols:

! # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~

Use this field only when you specify the client certificate file name.

Secondary
Server - Root
Certificate File
Name

Specify a certificate file. Click Browse and specify the certificate file.

Use this field only when you select TLS1.2/RFC5424 in Transfer Protocol and
selected Enable in the secondary server.
■ This field is mandatory when it is activated.
■ If you leave the certificate field blank when you apply settings for the second

time or later, the certificate that was updated the last time is used.

Set Up Alert Notifications window
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Item Description

Location
Identification
Name

Enter a name for identification of the storage system from which SIM is
transferred to the syslog server. Names can contain up to 32 alphanumeric
characters and the following symbols: (! # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ `
{ | } ~)

Spaces are not allowed. This field is mandatory when Primary Server or Secondary
Server are enabled.

Retry Displays the retry setting
■ Enable: Retry when communication with syslog server fails
■ Disable: Does not retry when communication with syslog server fails

Retry Interval Enter a value between 1 and 60 (seconds) as the retry interval when
communication with the Syslog Server fails. The default is 1.

Use this field only when you selected TLS1.2/RFC5424 in Transfer Protocol.

SNMP tab (SNMP v1 or v2c)

Set Up Alert Notifications window
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Item Description

SNMP Agent Select whether to use the SNMP agent
■ Enable: Reports SIM with SNMP and permits GET REQUEST, GETNEXT REQUEST,

or GETBULK REQUEST*.
■ Disable: Does not report SIM with SNMP nor permit GET REQUEST, GETNEXT

REQUEST, or GETBULK REQUEST*.

SNMP Version Select the SNMP protocol version

Sending Trap
Setting

Displays the community name and IP address for which SNMP traps are reported.
The Registered Sending Trap Settings table includes the following:
■ Community: Displays the communities to which SNMP traps are reported.
■ Send Trap to: Displays the IP address to which SNMP traps are reported.
■ Add: Adds an SNMP trap. The Add Sending Trap Setting window opens. Up to

32 communities can be registered.
■ Change: Opens the Change Sending Trap Setting window for the selected row.
■ Remove: Removes the selected community from the Registered Sending Trap

Settings table.

Request
Authenticatio
n Setting

Displays the name and IP address of the communities that have permission to
execute GET REQUEST, GETNEXT REQUEST and GETBULK REQUEST*. The
Registered Sending Trap Settings table includes the following:
■ Community: Displays the communities that have permission to execute GET

REQUEST, GETNEXT REQUEST and GETBULK REQUEST*.
■ Requests Permitted: Displays the IP addresses that have permission to execute

GET REQUEST, GETNEXT REQUEST and GETBULK REQUEST*.
■ Add: Displays the Add Request Authentication Setting window. Up to 32

communities can be registered.
■ Change: Opens the Change Request Authentication Setting window for the

selected row.
■ Remove: Removes the selected community from the Request Authentication

Settings table.

System Group
Information -
Storage
System Name

Enter the storage system name.

You can enter up to 180 alphanumeric characters excluding the following symbols:

\ , / ; : * ? ” < > | & % ^

Do not enter space characters at the beginning or the end of the value.

This field is mandatory. When you change this field, Storage System Name in the
Storage System window of Device Manager - Storage Navigator and the
maintenance utility is also changed.

Set Up Alert Notifications window
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Item Description

System Group
Information -
Contact

Enter the administrator's name or contact information.

You can enter up to 180 alphanumeric characters excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

When you change this field, Contact in the Storage System window of Device
Manager - Storage Navigator and the maintenance utility is also changed.

System Group
Information -
Location

Enter the location of the storage system.

You can enter up to 180 alphanumeric characters excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

When you change this field, Location in the Storage System window of Device
Manager - Storage Navigator and the maintenance utility is also changed.

SNMP Engine
ID

Displays the SNMP engine ID

Notes*: * Only SNMP v2c supports GETBULK REQUEST.

Set Up Alert Notifications window
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SNMP tab (SNMP v3)

Item Description

SNMP Agent Select whether to use the SNMP agent
■ Enable: Reports SIM with SNMP and permits GET REQUEST, GETNEXT REQUEST,

or GETBULK REQUEST.
■ Disable: Does not report SIM with SNMP nor permit GET REQUEST, GETNEXT

REQUEST, or GETBULK REQUEST.

SNMP Version Select the SNMP protocol version

Sending Trap
Setting

Displays the user name and IP address for which SNMP traps are reported. The
Registered Sending Trap Settings table includes the following:
■ Send Trap to: Displays the IP address to which SNMP traps are reported.
■ User Name: Displays the user name to be used for reporting SNMP traps.
■ Authentication - Mode: Displays whether authentication is enabled.
■ Authentication - Protocol: Displays the authentication method used if

authentication is enabled.
■ Encryption - Mode: Displays whether encryption is enabled.

Set Up Alert Notifications window
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Item Description

■ Encryption - Protocol : Displays the encryption method used if encryption is
enabled.

■ Add: Adds an SNMP trap. The Add Sending Trap Setting window opens. Up to
eight IP addresses can be registered.

■ Change: Opens the Change Sending Trap Setting window for the selected row.
■ Remove: Removes the selected user from the Registered Sending Trap Settings

table.

Request
Authenticatio
n Setting

Displays the users for whom you permit GET REQUEST, GETNEXT REQUEST and
GETBULK REQUEST. The Registered Sending Trap Settings table includes the
following:
■ User Name: Displays names of users that have permission to execute GET

REQUEST, GETNEXT REQUEST and GETBULK REQUEST.
■ Authentication - Mode: Displays whether authentication is enabled.
■ Authentication - Protocol: Displays the authentication method used if

authentication is enabled.
■ Encryption - Mode: Displays whether encryption is enabled.
■ Encryption - Protocol : Displays the encryption method used if encryption is

enabled.
■ Add: Displays the Add Request Authentication Setting window. Up to eight

users can be registered.
■ Change: Opens the Change Sending Trap Setting window for the selected row.
■ Remove: Removes the selected user from the Request Authentication Settings

table.

System Group
Information -
Storage
System Name

Enter the storage system name.

You can enter up to 180 alphanumeric characters excluding the following symbols:

\ , / ; : * ? ” < > | & % ^

Do not enter space characters at the beginning or the end of the value.

This field is mandatory. When you change this field, Storage System Name in the
Storage System window of Device Manager - Storage Navigator and the
maintenance utility is also changed.

System Group
Information -
Contact

Enter the administrator's name or contact information.

You can enter up to 180 alphanumeric characters excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

When you change this field, Contact in the Storage System window of Device
Manager - Storage Navigator and the maintenance utility is also changed.

Set Up Alert Notifications window
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Item Description

System Group
Information -
Location

Enter the location of the storage system.

You can enter up to 180 alphanumeric characters excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

When you change this field, Location in the Storage System window of Device
Manager - Storage Navigator and the maintenance utility is also changed.

SNMP Engine
ID

Displays the SNMP engine ID.

Add Email Address window

Item Description

Email Address Enter the source address of the email for failure information report. You can use
up to 255 alphanumeric characters, including these symbols: !# $ % & ` + - * / ' ^
{ } _ . @ ~ = ? |

Add Sending Trap Setting window (SNMP v1 or v2c)

This window appears when you click Add on the SNMP tab of the Set Up Alert
Notifications window if the SNMP protocol version is SNMP v1 or SNMP v2c.

Add Email Address window
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Item Description

Community Specify the community to which SNMP traps are reported.
■ To select an existing community from a pull down menu, clear New.
■ To create a community, select New, and then enter a name.

You can enter up to 180 alphanumeric characters excluding the following
symbols:

\ , / ; : * ? " < > | & % ^ '

Do not enter space characters at the beginning or the end of the value.

Send Trap to Specify the IP address to which SNMP traps are reported.
■ To select an existing IP address from a pull down menu, clear New.
■ To add an IP address, select New, and then enter an address.
■ IPv4: Enter a valid IPv4 address in the format XXX.XXX.XXX.XXX (where XXX is a

number from 0 to 255)
■ IPv6: Enter a valid IPv6 address in the format

YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY: (where YYYY is a hexadecimal number
from 0 to FFFF). You can also use an IPv6 address in abbreviated format.

■ Minus symbol: Removes the IP address in that row.
■ Add IP Address: Adds an IP address. You can add up to 32 IP addresses.

Add Sending Trap Setting window (SNMP v1 or v2c)
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Add Sending Trap Setting window (SNMP v3)

This window appears when you click Add on the SNMP tab of the Set Up Alert
Notifications window if the SNMP protocol version is SNMP v3.

Item Description

Send Trap to Specify the IP address to which SNMP traps are reported.
■ IPv4: Enter a valid IPv4 address in the format XXX.XXX.XXX.XXX (where XXX is a

number from 0 to 255)
■ IPv6: Enter a valid IPv6 address in the format

YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY: (where YYYY is a hexadecimal number
from 0 to FFFF). You can also use an IPv6 address in abbreviated format.

User Name Enter the user name to be used for reporting SNMP traps.

You can enter up to 32 alphanumeric characters, excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

Note:

Add Sending Trap Setting window (SNMP v3)
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Item Description

If you use a user name that has already been specified for Sending Trap Setting or
Request Authentication Setting, specify the same settings for the following
options that were specified for that name. Otherwise, SNMP traps might not be
sent correctly.
■ Authentication
■ Authentication - Protocol
■ Authentication - Password
■ Encryption
■ Encryption - Protocol
■ Encryption - Key

Authentication Select whether to perform authentication.
■ Enable: Authentication is performed.
■ Disable: Authentication is not performed.

Authentication and encryption information is displayed only if authentication is
enabled.

Authentication
- Protocol

If authentication is enabled, select the authentication method.
■ SHA
■ MD5

Authentication
- Password

If authentication is enabled, enter a password. The password must be 8 to 64
alphanumeric characters, excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

Encryption Select whether to perform encryption.
■ Enable: Encryption is performed.
■ Disable: Encryption is not performed.

Encryption information is displayed only if encryption is enabled.

Encryption -
Protocol

If encryption is enabled, select the encryption method.
■ AES
■ DES

Encryption -
Key

If encryption is enabled, enter a key. The key must be 8 to 64 alphanumeric
characters, excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

Add Sending Trap Setting window (SNMP v3)
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Item Description

Encryption -
Re-enter Key

Re-enter the same key.

Change Sending Trap Setting window (SNMP v1 or v2c)

This window appears when you click Change on the SNMP tab of the Set Up Alert
Notifications window if the SNMP protocol version is SNMP v1 or SNMP v2c.

Item Description

Community Enter the community name to which SNMP traps are reported.

You can enter up to 180 alphanumeric characters excluding the following
symbols:

\ , / ; : * ? " < > | & % ^ '

Do not enter space characters at the beginning or the end of the value.

Change Sending Trap Setting window (SNMP v1 or v2c)
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Item Description

Send Trap to Specify the IP address to which SNMP traps are reported.
■ To select an existing IP address from a pull down menu, clear New.
■ To add an IP address, select New, and then enter an address.
■ IPv4: Enter a valid IPv4 address in the format XXX.XXX.XXX.XXX (where XXX is a

number from 0 to 255)
■ IPv6: Enter a valid IPv6 address in the format

YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY: (where YYYY is a hexadecimal number
from 0 to FFFF). You can also use an IPv6 address in abbreviated format.

■ Minus symbol: Removes the IP address in that row.
■ Add IP Address: Adds an IP address. You can add up to 32 IP addresses.

Change Sending Trap Setting window (SNMP v3)

This window appears when you click Change on the SNMP tab of the Set Up Alert
Notifications window if the SNMP protocol version is SNMP v3.

Change Sending Trap Setting window (SNMP v3)
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Item Description

Send Trap to Specify the IP address to which SNMP traps are reported.
■ IPv4: Enter a valid IPv4 address in the format XXX.XXX.XXX.XXX (where XXX is a

number from 0 to 255)
■ IPv6: Enter a valid IPv6 address in the format

YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY: (where YYYY is a hexadecimal number
from 0 to FFFF). You can also use an IPv6 address in abbreviated format.

User Name Enter the user name to be used for reporting SNMP traps.

You can enter up to 32 alphanumeric characters, excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

Note:

If you use a user name that has already been specified for Sending Trap Setting or
Request Authentication Setting, specify the same settings for the following
options that were specified for that name. Otherwise, SNMP traps might not be
sent correctly.
■ Authentication
■ Authentication - Protocol
■ Authentication - Password
■ Encryption
■ Encryption - Protocol
■ Encryption - Key

Authentication Select whether to perform the authentication.
■ Enable: Authentication is performed.
■ Disable: Authentication is not performed.

Authentication and encryption information is displayed only if authentication is
enabled.

Authentication
- Protocol

If authentication is enabled, select the authentication method.
■ SHA
■ MD5

Authentication
- Change
Password

Select to display the Password field and change the password.

If you are enabling authentication, this selection cannot be cleared.

Change Sending Trap Setting window (SNMP v3)
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Item Description

Authentication
- Password

If authentication is enabled, enter a password. The password must be 8 to 64
alphanumeric characters, excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

Encryption Select whether or not to perform the encryption
■ Enable: Encryption is performed.
■ Disable: Encryption is not performed.

Encryption information is displayed only if encryption is enabled.

Encryption -
Protocol

If encryption is enabled, select the encryption method.
■ AES
■ DES

Encryption -
Change Key

Select to display the Key field and change the key.

If you are enabling authentication, this selection cannot be cleared.

Encryption -
Key

If encryption is enabled, enter a key. The key must be 8 to 64 alphanumeric
characters, excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

Encryption -
Re-enter Key

Re-enter the same key.

Add Request Authentication Setting window (SNMP v1 or v2c)

This window appears when you click Add on the SNMP tab of the Set Up Alert
Notifications window if the SNMP protocol version is SNMP v1 or SNMP v2c.

Add Request Authentication Setting window (SNMP v1 or v2c)
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Item Description

Community Specify the community permitted to execute GET REQUEST, GETNEXT
REQUEST, and GETBULK REQUEST1.
■ To select an existing community from a pull down menu, clear New.
■ To create a community, select New, and then enter a name.

You can enter up to 180 alphanumeric characters excluding the
following symbols:

\ , / ; : * ? " < > | & % ^ '

Do not enter space characters at the beginning or the end of the
value.

Requests
permitted

■ All: All users have perimission to execute GET REQUEST, GETNEXT
REQUEST, and GETBULK REQUEST1.

If All is selected, the IP address column is not displayed.
■ To select an existing IP address from a pull down menu, clear New.
■ To add an IP address, select New, and then enter an address.
■ IPv4: Enter a valid IPv4 address in the format XXX.XXX.XXX.XXX (where

XXX is a number from 0 to 255)
■ IPv6: Enter a valid IPv6 address in the format

YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY: (where YYYY is a hexadecimal
number from 0 to FFFF). You can also use an IPv6 address in
abbreviated format.

Add Request Authentication Setting window (SNMP v1 or v2c)
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Item Description

■ Minus symbol: Removes the IP address in that row.
■ Add IP Address: Adds an IP address. You can add up to 32 IP

addresses.

Notes:

1. Only SNMP v2c supports GETBULK REQUEST.

Add Request Authentication Setting window (SNMP v3)

This window appears when you click Add on the SNMP tab of the Set Up Alert
Notifications window if the SNMP protocol version is SNMP v3.

Item Description

User Name Enter the name of the user permitted to execute GET REQUEST,
GETNEXT REQUEST, and GETBULK REQUEST.

You can enter up to 32 alphanumeric characters, excluding the following
symbols:

\ , / ; : * ? " < > | & % ^

Add Request Authentication Setting window (SNMP v3)
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Item Description

Do not enter space characters at the beginning or the end of the value.

Note:

If you use a user name that has already been specified for Sending Trap
Setting or Request Authentication Setting, specify the same settings for
the following options that were specified for that name. Otherwise,
SNMP traps might not be sent correctly.
■ Authentication
■ Authentication - Protocol
■ Authentication - Password
■ Encryption
■ Encryption - Protocol
■ Encryption - Key

Authenticati
on

Select whether to perform the authentication.
■ Enable: Authentication is performed.
■ Disable: Authentication is not performed.

Authentication information is displayed only if authentication is
enabled.

Authenticati
on - Protocol

If authentication is enabled, select the authentication method.
■ SHA
■ MD5

Authenticati
on -
Password

If authentication is enabled, enter a password. The password must be 8
to 64 alphanumeric characters, excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

Authenticati
on - Re-
enter
Password

Re-enter the same password.

Encryption Select whether or not to perform the encryption
■ Enable: Encryption is performed.
■ Disable: Encryption is not performed.

Encryption information is displayed only if encryption is enabled.

Add Request Authentication Setting window (SNMP v3)
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Item Description

Encryption -
Protocol

If encryption is enabled, select the encryption method
■ AES
■ DES

Encryption -
Key

If encryption is enabled, enter a key. The key must be 8 to 64
alphanumeric characters, excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

Encryption -
Re-enter Key

Re-enter the same key.

Change Request Authentication Setting window (SNMP v1 or v2c)

This window appears when you click Change on the SNMP tab of the Set Up Alert
Notifications window if the SNMP protocol version is SNMP v1 or SNMP v2c.

Item Description

Community Specify the community permitted to execute GET REQUEST, GETNEXT
REQUEST, and GETBULK REQUEST*.

To select an existing community name from a pull down menu, clear
New.

Change Request Authentication Setting window (SNMP v1 or v2c)
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Item Description

You can enter up to 180 alphanumeric characters excluding the
following symbols:

\ , / ; : * ? " < > | & % ^ '

Do not enter space characters at the beginning or the end of the value.

Requests
Permitted

■ All: All users have permission to execute GET REQUEST, GETNEXT
REQUEST, and GETBULK REQUEST1.

If All is selected, the IP address column is not displayed.
■ To select an existing IP address from a pull down menu, clear New.
■ To add an IP address, select New, and then enter an address.
■ IPv4: Enter a valid IPv4 address in the format XXX.XXX.XXX.XXX (where

XXX is a number from 0 to 255)
■ IPv6: Enter a valid IPv6 address in the format

YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY: (where YYYY is a hexadecimal
number from 0 to FFFF). You can also use an IPv6 address in
abbreviated format.

■ Minus symbol: Removes the IP address in that row.
■ Add IP Address: Adds an IP address. You can add up to 32 IP

addresses.

* Only SNMP v2c supports GETBULK REQUEST. Notes:

Change Request Authentication Setting window (SNMP v3)

This window appears when you click Change on the SNMP tab of the Set Up Alert
Notifications window if the SNMP protocol version is SNMP v3.

Change Request Authentication Setting window (SNMP v3)
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Item Description

User Name Enter the name of the user permitted to execute GET REQUEST,
GETNEXT REQUEST, and GETBULK REQUEST.

You can enter up to 32 alphanumeric characters, excluding the following
symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

Note:

Change Request Authentication Setting window (SNMP v3)
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Item Description

If you use a user name that has already been specified for Sending Trap
Setting or Request Authentication Setting, specify the same settings for
the following options that were specified for that name. Otherwise,
SNMP traps might not be sent correctly.
■ Authentication
■ Authentication - Protocol
■ Authentication - Password
■ Encryption
■ Encryption - Protocol
■ Encryption - Key

Authenticati
on

Select whether to perform authentication.
■ Enable: Authentication is performed.
■ Disable: Authentication is not performed.

Authentication and encryption information is displayed only if
authentication is enabled.

Authenticati
on - Protocol

If authentication is enabled, select the authentication method.
■ SHA
■ MD5

Authenticati
on - Change
Password

Select to display the Password field and change the password.

If you are enabling authentication, this selection cannot be cleared.

Authenticati
on -
Password

If authentication is enabled, enter a password. The password must be 8
to 64 alphanumeric characters, excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

Authenticati
on - Re-enter
Password

Re-enter the same password.

Encryption Select whether to perform encryption.
■ Enable: Encryption is performed.
■ Disable: Encryption is not performed.

Encryption information is displayed only if encryption is enabled.

Change Request Authentication Setting window (SNMP v3)
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Item Description

Encryption -
Protocol

If encryption is enabled, select the encryption method.
■ AES
■ DES

Encryption -
Change Key

Select to display the Key field and change the key.

If you are enabling authentication, this selection cannot be cleared.

Encryption -
Key

If encryption is enabled, enter a key. The key must be 8 to 64
alphanumeric characters, excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Do not enter space characters at the beginning or the end of the value.

Encryption -
Re-enter Key

Re-enter the same key.

Add SNMP Trap window

The following table describes the fields and settings in the SNMP tab.

Item Description

IP Address Enter a new IP address or select an existing one.
■ New: Enter a new IP address.
■ Select: Select an existing IP address.

Add SNMP Trap window
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Item Description

■ IPv4: To set an IPv4 address, select IPv4, and enter four numbers within the
range of 0 to 255.

Example: XXX.XXX.XXX.XXX (X indicates a numeral)
■ IPv6: To set an IPv6 address, select IPv6, and enter eight hexadecimal

alphanumeric characters within the range of 0 to FFFF. You can also use an
abbreviated-format IPv6 address.

Example: YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY (Y indicates a hexadecimal
digit)

Community Enter a new community name or select an existing one.
■ New: Enter a new community name
■ Select: Select an existing community name

You can use up to 180 alphanumeric characters excluding these symbols: (\ , / ; :
* ? " < > | & % ^ )

Add SNMP Manager window

The following table describes the fields and settings in the SNMP Manager window.

Add SNMP Manager window
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Item Description

IP Address Enter the IP address of the SNMP Manager. You cannot use an address with all
zeros.
■ IPv4: To set an IPv4 address, select IPv4, and enter four numbers within the

range of 0 to 255.

Example: XXX.XXX.XXX.XXX (X indicates a numeral)
■ IPv6: To set an IPv6 address, select IPv6, and enter eight hexadecimal

alphanumeric characters within the range of 0 to FFFF. You can also use an
abbreviated-format IPv6 address.

Example: YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY (Y indicates a hexadecimal
digit)

Add SNMP Manager window
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Appendix I:  Device Manager - Storage Navigator
system GUI reference

This section explains the Device Manager - Storage Navigator windows used to view and
manage storage system tasks, reports, and alerts.

Storage Systems window

Hardware summary

Item Description

Edit Storage
System

Allows editing of the storage system name, contact, and location.

Storage
System Name

Device name of the storage system.

Contact Contact information such as personnel and telephone number where
you can inquire about the storage system.
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Item Description

Location Location of the connected storage system.

Storage
System Type

Model type of the storage system.

Serial Number Serial number of the storage system.

Total Cache
Size

Total size of the cache memory in the storage system. The capacity
used as the shared memory is not included.

Software
Version

This item displays the version of the software.
■ Main: Version of the firmware installed in the connected storage

system
■ Storage Navigator: Version of the HDvM - SN
■ CBA: Version of Captive Bundle Application (used for running

HDvM - SN with Adobe AIR)
■ RMI Server: Version of the RMI server installed in the SVP

IPv4 Address IPv4 address of the storage system set in the Storage Device List
window. SVP is connected to the storage system of this IP address.
■ CTL1: Displays IP address of the controller board 1.
■ CTL2: Displays IP address of the controller board 2.

A hyphen (-) displays if the IPv4 address is not set.

IPv6 Address IPv6 address of the storage system set in the Storage Device List
window. SVP is connected to the storage system of this IP address.
■ CTL1: Displays IP address of the controller board 1.
■ CTL2: Displays IP address of the controller board 2.

A hyphen (-) displays if the IPv4 address is not set.

Host Name Host name of the storage system set in the Storage Device List
window. SVP is connected to the storage system of this host name.
■ CTL1: Displays host name of the controller board 1
■ CTL2: Displays host name of the controller board 2

A hyphen (-) displays if the host name is not set.

Storage Systems window
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Allocation summary

Item Description

Internal /
External

This item switches the displayed items.
■ Total: Displays information on both the internal volumes and the

external volumes.
■ Internal Only: Displays information on only the internal volumes.
■ External Only: Displays information on only the external volumes.

Capacity Unit This item switches the displayed units of the capacity.
■ Appropriate: Displays the capacity in appropriate unit depending

on the capacity of each item.
■ TB/GB/MB: Displays the capacity of the specified unit.

Physical
Summary

This item displays the capacity of physical logical devices and the
number of devices. For details about this item, see the Physical
Summary table.

Virtual
Summary

This item displays capacity of virtual logical devices and the number of
devices. For details about this item, see the table below about virtual
summary.

Total Efficiency This field is blank if the calculation for items below is not complete. A
hyphen (-) is displayed if the information is invalid. For details, see the
Provisioning Guide.
■ Total Efficiency: Displays the ratio of the total saving effect

achieved by accelerated compression, capacity saving
(compression and deduplication), snapshot, and Hitachi Dynamic
Provisioning. The ratio of the system data is not included.

■ Data Reduction: Displays the data reduction ratio before and after
performing the accelerated compression function and the capacity
saving function (compression and deduplication). The ratio of the
system data is not included

■ Software Saving: Displays the capacity reduction ratio for data
which is before and after performing the capacity saving function.
The ratio of the system data is not included.
● Compression: Displays the capacity compression ratio for data

which is before and after performing the capacity saving
function.

● Deduplication: Displays the capacity deduplication ratio for data
which is before and after performing the capacity saving
function.

● Pattern Matching: Displays the capacity reduction ratio for data
before and after performing pattern matching of the capacity
saving function.

Storage Systems window
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Item Description

■ FMD Saving: Displays the capacity reduction ratio for data which is
before and after performing the accelerated compression function.
The ratio of the system data is not included.
● Compression: Displays the capacity compression ratio for data

which is before and after performing the accelerated
compression function.

● Pattern Matching: Displays the capacity reduction ratio for data
before and after performing pattern matching of the
accelerated compression function.

■ Snapshot: Displays the efficiency ratio achieved by snapshot. The
ratio of the system data is not included.

■ Provisioning: Displays the efficiency ratio achieved by Hitachi
Dynamic Provisioning. The ratio of the system data is not included.

■ Date and time for calculation: The start date and time and the end
date and time for the calculation are displayed within the square
brackets.

Note: The date and time in the square brackets are the system date
and time (date, time, and timezone) of the storage system. For Last
Updated in HDvM - SN, the date and time based on the system date
and time (date, time, and timezone) of the SVP are displayed.
Therefore, if the settings of the system date and time for the storage
system and the ones for the SVP are different, the date and time in
the square brackets in this window and the date and time displayed
for Last Updated are also different. For details about system date and
time settings for storage systems and SVPs, see the Service Processor
Technical Reference.

Total Saving
(Software
Deduplication,
Software
Compression,
FMD
Compression)

Total Saving: Displays the ratio and capacity reduced by the capacity
saving function against all data in a storage system.

When you use the capacity saving function, the saving ratio is
calculated against metadata, garbage data, and parity data generated
by the storage system in addition to user data. If the amount of used
data volume before the capacity saving function is executed is smaller
than the used pool capacity, a value which is invalid and smaller than
the actually saved capacity might be displayed as the saved capacity.

Software Deduplication: Displays the ratio reduced by the
deduplication function against all data in a storage system.

Software Compression: Displays the ratio reduced by the software
compression function against all data in a storage system.

FMD Compression: Displays the ratio reduced by the FMD
compression function against all data in a storage system.

Storage Systems window
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Item Description

Total DP
Subscription
Rate

This item displays the ratio of virtual logical device capacity to physical
logical device capacity in the pool volume of Dynamic Provisioning.

For a Dynamic Provisioning pool in which Thin Image pairs are
created, the virtual logical device capacity includes the snapshot data
capacity.

Total Number
of LDEVs

The number of LDEVs. The information displayed in this field depends
on the type of system. See the following table.

Physical summary

Item Description

Allocated This item displays the capacity of path-defined volumes and the
number of logical devices that the host can recognize. This capacity
does not include the control cylinder.

Reserved - Used
DP Pool

When Total is selected in Internal / External, this item displays the
total capacity of the pages that are actually used in pool of
Dynamic Provisioning and the number of logical devices. The total
capacity does not include the control cylinder.

For a DP pool in which Thin Image pairs are created, the total page
capacity includes the snapshot data capacity.

When an item other than Total is selected in Internal / External, this
item displays the number of logical devices that are actually used in
the Dynamic Provisioning pool. The capacity does not display in this
item, but is counted as part of Reserved - Other.

Reserved -
Unused DP Pool

When the total is selected in Internal / External, this item displays
the capacity remaining after subtracting the Used DP Pool value
from the total capacity of pool of Dynamic Provisioning. Control
cylinder is not included in the capacity. The number of logical
devices does not display.

When an item other than Total is selected in Internal / External, the
capacity and the number of logical devices are not displayed in this
item, and the capacity is counted as part of Reserved - Other.

Reserved - Other This item displays the total capacity and the number of logical
devices of the following volumes:
■ Thin Image pool volumes
■ Quorum disk

The control cylinder is not included in the capacity.

Storage Systems window
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Item Description

The total capacity includes:
■ The pool-VOL capacity that is not used as pool capacity
■ The capacity of the system pool-VOL management area (approx.

4.1 GB per pool)
■ Volumes that belong to a parity group for which accelerated

compression is enabled, but are not registered in a pool

When an item other than Total is selected in Internal / External, the
capacities for Reserved - Used HDP Pool and Reserved - Unused
HDP Pool are also counted as part of this item.

Available Space -
Unallocated

Displays volume capacity and number of logical devices which path
is not allocated. The volumes of Reserved - Used DP Pool ,
Reserved - Unused DP Pool, and Reserved - Other are not included.

Available Space -
Free Space

Displays the free space in which users can create volumes. The
number of logical devices is not displayed for this item.

Physical Total This item displays the total capacity of physical logical devices and
the number of logical devices. Control cylinder is not included in
the capacity.

Virtual summary

Item Description

DP Allocated * When total is selected in Internal / External, this item displays the
capacity of path-defined virtual volumes of Dynamic Provisioning,
and the number of logical devices. Virtual volumes for Thin Image
are not included. Control cylinder is not included in the capacity.

DP Unallocated* When total is selected in Internal / External, this item displays the
capacity of virtual volumes of Dynamic Provisioning that are not
path-defined, and the number of logical devices. Virtual volumes
for Thin Image are not included. Control cylinder is not included in
the capacity.

Other* When total is selected in Internal / External, the item displays the
virtual volumes of other than Dynamic Provisioning and the
number of logical devices. Control cylinder is not included in the
capacity.

Virtual Total This item displays the total capacity of virtual logical devices and
the number of logical devices. Control cylinder is not included in
the capacity.

Storage Systems window
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Item Description

* When an item other than Total is selected in Internal / External, the capacity and the
number of logical devices are not displayed.

Port Condition window

The following window displays when NAS modules are not installed.

The following window displays when NAS modules are installed

Port Condition window
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Note:
■ Ports not allocated to the user are indicated with Not Available.
■ Except for the Condition column, there may be a difference between the

actual device configuration and the displayed information depending on
the update timing of the storage system.

Refresh: Updates the window display to the latest status.

Number of Ports

The following table describes the fields and settings in Number of Ports.

Item Description

Available
(Connected)

Number of ports in use

Port Condition window
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Item Description

Available (Not
Connected)

Number of ports that are installed but not in use

Not Available Total number of ports that are installed but blocked, plus the
ports that are not assigned to the user

Not Installed Ports not installed

Port Condition

The following table describes the fields and settings in the Port Condition window.

Item Description

Controller Chassis Switches the display to the controller chassis. If no channel board
box is connected, this button is not displayed.

Channel Board Box Switches the display to the channel board box. If no channel
board box is connected, this button is not displayed.

Channel Board Name of the channel board

Board Type Type of the channel board

Port ID Name of the port

Condition Port Condition icon and port status
■  Available (Connected): The port is installed and in use.
■  Available (Not Connected): The port is installed and

available
■ Not Installed: The port is either not installed or cannot be

used.
■ Not Available: The port is either blocked or not assigned to the

user.

Speed Data transfer speed of the port is displayed in gigabits per
second as follows:
■ 1 Gbps
■ 2 Gbps
■ 4 Gbps
■ 8 Gbps
■ 10 Gbps

Port Condition window
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Item Description

■ 16 Gbps
■ 32 Gbps

If Auto is set for Port Speed in the Edit Ports window, this item is
displayed as follows:
■ Auto (1 Gbps)
■ Auto (2 Gbps)
■ Auto (4 Gbps)
■ Auto (8 Gbps)
■ Auto (10 Gbps)
■ Auto (16 Gbps)
■ Auto (32 Gbps)

The values in the parentheses are set by the storage system. If
linkup is not made, a hyphen (-) is displayed.

A hyphen (-) is displayed for the ports not assigned to the user.

For details of the Edit Ports window, see the Provisioning Guide.

For information about the availability of the 32 Gbps SFPs,
contact customer support.

SFP Data Transfer
Rate

Displays the maximum transfer rate of SFP which the mounted
package supports.

WWN/iSCSI Name WWN/iSCSI name of the port

Export Displays a window for outputting table information

Tasks window

Tasks window
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This window displays a list of tasks performed on the storage system. Up to 384 tasks
can display, including 256 that are Completed and/or Failed. Up to 128 tasks whose
statuses are In Progress, Waiting, and Suspended can also display.

Summary

Item Description

Completed Number of completed tasks.

In Progress Number of tasks in progress.

Waiting Number of tasks waiting.

Suspended Number of suspended tasks.

Failed Number of tasks in which an error occurred.

Tasks tab

Item Description

Task Name Task name specified by a user when the user performed the
task. Click to view the detail of the task.

Status Task status. Click to view more details about status or errors.
■

 Completed or Completed(Request): The task completed
normally.

■
 In progress: The task is being processed by the system.

■
 Waiting: The task is not yet started.

■
 Suspended: The task has been suspended.

■
 Failed: The task ended abnormally.

Type General name of the task.

User Name User name who performed the task.

Submission Time Date and time when the task was submitted.

Start Time Date and time when the task was started.

Blank indicates the task has not started yet.

End time Date and time when the task completed.

Blank indicates the task has not completed yet.

Tasks window
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Item Description

Auto Delete Enabled: A task is automatically deleted when the following two
events occur:
■ The task is completed
■ The number of tasks in the Task list reaches the maximum

number the window can display (384)

Disabled: Tasks will remain displayed until users delete them.
Tasks whose status is Failed are automatically Disabled by the
system.

Suspend Tasks
button

Suspends the selected tasks. They will not be started even if the
storage system is ready. Only waiting tasks can be suspended.

Resume Tasks
button

Resume the selected tasks. The status goes back to waiting.

Delete Tasks button Deletes the selected tasks from the window.
■ The waiting or suspended tasks will be cancelled.
■ The failed or aborted tasks can be deleted from the window.
■ Tasks in progress cannot be deleted.
■ If the maximum number of tasks displayed on the window is

reached when Auto Delete is enabled, execution of a new
task will result in automatic deletion of a task starting with
the oldest one.

Disable Auto Delete * When disabled, the selected task remains in the task list after
the task is completed.

Enable Auto Delete * When enabled, the selected task is deleted from the Task list
when the following two events occur:
■ The task is completed
■ The number of tasks in the Task list reaches the maximum

number the window can display (384)

Export * Window for saving table information to a file.

* Appears when you click More Actions.

Task Properties window

This window displays details about a task performed on the storage system. The content
of the window depends on the task you executed.

Task Properties window

Appendix I: Device Manager - Storage Navigator system GUI reference

System Administrator Guide for VSP E990 and VSP G130, G/F350, G/F370, G/F700, G/F900 501



Suspend Tasks window

Use this window to suspend waiting tasks.

Suspend Tasks window
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Item Description

Task Name Task name specified by a user when the user performed the
task.

Status Task status.

Type General name of the task.

User Name User name who performed the task.

Submission Time Date and time when the task was submitted.

Resume Tasks window

Use this window to resume suspended tasks.

Item Description

Task Name Task name specified by a user when the user performed the
task.

Status Task status.

Type General name of the task.

Resume Tasks window
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Item Description

User Name User name who performed the task.

Submission Time Date and time when the task was submitted.

Delete Tasks window

Use this window to delete tasks. If you delete a waiting task, the task will be cancelled.

Item Description

Task Name Task name specified by a user when the user performed the
task.

Status Task status.

Type General name of the task.

User Name User name who performed the task.

Submission Time Date and time when the task was submitted.

Delete Tasks window
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Disable Auto Delete window

Use this window to prevent a task from being automatically deleted from the task
window.

Item Description

Task Name Task name specified by a user when the user performed the
task.

Status Task status.

Type General name of the task.

User Name User name who performed the task.

Submission Time Date and time when the task was submitted.

Enable Auto Delete window

Use this window to automatically delete completed tasks from the task window when the
number of displayed tasks reaches the maximum (384 tasks).

Disable Auto Delete window
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Item Description

Task Name Task name specified by a user when the user performed the
task.

Status Task status.

Type General name of the task.

User Name User name who performed the task.

Submission Time Date and time when the task was submitted.

Edit Information Display Settings window

Use this window to change the display parameters.

Edit Information Display Settings window
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Item Description

Top Status Indicator
Refresh Interval

(Alerts, Audit log, and
Operation Lock)

Interval for the automatic updates of the icons on the upper-
right corner of the Device Manager - Storage Navigator main
window.

You can specify 10-3600 seconds. The default value is 60
seconds.

Task Screen Refresh
Interval

Interval for the automatic updates of the task window.

You can specify 10-3600 seconds, or No Update. The default
value is 60 seconds. This setting can be enabled only during
logged in.

No Update indicates that the task window will be updated
only when a user clicks Refresh or File > Refresh All.

LUN ID Notation Select whether to display the LUN ID in decimal or
hexadecimal notation. The default is decimal.

Secondary windows Specify whether to enable or disable Device Manager -
Storage Navigator's secondary window.

Enable: Enables Device Manager - Storage Navigator's
secondary window.

Disable: Disables Device Manager - Storage Navigator's
secondary window.

Edit Information Display Settings window
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Reports window

This window lists configuration reports about the storage system.

You can create up to 20 reports.

Summary

Item Description

Number of Reports Number of created reports.

Reports tab

Item Description

Report Name Task name specified when users created a report. Click to view
the report in HTML format.

User Name User name who created the report.

Submission Time Date and time when the report was created.

Create Configuration
Report

Creates a new report.

Download Reports Downloads the created report in both HTML and CSV format.

Delete Reports Deletes the selected report.

Export Window for outputting table information.

Create Configuration Report window

Use this window to create storage system configuration reports.

Reports window
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Item Description

Report Type Type of the report to be created.

Format File format.

Delete Reports window

Use this window to delete configuration reports.

Delete Reports window
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Item Description

Report Name Task name specified when users created a report.

User Name User name who created the report.

Submission Time Date and time when the report was created

Operation Lock Properties window

This window displays information about the lock status of the entire system and
resource groups.

Operation Lock Properties window
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Operation Lock Properties

Item Description

System Lock - Status Displays lock status of the entire system.

Locked: System locked user exists.

Hyphen (-): System locked user does not
exist.

System Lock - Lock User Displays the user that locked the entire
system.

A hyphen (-) indicates that there is no user
who locked the entire system.

System Lock - Lock Start Time Displays the time when the entire system
was locked.

A hyphen (-) indicates that the entire
system is not locked.

Number of Resource Groups - Locked Displays the number of locked resource
groups.

Number of Resource Groups - Unlocked Displays the number of unlocked resource
groups.

Resource Groups table

The following table describes the items in the Resource Groups table section of the
Operation Lock Properties window.

Operation Lock Properties window
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Item Description

Resource Group Name (ID) Displays resource group name and
resource group ID that user can operate

Status Displays lock status of resource groups
■ Locked : Resource groups are locked
■ Unlocked : Resource groups are

unlocked
■ System Locked : Entire system is locked

Lock User Displays the user name who locks

Lock Start Time Displays the time when the lock starts

Virtual Storage Machine Displays the model name and serial
number of the virtual storage machine set
for the resource group

Unlock All Forcibly unlocks all locked resource
groups. Note that the resource groups
that were not locked by the SVP are not
unlocked.

Storage System window (Alerts tab)

Item Description

Alert ID Identifier assigned to each alert

Date and Time Displays the date and time when alerts occurred

Reference Code Displays the SIM reference code

Storage System window (Alerts tab)
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Item Description

Error Level Displays error level of alerts.
■

: No alert
■

 Service: No need to deal with immediately. Errors that are
dealt with during periodical maintenance.

■
 Warning (Moderate): No need to deal with immediately.

Errors that are dealt with during periodical maintenance.
■

 Error (Serious): Contact the customer support. Take
adequate measures as instructed, report and solve the
problem.

■
 Acute: Contact the customer support. Take adequate

measures as instructed, report and solve the problem.

Error Section Displays information about the section of an error

Error Detail Displays more detail about the error

View Internal Alerts
- DKC

Displays an overview of internal DKC alerts

View Internal Alerts
- GUM

Displays an overview of internal GUM alerts

DKC button Displays an overview of the DKC alerts

GUM (CTL1) button Displays an overview of GUM (CTL1) alerts

GUM (CTL2) button Displays an overview of GUM (CTL2) alerts

Storage System window (Alerts tab)
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Alert Detail window

Item Description

Alert ID Identifier assigned to each alert

Date and Time Displays the date and time when alerts occurred

Reference Code Displays the SIM reference code

Error Level Displays error level of alerts
■

: No alert.
■

 Service: No need to deal with immediately. Errors that
are dealt with within periodical maintenance.

■
 Warning (Moderate): No need to deal with immediately.

Errors that are dealt with within periodical maintenance.
■

 Error (Serious): Contact customer support. Take
adequate measure as instructed, report and solve the
problem.

■
 Acute: Contact customer support. Take adequate

measure as instructed, report and solve the problem.

Alert Detail window
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Item Description

Error Section Displays information about the section of an error

Error Detail Displays more detail about the error

Location Displays the location for the error

Concerned Alerts Displays the Alert ID related to the notified alert

Action Codes

Item Description

Action Code Displays the alert action code

Possible Failure Parts Displays the part that might have been the cause of the alert

Location Displays the location for the error

Temperature Monitor window

Displays the temperature information for DKC and DB.

Temperature Monitor window
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Temperature Monitor window
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DKC Ambient Temperature table

Item Description

Chassis ID Displays the chassis ID of the storage system.

Measurement
Location

Displays the measurement location.

Ambient Temperature
(degrees C)

Displays the ambient temperature in degrees Celsius.

A hyphen (-) is displayed if the DKC is turned off, or the
temperature information cannot be acquired due to a unit or
network failure.

Export button Displays a window for outputting table information.

DB Internal Temperature table

Item Description

Disk Unit Displays the disk unit of the storage system.

Drive Box Displays the drive box.

Measurement
Location

Displays the measurement location.

Internal Temperature
(degrees C)

Displays the internal temperature in degrees Celsius.

Nothing is displayed in the DB internal temperature table
when the DKC is turned off. The DB is not displayed in the DB
internal temperature table when the temperature information
cannot be acquired because the chassis is not installed, the
DB is blocked for maintenance, or a unit or network failure
occurred.

Export button Displays a window for outputting table information.

Temperature Monitor window
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Appendix J:  Using Device Manager - Storage
Navigator secondary windows

Some Hitachi Device Manager - Storage Navigator operations are performed through
secondary window within the Java Runtime Environment (JRE).

This section describes requirements, operation methods, notes, and troubleshooting
required to use Hitachi Device Manager - Storage Navigator secondary windows.

Requirements for using HDvM - SN secondary windows

This topic describes the configuration prerequisites for using Device Manager - Storage
Navigator secondary windows.

Installing and configuring JRE

JRE must be installed and configured in a Windows or Unix environment. You can
download JRE from http://www.oracle.com/technetwork/java/index.html.

Java Runtime Environment version

To use Device Manager - Storage Navigator secondary windows:

Caution: If the SVP microcode version is 88-04-01-XX/00 or later, use JRE6
update131 or later, JRE7 update79 or later, or JRE8 update171 or later. You
can use Device Manager - Storage Navigator secondary windows only on PCs
on which these JRE versions are installed. If you want to use other JRE
versions, contact customer support.

Caution: If the SVP software version is earlier than 88-03-23-XX/00, the Device
Manager - Storage Navigator secondary windows cannot be used even if Java
11 or later is installed on the management client. If the SVP software version
is earlier than 88-03-23-XX/00 and you use the Device Manager - Storage
Navigator secondary windows, install Java 8 or earlier on the management
client.

Procedure

1. Check the architecture (32-bit or 64-bit) of the browser you are using.
2. From http://www.oracle.com/technetwork/java/index.html. download and install

Java Runtime Environment with the same architecture as the browser.
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3. Download the JRE Installation Guide from the same site and follow the instructions
to install JRE.

Note: Use only JRE supplied by Oracle Corporation.

Path setting (UNIX)

Verify that JRE is installed correctly by opening the ControlPanel.html file. It is located in
the JRE root directory. If the file opens, JRE is installed correctly.

Configuring JRE

On the JRE of each Device Manager - Storage Navigator management client, Java log file
trace and logging must be enabled and caching must be disabled. The Java log file can
help you troubleshoot a problem when an application error occurs in the Device
Manager - Storage Navigator web client. Disabling the caching feature can help prevent
complications when the software is updated. See the http://java.sun.com website for
more information on configuring JRE through the Java Control Panel.

Setting up Java

Set up Java to perform the following activities:
■ Enable tracing and logging so that you can collect log files when an application error

occurs on a management client
■ Change the cache settings so that to prevent the old software from remaining in

cache when a software is updated, the old software will not remain in the cache
■ Configure a proxy server

Proxy server settings

You can set Device Manager - Storage Navigator to either use or not use a proxy server
to access the SVP. To do this, change the HTTP setting on the web browser on the
management client to either use a proxy server, or set the SVP as an exception so that it
does not use a proxy server. Whichever setting you use, make the same setting for Java.

Path setting (UNIX)
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Procedure

1. Start the Java Control Panel.

■ In Windows, from Windows Control Panel, double-click the Java icon.

■ In Unix, run one of the following executable files:

SDK-directory/jre/bin/ControlPanel

SDK-directory/jre/ControlPanel

JDK-directory/jre/ControlPanel

■ Alternatively, use a web browser to display one of the following Control Panel
pages:

SDK-directory/jre/ControlPanel.html

JDK-directory/ControlPanel.html

2. In the Java Control Panel, click the Advanced tab.
3. Under Debugging, click Enable tracing and Enable logging.

Setting up Java
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4. In the Java Control Panel, click the General tab.
5. In the Temporary Internet Files, click Settings. The Temporary Files Settings dialog

box displays.

Setting up Java
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6. In the Temporary Files Settings dialog box:
a. For JRE 7.0, click the Keep temporary files on my computer checkbox to

enable it.
b. In the Disk Space area, enter 1 MB.
c. Click OK to close the dialog box.

7. Configure the proxy settings as required.
a. In the Java Control Panel, select the General tab.
b. Click Network Settings to display the Network Settings dialog box.

8. In the Java Control Panel, click OK to close it.

Enabling the HDvM - SN secondary window

If you plan to use any of the following functions in Device Manager - Storage Navigator
(HDvM - SN), you must enable the HDvM - SN secondary window:
■ Login Message function
■ Data Retention Utility
■ Server Priority Manager

The HDvM - SN secondary window runs within the Java Runtime Environment (JRE) on
the management client. The secondary window is disabled by default in HDvM - SN and
must be enabled by using HDvM - SN, or by using Web Console Launcher when Java 11
or later is installed on the HDvM - SN management client. If the secondary window is not
enabled, the functions listed above are not accessible in HDvM - SN.

Before you begin
■ Required role: Storage Administrator (View Only)

Procedure

1. From the Settings menu, click Environmental Settings > Edit Information
Display Settings.
The Edit Information Display Settings window opens.

2. In Secondary window, click Enable.
3. Click Apply.

Using Web Console Launcher to enable the secondary
window (Java 11 or later)

Enabling the HDvM - SN secondary window
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When Java 11 or later is installed on the Device Manager - Storage Navigator (HDvM - SN)
management client, you must download and execute Web Console Launcher to enable
the HDvM - SN secondary window. The setup file that you download contains the
following applications:
■ Web Console Launcher: This application is required to enable the HDvM - SN

secondary window when HDvM - SN is running on a web browser with Java 11 or later
installed.

■ Storage Device Launcher: This application is required to start HDvM - SN in the Adobe
AIR environment. Storage Device Launcher is contained only in the setup file for
Windows.

When the HDvM - SN secondary window is opened, you must enable the .jnlp file
included in the setup file.

Note: You must perform the following procedure each time the SVP firmware
is upgraded.

Procedure

1. From the Menu bar, click Tool > Download.
2. Download the Web Console Launcher tool for Windows or UNIX.
3. Expand and execute the download file by the following OS method:

Windows: Expand the file, right click WCLauncher\Setupwin.bat and execute it by
selecting Run as Administrator. This associates the downloaded .jnlp file with Web
Console Launcher.

UNIX: Enter tar zxvf WCLauncher_unix.tgz to expand the file, and then enter
sudo shsetupunix.sh in the expanded directory to execute it.

Note: When you execute Web Console Launcher, Java8 is disabled.

Next steps

Each time you open the HDvM - SN secondary window with Java 11 or later, you must
enable the .jnlp file using Web Console Launcher.

Caution: Do not delete or move the WCLauncher_win folder. This folder
contains files required to run Web Console Launcher.

Resetting the secondary window

The Device Manager - Storage Navigator secondary window is reset when you do any of
the following:
■ Click Apply or Cancel
■ Click Refresh or Refresh All on the File menu
■ Switch tabs

Resetting the secondary window
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Secondary window menus and buttons

The following figure shows the Device Manager - Storage Navigator secondary window.

The following table describes the menus and buttons accessible in the window.

Item Description

Title bar Provides information about the connected storage system.
■ IP indicates the IP address of the SVP.
■ S/N indicates the serial number.
■ D/N indicates the device name specified in the Edit storage system

window.

File > Refresh
All

Updates the information on the SVP. All information displayed on the
Device Manager - Storage Navigator secondary window is reacquired
from the storage system. We recommend that you use this command
only when error recovery is required.
■ Takes time until the processing has been completed.
■ While updating, other users are not allowed to perform any

operation on the Device Manager - Storage Navigator windows.
Maintenance of the storage system or the SVP operation by the
service personnel is not allowed, either.

■ Available only for the user with Storage Administrator (Initial
Configuration) role.

Secondary window menus and buttons
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Item Description

■ Available only when the user is in Modify mode.
■ The information may not display correctly if SVP maintenance is in

progress.
■ Try this command if the configuration information displayed on

the Device Manager - Storage Navigator differs from the actual
configuration information that can be recognized from the host.

File > Refresh Displays the latest information on Device Manager - Storage
Navigator.

The information might not display correctly when the exclusive lock is
effective or SVP maintenance is in progress.

File > Close Closes the Device Manager - Storage Navigator secondary window

Go menu Indicates software names

Help menu About: Opens the About dialog box to show the version of the
storage system.

 Unlocked

 Locked

Indicates the current operational mode of Device Manager - Storage
Navigator.

If all logged in users are currently working in the view mode, the blue

unlocked-shaped icon ( ) appears. If any user is working in the

Modify mode, the red locked-shaped icon ( ) appears.

Note: The operational status might not be displayed correctly when
the exclusive lock is effective or SVP maintenance is in progress.

 View

 Modify

Allows users to switch the operation mode between Modify and View.
The button always shows the current user operation mode. To change
the modes, click the button.

You cannot switch to the Modify mode while any other user is
operating in the Modify mode. Make sure to confirm the exclusive
lock icon before switching to the Modify mode.

Reset Reset the remaining time for the Modify mode. Appears only when
you are in Modify mode.

Logged in as Shows the user ID of the currently logged-in user.

Logout
Closes the Device Manager - Storage Navigator secondary window.

Apply Implements all the changes or settings displayed in blue bold italics.
This button is available only in Modify mode.

Secondary window menus and buttons
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Item Description

You can create and store up to 20,000 settings or operations before
actually applying them to the storage system. To avoid a possible
error, do not apply more than 20,000 settings at a time.

Cancel Cancels the changes or settings made on the window. This button is
available only in Modify mode.

HDvM - SN secondary windows and Modify mode

A secondary window opens when you click a command from the Device Manager -
Storage Navigator menu. To make settings in a secondary window, you must change to

Modify mode by clicking . Modify mode prohibits other users or programs from
changing the storage system setting. As soon as you close the secondary window, Modify
mode is released.

The secondary window displays the progress bar (shown in the following figure)
indicating the remaining time in the timeout period. To extend this period and remain in
Modify mode, click Reset.

Main window and Modify mode

There is no Modify mode for the Device Manager - Storage Navigator main window. Main
window and wizard operations are queued as tasks and performed in order. However,
when using a Device Manager - Storage Navigator secondary window, you must be in
Modify mode before changing any settings. Secondary window operations are not
queued or displayed in the task window.

Cautions when using secondary windows

If you use IPv6 to display the Device Manager - Storage Navigator main window when
both IPv4 and IPv6 are available, IPv6 addresses are displayed in the Device Manager -
Storage Navigator secondary window but actually IPv4 communication is used.
■ The mouse wheel may not function in the Device Manager - Storage Navigator

secondary window.
■ If you accept other processing while you are changing the configuration of the storage

system on the secondary window, an error occurs.
■ If an error occurs when you try to log in or when you click Apply, wait awhile and log

in again.
■ If an error occurs when you switches operation modes (View/Modify) or tabs, wait

awhile and click File > Refresh.

HDvM - SN secondary windows and Modify mode
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Validity period of the Device Manager - Storage Navigator program

The code signature using the certificate is signed for the Device Manager - Storage
Navigator program to certify the developer of the program. Also, the timestamp* is
stamped to certify that the developer of the program signed the code signature during
the validity period of the certificate. While the timestamp is valid, you can verify that
Hitachi is the developer of the program, and securely use the program.

Note: The timestamp stores (in a secure format that prevents falsification)
the date and time that the code signature was signed. Therefore, by using the
timestamp, you can verify whether the code signature was signed during the
validity period of the certificate, and whether the program has been safe from
falsification after the code signature was signed.

Before the Device Manager - Storage Navigator secondary window opens, the following
dialog box appears. (The contents of the dialog box differ depending on the Java
version.) To start the Device Manager - Storage Navigator secondary window, click Run.

Validity period of the Device Manager - Storage Navigator program
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Note: To check the validity period of the certificate, click More Information >
View Certificate Details. Even if the certificate expired, the user can securely
use the Storage Navigator secondary window while the timestamp is valid.

Validity period of the Device Manager - Storage Navigator program
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Java updates

Some Device Manager - Storage Navigator operations are performed using Java
applications. You may be prompted to update the Java application when navigating to
these operations, as shown in the following figure.

Note:

The Java Update Needed dialog box appears when a newer version of Java is
available. Depending on your environment, the appearance of this dialog box
might differ.

Note the following:
■ To download and install the recommended Java version, click Update (recommended).

If the secondary window does not display after the update is complete, see Enabling
the HDvM - SN secondary window (on page 32) .

■ To prevent Java content from displaying in the current browser session, click Block. If
the secondary window does not display after the update is complete, see Enabling the
HDvM - SN secondary window (on page 32) .

■ To use the currently installed Java version, click Later. The Device Manager - Storage
Navigator secondary window for the application you are using opens.

After you click Later, if the error 20020-108000 appears, open the Device Manager -
Storage Navigator main window, and then open the secondary window again.

■ To prevent this dialog box from appearing again, check Do not ask again until the next
update is available.

Enabling Java for secondary windows

Device Manager - Storage Navigator secondary windows require Java. We recommend
using the most recent version of Java.

Java updates
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Note: When updating Java:
■ You must log out of Device Manager - Storage Navigator, close all browser

windows, and then log back in.
■ If you select Do not ask again until the next update is available, and then

click Update or Block, you cannot use the Device Manager - Storage
Navigator secondary window.

Procedure

1. Log out of Device Manager - Storage Navigator.
2. Start Java Control Panel.

■ In Windows, from Windows Control Panel, double-click the Java icon.

■ In Unix, run one of the following executable files:

SDK-directory/jre/bin/ControlPanel

SDK-directory/jre/ControlPanel

JDK-directory/jre/ControlPanel

■ Alternatively, use a web browser to display one of the following Control Panel
pages:

SDK-directory/jre/ControlPanel.html

JDK-directory/ControlPanel.html

3. In Java Control Panel, click the Security tab.
4. Perform one of the following:

If Enable Java content in the browser is selected:
a. Clear the check box, and then click Apply.
b. Select the check box, and then click Apply.

If Enable Java content in the browser is not selected:
a. Select the check box, and then click Apply.

5. Click OK.
6. Log in to Device Manager - Storage Navigator.

Enabling Java for secondary windows
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Troubleshooting secondary windows

The following tables list error conditions in the Device Manager - Storage Navigator
(HDvM - SN) secondary window and provide recommended actions to resolve the errors:
■ Java application errors (on page 531)
■ No response errors (on page 536)
■ Incorrect display errors (on page 537)
■ Other errors (on page 539)

Table 27 Java application errors

Error condition Probable cause / recommended action

When you click the HDvM - SN menu, the
system does not respond. One minute
later, application error (20020-108000)
occurs.

The pop-up blocker function of your web
browser might restrict HDvM - SN. If the
problem still continues after you perform
the operation multiple times, perform one
or both of the following actions:
■ Disable the pop-up blocker function of

your web browser.
■ Disable the pop-up blocker function of

any browser plug-in/add-on.

If neither of the above can be performed
in Internet Explorer, you can open the
window by clicking the HDvM - SN menu
while holding down the Ctrl key.

Another possible cause is that a Java
application was not allowed to start. If a
message appears and asks if you want to
run an application, click Run.

If none of the above actions solve the
problem, reinstall the JRE.

When you click the HDvM - SN menu, a
message appears asking you to download
the file SJsvlSNStartServlet.do or
SJsvlAppStartServlet.do. One minute later,
the application error (20020-108000)
occurs.

The possible causes are that the JRE is not
installed in the management client, the
JRE installation failed, or the JRE add-on is
disabled on the web browser. Cancel the
message, and install the JRE. If the JRE is
already installed, reinstall it.

When you click the HDvM - SN menu, a
message appears asking you to save a Jnlp
file.

Perform the following to save the
encrypted page:

1. In Internet Explorer, click Tools >
Internet options, and then select the
Advanced tab.

Troubleshooting secondary windows
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Error condition Probable cause / recommended action

2. In the Security section, uncheck Do
not save encrypted pages to disk.

3. Click OK.

■ The application errors (20020-108000
and 10-6027) occur when you click the
HDvM - SN menu.

■ The application error (10-6027) occurs
and HDvM - SN terminates when you
click the HDvM - SN menu.

If the problem continues after you
perform the operation multiple times, see
the probable causes listed below.

For Windows: Exit all applications using
Java, and then terminate the javaw.exe
and javaws.exe applications through Task
Manager.
■ Java on the HDvM - SN web client might

have failed to start due to timeout.
Close all other applications and
perform the HDvM - SN operation
again.

■ The version of HDvM - SN recognized
by the management client might not
match the version installed on the SVP.
Close all the windows of your web
browser and then clear the Java and
web browser cache.

■ The management client might have
entered standby or hibernate mode.
Restart the management client.

■ If a proxy server is used for network
connections, the proxy cache may be
storing the older version of the
program. If the problem continues
after you clear the Java and web
browser caches, contact your network
administrator.

■ The network connection between the
SVP and the management client might
be blocked by a firewall or some kind
of device.

Check the firewall settings and contact
your network administrator.

Troubleshooting secondary windows
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Error condition Probable cause / recommended action

If none of the above actions solve the
problem, save the dump file, the Java
trace file and the log file on the
management client, and report to
customer support. Then restart HDvM -
SN.

When you click the HDvM - SN menu, the
system does not respond.

If the problem continues after you
perform the operation multiple times,
close all the HDvM - SN windows and clear
the Java and web browser caches.

The application error (1-7050) occurs
when you click the HDvM - SN menu.

The version of HDvM - SN recognized by
the management client might not match
the version installed on the SVP. Close all
the windows of your web browser and
then clear the Java and web browser
caches. In addition, if a proxy server is
used for network connections, the proxy
server cache may be storing the older
version of the program. If the problem
continues after you clear cache of both
Java and web browser, contact your
network administrator.

Java console is grayed out and does not
start when you try to open the HDvM - SN
secondary window (Java application).

Restart the management client, or
terminate the HDvM - SN process with
one of the following methods:
■ For Windows: Exit all applications using

Java, and then terminate the javaw.exe
and javaws.exe applications through
Task Manager.

■ For UNIX: Exit all applications using
Java, and then terminate javaw and
javaws with the kill command.

A message box remains displayed when
opening the HDvM - SN secondary
window (Java application). The HDvM - SN
secondary window does not appear for a
long time.

Restart the management client, or
terminate the HDvM - SN process with
one of the following methods:
■ For Windows: Exit all applications using

Java, and then terminate the javaw.exe
and javaws.exe applications through
the Task Manager.

■ For UNIX: Exit all applications using
Java, and then terminate javaw and
javaws with the kill command.

Troubleshooting secondary windows
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Error condition Probable cause / recommended action

A message remains displayed when the
HDvM - SN secondary window opens and
the system does not respond.

The SVP may be set as an exception on
the proxy setting of the web browser.

Do the same settings on the Network
Settings displayed in the General tab of
the Java Control Panel.

If you open the Java console dialog box by
selecting the Java icon on the system tray
while opening the HDvM - SN secondary
window (Java application), the browser
and Java console may stop responding.

Do not open the Java console dialog box
while opening the HDvM - SN secondary
window. If the browser and Java console
stop responding, restart the management
client.

When you click the HDvM - SN menu. The
application error (20020-108000) occurs.

If the problem continues after you repeat
the operation several times, you might
have cancelled the display of the
secondary window. Restart the
management client, or terminate the
HDvM - SN process with one of the
following methods: For example:
■ You might have clicked Exit on the

Security Warning window.
■ You might have clicked Cancel on the

Warning - Security window.

Close all the HDvM - SN windows and
clear the Java and web browser caches.

If the problem continues after you clear
both Java and web browser caches, save
the HDvM - SN dump file and the Java
trace file, and send them to HDvM - SN.

Troubleshooting secondary windows
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Error condition Probable cause / recommended action

The following message displays in HDvM -
SN.
■ Java has discovered application

components that could indicate a
security concern.

■ Block potentially unsafe components
from being run. (recommended)

■ The application contains both signed
and unsigned code. Contact the
application vendor to ensure that it has
not been tampered with.

Select Yes to continue using HDvM - SN. If
the problem continues, the cause may be
one of the following:
■ The version of HDvM - SN recognized

by the management client might not
match the version installed on the SVP.
Close all the windows of your web
browser and then clear the cache of
both Java and the web browser

■ If a proxy server is used for network
connections, the proxy server cache
may be storing an older version of the
program. Clear the cache of both Java
and the web browser. If the problem
remains, contact your network
administrator.

In Internet Explorer, the following pop-up
window appears when you open the
HDvM - SN secondary window.

"Internet Explorer has stopped working. A
problem caused the program to stop
working correctly. Windows will close the
program and notify you if a solution is
available."

Third-party browser extensions of Internet
Explorer might be enabled.

Disable third-party browser extensions as
follows:

1. In the Windows menu bar, click Tools
> Internet Options, and then click the
Advanced tab.

2. In the Advanced tab, clear the Enable
third-party browser extensions
(requires restart) check box.

3. Restart Internet Explorer.

In Internet Explorer, an application error
(10-6027) occurs when you open the
HDvM - SN secondary window.

The SmartScreen Filter function might be
enabled when you use Internet Explorer
8.0 or later. Turn off SmartScreen Filter as
follows:

1. In the Windows menu bar, click
Safety > SmartScreen Filter > Turn Off
SmartScreen Filter.

2. Restart Internet Explorer.

In Internet Explorer or Google Chrome,
either of the following pop-up windows
appears when you open the HDvM - SN
secondary window.

"Application Blocked by Java Security" or
"Application Blocked by Security Settings"

The certificate used to sign the SVP
program might have expired. Update the
SVP microcode version to 88-04-01-XX/00
or later.

Troubleshooting secondary windows
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Table 28 No response errors

Error condition Probable cause / recommended action

HDvM - SN hangs and does not respond.

HDvM - SN may hang in the following
cases:
■ When you move a window displayed in

front of the HDvM - SN secondary
window, the area behind the window
remains gray and does not go back to
normal for a long period of time.

■ The entire HDvM - SN secondary
window goes gray and does not go
back to normal for a long period of
time.

From the HDvM - SN secondary window,
press Ctrl+Alt+Shift+D all at once to exit
HDvM - SN.

If you cannot exit HDvM - SN, reboot the
management client or restart HDvM - SN
after finishing HDvM - SN forcibly by the
following way.
■ For Windows: Exit all applications using

Java, and then terminate the javaw.exe
and javaws.exe applications through
Task Manager.

■ For UNIX: Exit all applications using
Java, and then terminate javaw and
javaws with the kill command.

When you click Refresh All or Refresh in
the HDvM - SN secondary window, it
displays the message "Loading" for a long
time.

The probable causes are:
■ Another application such as Command

Control Interface may be changing
configuration. The window will be
updated shortly after the configuration
change ends.

■ Volume Migration operations, Quick
Restore operations or Thin Image
operations may be in progress. The
window will be updated shortly after
the operations end.

Error 110-67005 occurred during a HDvM -
SN operation on the secondary window.

The probable causes are:
■ Another application such as Command

Control Interface may be changing
configuration.

■ Volume Migration operations, Quick
Restore operations, or Thin Image
operations may be in progress.

■ The configuration data may not be
matched if a communication error
occurs between the storage system
and the SVP. Wait a few minutes and
then click File > Refresh All to reread
the configuration information. Then
launch Device Manager - Storage
Navigator again.

Troubleshooting secondary windows
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Error condition Probable cause / recommended action

While you are using a HDvM - SN
secondary Window, it closes unexpectedly
and error 20020-108000 occurs.

Start the HDvM - SN secondary window
from the HDvM - SN main window again. If
this error occurs repeatedly, close all the
HDvM - SN windows, and then clear the
Java and web browser caches.

The web browser closes abnormally This problem can occur if a Mozilla
process keeps running after Mozilla stops
responding. Delete the "java_vm" and
"mozilla" processes and continue with
HDvM - SN operations.

One of the following sets of errors
occurred when using HDvM - SN:
■ 20121-107024 and 10-6027
■ 20020-108000 and 10-6027
■ 10-6027

The probable causes are:
■ The SVP may have been restarted.

Close HDvM - SN, wait 10 minutes, and
then restart it.

■ The version of HDvM - SN recognized
by the management client might not
match the version installed on the SVP.
Close all the browser windows and
then clear the browser cache.

■ The management client might be in
standby or hibernate mode. Restart
HDvM - SN.

■ If a proxy server is used for network
connections, the proxy server cache
may be storing the older version of the
program. If the problem continues
after you clear the browser cache,
contact your network administrator.

■ Restart the web browser

If none of the above actions solve the
problem, save the HDvM - SN dump file
and send it to customer support.

Table 29 Incorrect display errors

Error condition Probable cause / recommended action

Only the Exit button and the Refresh and
Refresh All commands are effective when
accessing the SVP from HDvM - SN.

The SVP might not be ready to perform
some write processes from the other
system. Wait a few minutes and then click
File > Refresh. If the SVP is not restored,
click Refresh All.

Troubleshooting secondary windows

Appendix J: Using Device Manager - Storage Navigator secondary windows

System Administrator Guide for VSP E990 and VSP G130, G/F350, G/F370, G/F700, G/F900 537



Error condition Probable cause / recommended action

Only the Exit button and the Refresh All
command are effective when accessing
the SVP from the HDvM - SN.

An error may have occurred in the SVP.
Click File > Refresh All. If the SVP is not
restored, log in to HDvM - SN again.

The commands in the Go menu are
unavailable.

The required software options might not
be installed or an error might occur on the
window that appears after you click the
command.

Make sure that all the required software
options are installed. If they are installed,
do one of the following:
■ Click File > Refresh.
■ Click File > Refresh All.
■ Log in to HDvM - SN again.

When you switch windows from one
window to the HDvM - SN window, the
HDvM - SN window is not displayed.

Close all windows, and then log in to
HDvM - SN again.

The items in a list are not synchronized
with a scroll bar.

Click the scroll buttons  or 

above and below the scroll bar.

The focus disappears from the edit box. Close all dialog boxes, and then log in to
HDvM - SN again.

The web browser does not display
correctly, because some GUI items such as
labels and icons cannot be loaded
properly.

Log out of HDvM - SN, and then log in
again. If this error occurs before you log in
to the HDvM - SN, close all dialog boxes
and then log in to HDvM - SN.

The characters are unreadable because
they are overlapped or garbled.

Log out of HDvM - SN, and then log in
again.

The characters are garbled in a window
where a tree is displayed.

Click File > Refresh.

Even though you have clicked Apply to
change storage system settings, the new
settings are not displayed in HDvM - SN.

Click File > Refresh.
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Error condition Probable cause / recommended action

The dialog box that says Loading... stays
open for a long period of time.

A HDvM - SN message dialog box other
than the dialog box that says Loading...
might be displayed behind this window.
Press Alt+Tab to switch the dialog box.

If the dialog box that says Loading...
remains displayed for several hours after
you apply the settings to the storage
system, contact customer support.

The following information does not
display in HDvM - SN windows:
■ Information on the storage system,

such as ports or HDDs
■ Information configured with another

management client

Click File > Refresh. If the problem
continues, close all HDvM - SN windows,
and then clear the Web browser caches.

The HDvM - SN secondary window does
not display.

■ In the Java Control Panel, click the
Temporary Internet Files section. In the
Disk Space area, enter 1 MB, and then
click Delete Files.

■ Click Security > Java Control Panel.
Ensure that Enable Java content in the
browser is checked.

■ Clear the browser cache.
■ Ensure that Java Plug-in is enabled.

If none of the above actions solve the
problem, the web browser might not
recognize Plug-in correctly. Initialize and
redo the web browser settings.

Table 30 Other errors

Error condition Probable cause / recommended action

If you click in a HDvM - SN secondary
window while a dialog box is open, the
dialog box disappears behind the HDvM -
SN secondary window.

Click the dialog box again.

An error occurs because a digital
signature or security certificate has
expired.

You can continue using HDvM - SN even
though the digital signature for the HDvM
- SN Java application is expired.
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Error condition Probable cause / recommended action

You specify IPv6 communication
addresses when you start HDvM - SN, but
IPv6 is not being used. Instead, IPv6 is
being used and IPv4 addresses are output
to audit logs for operations on the HDvM -
SN secondary window.

IPv4 has higher priority when both IPv4
communication and IPv6 communication
can be used. As a result, IPv4 may be used
when you specify IPv6 communication
addresses. Also, IPv4 addresses may
appear in audit logs.

Clearing Java caches

When an error occurs on Device Manager - Storage Navigator, clearing the Java and web
browser caches might solve the problem.

Procedure

1. Select Start > Control Panel > Java. The Java Control Panel opens.
2. In the Java Control Panel, click the General tab.
3. In the Temporary Internet Files section of the General tab, click Settings. The

Temporary Internet Files dialog box opens.
4. Click Delete Files. The Delete Temporary Files confirmation dialog box opens.
5. Select Applications and Applets. Selecting Trace and Log Files is optional.
6. Click OK to confirm the deletion and close the Delete Temporary Files

confirmation dialog box.
7. Click OK to close the Temporary Internet Files dialog box.
8. Click OK to close the Java Control Panel.
9. Close the Control Panel.

Saving Java log and trace files

Before you contact your service representative, save the detail dump files collected using
the Dump tool, and the Java log and trace file on your management client, and then
restart the web browser.

Examples of the Windows trace and log file locations are shown below.
■ C:\Users\logon user ID\AppData\LocalLow\Sun\Java\Deployment\log\*.trace
■ C:\Users\logon userID\AppData\LocalLow\Sun\Java\Deployment\log\*.log

Examples of the UNIX trace and log file locations follow:
■ user home directory\.java\deployment\log\*.trace
■ user home directory\.java\deployment\log\*.log

Clearing Java caches
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Problems with a website security certificates

Some operations in the Device Manager - Storage Navigator menu are executed with a
Java application. Therefore, an SSL-related security warning may appear when the
secondary window opens. If the message “There is a problem with this website's security
certificate." is displayed, follow the procedure below.

This alert message is displayed also when the IP address or host name specified in the
URL do not match the CN(Common Name) listed in the security certificate.

Procedure

1. Click Continue to this website (not recommended).

2. If a message about downloading SJsvlSNStartServlet.do displays, click Open.

3. If A website wants to open web content using an outdated program on your
computer is displayed, click Allow.

Problems with a website security certificates
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4. If the Security Warning window is displayed, click Continue. The application will
start downloading.

5. If the Security Warning window is displayed, select I accept the risk and want to
run this application, and click Run.
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6. Device Manager - Storage Navigator opens.
7. Close the warning window.

Note: Sometimes, the window that displays There is a problem with
this website' s security certificate does not close automatically. It is
OK to close the window manually.
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